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API Documentation
Common Request Headers
Last updated：2024-01-31 17:07:40

Overview

This document describes common request headers that may be used in API requests. The headers mentioned below 
will not be addressed again in related API documents.

Request Headers

Header Description Type Required

Authorization
Carries the authentication information, i.e., 
signing information, used to verify the validity of 
a request 

string Yes

Content-Length Length in bytes of the content of an HTTP 
request defined in RFC 2616

integer NoRequired for PUT 
and POST requests

Content-Type
Content type (MIME) of an HTTP request as 
defined in RFC 2616, such as application/xml string

NoRequired for PUT 
and POST requests with 
a request body

Content-MD5

Base64-encoded MD5 hash value of the request 
body content as defined in RFC 1864, such as 
ZzD3iDJdrMAAb00lgLLeig==. The value is 
used to verify whether the request body 
experienced any changes during transfer.

string No

Date Current time in GMT as defined in RFC 1123, 
such as Wed, 29 May 2019 04:10:12 GMT

string No

Host Requested host in the format of <BucketName-
APPID>.ci.<Region>.myqcloud.com

string Yes

x-ci-security-
token

Security token field required when using 
temporary security credentials

string NoRequired when a 
temporary key is used 
and the authentication 
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information is carried 
through Authorization
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Common Response Headers
Last updated：2024-01-31 17:07:40

Overview

This document describes common response headers that may be used in API requests. The headers mentioned 
below will not be addressed again in related API documents.

Response Headers

Header Description Type

Content-Length HTTP response length in bytes as defined in RFC 2616 string

Content-Type HTTP response type (MIME) as defined in RFC 2616 string

Connection Indicates whether the network connection will be turned off after the response is 
complete, defined in RFC 2616. Enumerated values: `keep-alive`, `close`.

Enum

Date Server response time in GMT format as defined in RFC 1123, such asWed, 29 
May 2019 04:10:12 GMT

string

Server Name of the server that accepts the request and returns the response. Default 
value: tencent-ci

string

x-ci-request-id ID automatically generated by the server for each request when the request is 
sent

string

x-ci-trace-id ID automatically generated by the server for each error when a request fails. 
This header will be included in the response only if the request has failed.

string
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Bucket Configuration
Binding CI
Last updated：2024-01-31 17:07:40

Overview

This API is used to bind CI to an existing COS bucket. For bucket-related features such as queries and modifications, 
please use COS APIs.

Request

Sample request
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PUT / HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Note: 

 Authorization: Auth String (see Request Signature for more information).

Request headers

This API only uses common request headers. For more information, please see Common Request Headers.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/436/7728
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Request body

The request body of this request is empty.

Response

Response headers

This API returns only common response headers. For more information, please see Common Response Headers.

Response body

The response body of this response is empty.

https://intl.cloud.tencent.com/document/product/436/7729
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Querying CI
Last updated：2024-01-31 17:07:40

Overview

This API is used to query whether CI has been enabled for a bucket.

Request

Sample request
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GET / HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

Note: 

 Authorization: Auth String (see Request Signature for more information).

Request headers

This API only uses common request headers. For more information, please see Common Request Headers.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/436/7728
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Request body

The request body of this request is empty.

Response

Response headers

This API returns only common response headers. For more information, please see Common Response Headers.

Response body

https://intl.cloud.tencent.com/document/product/436/7729
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<?xml version="1.0" encoding="UTF-8" ?>

<CIStatus>on</CIStatus>

The node information is as follows:

Node Name (Keyword) Description

CIStatus Valid values:  on ,  off 
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Unbinding CI
Last updated：2024-01-31 17:07:39

Overview

This API is used to unbind CI from a bucket (the bucket and its files will be retained in COS).

Request

Sample request
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PUT /?unbind HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

Note: 

 Authorization: Auth String (see Request Signature for more information).

Request headers

This API only uses common request headers. For more information, please see Common Request Headers.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/436/7728
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Request body

The request body of this request is empty.

Response

Response headers

This API returns only common response headers. For more information, please see Common Response Headers.

Response body

The response body of this response is empty.

https://intl.cloud.tencent.com/document/product/436/7729
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Querying Hotlink Protection
Last updated：2024-01-31 17:07:40

Overview

This API is used to query the hotlink protection details (blocklist and allowlist) about a bucket.

Request

Sample request



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 25
of 2300

GET /?hotlink HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

Note: 

 Authorization: Auth String (see Request Signature for more information).

Request headers

This API only uses common request headers. For more information, please see Common Request Headers.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/436/7728
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Request body

The request body of this request is empty.

Response

Response headers

This API returns only common response headers. For more information, please see Common Response Headers.

Response body

The response body contains the type of hotlink protection and enumerates all allowed URLs.

https://intl.cloud.tencent.com/document/product/436/7729
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<?xml version="1.0" encoding="UTF-8" ?>

<Hotlink>

    <Status>on</Status>

    <Type>white</Type>

    <Url>xxx</Url>

    <Url>xxx</Url>

</Hotlink>
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Setting Hotlink Protection
Last updated：2024-01-31 17:07:40

Feature

This API is used to add hotlink protection (set blocklist/allowlist) for a bucket.

Request

Request example
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PUT /?hotlink HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Note: 
Authorization: Auth String. For more information, see Request Signature.

Request headers

https://intl.cloud.tencent.com/document/product/436/7778
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This API only uses common request headers. For more information on common request headers, see Common 
Request Headers.

Request body

The node content of this request body is as follows:

<Hotlink>

        <Url>xxxxx</Url>

        <Type>black</Type>

</Hotlink>>

https://intl.cloud.tencent.com/document/product/436/7728
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Node 
Name

Parent Node Description Type Required

Url Hotlink  Indicates the domain name address. Container Yes

Type Hotlink

Indicates the hotlink protection type. The value 
white indicates allowlist, the value black indicates 
blocklist, and the value off indicates the hotlink 
protection is disabled.

String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body of this response is empty.

Use Cases

Request

https://intl.cloud.tencent.com/document/product/436/7729
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PUT /?hotlink HTTP/1.1

Host: examplebucket-1250000000.pic.ap-chengdu.myqcloud.com

Date: Wed, 18 Mar 2000 06:57:54 GMT

Authorization: XXXXXXXXXXXX

<Hotlink>

        <Url>www.example.com</Url>

        <Type>black</Type>

</Hotlink>
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Response

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Fri, 25 Feb 2017 04:10:22 GMT

Server: tencent-cos

x-cos-request-id: NTg3ZjFjMmJfOWIxZjRlXzZmNDhf****
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Enabling Original Image Protection
Last updated：2024-01-31 17:07:40

Overview

This API is used to enable the original image protection feature for a bucket.

Request

Sample request
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PUT /?origin-protect HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

Note: 

 Authorization: Auth String (see Request Signature for more information).

Request headers

This API only uses common request headers. For more information, please see Common Request Headers.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/436/7728
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Request body

The request body of this request is empty.

Response

Response headers

This API returns only common response headers. For more information, please see Common Response Headers.

Response body

The response body of this response is empty.

https://intl.cloud.tencent.com/document/product/436/7729
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Querying Original Image Protection Status
Last updated：2024-01-31 17:07:39

Overview

This API is used to query whether the original image protection feature is enabled.

Request

Sample request
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GET /?origin-protect HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

Note: 

 Authorization: Auth String (see Request Signature for more information).

Request headers

This API only uses common request headers. For more information, please see Common Request Headers.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/436/7728
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Request body

The request body of this request is empty.

Response

Response headers

This API returns only common response headers. For more information, please see Common Response Headers.

Response body

https://intl.cloud.tencent.com/document/product/436/7729
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<?xml version="1.0" encoding="UTF-8" ?>

<OriginProtectStatus>on</OriginProtectStatus>

Node Name (Keyword) Description

OriginProtectStatus Valid values:  on ,  off 
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Disabling Original Image Protection
Last updated：2024-01-31 17:07:39

Overview

This API is used to disable the original image protection feature.

Request

Sample request
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DELETE /?origin-protect HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

Note: 

 Authorization: Auth String (see Request Signature for more information).

Request headers

This API only uses common request headers. For more information, please see Common Request Headers.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/436/7728
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Request body

The request body of this request is empty.

Response

Response headers

This API returns only common response headers. For more information, please see Common Response Headers.

Response body

The response body of this response is empty.

https://intl.cloud.tencent.com/document/product/436/7729
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Image Processing
Basic Image Processing
Scaling
Last updated：2024-02-18 10:36:35

Feature Overview

CI uses the imageMogr2 API to scale images. The input image cannot be larger than 32 MB, with its width and height 
not exceeding 30,000 pixels, and the total number of pixels not exceeding 250 million. The width and height of the 
output image cannot exceed 9,999 pixels. For an input animated image, the total number of pixels (Width x Height x 

Number of frames) cannot exceed 250 million pixels.
An image can be processed:
Upon download
Upon upload
In cloud

API Format

1. Processing upon download
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GET /<ObjectKey>?imageMogr2/thumbnail/<imageSizeAndOffsetGeometry> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. Processing upon upload
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/thumbnail/<imageSizeAndOffsetGeometry>"

  }]
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}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://intl.cloud.tencent.com/document/product/1045/33695
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Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/thumbnail/<imageSizeAndOffsetGeometry>"

  }]

}

Parameters

Operation: thumbnail

Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

/thumbnail/!<Scale>p The percentage to scale the width and height of the input image

/thumbnail/!<Scale>px The percentage to scale the width of the input image, without changing the 
height

/thumbnail/!x<Scale>p The percentage to scale the height of the input image, without changing the 
width

/thumbnail/<Width>x The width of the output image, with the height scaled automatically

/thumbnail/x<Height> The height of the output image, with the width scaled automatically

/thumbnail/<Width>x<Height> The maximum width and height of the thumbnail for scaling

/thumbnail/<Width>x<Height>>

Specifies the maximum width and height of a thumbnail as  Width  and 
 Height  respectively for proportional scaling down. The smaller value 
between the width scale ratio and height scale ratio will be used as the scale 
ratio. If both the output width and height are greater than the input width and 
height, the image will not be scaled.

/thumbnail/<Width>x<Height><

Specifies the maximum width and height of a thumbnail as  Width  and 
 Height  respectively for proportional scaling up. The smaller value 
between the width scale ratio and height scale ratio will be used as the scale 
ratio. If both the output width and height are less than the input width and 
height, the image will not be scaled.

/thumbnail/! The minimum width and height of the thumbnail for scaling
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<Width>x<Height>r

/thumbnail/<Width>x<Height>! The output width and height with the aspect ratio of the input image ignored. 
Note that the output image may be distorted.

/thumbnail/<Area>@ The maximum number of pixels of the output image

/pad/

Whether to pad the blank area with the color specified by  color  after the 
input image is scaled as large as possible in a rectangle with the specified 
width and height, with the image centered. Valid values:  0  (not to pad), 
 1  (to pad)

/color/

Fill color. The value must be in hexadecimal format, such as  #FF0000 . For 
format conversion, see RGB Color Codes Chart. The value must be URL-
safe Base64-encoded as described in FAQs. Default value: #FFFFFF 
(white).

/ignore-error/1
If this parameter is carried and the image failed to be processed because the 
image size or the parameter value is too large, the input image will be 
returned with no error reported.

Examples

Note: 
Processing upon download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, see Persistent Image Processing and use Processing upon upload or Processing 
in-cloud data.

Input image:


https://www.rapidtables.com/web/color/RGB_Color.html
https://intl.cloud.tencent.com/document/product/1045/33430
https://intl.cloud.tencent.com/document/product/1045/33695
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Example 1: scaling the width and height

This example scales down the input image by 50% in width and height:
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/thum

Output image:
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Example 2: scaling the width without changing the height

This example scales down the width of the input image by 50% without changing its height:
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/thum

Output image:
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Example 3: scaling in padding mode

This example scales the input image as large as possible in a 600 x 600 rectangle and pads the blank area with a 
specified color:
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/thum

Output image:
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Example 4: scaling in padding mode with a signature carried

This example processes the image in the same way as in the example above except that a signature is carried. The 
signature is joined with other processing parameters using an ampersand (&).
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 

 You can obtain the value of  <signature>  by referring to Request Signature.

Notes

https://intl.cloud.tencent.com/document/product/436/7778
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To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple example for your reference (it 

might have expired or become inaccessible). For more information, see Upload via Pre-Signed URL.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Cropping
Last updated：2024-02-18 10:36:35

Feature Overview

CI uses the imageMogr2 API to crop images, including regular cropping, scaling and cropping, cropping to circle, 
rounded corner cropping, and smart face cropping.
An image can be processed:

During download
During upload
In the cloud

Restrictions

Format: Currently, JPG, BMP, GIF, PNG, and WebP images can be processed, and HEIF images can be decoded 
and processed.

Size: The input image cannot be larger than 32 MB, with its width and height not exceeding 30,000 pixels respectively, 
and the total number of pixels not exceeding 250 million. The width and height of the output image cannot exceed 
9,999 pixels respectively. For an animated input image, the total number of pixels (width * height * number of frames) 
cannot exceed 250 million.
Frames (for animated images): For GIF images, the number of frames cannot exceed 300.

API Sample

1. Processing during download
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GET /<ObjectKey>?imageMogr2/cut/<width>x<height>x<dx>x<dy>

                           /crop/<imageSizeAndOffsetGeometry>

                           /iradius/<radius>

                           /rradius/<radius>

                           /scrop/<Width>x<Height> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
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 Spaces and line breaks above are for readability only and can be ignored.

2. Processing during upload

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,
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  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/cut/<width>x<height>x<dx>x<dy>

                       /crop/<imageSizeAndOffsetGeometry>

                       /iradius/<radius>

                       /rradius/<radius>

                       /scrop/<Width>x<Height>"

  }]

}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

https://intl.cloud.tencent.com/document/product/1045/33695
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POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/cut/<width>x<height>x<dx>x<dy>
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                       /crop/<imageSizeAndOffsetGeometry>

                       /iradius/<radius>

                       /rradius/<radius>

                       /scrop/<Width>x<Height>"

  }]

}

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Parameters

Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

/ignore-
error/1

If this parameter is carried and the image fails to be processed because the image is too large 
or a parameter value exceeds the limit, the input image will be returned with no error reported.

Parameters for regular cropping

Operation name: cut.

Parameter Description

<width> Width of the output image

<height> Height of the output image

<dx> Horizontal offset relative to the top-left vertex

<dy> Vertical offset relative to the top-left vertex

Note: 
 The values should be greater than 0 and smaller than the width/height of the input image.

Parameters for scaling and cropping

Operation name: crop.

Parameter Description

/crop/<Width>x Width of the output image with the height unchanged. The value must be greater 

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 65
of 2300

than 0 and smaller than the width of the input image.

/crop/x<Height> Height of the output image with the width unchanged. The value must be greater 
than 0 and smaller than the height of the input image.

/crop/<Width>x<Height> Width and height of the output image. The values of width and height should be 
greater than 0 and smaller than those of the input image, respectively.

When performing scaling and cropping, you can also use the  gravity  parameter to specify the start position of 

the operation. For more information, see [Scaling and cropping](#Scaling and cropping).

Parameters for cropping to circle

Operation name: iradius.

Parameter Description

/iradius/<radius>

Crops to a circle.  radius  specifies the radius of the inscribed circle, which should be 
an integer greater than zero and less than half of the shorter side of the input image. The 
center of the inscribed circle is the center of the image. This operation is not supported for 
GIF images.

Parameters for rounded corner cropping

Operation name: rradius.

Parameter Description

/rradius/<radius>

Crops with round corners.  radius  specifies the radius of the rounded corner of the 
image, which should be an integer greater than zero and less than half of the shorter side 
of the input image. The two sides of the image are the tangent lines of the rounded corner. 
This operation is not supported for GIF images.

Parameters for smart face cropping

Operation name: scrop.

Parameter Description

/scrop/<Width>x<Height>
Scales and crops an image based on the face position in the image. The width and 
height of the target image are specified by  Width  and  Height  respectively.

3x3 Grid Position Diagram
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The 3x3 grid position diagram is as follows. Once you specify the  gravity  parameter for an operation, the 

corresponding red dot becomes the reference point, and offsets will be relative to this point. 


Note: 
If  gravity  is set to  center ,  dx  and  dy  are invalid.

If  gravity  is set to  north  or  south ,  dx  is invalid.

If  gravity  is set to  west  or  east ,  dy  is invalid.

Samples

Note: 

Processing during download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, see Persistent Image Processing and use the processing during upload or 
processing in-cloud data feature.

https://intl.cloud.tencent.com/document/product/1045/33695
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Sample 1: Regular cropping

This example shows how to translate by 100 px horizontally to the right and 10 px vertically to the bottom relative to 
the top-left vertex of the input image and then crop it according to the specified target image resolution of 600x600 px.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/cut/

Input image:
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Output image:
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Sample 2: Scaling and cropping

This example shows how to scale and crop an image to 300x400 px by using the center as the reference point.
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/crop

Output image:
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Sample 3: Cropping to circle

This example shows how to crop the input image to a circle with the radius of 200.
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/irad

Output image:
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Sample 4: Rounded corner cropping

This example shows how to crop the input image to rounded corners with the radius of 100.
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/rrad

Output image:
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Sample 5: Smart face cropping

This example shows how to crop the input image to the specified resolution of 100x600 px based on the face position 
in the image.
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/scro

Note: 

If no face is recognized, the input image will be returned.

Sample 6: Smart face cropping with a signature carried

This example processes the image in the same way as in the example above, except that a signature is carried. The 
signature is concatenated with other processing parameters by an ampersand (&).
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 

 You can get the value of  <signature>  as instructed in Request Signature.

Notes

https://intl.cloud.tencent.com/document/product/436/7778


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 78
of 2300

To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple sample for your reference (it 

might have expired or become inaccessible). For more information, see Upload via Pre-Signed URL.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Rotation
Last updated：2024-02-18 10:36:35

Feature Overview

CI uses the imageMogr2 API to rotate an image by a specified angle or automatically.
An image can be processed:
During download

During upload
In the cloud

Restrictions

Format: Currently, JPG, BMP, GIF, PNG, and WebP images can be processed, and HEIF images can be decoded 
and processed.
Size: The input image cannot be larger than 32 MB, with its width and height not exceeding 30,000 pixels respectively, 

and the total number of pixels not exceeding 250 million. The width and height of the output image cannot exceed 
9,999 pixels respectively. For an animated input image, the total number of pixels (width * height * number of frames) 
cannot exceed 250 million.
Frames (for animated images): For GIF images, the number of frames cannot exceed 300.

API Format

1. Processing during download
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GET /<ObjectKey>?imageMogr2/rotate/<rotateDegree>

               /auto-orient HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
 Spaces and line breaks above are for readability only and can be ignored.

2. Processing during upload
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/rotate/<rotateDegree>

                       /auto-orient"
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  }]

}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

https://intl.cloud.tencent.com/document/product/1045/33695
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Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/rotate/<rotateDegree>

                       /auto-orient"

  }]

}

Note: 
Authorization: Auth String (for more information, see Request Signature).

When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Parameters

Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

/rotate/<rotateDegree> Rotates an image clockwise by a specified angle. The value can be 0−360. By default, 
the image is not rotated.

/auto-orient Rotates an image automatically according to its EXIF data.

/flip/<flip> Flips an image. Valid values:  vertical ,  horizontal .

/ignore-error/1
If this parameter is carried and the image fails to be processed because the image is 
too large or a parameter value exceeds the limit, the input image will be returned with 
no error reported.

Samples

Note: 
Processing during download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, see Persistent Image Processing and use the processing during upload or 

processing in-cloud data feature.

Sample 1: Rotating an image by a specified angle

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/33695
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This example rotates an image clockwise by 90 degrees:

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/rota

Output image:




Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 85
of 2300

Sample 2: Rotating an image by a specified angle with a signature carried
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This example processes the image in the same way as in the example above, except that a signature is carried. The 
signature is concatenated with other processing parameters by an ampersand (&).

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 
 You can get the value of  <signature>  as instructed in Request Signature.

Notes

https://intl.cloud.tencent.com/document/product/436/7778


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 87
of 2300

To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple sample for your reference (it 

might have expired or become inaccessible). For more information, see Upload via Pre-Signed URL.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 88
of 2300

Converting Format
Last updated：2024-02-18 10:36:36

Feature Overview

CI uses the imageMogr2 API to perform format conversion, GIF optimization, and progressive display.
An image can be processed:
During download

During upload
In the cloud

Restrictions

Animated image formats such as GIF, WebP, and TPG can be interconverted.
Static image formats such as JPG, PNG, BMP, TPG, and HEIF can be interconverted.

API Format

1. Processing during download
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GET /<ObjectKey>?imageMogr2/format/<Format>

               /cgif/<FrameNumber>

               /interlace/<Mode> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. Processing during upload
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/format/<Format>

                       /cgif/<FrameNumber>
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                       /interlace/<Mode>"

  }]

}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

https://intl.cloud.tencent.com/document/product/1045/33695
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Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/format/<Format>

                       /cgif/<FrameNumber>

                       /interlace/<Mode>"

  }]

}

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Parameters

Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

/format/<Format>
Converts the image format. The target format can be JPG, BMP, GIF, PNG, WebP, or 
YJPEG (which is optimized based on JPEG and is essentially JPG). The default 
format is the format of the input image.

/cgif/<FrameNumber>

Optimizes images in the GIF format by reducing frames and colors of images. There 
are two cases:
FrameNumber=1: Cut the input GIF to the default number of frames (30). If the original 
number of frames is greater than 30, excessive frames will be cut. 
FrameNumber=(1,100]: Compress the image to the specified number of frames 
(  FrameNumber ).

/interlace/<Mode>

Progressive mode of the output JPG image. Valid values: 
 0  (default value): Disables the progressive mode. 
 1 : Enables the progressive mode. 
This parameter takes effect only when the output image is in JPG format.

/ignore-error/1
If this parameter is carried and the image fails to be processed because the image is 
too large or a parameter value exceeds the limit, the input image will be returned with 
no error reported.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Samples

Note: 
Processing during download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, see Persistent Image Processing and use the processing during upload or 

processing in-cloud data feature.

Sample 1: Converting a JPEG image to PNG format

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/form

https://intl.cloud.tencent.com/document/product/1045/33695
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Sample 2: Converting a JPEG image to PNG format with a signature carried

This example processes the image in the same way as in the example above, except that a signature is carried. The 
signature is concatenated with other processing parameters by an ampersand (&).

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 
 You can get the value of  <signature>  as instructed in Request Signature.

https://intl.cloud.tencent.com/document/product/436/7778
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Notes

To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple sample for your reference (it 

might have expired or become inaccessible). For more information, see Upload via Pre-Signed URL.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Quality Change
Last updated：2024-02-18 10:36:35

Feature Overview

CI uses the imageMogr2 API to adjust the quality of an image.
An image can be processed:
During download

During upload
In the cloud
Note: 
 This API supports images in JPG, WebP, TPG, HEIF, or AVIF format.

API Sample

1. Processing during download
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GET /<ObjectKey>?imageMogr2/quality/<Quality>

                           /rquality/<quality>

                           /lquality/<quality> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. Processing during upload



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 98
of 2300

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/quality/<Quality>

                       /rquality/<quality>
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                       /lquality/<quality>"

  }]

}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

https://intl.cloud.tencent.com/document/product/1045/33695
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Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/quality/<Quality>

                       /rquality/<quality>

                       /lquality/<quality>"

  }]

}

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Parameters

Operation name: quality.

Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

/quality/<Quality>

Absolute quality of the image. The value can be 0–100. Use the value of the original 
image quality (default) or the specified quality, whichever is smaller. If there is an 
exclamation mark (!) after <Quality> (such as  90! ), the specified quality value is 
forcibly used.

/rquality/<quality>
Image quality relative to that of the input image. The value can be 0−100. For example, 
if the input image quality is 80 and  rquality  is set to  80 , the quality of the 
output image will be 64 (80 * 80%).

/lquality/<quality>

Minimum quality of the image. Value range: 0−100. 
If the input image quality is 85 and  lquality  is set to 80, the quality of the output 
image will be 85.
If the input image quality is 60 and  lquality  is set to 80, the quality of the output 
image will be improved to 80.

/ignore-error/1 If this parameter is carried and the image fails to be processed because the image is 
too large or a parameter value exceeds the limit, the input image will be returned with 
no error reported.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 101
of 2300

Samples

Note: 
Processing during download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, see Persistent Image Processing and use the processing during upload or 
processing in-cloud data feature.

Sample 1: Setting an absolute quality

This example sets the absolute quality to 60:

https://intl.cloud.tencent.com/document/product/1045/33695
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http://examples-1251000004.picsh.myqcloud.com/sample.jpeg?imageMogr2/quality/60

Output:
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Sample 2: Setting a relative quality

This example sets the relative quality to 60:



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 104
of 2300

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/rqua

Output:
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Sample 3. Setting the relative quality to 60 with a signature carried

This example processes the image in the same way as in the example above, except that a signature is carried. The 
signature is concatenated with other processing parameters by an ampersand (&).
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 

 You can get the value of  <signature>  as instructed in Request Signature.

Notes

https://intl.cloud.tencent.com/document/product/436/7778
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To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple sample for your reference (it 

might have expired or become inaccessible). For more information, see Upload via Pre-Signed URL.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Gaussian Blurring
Last updated：2024-02-18 10:36:36

Feature Overview

CI uses the imageMogr2 API to blur an image.
An image can be processed:
During download

During upload
In the cloud

Restrictions

Format: Currently, JPG, BMP, GIF, PNG, and WebP images can be processed, and HEIF images can be decoded 
and processed.
Size: The input image cannot be larger than 32 MB, with its width and height not exceeding 30,000 pixels respectively, 

and the total number of pixels not exceeding 250 million. The width and height of the output image cannot exceed 
9,999 pixels respectively. For an animated input image, the total number of pixels (width * height * number of frames) 
cannot exceed 250 million.
Frames (for animated images): For GIF images, the number of frames cannot exceed 300.

API Sample

1. Processing during download
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GET /<ObjectKey>?imageMogr2/blur/<radius>x<sigma>	  HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. Processing during upload
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/blur/<radius>x<sigma>"

  }]
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}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://intl.cloud.tencent.com/document/product/1045/33695
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Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/blur/<radius>x<sigma>"

  }]

}

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Parameters

Operation name: blur.

Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

radius<radius> Blurring radius. Value range: 1–50.

sigma<sigma> Standard deviation of normal distribution. The value must be greater than 0.

/ignore-error/1
If this parameter is carried and the image fails to be processed because the image is too 
large or a parameter value exceeds the limit, the input image will be returned with no error 
reported.

Samples

Note: 
Processing during download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, see Persistent Image Processing and use the processing during upload or 
processing in-cloud data feature.

Sample 1: Blurring an image with a radius of 8 and a sigma of 5

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/33695
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/blur

Output after Gaussian blurring:
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Sample 2: Blurring an image with a radius of 8 and a sigma of 5 with a signature carried

This example processes the image in the same way as in the example above, except that a signature is carried. The 
signature is concatenated with other processing parameters by an ampersand (&).
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 

 You can get the value of  <signature>  as instructed in Request Signature.

Notes

https://intl.cloud.tencent.com/document/product/436/7778
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To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple sample for your reference (it 

might have expired or become inaccessible). For more information, see Upload via Pre-Signed URL.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Adjusting Brightness
Last updated：2024-02-18 10:36:35

Feature Overview

CI uses the imageMogr2 API to adjust the brightness of an image.
An image can be processed:
During download

During upload
In the cloud

Restrictions

Format: Currently, JPG, BMP, GIF, PNG, and WebP images can be processed, and HEIF images can be decoded 
and processed.
Size: The input image cannot be larger than 32 MB, with its width and height not exceeding 30,000 pixels respectively, 

and the total number of pixels not exceeding 250 million. The width and height of the output image cannot exceed 
9,999 pixels respectively. For an animated input image, the total number of pixels (width * height * number of frames) 
cannot exceed 250 million.
Frames (for animated images): For GIF images, the number of frames cannot exceed 300.

API Sample

1. Processing during download
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GET /<ObjectKey>?imageMogr2/bright/<value> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. Processing during upload
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/bright/<value>"

  }]
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}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://intl.cloud.tencent.com/document/product/1045/33695
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Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/bright/<value>"

  }]

}

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Parameters

Operation name: bright.

Parameter Description

ObjectKey Object name, such as folder/sample.jpg.

bright/<value>

Adjusts the brightness of an image. The value must be an integer in the range of [-100, 
100].
value < 0: Reduces the image brightness.
value = 0: Does not adjust the image brightness.
value > 0: Increases the image brightness.

/ignore-error/1
If this parameter is carried and the image fails to be processed because the image is too 
large or a parameter value exceeds the limit, the input image will be returned with no error 
reported.

Samples

Note: 
Processing during download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, see Persistent Image Processing and use the processing during upload or 

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/33695
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processing in-cloud data feature.

Sample 1: Adjusting the brightness

This example increases the brightness of an image by 70:

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/brig

Output image:
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Sample 2: Adjusting the brightness with a signature carried

This example processes the image in the same way as in the example above, except that a signature is carried. The 
signature is concatenated with other processing parameters by an ampersand (&).



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 124
of 2300

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 

 You can get the value of  <signature>  as instructed in Request Signature.

Notes

https://intl.cloud.tencent.com/document/product/436/7778
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To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple sample for your reference (it 

might have expired or become inaccessible). For more information, see Upload via Pre-Signed URL.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Adjusting Contrast
Last updated：2024-02-18 10:36:35

Feature Overview

CI uses the imageMogr2 API to adjust the contrast of an image, which is the difference in luminance between the 
brightest and darkest points in the image (i.e., the contrast in grayscale).
An image can be processed:

During download
During upload
In the cloud

Restrictions

Format: Currently, JPG, BMP, GIF, PNG, and WebP images can be processed, and HEIF images can be decoded 
and processed.

Size: The input image cannot be larger than 32 MB, with its width and height not exceeding 30,000 pixels respectively, 
and the total number of pixels not exceeding 250 million. The width and height of the output image cannot exceed 
9,999 pixels respectively. For an animated input image, the total number of pixels (width * height * number of frames) 
cannot exceed 250 million.
Frames (for animated images): For GIF images, the number of frames cannot exceed 300.

API Sample

1. Processing during download
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GET /<ObjectKey>?imageMogr2/contrast/<value> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. Processing during upload
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/contrast/<value>"

  }]
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}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://intl.cloud.tencent.com/document/product/1045/33695
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Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/contrast/<value>"

  }]

}

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Parameters

Operation name: contrast.

Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

/contrast/<value>

Adjusts the contrast of an image. The value must be an integer in the range of [-100, 100].
 value  < 0: Reduces the contrast.
 value  = 0: Does not adjust the contrast.
 value  > 0: Increases the contrast. 

/ignore-error/1
If this parameter is carried and the image fails to be processed because the image is too 
large or a parameter value exceeds the limit, the input image will be returned with no error 
reported.

Samples

Sample 1: Adjusting the contrast

Note: 
Processing during download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, see Persistent Image Processing and use the processing during upload or 
processing in-cloud data feature.
This example reduces the contrast of an image by 50:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/33695
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/cont

Output image:
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Sample 2: Adjusting the contrast with a signature carried

This example processes the image in the same way as in the example above, except that a signature is carried. The 
signature is concatenated with other processing parameters by an ampersand (&).
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 

 You can get the value of  <signature>  as instructed in Request Signature.

Notes

https://intl.cloud.tencent.com/document/product/436/7778
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To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple sample for your reference (it 

might have expired or become inaccessible). For more information, see Upload via Pre-Signed URL.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Sharpening
Last updated：2024-02-18 10:36:35

Feature Overview

CI uses the imageMogr2 API to sharpen an image.
An image can be processed:
During download

During upload
In the cloud

Restrictions

Format: Currently, JPG, BMP, GIF, PNG, and WebP images can be processed, and HEIF images can be decoded 
and processed.
Size: The input image cannot be larger than 32 MB, with its width and height not exceeding 30,000 pixels respectively, 

and the total number of pixels not exceeding 250 million. The width and height of the output image cannot exceed 
9,999 pixels respectively. For an animated input image, the total number of pixels (width * height * number of frames) 
cannot exceed 250 million.
Frames (for animated images): For GIF images, the number of frames cannot exceed 300.

API Sample

1. Processing during download
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GET /<ObjectKey>?imageMogr2/sharpen/<value> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. Processing during upload
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/sharpen/<value>"

  }]
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}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://intl.cloud.tencent.com/document/product/1045/33695
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Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/sharpen/<value>"

  }]

}

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Parameters

Operation name: sharpen.

Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

/sharpen/<value>
Sharpens an image, where  value  controls the strength of the sharpening effect. The 
value must be an integer ranging from 10 to 300 (70 is recommended). The greater the 
value, the more obvious the sharpening effect.

/ignore-error/1
If this parameter is carried and the image fails to be processed because the image is too 
large or a parameter value exceeds the limit, the input image will be returned with no error 
reported.

Samples

Note: 
Processing during download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, see Persistent Image Processing and use the processing during upload or 
processing in-cloud data feature.

Sample 1: Sharpening an image

This example sharpens an image with the sharpening value of  70 :

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/33695


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 140
of 2300

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/shar

Output image:
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Sample 2: Sharpening an image with a signature carried

This example processes the image in the same way as in the example above, except that a signature is carried. The 
signature is concatenated with other processing parameters by an ampersand (&).
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 

 You can get the value of  <signature>  as instructed in Request Signature.

Notes

https://intl.cloud.tencent.com/document/product/436/7778
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To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple sample for your reference (it 

might have expired or become inaccessible). For more information, see Upload via Pre-Signed URL.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Grayscale Image
Last updated：2024-02-18 10:36:35

Feature Overview

CI uses the imageMogr2/grayscale API to set an image to be a grayscale image.

API Sample

1. Processing during download
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GET /<ObjectKey>?imageMogr2/grayscale/<value> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. Processing during upload
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/grayscale/<value>"

  }]
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}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://intl.cloud.tencent.com/document/product/1045/33695
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Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/grayscale/<value>"

  }]

}

Parameters

Operation name: grayscale.

Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

/grayscale/<value>
Whether to set an image to be a grayscale image. 
Valid values of the  value  field:  0  (no),  1  (yes).

/ignore-error/1
If this parameter is carried and the image fails to be processed because the image is too 
large or a parameter value exceeds the limit, the input image will be returned with no error 
reported.

Samples

Note: 
Processing during download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, see Persistent Image Processing and use the processing during upload or 
processing in-cloud data feature.

Sample 1: Setting an image to be a grayscale image

This example sets an image to be a grayscale image:

https://intl.cloud.tencent.com/document/product/1045/33695
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/gray

Output image:
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Sample 2: Sharpening an image with a signature carried

This example processes the image in the same way as in the example above, except that a signature is carried. The 
signature is concatenated with other processing parameters by an ampersand (&).
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 

 You can get the value of  <signature>  as instructed in Request Signature.

Notes

https://intl.cloud.tencent.com/document/product/436/7778
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To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple sample for your reference (it 

might have expired or become inaccessible). For more information, see Upload via Pre-Signed URL.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Image Watermarking
Last updated：2024-02-18 10:36:35

Feature Overview

CI uses the watermark API to add image watermarks. Currently, only image watermarks stored in CI can be added. 
An input image cannot be larger than 32 MB, with its width and height not exceeding 30,000 pixels and the total 
number of pixels not exceeding 250 million. The width and height of the output image cannot exceed 9,999 pixels. For 

an input animated image, its total number of pixels (Width x Height x Number of frames) cannot exceed 250 million.
An image can be processed:
Upon download
Upon upload
In cloud

Note: 
You can overlay up to 10 image watermarks over a single image.
An animated image cannot be used as a watermark.

API Format

1. Processing upon download
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GET /<ObjectKey>?watermark/1/image/<encodedURL>

                            /gravity/<gravity>

                            /dx/<dx>

                            /dy/<dy>

                            /blogo/<type> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
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 Spaces and line breaks above are for readability only and can be ignored.

2. Processing upon upload

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,
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  "rules": [{

      "fileid": "exampleobject",

      "rule": "watermark/1/image/<encodedURL>

                    	 /gravity/<gravity>

                    	 /dx/<dx>

                    	 /dy/<dy>

                    	 /blogo/<type>"

  }]

}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

https://intl.cloud.tencent.com/document/product/1045/33695
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POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "watermark/1/image/<encodedURL>
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                    	 /gravity/<gravity>

                    	 /dx/<dx>

                    	 /dy/<dy>

                    	 /blogo/<type>"

  }]

}

Note: 
Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Parameters

In the code above, watermark is the operation name and the number 1 indicates that the watermark is an image.

Parameter Description

ObjectKey Object name, such as folder/sample.jpg.

/image/
URL-safe Base64-encoded URL of the image watermark. For example, if the image watermark URL 
1250000000.cos.ap-shanghai.myqcloud.com/shuiyin_2.png , you should set this param
 aHR0cDovL2V4YW1wbGVidWNrZXQtMTI1MDAwMDAwMC5jb3MuYXAtc2hhbmdoYWkubXlxY2xv

/gravity/ Position of the image watermark, which is a square in a 3x3 grid. Default value:   SouthEast 

/dx/ Horizontal offset in pixels. Default value: 0

/dy/ Vertical offset in pixels. Default value: 0

/blogo/
Adaptation mode for an image watermark that is larger than the input image. Valid values:
1: scales the image watermark to the size of the input image.
2: crops the image watermark to the size of the input image.

/scatype/

Scaling mode for the image watermark (relative to the input image). This parameter must be used tog
1: scales by width.
2: scales by height.
3: scales by area.

/spcent/ Scale ratio of the image watermark, in permillage. This parameter must be used together with
 /scatype/ . Value range:
1−1000 (if /scatype/ is set to 1)
1−1000 (if /scatype/ is set to 2)

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/33430
https://intl.cloud.tencent.com/document/product/1045/33720?lang=en#1
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1−250 (if /scatype/ is set to 3)

Example:  http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jp
watermark/1/image/xxxxxxx/scatype/3/spcent/250 

/dissolve/ Opacity of the image watermark. Value range: 1−100. Default value: 90 (meaning 90% opacity)

/batch/ Whether to tile the image watermark. If this parameter is set to 1, the image watermark will be tiled ac

/degree/ Angle to rotate the image watermark. This parameter is valid only when /batch/ is set to 1. Value rang

Note: 
 An image watermark must:  
Be stored in the same bucket as the input image.
Have a URL containing a COS domain name (a CDN acceleration domain name such as  examplebucket-

1250000000.file.myqcloud.com/shuiyin_2.png  is unsupported) and be accessible (if the image 

watermark is set to private-read, it must carry a signature).
Have a URL starting with  http:// . Note that “http://” cannot be omitted or changed to “https://”. For example, 

 examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/shuiyin_2.png  and 

 https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/shuiyin_2.png  are 

invalid watermark URLs.

3x3 Grid Position Diagram

The 3x3 grid position diagram is as follows. Once you specify the  gravity  parameter for an operation, the 

corresponding red dot becomes the reference point, and offsets will be relative to this point. 
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Note: 
If  gravity  is set to  center ,  dx  and  dy  are invalid.

If  gravity  is set to  north  or  south ,  dx  is invalid.

If  gravity  is set to  west  or  east ,  dy  is invalid.

Examples

Note: 
Processing upon download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, see Persistent Image Processing and use Processing upon upload or Processing 

in-cloud data.

Example 1: Adding an image watermark

https://intl.cloud.tencent.com/document/product/1045/33695
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?watermark/1/ima

After an image watermark is added:
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Example 2: Adding an image watermark with the tile mode and opacity specified
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https://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?watermark/1/im

The effect of an added image watermark rotated by 45 degrees and tiled with 40% opacity is as follows:




Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 164
of 2300

Example 3: Adding an image watermark with a signature carried

This example processes the image in the same way as in the example above except that a signature is carried. The 
signature is joined with other processing parameters using an ampersand (&).
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 

 You can obtain the value of  &lt;signature>  by referring to Request Signature.

Notes

https://intl.cloud.tencent.com/document/product/436/7778
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To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple example for your reference (it 

might have expired or become inaccessible). For more information, see Upload via Pre-Signed URL.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Text Watermarking
Last updated：2024-02-18 10:36:36

Feature Overview

CI uses the watermark API to add text watermarks in real time. An input image cannot be larger than 32 MB, with its 
width and height not exceeding 30,000 pixels and the total number of pixels not exceeding 250 million. The width and 
height of the output image cannot exceed 9,999 pixels. For an input animated image, its total number of pixels (Width 

x Height x Number of frames) cannot exceed 250 million.
An image can be processed:
Upon download
Upon upload
In cloud

API Format

1. Processing upon download
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GET /<ObjectKey>?watermark/2/text/<encodedText>

                            /font/<encodedFont>

                            /fontsize/<fontSize>

                            /fill/<encodedColor>

                            /dissolve/<dissolve>

                            /gravity/<gravity>

                            /dx/<dx>

                            /dy/<dy>

                            /batch/<type>

                            /degree/<degree>

                            /shadow/<shadow> HTTP/1.1



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 169
of 2300

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
 Spaces and line breaks above are for readability only and can be ignored.

2. Processing upon upload

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com
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Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "watermark/2/text/<encodedText>

                        /font/<encodedFont>

                        /fontsize/<fontSize>

                        /fill/<encodedColor>

                        /dissolve/<dissolve>

                        /gravity/<gravity>

                        /dx/<dx>

                        /dy/<dy>

                        /batch/<type>

                        /degree/<degree>

                        /shadow/<shadow>"

  }]

}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

https://intl.cloud.tencent.com/document/product/1045/33695
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POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "watermark/2/text/<encodedText>
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                        /font/<encodedFont>

                        /fontsize/<fontSize>

                        /fill/<encodedColor>

                        /dissolve/<dissolve>

                        /gravity/<gravity>

                        /dx/<dx>

                        /dy/<dy>

                        /batch/<type>

                        /degree/<degree>

                        /shadow/<shadow>"

  }]

}

Note: 
Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Parameters

In the code above,  watermark  is the operation name and the number  2  indicates that the watermark is a text.

Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

/text/ Watermark text, which must be URL-safe Base64-encoded

/font/ Font of the text, which must be URL-safe Base64-encoded. Default font: Tahoma.ttf (see 
Supported Fonts).

/fontsize/
Font size, in pt. Default value: 13. To scale the text watermark proportionally based on the 
original image, convert the text watermark to a PNG image. For more configuration 
information, see Image Watermarking.

/fill/
Font color. The value must be in hexadecimal format, for example,  #FF0000 . For format 
conversion, see RGB Color Codes Chart. The value must be URL-safe Base64-encoded. 
Default value:  #3D3D3D  (gray).

/dissolve/ Text opacity. Value range: 1−100. Default value:  90  (meaning 90% opacity)

/gravity/ Position of the text watermark, which is a square in a 3x3 grid. Default value:  southeast 

/dx/ Horizontal offset in pixels. Default value:  0 

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/33430
https://intl.cloud.tencent.com/document/product/1045/33430
https://intl.cloud.tencent.com/document/product/1045/40681
https://intl.cloud.tencent.com/document/product/1045/33720
https://www.rapidtables.com/web/color/RGB_Color.html
https://intl.cloud.tencent.com/document/product/1045/33430
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/dy/ Vertical offset in pixels. Default value:  0 

/batch/
Whether to tile the text watermark. If this parameter is set to  1 , the text watermark will be 
tiled across the input image.

/degree/
Angle to rotate text watermarks. This parameter is valid only when  /batch/  is set to  1 . 
Value range: 0−360. Default value:  0 

/shadow/ Text shadow effect. Value range: 0−100. Default value:  0 , indicating no shadow.

3x3 Grid Position Diagram

The 3x3 grid position diagram is as follows. Once you specify the  gravity  parameter for an operation, the 

corresponding red dot becomes the reference point, and offsets will be relative to this point.


Note: 
If  gravity  is set to  center ,  dx  and  dy  are invalid.
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If  gravity  is set to  north  or  south ,  dx  is invalid.

If  gravity  is set to  west  or  east ,  dy  is invalid.

Examples

Note: 

Processing upon download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, see Persistent Image Processing and use Processing upon upload or Processing 
in-cloud data.

Example 1: Adding a text watermark

https://intl.cloud.tencent.com/document/product/1045/33695
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?watermark/2/tex

After text watermarks are added:
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Example 2: Adding a text watermark with a signature carried

This example processes the image in the same way as in the example above except that a signature is carried. The 
signature is joined with other processing parameters using an ampersand (&).
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 

 You can get the value of  <signature>  as instructed in Request Signature.

Notes

https://intl.cloud.tencent.com/document/product/436/7778
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To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple example for your reference (it 

might have expired or become inaccessible). For more information, see Upload via Pre-Signed URL.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Obtaining Basic Image Information
Last updated：2024-02-18 10:36:35

Overview

CI uses the imageInfo API to query an image’s basic information such as its format, width, and height.

Use Limits

The input image cannot be larger than 32 MB.
The width and height of the input image cannot exceed 30,000 pixels and the total number of pixels cannot exceed 

250 million. The width and height of the output image cannot exceed 9,999 pixels.
For an input animated image, the total number of pixels (Width x Height x Number of frames) cannot exceed 250 
million pixels.

API Format
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download_url?imageInfo

Parameters

Request parameters

Operation: imageInfo

Parameter Description
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download_url URL of the input image, formatted as  &lt;BucketName-
APPID>.cos.&lt;Region>.myqcloud.com/&lt;picture name> 

Example:  examplebucket-1250000000.cos.ap-
shanghai.myqcloud.com/picture.jpeg 

Response parameters

Parameter Description

format Image format such as  png  or  gif 

width Width of the image, in pixels

height Height of the image, in pixels

size Image size, in bytes

md5 MD5 checksum of the image

frame_count Number of frames. For static images, this value is  1 .

Examples

Example 1: public-read

Request
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageInfo

Response
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{"format": "jpeg", "width": "960", "height": "540", "size": "158421", "md5": "77a16

Example 2: private-read with a signature carried

This example obtains the average hue in the same way as in the example above except that a signature is carried. 

The signature is joined with other parameters using an ampersand (&):
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 

 You can obtain the value of  <signature>  by referring to Request Signature.

Notes

https://intl.cloud.tencent.com/document/product/436/7778
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To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple example for your reference (it 

might have expired or become inaccessible). For more information, please see Request Signature.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Obtaining Image EXIF
Last updated：2024-02-18 10:36:35

Feature Overview

Exchangeable Image File (EXIF) records the camera settings, thumbnails, and other attributes of digital images. CI 
uses the exif API to obtain EXIF data. An input image cannot be larger than 32 MB, with its width and height not 
exceeding 30,000 pixels and the total number of pixels not exceeding 250 million. The width and height of an output 

image cannot exceed 9,999 pixels. For an input animated image, the total number of pixels (Width x Height x Number 
of frames) cannot exceed 250 million.
Note: 
 If an image does not have EXIF data,  {"error" : "no exif data"}  will be returned.

API Format
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GET /<ObjectKey>?exif HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Parameters

Operation: exif
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Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

Examples

Example 1: Public-read

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?exif
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Example 2: Private-read with a signature carried

This example obtains the average hue in the same way as in the example above except that a signature is carried. 
The signature is joined with other parameters using an ampersand (&):

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 
 You can obtain the value of  <signature>  by referring to Request Signature.

https://intl.cloud.tencent.com/document/product/436/7778
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Notes

To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple example for your reference (it 

might have expired or become inaccessible). For more information, see Upload via Pre-Signed URL.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Obtaining Image’s Average Hue
Last updated：2024-02-18 10:36:35

Feature Overview

CI uses the imageAve API to obtain the average hue of an image. The input image cannot be larger than 32 MB, with 
its width and height not exceeding 30,000 pixels, and the total number of pixels not exceeding 250 million. The width 
and height of the output image cannot exceed 9,999 pixels. For an input animated image, the total number of pixels 

(Width x Height x Number of frames) cannot exceed 250 million pixels.

API Format
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GET /<ObjectKey>?imageAve HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Parameter description

Operation: imageAve
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Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

Examples

Example 1: Public-read

Request
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageAve

Response

{"RGB": "0x736246"}

Example 2: Private-read with a signature carried

This example obtains the average hue in the same way as in the example above except that a signature is carried. 
The signature is joined with other parameters using an ampersand (&):
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 

 You can obtain the value of  <signature>  by referring to Request Signature.

Notes

https://intl.cloud.tencent.com/document/product/436/7778
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To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple example for your reference (it 

might have expired or become inaccessible). For more information, see Upload via Pre-Signed URL.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Removing Image Metadata
Last updated：2024-02-18 10:36:35

Feature Overview

CI uses the imageMogr2 API to remove image metadata, including EXIF data.
An image can be processed:
During download

During upload
In the cloud

Restrictions

Format: Currently, JPG, BMP, GIF, PNG, and WebP images can be processed, and HEIF images can be decoded 
and processed.
Size: The input image cannot be larger than 32 MB, with its width and height not exceeding 30,000 pixels respectively, 

and the total number of pixels not exceeding 250 million. The width and height of the output image cannot exceed 
9,999 pixels respectively. For an animated input image, the total number of pixels (width * height * number of frames) 
cannot exceed 250 million.
Frames (for animated images): For GIF images, the number of frames cannot exceed 300.

API Sample

1. Processing during download
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GET /<ObjectKey>?imageMogr2/strip HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. Processing during upload
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/strip"

  }]
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}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://intl.cloud.tencent.com/document/product/1045/33695
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Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/strip"

  }]

}

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Parameters

Operation name: strip.

Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

/ignore-error/1
If this parameter is carried and the image fails to be processed because the image is too 
large or a parameter value exceeds the limit, the input image will be returned with no error 
reported.

Samples

Note: 
Processing during download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, see Persistent Image Processing and use the processing during upload or 
processing in-cloud data feature.

Sample 1: Public-read

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/33695
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/stri

Sample 2: Private-read with a signature carried

This example processes the image in the same way as in the example above, except that a signature is carried. The 

signature is concatenated with other processing parameters by an ampersand (&).
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 

 You can get the value of  <signature>  as instructed in Request Signature.

Notes

https://intl.cloud.tencent.com/document/product/436/7778
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To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple sample for your reference (it 

might have expired or become inaccessible). For more information, see Upload via Pre-Signed URL.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Quick Thumbnail Template
Last updated：2024-02-18 10:36:35

Feature Overview

CI uses the imageView2 API to provide a common image processing template. You can append parameters to the 
download URL to generate the desired thumbnail. The input image cannot be larger than 32 MB, with its width and 
height not exceeding 30,000 pixels and the total number of pixels not exceeding 250 million. The width and height of 

the output image cannot exceed 9,999 pixels. For an input animated image, the total number of pixels (width x height x 
number of frames) cannot exceed 250 million (GIF frame limit: 300).
An image can be processed:
Upon download
Upon upload

In cloud

API Format

1. Processing upon download



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 206
of 2300

GET /<ObjectKey>?imageView2/<mode>/w/<Width>

                                  /h/<Height>

                                  /format/<Format>

                                  /q/<Quality>

                                  /rq/<Quality>

                                  /lq/<Quality> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
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 Quality parameters apply only to images in JPG and WebP formats.

2. Processing upon upload

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,
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  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageView2/<mode>/w/<Width>

                 /h/<Height>

                 /format/<Format>

                 /q/<Quality>

                 /rq/<Quality>

                 /lq/<Quality>"

  }]

}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

https://intl.cloud.tencent.com/document/product/1045/33695
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POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageView2/<mode>/w/<Width>
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                 /h/<Height>

                 /format/<Format>

                 /q/<Quality>

                 /rq/<Quality>

                 /lq/<Quality>"

  }]

}

Note: 
Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 

Granularity Details.

Parameters

Parameter Description

ObjectKey Object name, such as folder/sample.jpg.

/1/w/<Width>/h/<Height>

Specifies the minimum width and height of the thumbnail. In this mode, the 
image will be first scaled down until one of the minimum values set is 
reached. Then, the image will be centered and evenly cropped on both 
sides to meet the specified values. If only one value is set, a square 
thumbnail will be generated.

For example, if the input image size is 1000x500 and this parameter is set 
to ?imageView2/1/w/500/h/400, the image will be scaled down to 800x400 
first. Then, 150 pixels will be cropped from the left and right sides 
respectively, outputting a 500x400 thumbnail.

/2/w/<Width>/h/<Height>

Specifies the maximum width and height of the thumbnail.

In this mode, the image is scaled down until both the width and length are 
not greater than the maximum values set.

For example, if the input image size is 1000x500 and this parameter is set 
to ?imageView2/2/w/500/h/400, the image is scaled down to 500x250.

If only one value is set, the image will be adapted.

/3/w/<Width>/h/<Height>

Specifies the minimum width and height of the thumbnail. In this mode, the 
image will be scaled down until both the width and height are not smaller 
than the minimum values set.

For example, if the input image size is 1000x500 and this parameter is set 
to ?imageView2/3/w/500/h/400, the image will be scaled down to 800x400. 
If only one value is set, a square thumbnail will be generated.

/4/w/<LongEdge>/h/<ShortEdge> Mode 4: specifies the minimum values of the long edge and short edge of 

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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the thumbnail to scale down the image.

If only one value is set, a square thumbnail will be generated.

/5/w/<LongEdge>/h/<ShortEdge>

Mode 5: specifies the maximum values of the long edge and short edge of 
the thumbnail to scale down the image. The image will be then centered 
and cropped.

If only one value is set, a square thumbnail will be generated.

After the scaling, the excess will be cropped.

/format/<Format> Format of the thumbnail, which can be JPG, BMP, GIF, PNG, or WebP. 
Default value: format of the input image

/q/<Quality>

Image quality. Value range: 0−100. Default value: quality of the input 
image. The smaller value between the input image quality and the specified 
quality will be used. If there is an exclamation mark (!) after &lt;Quality>, 
the specified quality will be used.

/rq/<quality>
Relative quality of the image, relative to that of the input image. Value 
range: 0−100. For example, if the input image quality is 80 and rquality is 
set to 80, the quality of the output image is 64 (that is, 80 x 80%).

/lq/<quality>

The lowest quality of the output image. Value range: 0−100.

If the input image quality is 85 and lquality is set to 80, the quality of the 
output image is 85.

If the input image quality is 60 and lquality is set to 80, the quality of the 
output image will be improved to 80.

Examples

Note: 
Processing upon download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, see Persistent Image Processing and use Processing upon upload or Processing 
in-cloud data.

Example 1: Using mode 1

The following example uses mode 1, and sets the minimum width and height of the thumbnail to 400x600, and the 
absolute quality to 85:

https://intl.cloud.tencent.com/document/product/1045/33695
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageView2/1/w/

Generated thumbnail:
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Example 2: Using mode 1 with a signature carried

This example processes the image in the same way as in the example above except that a signature is carried. The 
signature is joined with other processing parameters using an ampersand (&):
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 

 You can obtain the value of  <signature>  by referring to Request Signature.

Notes

https://intl.cloud.tencent.com/document/product/436/7778
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To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple example for your reference (it 

might have expired or become inaccessible). For more information, see Upload via Pre-Signed URL.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Pipeline Operators
Last updated：2024-02-18 10:36:35

Overview

CI allows you to use pipeline operators (|) to separate multiple image processing parameters. In this way, multiple 
operations can be performed in sequence in a single request. The input image cannot be larger than 32 MB, with its 
width and height not exceeding 30,000 pixels, and the total number of pixels not exceeding 250 million. The width and 

height of the output image cannot exceed 9,999 pixels. For an input animated image, the total number of pixels (Width 
x Height x Number of frames) cannot exceed 250 million pixels.

API Format

You can append a style separator (?) to the end of an image URL and then add processing operations. Use pipeline 
operators (|) to separate multiple operations (up to 10 operations are supported). These operations will be performed 
in sequence.

Examples

This example scales the input image to 50% and then adds a text watermark in the lower-right corner.
Assume that the URL of the input image is as follows:
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg

Input image: 
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Example 1: scaling and adding watermark

Add the scaling operation:
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/thum

The scaled image is as follows:
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Append a pipeline operator (|) and then add the text watermarking operation:
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/thum

Output image: 
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Example 2: using pipeline operators with a signature carried

This example processes the image in the same way as in the example above except that a signature is carried. The 
signature is joined with other processing parameters using an ampersand (&):
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 

 You can obtain the value of  <signature>  by referring to Request Signature.

Notes

https://intl.cloud.tencent.com/document/product/436/7778
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To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple example for your reference (it 

might have expired or become inaccessible). For more information, please see Request Signature.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Image Size Limiting
Last updated：2024-02-18 10:36:35

Feature Overview

CI uses the imageMogr2/size-limit API to limit the size of an image processed (e.g., scaled or compressed).

Restrictions

Format: The API for limiting the image size is supported only for JPG images.
Size: The original image cannot be larger than 32 MB. Its dimensions cannot exceed 50000 pixels and its resolution 

cannot exceed 250 million pixels. The dimensions of the output image cannot exceed 50000 pixels.

API Format
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GET /<ObjectKey>?imageMogr2/size-limit HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 

Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Parameters

Operation: size-limit

Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

size-limit

Limits the size of the output image. The unit can be  k  (KB) or  m  (MB). 
Only JPG images are supported. 
 Appending an exclamation mark (!) means to compare the sizes of the input and output 
images. If the output image is smaller, the output image will be returned; otherwise, the input 
image will be returned; for example,   examplebucket-1250000000.cos.ap-
shanghai.myqcloud.com/picture.jpg?imageMogr2/size-limit/15k! 

 We recommend you use this parameter together with  strip  to remove redundant image 
metadata, for example,  examplebucket-1250000000.cos.ap-
shanghai.myqcloud.com/picture.png?imageMogr2/strip/format/jpg/size-

limit/15k!  

/ignore-
error/1

If this parameter is carried and the image fails to be processed because the image is too large 
or a parameter value exceeds the limit, the input image will be returned with no error reported.

Examples

Example 1: converting image format and limiting the output image size

This example converts a PNG image into JPG format and limits the output image size to 15 KB:



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 228
of 2300

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/strip

Example 2: converting image format and limiting the output image size with a signature carried

This example processes the image in the same way as in the example above except that a signature is carried. The 

signature is joined with other processing parameters using an ampersand (&):
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.png?q-sign-algorithm

Note: 

 You can obtain the value of  <signature>  by referring to Request Signature.

Notes

https://intl.cloud.tencent.com/document/product/436/7778
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To prevent unauthorized users from accessing or downloading the input image by using a URL that does not contain 
any processing parameter, you can add the processing parameters to the request signature, making the processing 
parameters the key of the parameter with the value left empty. The following is a simple example for your reference (it 

might have expired or become inaccessible). For more information, see Upload via Pre-Signed URL.

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://intl.cloud.tencent.com/document/product/436/14114
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Supported Fonts
Last updated：2024-02-18 10:36:35

Fonts supported by CI are as follows:

Font Supported Language

SimFang.ttf Chinese/English

SimHei.ttf Chinese/English

SimKai.ttf Chinese/English

SimSun.ttc Chinese/English

STHeiti-Light.ttc Chinese/English

STHeiti-Medium.ttc Chinese/English

YouYuan.ttf Chinese/English

Ahronbd.ttf English

Arial.ttf English

Ariblk.ttf English

Helvetica.dfont English

HelveticaNeue.dfont English
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Image Styles
Adding Style
Last updated：2024-02-18 10:36:36

Overview

This API is used to set a style for a bucket to process images in the same way.
Note: 
 Currently, the QPS for bucket writes is limited to 1, and bucket reads to 10.

Request

Sample request
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PUT /?style HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

<XML File>

Note: 
Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API uses only common request headers. For more information, please see Common Request Headers.

Request body

<?xml version="1.0" encoding="UTF-8" ?>

<AddStyle>

    <StyleName>string</StyleName>

    <StyleBody>string</StyleBody>

</AddStyle>

https://intl.cloud.tencent.com/document/product/436/7728
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Nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

AddStyle None The style to be 
added

Container Yes

Content of  AddStyle :

Node Name 
(Keyword)

Parent Node Description Type Required

StyleName AddStyle Style name string Yes

StyleBody AddStyle Style details string Yes

Response

Response headers

This API uses only common response headers. For more information, please see Common Response Headers.

Response body

The response body returned is empty.

Error codes

This API does not have any special error codes. For more information about all error codes, please see Error Codes.

Examples

Request

https://intl.cloud.tencent.com/document/product/436/7729
https://intl.cloud.tencent.com/document/product/1045/33700
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PUT /?style HTTP/1.1

Host: examplebucket-1250000000.pic.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2019 09:06:15 GMT

Authorization:XXXXXXXXXXXX

<?xml version="1.0" encoding="UTF-8" ?>

<AddStyle>

    <StyleName>style_name</StyleName>

    <StyleBody>imageMogr2/thumbnail/!50px</StyleBody>

</AddStyle>
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Response

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Date: Tue, 03 Apr 2019 09:06:16 GMT

x-cos-request-id: xxxxxxxxxxxxxxxxxx
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Querying Style
Last updated：2024-02-18 10:36:36

Overview

This API is used to query the styles set for a bucket. If the request body is not used, all styles set for the bucket will be 
queried. If the request body is used, only styles carried in the request body will be queried.

Request

Sample request
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GET /?style HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

Note: 

Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request line

GET /?style HTTP/1.1

This API accepts  GET  requests.

Request headers

Common request headers

This API uses common request headers. For more information, please see Common Request Headers.

https://intl.cloud.tencent.com/document/product/436/7728
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Non-common request headers

This API does not use any non-common request header.

Request body

<?xml version="1.0" encoding="UTF-8" ?>

<GetStyle>

  <StyleName>string</StyleName>

</GetStyle>
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Response

Response headers

Common response headers

This API uses common response headers. For more information, please see Common Response Headers.

Non-common response headers

This API does not use any non-common response header.

Response body

https://intl.cloud.tencent.com/document/product/436/7729
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<StyleList>

  <StyleRule>

  <StyleName>string</StyleName>

  <StyleBody>string</StyleBody>

</StyleRule>

  <StyleRule>

  <StyleName>string</StyleName>

  <StyleBody>string</StyleBody>

</StyleRule>

</StyleList>
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Deleting Style
Last updated：2024-02-18 10:36:35

Overview

This API is used to delete a style from a bucket.

Request

Sample request
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DELETE /?style HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

<XML File>

Note: 
Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request line

DELETE /?style HTTP/1.1

This API accepts  DELETE  requests.

Request headers

Common request headers

This API uses common request headers. For more information, please see Common Request Headers.

https://intl.cloud.tencent.com/document/product/436/7728
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Non-common request headers

This API does not use any non-common request header.

Request body

<?xml version="1.0" encoding="UTF-8" ?>

<DeleteStyle>

  <StyleName>string</StyleName>

</DeleteStyle>
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Response

Response headers

Common response headers

This API uses common response headers. For more information, please see Common Response Headers.

Non-common response headers

This API does not use any non-common response header.

Response body

The response body returned is empty.

https://intl.cloud.tencent.com/document/product/436/7729
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Image Compression
Guetzli Compression
Enabling Guetzli Compression
Last updated：2024-02-18 10:36:35

Overview

This API is used to enable the Guetzli compression feature for a bucket.

Request

Sample request



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 251
of 2300

PUT /?guetzli HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

Note: 

Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Guetzli compression currently cannot be used at COS domain names. Use  pic  domain names as described in the 

sample.

Request line

PUT /?guetzli HTTP/1.1

This API accepts  PUT  requests.

Request headers
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Common request headers

This API uses common request headers. For more information, please see Common Request Headers.

Non-common request headers

This API does not use any non-common request header.

Request body

The request body of this request is empty.

Response

Response headers

Common response headers

This API uses common response headers. For more information, please see Common Response Headers.

Non-common response headers

This API does not use any non-common response header.

Response body

The response body returned is empty.

https://intl.cloud.tencent.com/document/product/436/7728
https://intl.cloud.tencent.com/document/product/436/7729
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Querying Guetzli Status
Last updated：2024-02-18 10:36:36

Overview

This API is used to query whether the Guetzli compression feature is enabled.

Request

Sample request
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GET /?guetzli HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

Note: 

Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request line

GET /?guetzli HTTP/1.1

This API accepts  GET  requests.

Request headers

Common request headers
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The implementation of this operation uses common request headers. For more information on common request 
headers, see Common Request Headers.

Non-common request headers

This API does not use any non-common request header.

Request body

The request body of this request is empty.

Response

Response headers

Common response headers

This response uses common response headers. For more information on common response headers, see Common 
Response Headers.

Non-common response headers

This API does not use any non-common response header.

Response body

https://intl.cloud.tencent.com/document/product/436/7728
https://intl.cloud.tencent.com/document/product/436/7729
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<?xml version="1.0" encoding="UTF-8" ?>

<GuetzliStatus>on</GuetzliStatus>

Valid values:  on ,  off .
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Disabling Guetzli Compression
Last updated：2024-02-18 10:36:36

Overview

This API is used to disable the Guetzli compression feature.

Request

Sample request
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DELETE /?guetzli HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

Note: 

Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 261
of 2300

Request line

DELETE /?guetzli HTTP/1.1

This API accepts  DELETE  requests.

Request headers

Common request headers

This API uses common request headers. For more information, please see Common Request Headers.

https://intl.cloud.tencent.com/document/product/436/7728
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Non-common request headers

This API does not use any non-common request header.

Request body

The request body of this request is empty.

Response

Response headers

Common response headers

This API uses common response headers. For more information, please see Common Response Headers.

Non-common response headers

This API does not use any non-common response header.

Response body

The response body returned is empty.

https://intl.cloud.tencent.com/document/product/436/7729
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WebP Compression
Last updated：2024-02-18 10:36:35

Feature Description

Image compression is the process of downsizing an image as much as possible without sacrificing quality so that it 
can be stored at a lower cost and accessed more quickly.
CI launched the WebP compression feature to convert images to .webp format, which is superior to .jpg in terms of 

compression. A .webp image is over 25% smaller than a .jpg image with the same quality. This format is suitable for 
multi-terminal use cases.

Restrictions

Format: Images in JPG, PNG, BMP, GIF, HEIF, or AVIF format can be converted to WebP format.
Size: The input image cannot be larger than 32 MB, with its width and height not exceeding 30,000 pixels respectively, 
and the total number of pixels not exceeding 250 million. The width and height of the output image cannot exceed 

9,999 pixels respectively. For an animated input image, the total number of pixels (width * height * number of frames) 
cannot exceed 250 million.
Frames (for animated images): For GIF images, the number of frames cannot exceed 300.

Directions

CI uses the  imageMogr2  API to provide the WebP compression feature.

This feature supports processing:
During download

During upload
In the cloud
Note: 
WebP compression is billed at basic image processing prices. For detailed pricing, see Image Processing Fees.
If an image is converted to WebP format, some browsers may not be able to read its EXIF data. As a result, the image 

cannot be rotated. You can add the  auto-orient  parameter to rotate the input image first before compressing it 

(see Rotation) .
WebP compression inherits the quality parameters of the input image by default. You can adjust the compression ratio 
by modifying the image quality as instructed in Quality Change.

https://intl.cloud.tencent.com/document/product/1045/33422
https://intl.cloud.tencent.com/document/product/1045/45582
https://intl.cloud.tencent.com/document/product/1045/33715
https://intl.cloud.tencent.com/document/product/1045/33717
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API Sample

1. Processing during download

GET /<ObjectKey>?imageMogr2/format/webp HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. Processing during upload
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/webp"

}]
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}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://intl.cloud.tencent.com/document/product/1045/33695
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Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/webp"

}]

}

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Parameters

Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

/format/<Format> Compression format, which is  webp  here.

Samples

Note: 

Processing during download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, use processing during upload or processing in-cloud data instead.
Assume the input image is a 1,335.2 KB image in PNG format.


https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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You can convert the image to WebP format by using the following request URL:
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http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/format

Output:
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Compression ratio comparison

Format Image Size

PNG (input image) 1,335.2 KB

WebP 65 KB (compression ratio: 95.13%)
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HEIF Compression
Last updated：2024-02-18 10:36:35

Feature Overview

Image compression is the process of downsizing an image as much as possible without sacrificing quality so that it 
can be stored at a lower cost and accessed more quickly.
CI launched the HEIF compression feature to convert images into HEIF format that offers an ultra-high compression 

ratio. HEIF offers over 80% smaller file sizes at the same quality compared with JPG. iOS has adopted HEIF as the 
default image format, and Android P has native support for this format.

Restrictions

Format: Images in JPG, PNG, BMP, WebP, TPG, AVIF, or other formats can be converted into HEIF.
Size: The input image cannot be larger than 32 MB, with its width and height not exceeding 30,000 pixels, and the 
total number of pixels not exceeding 250 million. The width and height of the output image cannot exceed 9,999 pixels. 

For an input animated image, the total number of pixels (Width x Height x Number of frames) cannot exceed 250 
million pixels.
Number of frames (for animated images): For GIF, the number of frames cannot exceed 300.

Preparation

To use HEIF compression, enable the image advanced compression feature for your bucket on the bucket’s 
configuration page. For more information, see Setting Image Advanced Compression.

Use Directions

CI uses the imageMogr2 API to provide the HEIF compression feature.

An image can be processed:
Upon download
Upon upload
In cloud
Note: 

https://intl.cloud.tencent.com/document/product/1045/33422
https://intl.cloud.tencent.com/document/product/436/40117
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 HEIF compression is billed at the image advanced compression ratio. For detailed pricing, see Image Processing 
Fees.

API Format

1. Processing upon download

download_url?imageMogr2/format/heif
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2. Processing upon upload

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",
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    "rule": "imageMogr2/format/heif"

}]

}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

https://intl.cloud.tencent.com/document/product/1045/33695
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Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/heif"

}]

}

Note: 
Authorization: Auth String (See Request Signature for details.)

When this feature is used by a sub-account, relevant permissions must be granted.

Parameters

Parameter Description

download_url

URL of the input image, formatted as  &lt;BucketName-
APPID>.cos.&lt;Region>.myqcloud.com/&lt;picture name> 

Example:  examplebucket-1250000000.cos.ap-
shanghai.myqcloud.com/picture.jpeg 

/format/<Format> Compression format, which is  heif 

Examples

Note: 
Processing upon download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, use Processing upon upload or Processing in-cloud data instead.
Assume that the input image is a 1,335.2 KB image in PNG format, as shown below:


https://intl.cloud.tencent.com/document/product/436/7778
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You can convert the image into HEIF format by using the following URL:



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 277
of 2300

http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/format

Compression ratio comparison

Format Image Size

PNG (input image) 1,335.2 KB

HEIF 52.87 KB (compression ratio: 96.0%)
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TPG Compression
Last updated：2024-02-18 10:36:35

Feature Description

Image compression is the process of downsizing an image as much as possible without sacrificing quality so that it 
can be stored at a lower cost and accessed more quickly.
CI launched the TPG compression feature. It converts images to the .tpg format, which is a proprietary image format 

launched by Tencent and supports animated images. Currently, QQ Browser, Qzone, and other Tencent products 
support .tpg by default. A .tpg image is over 90% or 50% smaller than a .gif or .png image with the same quality, 
respectively.

Restrictions

Format: Images in JPG, PNG, BMP, GIF, WebP, HEIF, or AVIF format can be converted to TPG format.
Size: The input image cannot be larger than 32 MB, with its width and height not exceeding 30,000 pixels respectively, 

and the total number of pixels not exceeding 250 million. The width and height of the output image cannot exceed 
9,999 pixels respectively. For an animated input image, the total number of pixels (width * height * number of frames) 
cannot exceed 250 million.
Frames (for animated images): For GIF images, the number of frames cannot exceed 300.

Prerequisites

To use TPG compression, enable the image advanced compression feature for your bucket on its configuration page. 
For more information, see Setting Image Advanced Compression.

TPG is Tencent's proprietary image format. To use it, ensure that the environment where images are loaded 
supports TPG decoding. CI provides the TPG decoder-integrated SDKs for iOS, Android to facilitate quick 
integration with TPG.

Directions

CI uses the  imageMogr2  API to provide the TPG compression feature.

This feature supports processing:

During download

https://intl.cloud.tencent.com/document/product/1045/33422
https://intl.cloud.tencent.com/document/product/436/40117
https://intl.cloud.tencent.com/document/product/1045/47707
https://intl.cloud.tencent.com/document/product/1045/45575
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During upload
In the cloud
Note

 TPG compression is billed at image advanced compression prices by CI. For detailed pricing, see Image Processing 
Fees.

API Sample

1. Processing during download

https://intl.cloud.tencent.com/document/product/1045/45582
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GET /<ObjectKey>?imageMogr2/format/tpg HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. Processing during upload
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/tpg"

}]
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}

Note
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://intl.cloud.tencent.com/document/product/1045/33695
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Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/tpg"

}]

}

Note
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Parameters

Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

/format/<Format> Compression format, which is  tpg  here.

Samples

Note

Processing during download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, use processing during upload or processing in-cloud data instead.
Assume the input image is a 1,335.2 KB image in PNG format.


https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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You can convert the image to TPG format by using the following request URL:
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http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/format

Compression ratio comparison

Format Image Size

PNG (input image) 1,335.2 KB

TPG 36.67 KB (compression ratio: 97.3%)
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AVIF Compression
Last updated：2024-02-18 10:36:35

Overview

Image compression is the process of downsizing an image as much as possible without sacrificing quality so that it 
can be stored at a lower cost and accessed more quickly.
CI launched the AVIF compression feature. It converts images to the .avif format, which is a new image format 

launched by Netflix based on AV1 in February 2020 and currently is supported by browsers such as Chrome and 
Firefox.

Restrictions

Format: Images in JPG, PNG, BMP, GIF, WebP, TPG, HEIF, or other formats can be converted into AVIF.
Size: The input image cannot be larger than 32 MB, with its width and height not exceeding 30,000 pixels, and the 
total number of pixels not exceeding 250 million. The width and height of the output image cannot exceed 9,999 pixels. 

For an input animated image, the total number of pixels (Width x Height x Number of frames) cannot exceed 250 
million pixels.
Number of frames (for animated images): For GIF, the number of frames cannot exceed 300.

Prerequisites

To use AVIF compression, enable the image advanced compression feature for your bucket on the bucket's 
configuration page. For more information, see Image Advanced Compression.

Directions

CI uses the imageMogr2 API to provide the AVIF compression feature.

An image can be processed:
Upon download
Upon upload
In cloud
Note: 

AVIF compression is billed at image advanced compression prices. For detailed pricing, see Image Processing Fees.

https://intl.cloud.tencent.com/document/product/1045/33422
https://intl.cloud.tencent.com/document/product/1045/40106
https://intl.cloud.tencent.com/document/product/1045/45582
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API Format

1. Processing upon download

GET /<ObjectKey>?imageMogr2/format/avif HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. Processing upon upload
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/avif"

}]



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 289
of 2300

}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://intl.cloud.tencent.com/document/product/1045/33695
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Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/avif"

}]

}

Note: 
Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Parameters

Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

/format/<Format> Compression format, which is  avif 

Examples

Note: 

Processing upon download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, use Processing upon upload or Processing in-cloud data instead.
Assume that the input image is a 1,335.2 KB image in PNG format, as shown below:


https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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You can convert the image into AVIF format using the following URL:
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http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/format

Compression ratio comparison

Format Image Size

PNG (input image) 1,335.2 KB

AVIF 62.8 KB (compression ratio: 95.3%)
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Advanced Compression
Last updated：2024-02-18 10:36:35

Overview

CI’s advanced compression feature allows you to easily convert images into formats that provide a high compression 
ratio, such as TPG and HEIF. This effectively reduces the transmission time, loading time, and the use of bandwidth 
and traffic.

An image can be processed:
Upon download
Upon upload
In cloud

Feature Description

TPG compression TPG is a Tencent-designed image format. Converting JPG, PNG, or WebP images into 
TPG greatly reduces the image sizes.

HEIF compression If your images are used in iOS environments, you can convert them from JPG, PNG, 
GIF, WebP, or other formats into HEIF, which offers an ultra-high compression ratio.

Note: 

To use Image Advanced Compression, you need to enable it on the bucket configuration page. For more information, 
please see Image Advanced Compression.
To use the TPG format, ensure that the environment where images are loaded supports TPG decoding. CI 
provides TPG decoder−integrated SDKs for iOS, Android, and Windows clients to facilitate quick integration with 
TPG.
Currently, iOS 11 or later and Android P have native support for the HEIF format.

For the pricing of Image Advanced Compression, please see Billing and Pricing.

API Format

1. Processing upon download

https://intl.cloud.tencent.com/document/product/1045/40106
https://main.qcloudimg.com/raw/851dd252378813d250eeca5ed55ffd36/TPG_win_SDK.zip
https://intl.cloud.tencent.com/document/product/1045/33431
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download_url?imageMogr2/format/<Format>

2. Processing upon upload



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 295
of 2300

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/format/<Format>"

  }]
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}

3. Processing in-cloud data

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{
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  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/format/<Format>"

  }]

}

Note: 
Processing upon download is used as an example here, which does not store the output image in a bucket. If you 
need to store the output image, please see Persistent Image Processing and use Processing upon upload or 
Processing in-cloud data.

Parameters

Parameter Description

download_url

URL of the input image, formatted as  &lt;BucketName-
APPID>.cos.&lt;Region>.myqcloud.com/&lt;picture name> 

Example:  examplebucket-1250000000.cos.ap-
shanghai.myqcloud.com/picture.jpeg 

/format/<Format> Target compression format, which can be TPG or HEIF

Examples

Assume that the input image is a 1,335.2 KB image in PNG format, as shown below:


https://intl.cloud.tencent.com/document/product/1045/33695
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You can convert the image into TPG format using the following URL:
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http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/format

Alternatively, you can convert the image into HEIF format using the following URL:
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http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/format

Compression ratio comparison

Format Image Size

PNG (input image) 1,335.2 KB

TPG 36.67 KB (compression ratio: 97.3%)

HEIF 52.87 KB (compression ratio: 96.0%)
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SVG Compression
Last updated：2024-02-18 10:36:35

Overview

Image compression is the process of downsizing an image as much as possible without sacrificing quality so that it 
can be stored at a lower cost and accessed more quickly.
CI has launched the SVG compression feature, which can delete certain redundant information from an SVG file 

without compromising the display effect in order to downsize the file.

Restrictions

Format: Only SVG images can be used as the input.
Size: The input image cannot be larger than 32 MB.

Directions

CI uses the  imageMogr2  API to provide the SVG compression feature.

An image can be processed:

Upon download
Upon upload
In cloud
Note: 
  SVG compression is billed at image advanced compression prices. For detailed pricing, see Image Processing Fees.

API Format

1. Processing upon download

https://intl.cloud.tencent.com/document/product/1045/33422
https://intl.cloud.tencent.com/document/product/1045/45582
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GET /<ObjectKey>?imageMogr2/format/svgc HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. Processing upon upload
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/svgc"

}]
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}

Note: 
 Pic-Operations  is a JSON string. Its parameters are as described in Persistent Image Processing.

3. Processing in-cloud data

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

https://intl.cloud.tencent.com/document/product/1045/33695
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Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/svgc"

}]

}

Note: 
Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Parameters

Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

/format/<Format> Compression format, which is  svgc  here.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Persistent Image Processing
Last updated：2024-02-18 10:36:35

Processing During Upload

CI allows you to process images during upload. To enable this, add  Pic-Operations  to the request header and 

set relevant parameters. You can also save the input images and processing results to COS. Currently, images within 
32 MB can be processed.

Request syntax

The request during image upload is the same as that used to simply upload a file to COS v5, except that you need to 
add the image processing parameter to the request header.
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

Note: 
For more information on COS' simple upload API, see PUT Object.
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7749
https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.
The QPS for persistent processing can be up to 100. If you need a higher QPS, contact us.

Request content

 Pic-Operations  is a JSON string. Its parameters are as follows:

Parameter Type Required Description

is_pic_info Int No
Whether to return the input image information. Valid values:  0  (no); 
 1  (yes). Default value:  0 .

rules Array No
Processing rules (up to five rules are supported). Each rule corresponds 
to one processing result. If this parameter is not specified, images will 
not be processed.

Parameters of rules (a JSON array) are as follows:

Parameter Type Required Description

bucket String No
Name of the destination bucket to store the results in the format of 
BucketName-APPID. If this parameter is not specified, the results will 
be stored in the current bucket by default.

fileid String Yes

Storage path and name of the output file.

Naming rules are as follows (assume the input file is 
 /p1/test1.jpg ):

1. A value starting with a slash (/) indicates an absolute path. For 
example, if  fileid  is set to  /p2/test2.jpg , the 
 test2.jpg  file will be stored in the  p2  folder.

2. A value not starting with a slash indicates a relative path. For 
example, if  fileid  is set to  p2/test2.jpg , a folder named 
 p2  will be created in the  p1  folder, and the  test2.jpg  file will 
be stored in the  p2  folder.

3. Note: Do not end the value with a slash; otherwise, an empty filename 
will be generated.

rule String Yes

Processing parameters. For more information, see CI's image 
processing API. To process an image by using a specified style, the 
value must start with  style/ , with the style name followed. For 
example, if the style name is test, the value of rule should be 
 style/test .

Response content

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/42350
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The response body is as described below:

Parameter Type Description

UploadResult Container Input image information

 Content of  UploadResult :

Parameter Type Description

OriginalInfo Container Input image information

ProcessResults Container Image processing result

 Content of  OriginalInfo :

Node Name Type Description

Key String Input image name

Location String Image path

ImageInfo Container Input image information

ETag String
 ETag  of the input image. If the output image overwrites the input image, 
the value of  ETag  will be that of the output image.

 Content of  ImageInfo :

Node Name Type Description

Format String Format

Width Int Image width

Height Int Image height

Quality Int Image quality

Ave String Image average hue

Orientation Int Image rotation angle

 Content of  ProcessResults :

Node Name Type Description
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Object Container Processing result of each image

 Content of  Object :

Node Name Type Description

Key String Filename

Location String Image path

Format String Image format

Width Int Image width

Height Int Image height

Size Int Image size

Quality Int Image quality

ETag String
 ETag  information of the output 
image

Sample

Request
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PUT /filename.jpg HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Wed, 28 Oct 2015 20:32:00 GMT

Authorization:XXXXXXXXXXXX

Pic-Operations: {"is_pic_info":1,"rules":[{"fileid":"test.jpg","rule":"imageView2/f

Content-Length: 64

[Object]

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

        <OriginalInfo>

            <Key>filename.jpg</Key>

            <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/filename
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            <ETag>&quot;580cd6930444576523c25f86ce2af9b1fc2d5484&quot;</ETag>

            <ImageInfo>

                <Format>JPEG</Format>

                <Width>640</Width>

                <Height>427</Height>

                <Quality>100</Quality>

                <Ave>0xa18454</Ave>

                <Orientation>1</Orientation>

            </ImageInfo>

        </OriginalInfo>

        <ProcessResults>

            <Object>

                <Key>test.jpg</Key>

                <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/test

                <Format>png</Format>

                <Width>640</Width>

                <Height>427</Height>

                <Size>463092</Size>

                <Quality>100</Quality>

                <ETag>&quot;eaa4e3d8fd498bbc63be3b71c46b9c61f23e3f0c&quot;</ETag>

            </Object>

        </ProcessResults>

</UploadResult>

Note: 
Processing during upload is supported for the multipart upload feature of COS v5. To implement image processing, 
you only need to add the  Pic-Operations  parameter in the request header when calling the Complete Multipart 

Upload API.

https://intl.cloud.tencent.com/document/product/436/7742
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POST /<ObjectKey>?uploadId=UploadId HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: <PicOperations>

Note: 
For more information, see Complete Multipart Upload.

https://intl.cloud.tencent.com/document/product/436/7742
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Processing In-Cloud Data

CI's image processing API can process an image stored in COS and save the processing result to COS.

Request syntax

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size
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Authorization: Auth String

Pic-Operations: <PicOperations>

Request content

 Pic-Operations  is a JSON string. Its parameters are as follows:

Parameter Type Required Description

is_pic_info Int No
Whether to return the input image information. Valid values: 
 0  (no);  1  (yes). Default value:  0 .

rules Array No
Processing rules (up to five rules are supported). Each rule 
corresponds to one processing result. If this parameter is 
not specified, images will not be processed.

 Parameters of  rules  (a JSON array) are as follows:

Parameter Type Required Description

bucket String No
Name of the destination bucket to store the results in the format of 
 BucketName-APPID . If this parameter is not specified, the results 
will be stored in the current bucket by default.

fileid String Yes

Storage path and name of the output file. 
Naming rules are as follows (assume the input file is 
 /p1/test1.jpg ):
1. A value starting with a slash (/) indicates an absolute path. For 
example, if fileid is set to /p2/test2.jpg, the test2.jpg file will be stored in 
the p2 folder.
2.  A value not starting with a slash indicates a relative path. For 
example, if fileid is set to p2/test2.jpg, a folder named p2 will be created 
in the p1 folder, and the test2.jpg file will be stored in the p2 folder.
3. Note: Do not end the value with a slash; otherwise, an empty filename 
will be generated.

rule String Yes

Processing parameters. For more information, see Basic Image 
Processing. To process an image by using a specified style, the value 
must start with  style/ , with the style name followed. For example, if 
the style name is  test , the value of  rule  should be 
 style/test .

Response content

The response body is as described below:

https://intl.cloud.tencent.com/document/product/1045/33694
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Parameter Type Description

UploadResult Container Input image information

 Content of  UploadResult :

Parameter Type Description

OriginalInfo Container Input image information

ProcessResults Container Image processing result

 Content of  OriginalInfo :

Node Name Type Description

Key String Input image name

Location String Image path

ImageInfo Container Input image information

ETag String
 ETag  of the input image. If the output image overwrites the input 
image, the value of  ETag  will be that of the output image.

 Content of  ImageInfo :

Node Name Type Description

Format String Format

Width Int Image width

Height Int Image height

Quality Int Image quality

Ave String Image average hue

Orientation Int Image rotation angle

 Content of  ProcessResults :

Node Name Type Description

Object Container Processing result of each image
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 Content of  Object :

Node Name Type Description

Key String Filename

Location String Image path

Format String Image format

Width Int Image width

Height Int Image height

Size Int Image size

Quality Int Image quality

ETag String  ETag  of the output image

Sample

Request
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POST /filename.jpg?image_process HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Wed, 18 Jan 2017 16:17:03 GMT

Authorization: XXXXXXXXXX

Pic-Operations: {"is_pic_info":1,"rules":[{"fileid":"test.jpg","rule":"imageView2/f

Content-Length: XX

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

            <OriginalInfo>

                <Key>filename.jpg</Key>

                <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/file
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                <ETag>&quot;eaa4e3d8fd498bbc63be3b71c46b9c61f23e3f0c&quot;</ETag>

                <ImageInfo>

                    <Format>JPEG</Format>

                    <Width>640</Width>

                    <Height>427</Height>

                    <Quality>100</Quality>

                    <Ave>0xa18454</Ave>

                    <Orientation>1</Orientation>

                </ImageInfo>

            </OriginalInfo>

            <ProcessResults>

                <Object>

                    <Key>test.jpg</Key>

                    <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/

                    <Format>png</Format>

                    <Width>640</Width>

                    <Height>427</Height>

                    <Size>463092</Size>

                    <Quality>100</Quality>

                    <ETag>&quot;eaa4e3d8fd498bbc63be3b71c46b9c61f23e3f0c&quot;</ETa

                </Object>

            </ProcessResults>

</UploadResult>
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Blind Watermarking
Last updated：2024-02-18 10:36:36

Overview

The blind watermark feature allows you to add an invisible watermark to an image, which does not affect the look and 
feel and retains the originality of the image. If you suspect that your image has been stolen, you can extract the 
invisible watermark through blind watermark extraction to prove your ownership of the image.


You can call this API to:
Add or extract a blind watermark to or from an image during upload.
Add or extract a blind watermark to or from an image stored in COS.
Add a blind watermark to an image during download.
CI introduces three blind watermarking types: semi-blind watermarking, perfectly blind watermarking, and text blind 

watermarking.

Blind Watermarking Type Feature Applicable Scenario

Semi-blind watermarking (type 1)
Has strong anti-theft effects but 
requires the input image for 
watermark extraction

Images smaller than 640x640

Perfectly blind watermarking (type 
2)

Is easy to extract and requires 
only the watermarked image for 
watermark extraction

Batch adding and verification

Text blind watermarking (type 3) Adds text to the image Adding terminal information

Blind watermarking is a paid service, which needs to be activated on the bucket's configuration page. For detailed 
pricing, see Image Processing Fees.
Note: 
Currently, you cannot add a blind watermark to animated images such as GIF.
Both the width and height of the image watermark must not be greater than 1/8 of the input image.

You need to choose a white watermark with a black background for the effect of blind watermarking.
Text watermarks can contain digits and letters.
Blind watermarking protects your images against various theft attacks such as cropping, smudging, and color change. 
The anti-theft effect is affected by the size of the input image and the attack intensity. For details, please submit a 
ticket.

Blind watermarking is supported in all regions of CI. For more information, see Regions and Domain Names.

https://intl.cloud.tencent.com/document/product/1045/43029
https://intl.cloud.tencent.com/document/product/1045/45582
https://console.intl.cloud.tencent.com/workorder/category
https://intl.cloud.tencent.com/document/product/1045/33423
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Use Cases

Authentication and accountability

By adding semi-blind watermarks to your images, you can claim your images when they are stolen and extract blind 
watermarks using the corresponding input images to prove that you own the images.

Checking duplicates upon upload

Sometimes, other users might upload duplicate images (such as real estate images, car images, and product images). 

To solve this problem, you can perform perfectly blind watermark extraction before the upload, and if you can extract a 
blind watermark from an image, it has been uploaded before. In this case, you can perform corresponding operations, 
such as telling the user not to upload duplicate images. If an image does not contain a blind watermark, you can add 
one to it to prevent duplicate uploads.

Avoiding image leakage

For internal images, you can add information about the requester to the images by using text blind watermarks. In this 

way, when an image is leaked, you can extract the blind watermark and get information about the leaker.

Adding Blind Watermarks

Request 1: adding a blind watermark upon upload

The request is the same as that in a PUT Object call, except that you need to add the image processing parameter 
 Pic-Operations  to the request header and use blind watermarking parameters.

Sample request

https://intl.cloud.tencent.com/document/product/436/7749
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

[Object Content]

Note: 
Authorization: Auth String (See Request Signature for details.)

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API uses Common Request Headers.

Add the image processing parameter  Pic-Operations  (a JSON string) to the request header. Its parameters are 

as follows:

Parameter Description Type Required

is_pic_info
Whether to return the input image information 
 0  (default): no 
 1 : yes

Int No

rules
Processing rules (up to five rules are supported). Each rule 
corresponds to one processing result. If this parameter is not 
specified, images will not be processed.

Array No

Parameters of  rules  (a JSON array) are as follows:

Parameter Description Type Required

bucket
Name of the destination bucket to store the results, formatted as 
 BucketName-APPID . If this parameter is not specified, the results 
will be stored in the current bucket.

String No

fileid

Storage path and name of the output file. 
Naming rules are as follows (assume the input file is 
 /p1/test1.jpg ):
1. A value starting with a slash (/) indicates an absolute path. For 
example, if fileid is set to /p2/test2.jpg, the test2.jpg file will be stored in 
the p2 folder. 
2. A value not starting with a slash indicates a relative path. For 
example, if fileid is set to p2/test2.jpg, a folder named p2 will be created 
in the p1 folder, and the test2.jpg file will be stored in the p2 folder.
3.  Note: Do not end the value with a slash; otherwise, an empty 
filename will be generated.

String Yes

rule

Processing parameters. For more information, see the image 
processing API. To process an image by using a specified style, the 
value must start with  style/ , with the style name followed. For 
example, if the style name is  test , the value of  rule  should be 
 style/test .

String Yes

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/436/7728
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To use blind watermarking, add the watermarking parameter  watermark  to  rule  as follows:

watermark/3/type/<type>/image/<imageUrl>/text/<text>/level/<level>

The parameters are as follows:

Parameter Description Type Required

type
Blind watermarking type. Valid values:  1  (semi-blind 
watermarking),  2  (perfectly blind watermarking),  3  (text blind 
watermarking)

Int Yes
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image URL of the blind image watermark, which must be URL-safe Base64 
encoded. This parameter is required if  type  is set to  1  or  2 , 
and does not take effect if  type  is set to  3 . The image 
watermark must:
1. Be stored in the same bucket as the input image. 
2. Have a URL that starts with http://. Note that "http://" cannot be 
omitted or changed to "https://". For example, the following watermark 
URLs are invalid: 
 examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png 

 https://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png 

String No

text
Text watermark, which must be URL-safe Base64-encoded. This 
parameter is required if  type  is set to  3  and does not take 
effect if  type  is set to  1  or  2 .

String No

level
Perfectly blind watermarking level, which only takes effect when 
 type  is set to  2 . Valid values:  1  (default),  2 ,  3 . The 
larger the value, the better the watermarking effects.

Int No

Request parameters

This API has no request parameter.

Request body

The request body of this API is the content of the input image.

Response

Response headers

This API only returns Common Response Headers.

Response body

Parameters in the response body are as follows:

Parameter Description Type

UploadResult Upload results Container

Content of  UploadResult : 

Parameter Description Type

OriginalInfo Information about the input image Container

https://intl.cloud.tencent.com/document/product/436/7729
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ProcessResults Processing results Container

Content of  OriginalInfo :

Parameter Description Type

Key Name of the input image String

Location Image location String

ImageInfo Information about the input image Container

Content of  ImageInfo :

Parameter Description Type

Format Image format String

Width Image width Int

Height Image height Int

Quality Image quality Int

Ave Image average hue String

Orientation Image rotation angle Int

Content of  ProcessResults :

Parameter Description Type

Object Processing results of each image Container

Content of  Object :

Parameter Description Type

Key Filename String

Location Image location String

Format Image format String

Width Image width Int

Height Image height Int
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Size Image size Int

Quality Image quality Int

Example

Request

PUT /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com
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Date: Tue, 03 Apr 2018 09:06:15 GMT

Authorization:XXXXXXXXXXXX

Pic-Operations:

{

    "is_pic_info": 1,

    "rules": [{

        "fileid": "exampleobject",

        "rule": "watermark/3/type/1/image/aHR0cDovL2V4YW1wbGVzLTEyNTEwMDAwMDQucGljc

    }]

}

Content-Length: 64

[Object Content]

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

          <OriginalInfo>

              <Key>exampleobject</Key>

              <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exampl
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              <ImageInfo>

                   <Format>JPEG</Format>

                   <Width>640</Width>

                   <Height>427</Height>

                   <Quality>100</Quality>

                   <Ave>0xa18454</Ave>

                   <Orientation>1</Orientation>

              </ImageInfo>

          </OriginalInfo>

          <ProcessResults>

              <Object>

                   <Key>exampleobject</Key>

                   <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/e

                   <Format>png</Format>

                   <Width>640</Width>

                   <Height>427</Height>

                   <Size>463092</Size>

                   <Quality>100</Quality>

              </Object>

          </ProcessResults>

</UploadResult>

Note: 
[Object Content] in the request body is the binary string of the input image, and  imageUrl  in  rule  in the 

request header  Pic-Operations  is the URL of the image watermark.

 Location  in  ProcessResults  in the response body is the URL of the image with a blind watermark.

Request 2: adding a blind watermark upon download

You can add a blind watermark upon download in the same way as adding a regular watermark, except that you need 
to use the  watermark  parameter after the image URL.

Sample request
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GET /<ObjectKey>?watermark/3/type/<type>/image/<imageUrl>/text/<text> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Request parameters

The request parameters are as follows:

Parameter Description Type Required
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ObjectKey Object name, such as  folder/sample.jpg . String Yes

type
Blind watermarking type. Valid values:  1  (semi-blind watermarking), 
 2  (perfectly blind watermarking),  3  (text blind watermarking)

Int Yes

image

URL of the blind image watermark, which must be URL-safe Base64 
encoded. This parameter is required if  type  is set to  1  or  2 , 
and does not take effect if  type  is set to  3 . The image watermark 
must:
1. Be stored in the same bucket as the input image. 
2.  Have a URL that starts with http://. Note that "http://" cannot be 
omitted or changed to "https://". For example, the following watermark 
URLs are invalid: 
 examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png 

 https://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png 

String No

text
Text watermark, which must be URL-safe Base64-encoded. This 
parameter is required if  type  is set to  3  and does not take effect if 
 type  is set to  1  or  2 .

String No

level
Perfectly blind watermarking level, which only takes effect when 
 type  is set to  2 . Valid values:  1  (default),  2 ,  3 . The larger 
the value, the better the watermarking effects.

Int No

Example
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https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/sample.jpeg?watermark

Request 3: adding a blind watermark to an image stored in COS

You can call this API to add a blind watermark to an image stored in COS and save the result to COS.

Sample request
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POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

Note: 
Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API uses Common Request Headers.
Add the image processing parameter  Pic-Operations  (a JSON string) to the request header. Its parameters are 

as follows:

Parameter Description Type Required

is_pic_info
Whether to return the input image information  0  (default): no  1 : 
yes

Int No

rules
Processing rules (up to five rules are supported). Each rule 
corresponds to one processing result. If this parameter is not 
specified, images will not be processed.

Array No

Parameters of  rules  (a JSON array) are as follows:

Parameter Description Type Required

bucket
Name of the destination bucket to store the results, formatted as 
 BucketName-APPID . If this parameter is not specified, the results will 
be stored in the current bucket.

String No

fileid

Storage path and name of the output file.
Naming rules are as follows (assume the input file is 
 /p1/test1.jpg ):
1. A value starting with a slash (/) indicates an absolute path. For 
example, if fileid is set to /p2/test2.jpg, the test2.jpg file will be stored in 
the p2 folder. 
2.  A value not starting with a slash indicates a relative path. For example, 
if fileid is set to p2/test2.jpg, a folder named p2 will be created in the p1 
folder, and the test2.jpg file will be stored in the p2 folder.
3.  Note: Do not end the value with a slash; otherwise, an empty filename 
will be generated.

String Yes

rule

Processing parameters. For more information, see the image processing 
API. To process an image by using a specified style, the value must start 
with  style/ , with the style name followed. For example, if the style 
name is  test , the value of  rule  should be  style/test .

String Yes

To use blind watermarking, add the watermarking parameter  watermark  to  rule  as follows:

https://intl.cloud.tencent.com/document/product/436/7728
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watermark/3/type/<type>/image/<imageUrl>/text/<text>/level/<level>

The parameters are as follows:

Parameter Description Type Required

type
Blind watermarking type. Valid values:  1  (semi-blind watermarking), 
 2  (perfectly blind watermarking),  3  (text blind watermarking)

Int Yes

image URL of the blind image watermark, which must be URL-safe Base64-
encoded. This parameter is required if  type  is set to  1  or  2 , and 

String No



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 339
of 2300

does not take effect if  type  is set to  3 . The image watermark must:
1. Be stored in the same bucket as the input image. 
2. Have a URL that starts with http://. Note that "http://" cannot be 
omitted or changed to "https://". For example, the following watermark 
URLs are invalid: 
 examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png 

 https://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png 

text
Text watermark, which must be URL-safe Base64-encoded. This 
parameter is required if  type  is set to  3  and does not take effect if 
 type  is set to  1  or  2 .

String No

level
Perfectly blind watermarking level, which only takes effect when  type  
is set to  2 . Valid values:  1  (default),  2 ,  3 . The larger the value, 
the better the watermarking effects.

Int No

Request parameters

This API has no request parameter.

Request body

This API does not have a request body.

Response

Response headers

This API only returns Common Response Headers.

Response body

Parameters in the response body are as follows:

Parameter Description Type

UploadResult Upload results Container

Content of  UploadResult : 

Parameter Description Type

OriginalInfo Information about the input image Container

ProcessResults Processing results Container

https://intl.cloud.tencent.com/document/product/436/7729
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Content of  OriginalInfo : 

Parameter Description Type

Key Name of the input image String

location Location of the input image String

ImageInfo Information about the input image Container

Content of  ImageInfo : 

Parameter Description Type

Format Image format String

Width Image width Int

Height Image height Int

Quality Image quality Int

Ave Image average hue String

Orientation Image rotation angle Int

Content of  ProcessResults :

Parameter Description Type

Object Processing results of each image Container

Content of  Object :

Parameter Description Type

Key Filename String

location Location of the input image String

Format Image format String

Width Image width Int

Height Image height Int

Size Image size Int
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Quality Image quality Int

Example

Request

POST /exampleobject?image_process HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2018 09:06:15 GMT

Authorization:XXXXXXXXXXXX
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Pic-Operations:

{

    "is_pic_info": 1,

    "rules": [{

        "fileid": "exampleobject",

        "rule": "watermark/3/type/1/image/aHR0cDovL2V4YW1wbGVzLTEyNTEwMDAwMDQucGljc

    }]

}

Content-Length: 64

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

          <OriginalInfo>

              <Key>exampleobject</Key>

              <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exampl
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              <ImageInfo>

                   <Format>JPEG</Format>

                   <Width>640</Width>

                   <Height>427</Height>

                   <Quality>100</Quality>

                   <Ave>0xa18454</Ave>

                   <Orientation>1</Orientation>

              </ImageInfo>

          </OriginalInfo>

          <ProcessResults>

              <Object>

                   <Key>exampleobject</Key>

                   <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/e

                   <Format>png</Format>

                   <Width>640</Width>

                   <Height>427</Height>

                   <Size>463092</Size>

                   <Quality>100</Quality>

              </Object>

          </ProcessResults>

</UploadResult>

Extracting Blind Watermarks

Example 1: Extracting upon upload

Sample request

The request for uploading an image with the blind watermark extracted is the same as that in a PUT Object call, 
except that you need to add the image processing parameter  Pic-Operations  to the request header and use the 

watermark extraction parameter  watermark/4 .

https://intl.cloud.tencent.com/document/product/436/7749
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization:XXXXXXXXXXXX

Pic-Operations: <PicOperations>

[Object Content]

Note: 
Authorization: Auth String (See Request Signature for details.)

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API uses Common Request Headers.

Add the image processing parameter  Pic-Operations  (a JSON string) to the request header. Its parameters are 

as follows:

Parameter Description Type Required

is_pic_info
Whether to return the input image information  0  (default): no  1 : 
yes

Int No

rules
Processing rules (up to five rules are supported). Each rule 
corresponds to one processing result. If this parameter is not 
specified, images will not be processed.

Array No

Parameters of  rules  (a JSON array) are as follows:

Parameter Description Type Required

bucket
Name of the destination bucket to store the results, formatted as 
 BucketName-APPID . If this parameter is not specified, the results will 
be stored in the current bucket.

String No

fileid

Storage path and name of the output file. 
Naming rules are as follows (assume the input file is 
 /p1/test1.jpg ):
1. A value starting with a slash (/) indicates an absolute path. For 
example, if fileid is set to /p2/test2.jpg, the test2.jpg file will be stored in 
the p2 folder. 
2.  A value not starting with a slash indicates a relative path. For example, 
if fileid is set to p2/test2.jpg, a folder named p2 will be created in the p1 
folder, and the test2.jpg file will be stored in the p2 folder.
3.  Note: Do not end the value with a slash; otherwise, an empty filename 
will be generated.

String Yes

rule

Processing parameters. For more information, see the image processing 
API. To process an image by using a specified style, the value must start 
with  style/ , with the style name followed. For example, if the style 
name is  test , the value of  rule  should be  style/test .

String Yes

To extract a blind watermark, you need to add the  watermark  parameter to  rule  as follows:

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/436/7728
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watermark/4/type/<type>/image/<imageUrl>

The parameters are as follows:

Parameter Description Type Required

type

Blind watermarking type. Valid values:  1  (semi-blind watermarking), 
 2  (perfectly blind watermarking),  3  (text blind watermarking). The 
value must be the same as that used when the blind watermark 
was added.

Int Yes
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image Image URL, which should be specified according to the value of 
 type . If the value of  type  is: 
 1 ,  image  is required and is the URL of the input image. 
 2 ,  image  is required and is the URL of the image watermark. 
 3 ,  image  does not need to be specified and will not take effect. 
The value of  image  must be URL-safe Base64-encoded, and the 
image must: 1. Be stored in the same bucket as the image with the blind 
watermark. 2. Have a URL that starts with  http:// . Note that 
"http://" cannot be omitted or changed to "https://". For example, the 
following watermark URLs are invalid: 
 examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png 

 https://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png 

String No

Request parameters

This API has no request parameter.

Request body

The request body of the API is the binary string of the image.

Response

Response headers

This API only returns Common Response Headers.

Response body

 WatermarkStatus  will be added to the  UploadResult.ProcessResults.Object  node only if  type  is 

set to  2  in the request body of the blind watermark extraction request.

Parameter Parent 
Node

Description Type

WatermarkStatus Object

This parameter is returned if  type  is set to  2  to indicate 
the confidence of the watermark extracted. Value range: 0–100. 
If the value is greater than 75, there is a blind watermark. 
If the value falls in the range of 60−75, there is a suspected blind 
watermark. 
If the value is smaller than 60, no blind watermark is extracted.

Int

Example

https://intl.cloud.tencent.com/document/product/436/7729
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Request

PUT /exampleobject1 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2018 09:06:15 GMT

Authorization:XXXXXXXXXXXX

Pic-Operations:

{

    "is_pic_info": 1,

    "rules": [{
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        "fileid": "exampleobject2",

        "rule": "watermark/4/type/2/image/aHR0cDovL2V4YW1wbGVzLTEyNTEwMDAwMDQucGljc

    }]

}

Content-Length: 64

[Object Content]

Response

HTTP/1.1 200 OK
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Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

      <OriginalInfo>

          <Key>exampleobject1</Key>

          <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exampleobj

          <ImageInfo>

                <Format>JPEG</Format>

                <Width>640</Width>

                <Height>427</Height>

                <Quality>100</Quality>

                <Ave>0xa18454</Ave>

                <Orientation>1</Orientation>

                <FrameCount>1</FrameCount>

          </ImageInfo>

      </OriginalInfo>

      <ProcessResults>

          <Object>

                <Key>exampleobject2</Key>

                <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exam

                <Format>png</Format>

                <Width>640</Width>

                <Height>427</Height>

                <Size>463092</Size>

                <Quality>100</Quality>

                <FrameCount>1</FrameCount>

                <WatermarkStatus>86</WatermarkStatus>

          </Object>

      </ProcessResults>

</UploadResult>

Note: 
If  type  is set to  1  in the request,  imageUrl  in  rule  in  Pic-Operations  is the URL of the input 

image without a blind watermark added. If  type  is set to  2  in the request,  imageUrl  is the URL of the image 

watermark.
 url  in  ProcessResults  in the response body is the URL of the image watermark extracted.

Example 2: Extracting from an image stored in COS

The request for extracting a blind watermark from an image stored in COS is the same as that used to Process In-
Cloud Data, except that you need to add the image processing parameter  Pic-Operations  to the request 

header and use the watermark extraction parameter  watermark/4 .

https://intl.cloud.tencent.com/document/product/436/40592
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Abnormal Image Detection
Last updated：2024-02-18 10:36:36

Feature Overview

CI uses the ImageInspect API to detect whether other types of suspicious files are hidden in an image.

Restrictions

Format: This feature can detect three types of abnormal images: PNG with TS video stream, BMP with TS video 
stream, and TS video stream (with only the extension changed).

Size: The input image cannot be larger than 32 MB, with its width and height not exceeding 30,000 pixels respectively, 
and the total number of pixels not exceeding 250 million. The width and height of the output image cannot exceed 
9,999 pixels respectively. For an animated input image, the total number of pixels (width * height * number of frames) 
cannot exceed 250 million.

API Format
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GET /<ObjectKey>?ci-process=ImageInspect HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Parameters

Request parameters
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Operation name: ImageInspect.

Parameter Description

ObjectKey Object name, such as  folder/sample.jpg .

Response parameters

Parameter Description

picSize Image size in bytes

picType Image format, such as JPG and PNG.

suspicious Whether non-image files are detected. Valid values:  false  (no),  true  (yes).

suspiciousBeginByte The starting byte position of the detected suspicious file in bytes

suspiciousEndByte The ending byte position of the detected suspicious file in bytes

suspiciousSize Size of the detected suspicious file

suspiciousType Type of the detected suspicious file, such as MPEG-TS.

Examples

Example 1: Public-read

Request
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?ci-process=Imag

Response
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{"picSize":1097476,"picType":"PNG","suspicious":true,"suspiciousBeginByte":120,"sus

Example 2: Private-read with a signature carried

This example obtains the average hue in the same way as in the example above except that a signature is carried. 

The signature is joined with other parameters using an ampersand (&):
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

Note: 

 You can obtain the value of  <signature>  by referring to Request Signature.

https://intl.cloud.tencent.com/document/product/436/7778
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Queue APIs
Querying Queue
Last updated：2024-02-18 10:36:35

Feature Description

This API is used to search for an image processing queue.

Request

Sample request
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GET /picqueue HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Request parameters

Parameter 
(Keyword)

Description Type Required

queueIds Queue ID. If you enter multiple IDs, separate them by comma. String No

state

1. Active: Jobs in the queue will be scheduled and executed by 
the media processing service. 
2. Paused: The queue is paused, and jobs in it will no longer be 
scheduled and executed. All jobs in the queue will remain in the 
Paused status, while jobs being executed will not be affected.

String No

pageNumber Page number. Default value:  1 . String No

pageSize Number of entries per page. Default value:  10 . String No

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers. 

Response body

The response body returns application/xml data. The following contains all the nodes when  pageNumber  and 

 pageSize  are specified:

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 362
of 2300

<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p8366c460c67b4c65a9bf81b41eaa3c4b</QueueId>

        <Name>queue-pic-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>
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            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>PicProcessing</Category>

    </QueueList>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

RequestId Response Unique ID of the request. String

TotalCount Response Total number of queues Int

PageNumber Response
Current page number, which is the same as 
 pageNumber  in the request. Int

PageSize Response
Number of entries per page, which is the same as 
 pageSize  in the request. Int

QueueList Response Queue array Container 
array

NonExistPIDs Response List of IDs of non-existent queues String array

 QueueList  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

QueueId Response.QueueList Queue ID String

Name Response.QueueList Queue name String
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State Response.QueueList Current status:  Active  or  Paused  String

NotifyConfig Response.QueueList Callback configuration Container

MaxSize Response.QueueList Maximum length of the queue Int

MaxConcurrent Response.QueueList Maximum number of concurrent jobs in the 
current queue

Int

Category Response.QueueList Queue type String

UpdateTime Response.QueueList Update time String

CreateTime Response.QueueList Creation time String

 NotifyConfig  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Url Response.QueueList.NotifyConfig Callback address String

State Response.QueueList.NotifyConfig Switch status:  On  or  Off  String

Type Response.QueueList.NotifyConfig Callback type: Url String

Event Response.QueueList.NotifyConfig
Job completed:  TaskFinish ; 
workflow completed: 
 WorkflowFinish 

String

ResultFormat Response.QueueList.NotifyConfig Callback type:  XML  or  JSON . String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request 1: Searching for the specified queue

https://intl.cloud.tencent.com/document/product/1045/33700
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GET /picqueue?queueIds=pb926e1dce3ed4e47a4f08692164f4869,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response 1
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x

<Response>

    <RequestId>NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x</RequestId>

    <QueueList>
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        <QueueId>p8366c460c67b4c65a9bf81b41eaa3c4b</QueueId>

        <Name>queue-pic-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>PicProcessing</Category>

    </QueueList>

    <NonExistPIDs>A</NonExistPIDs>

    <NonExistPIDs>B</NonExistPIDs>

</Response>

Request 2: Querying the list of queues
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GET /picqueue?pageSize=10&pageNumber=1&category=CateAll HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response 2
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x

<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>1</TotalCount>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 370
of 2300

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p8366c460c67b4c65a9bf81b41eaa3c4b</QueueId>

        <Name>queue-pic-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>PicProcessing</Category>

    </QueueList>

</Response>
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Updating Queue
Last updated：2024-02-18 10:36:35

Feature Description

This API is used to update an image processing queue.

Request

Sample request
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PUT /picqueue/<queueId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Name>My-Queue-Pic</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

The nodes are as described below:

Node Name 
(Keyword)

Parent 
Node

Description Type Required Default 
Value

Constraints

Request None Response 
container

Container Yes None None

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required Default 
Value

Constraints

Name Request Queue name, which can 
contain up to 128 bytes.

String Yes None None

State Request

1. Active: Jobs in the 
queue will be scheduled 
and executed by the media 
processing service. 
2. Paused: The queue is 
paused, and jobs in it will 
no longer be scheduled 
and executed. All jobs in 
the queue will remain in 
the  Paused  status, 
while jobs being executed 
will not be affected.

String Yes None None

NotifyConfig Request Callback configuration Container Yes None None

 NotifyConfig  has the following sub-nodes:

Node Name Parent Node Description Type Required Default Constraints
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(Keyword) Value

State Request.NotifyConfig

Callback 
status: 
 Off  or 
 On .

String No Off On/Off

Event Request.NotifyConfig Callback 
event

String
Yes if 
 State  
is  On 

None

Job completion: 
 TaskFinish ; 
workflow completio
 WorkflowFinis

ResultFormat Request.NotifyConfig Callback 
format

String No XML JSON/XML

Type Request.NotifyConfig
Callback 
type String

Yes if 
 State  
is  On 

None  Url  or  TDMQ 

Url Request.NotifyConfig Callback 
address

String

Yes if 
 State  
is  On  
and 
 Type  
is  Url 

None
The callback addre
cannot be a private
network address.

MqMode Request.NotifyConfig
TDMQ 
queue 
mode

String

Yes if 
 State  
is  On  
and 
 Type  
is 
 TDMQ 

Queue

 Topic : Topic 
subscription 
 Queue : Queue 
service 

MqRegion Request.NotifyConfig
TDMQ 
region String

Yes if 
 State  
is  On  
and 
 Type  
is 
 TDMQ 

None

Valid values:  sh  
(Shanghai),  bj  
(Beijing),  gz  
(Guangzhou),  cd 
(Chengdu),  hk  
(Hong Kong, China

MqName Request.NotifyConfig TDMQ 
topic name

String Yes if 
 State  
is  On  
and 

None None
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 Type  
is 
 TDMQ 

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers. 

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>pb926e1dce3ed4e47a4f08692164f4869</QueueId>

        <Name>My-Queue-Pic</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>
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            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RequestId Response Unique ID of the request String

Queue Response Queue information Container

 Queue  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

QueueId Response.Queue Queue ID String

Name Response.Queue Queue name String

State Response.Queue Current status:  Active  or  Paused . String

NotifyConfig Response.Queue
Callback configuration, which is the same as 
 Request.NotifyConfig . Container

MaxSize Response.Queue Maximum length of the queue Int

MaxConcurrent Response.Queue Maximum number of concurrent jobs in the current 
queue

Int

Category Response.Queue Queue type String

UpdateTime Response.Queue Update time String

CreateTime Response.Queue Creation time String

Error codes
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There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

PUT /picqueue/pb926e1dce3ed4e47a4f08692164f4869 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

https://intl.cloud.tencent.com/document/product/1045/33700
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Content-Length: 162

Content-Type: application/xml

<Request>

    <Name>My-Queue-Pic</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>
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        <QueueId>pb926e1dce3ed4e47a4f08692164f4869</QueueId>

        <Name>My-Queue-Pic</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>
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AI-Based Content Recognition
Face Recognition
Face Filter
Last updated：2024-02-18 15:49:30

Feature Description

Face filter supports beauty filter, gender swap, age change, and face cut-out. It is suitable for many use cases, such 
as social entertainment, marketing, and interactive communication.

Feature Description

Beauty filter You can upload a selfie and quickly apply smart skin brightening, skin smoothing, face 
slimming, eye enlarging, and contouring filters. You can also customize parameters.

Gender swap

You can upload a face image and have the gender swapped based on the face editing and 
generation algorithms. Beauty filters, makeup, bang, and long hair can be added to a face 
swapped from male to female, while beard and short hair can be added to a face swapped 
from female to male.

Age change You can upload a face image and make the face look older or younger based on the face 
editing and generation algorithms.

Face cut-out

You can upload an image and get the body contour recognized and separated from the 
background. The binary image, grayscale image, and foreground portrait are returned. This is 
applicable to portrait keying, photo synthesis, face special effect, and other use cases and 
greatly improves the tool efficiency.

Note: 

Face filters can be applied to a Base64-encoded image of up to 5 MB in size. PNG, JPG, JPEG, and BMP formats are 
supported, while GIF is not. To use face cut-out, the image resolution must be lower than 2000x2000 px.
Face filter is a paid service. For billing details, see Content Recognition Fees.
This feature currently can be used only through APIs.

Request

Sample request
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GET /<ObjectKey>?ci-process=face-effect&type=<type> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity.

https://intl.cloud.tencent.com/document/product/436/7778
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Request parameters

Parameter Description Type Required

ObjectKey Object name, such as  folder/document.jpg . String Yes

ci-process
CI's processing capability, which is fixed at  face-effect  for 
face filter.

String Yes

type Face filter type. Valid value: face-beautify, face-gender-
transformation, face-age-transformation, face-segmentation.

String Yes

whitening
Skin brightening level, which takes effect if  type  is  face-
beautify . Value range: [0,100]. Default value: 30. The higher 
the value, the more obvious the effect.

Integer No

smoothing
Skin smoothing level, which takes effect if  type  is  face-
beautify . Value range: [0,100]. Default value: 10. The higher 
the value, the more obvious the effect.

Integer No

faceLifting
Face slimming level, which takes effect if  type  is  face-
beautify . Value range: [0,100]. Default value: 70. The higher 
the value, the more obvious the effect.

Integer No

eyeEnlarging
Eye enlarging level, which takes effect if  type  is  face-
beautify . Value range: [0,100]. Default value: 70. The higher 
the value, the more obvious the effect.

Integer No

gender

Target gender, which takes effect if  type  is  face-gender-
transformation . 0: male to female; 1: female to male. There is 
no default value. Note that only the gender of the largest face in the 
image will be swapped.

Integer Yes

age

Target age, which takes effect if  type  is  face-age-
transformation . Value range: [10, 80]. There is no default 
value. Note that only the age of the largest face in the image will be 
changed.

Integer Yes

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request does not have a request body.

https://intl.cloud.tencent.com/document/product/1045/43609
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Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers. 

Response body

The response body returns application/xml data. The following contains all the nodes:

<Response>

  <ResultImage>Base64-encoded image</ResultImage>

https://intl.cloud.tencent.com/document/product/1045/43610
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  <ResultMask>Base64-encoded file</ResultMask>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

ResultImage Response Base64-encoded result image data String

ResultMask Response

Face cut-out output parameter, which is a Base64-encoded file 
consisting of floating point numbers after being decoded. These 
numbers represent pixels in each line starting from the top-left 
corner of the input image. The value of each number is the 
grayscale value (0–255) converted from the confidence (0–1) of the 
body contour.

String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/43611
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GET /test.jpg?ci-process=face-effect&type=face-beautify&whitening=70&smoothing=80&f

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-image

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <ResultImage>Base64-encoded image</ResultImage>

</Response>
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FaceID
ID Card Recognition
Last updated：2024-02-18 15:49:31

Feature Description

This feature can recognize all fields on the front and back of a second-generation Chinese ID card, including name, 
gender, ethnicity, date of birth, address, ID number, issuing authority, and validity period. It can also crop ID card 
photos and face photos, as well as warn about photographed, doctored, and photocopied images, edge and frame 

occlusions, temporary ID cards, and invalid validity periods.
Note: 
Currently, the ID card recognition feature has the following image requirements: the image cannot exceed 7 MB after 
being Base64-encoded. A resolution above 500x800 is recommended. PNG, JPG, JPEG, and BMP image are 
supported. We recommend that the card part occupy more than 2/3 area of the image.

ID card recognition is a paid service. For billing details, see Content Recognition Fees.
This feature currently can be used only through APIs.

Request

Processing during upload

The request for recognizing ID cards during image upload is the same as that used to simply upload a file to COS, 
except that you need to add the relevant processing parameter. Then, the recognition results will be returned during 
image upload, and the input images can be stored in COS.
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PUT /<ObjectKey>?ci-process=IDCardOCR&CardSide=<CardSide>&Config=<Config> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity.

https://intl.cloud.tencent.com/document/product/436/7778
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Processing in-cloud data

This feature can process an ID card image stored in COS and return the recognition result.

GET /<ObjectKey>?ci-process=IDCardOCR&CardSide=<CardSide>&Config=<Config> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity.

Request parameters

Request parameters

Parameter Description Type Required

ObjectKey Object name, such as  folder/document.jpg . String Yes

ci-process
CI's processing capability, which is fixed at  IDCardOCR  for ID card 
recognition.

String Yes

CardSide

FRONT: The side of the ID card with the face (face side)
BACK: The side of the ID card with the national emblem (national 
emblem side)
If this parameter is not specified, the system will automatically determine 
the ID card's front and back sides.

String No

Config

The following fields are all of bool type and default to false:
CropIdCard: Crops the ID card photo (by removing extra edges outside 
the ID card and automatically correcting the shooting angle)
CropPortrait: Crops the face photo (by automatically cutting out the face 
area in the ID card)
CopyWarn: Warns about photocopied images
BorderCheckWarn: Warns about border and frame occlusions
ReshootWarn: Warns about spoofed images
DetectPsWarn: Warns about doctored images
TempIdWarn: Warns about temporary ID cards
InvalidDateWarn: Warns about invalid ID card validity periods
Quality: Gets the image quality score (by evaluating the blurriness of the 
image )
MultiCardDetect: Enables multi-card detection
For the parameter setting method, see Config = 
{"CropIdCard":true,"CropPortrait":true}.

String No

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request does not have a request body.

https://intl.cloud.tencent.com/document/product/1045/43609
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Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers. 

Response body

The response body returns application/xml data. The following contains all the nodes:

<Response>

  <IdInfo>

https://intl.cloud.tencent.com/document/product/1045/43610
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    Recognized ID card information

  </IdInfo>

  <AdvancedInfo>

    Recognized ID card information

  </AdvancedInfo>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

IdInfo Response Recognized ID card information. Container

AdvancedInfo Response Extended information, which will not be returned if not 
requested.

Container

 IdInfo  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Name IdInfo Name (face side) String

Sex IdInfo Gender (face side) String

Nation IdInfo Ethnicity (face side) String

Birth IdInfo Date of birth (face side) String

Address IdInfo Address (face side) String

IdNum IdInfo ID number (face side) String

Authority IdInfo Issuing authority (national emblem side) String

ValidDate IdInfo Validity period (national emblem side) String

 AdvancedInfo  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type
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IdCard AdvancedInfo Base64-encoded content of the cropped ID card photo, 
which will be returned if  Config.CropIdCard  is set 
to  true .

String

Portrait AdvancedInfo
Base64-encoded content of the face on the ID card, which 
will be returned if  Config.CropPortrait  is set to 
 true .

String

Quality AdvancedInfo

Image quality score, which will be returned if 
 Config.Quality  is set to  true . Value range: 0–
100. The lower the score, the blurrier the image. The 
recommended threshold is ≥ 50.

String

BorderCodeValue AdvancedInfo

Alarm threshold score for incomplete ID card borders, 
which will be returned if  Config.BorderCheckWarn  
is set to  true . Value range: 0–100. The lower the 
score, the lower the probability of border occlusion. The 
recommended threshold value is ≥ 50.

String

WarnInfos IdInfo

Warning information. Code values and descriptions:
9100: The ID card validity period is invalid.
9101: The ID card borders are incomplete.
9102: The ID card image is photocopied.
9103: The ID card image is spoofed.
9104: The ID card is a temporary one.
9105: The ID card frame is occluded.
9106: The ID card image is doctored.
There may be multiple WarnInfos values.

String

Samples

Request



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 398
of 2300

GET /test.jpg?ci-process=IDCardOCR&CardSide=FRONT&Config={"CropIdCard":true, "CropI

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-image

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <IdInfo>

     <Name>Li Ming</Name>

     <Sex>Male</Sex>
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     <Nation>Han</Nation>

     <Birth>1987/1/1</Birth>

     <Address>Tencent Building, Hi-tech Park, Shijingshan District, Beijing</Addres

     <IdNum>440524198701010014</IdNum>

  </IdInfo>

  <AdvancedInfo>

     <IdCard>Base64-encoded content of the cropped ID card photo</IdCard>

     <Portrait>Base64-encoded content of the face on the ID card</Portrait>

  </AdvancedInfo>

</Response>

Error Codes

The following only lists the error codes for the business logic of this API. For other errors, see Error Codes.

Error Code Description

FailedOperation.DownLoadError Failed to download the file.

FailedOperation.EmptyImageError The image is empty.

FailedOperation.IdCardInfoIllegal The ID card information is invalid (ID number, name, 
etc.).

FailedOperation.ImageBlur The image is blurry.

FailedOperation.ImageDecodeFailed Failed to decode the image.

FailedOperation.ImageNoIdCard No ID card is detected in the image.

FailedOperation.ImageSizeTooLarge The image is too large. See the description of image size 
limit in the output parameters.

FailedOperation.MultiCardError There are multiple cards in the photo.

FailedOperation.OcrFailed OCR failed.

FailedOperation.UnKnowError An unknown error occurred.

FailedOperation.UnOpenError The service has not been activated.

InvalidParameter.ConfigFormatError The  Config  format is incorrect.

InvalidParameterValue.InvalidParameterValueLimit The parameter value is incorrect.

LimitExceeded.TooLargeFileError The file is too large.

https://intl.cloud.tencent.com/document/product/1045/43611
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ResourcesSoldOut.ChargeStatusException The billing status is abnormal.
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Image OCR
OCR
Last updated：2024-02-18 15:49:31

Feature Description

Based on Tencent Cloud's industry-leading deep learning technology, the optical character recognition (OCR) feature 
is capable of intelligently recognizing words on images and converting them into editable text. It can be used in photo 
scanning, paper document digitization, ecommerce ad moderation, and many other scenarios to greatly improve the 

efficiency of information processing.
This API adopts the sync GET request method.

Billing Description

Calling the API successfully will incur OCR fees and COS read request fees as described in Content Recognition 
Fees and Request Fees respectively.
If the image files are stored in COS STANDARD_IA storage class, calling the API successfully will incur 

STANDARD_IA data retrieval fees.
Image processing is not supported for objects stored in the ARCHIVE or DEEP ARCHIVE storage classes. To process 
these objects, you need to restore them first as instructed in POST Object restore.

Restrictions

Supported image formats: PNG, JPG, JPEG, BMP, PDF.
Image size: The downloaded file cannot exceed 7 MB in size after being Base64-encoded.
Image resolution: A resolution above 600*800 px is recommended; otherwise, the recognition effect may be affected.

Calling the API requires a signature. For more information, see Request Signature.

Request

Sample request

https://www.tencentcloud.com/pdf/document/1045/33453?lang=en&domain=intl.cloud.tencent.com
https://intl.cloud.tencent.com/document/product/436/40100
https://intl.cloud.tencent.com/document/product/436/40097
https://intl.cloud.tencent.com/document/product/436/12633
https://intl.cloud.tencent.com/document/product/1045/33452
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GET /<ObjectKey>?ci-process=OCR&type=general&language-type=zh&ispdf=true&pdf-pagenu

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 

Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request parameters

Parameter Description Type Required

ObjectKey Object name, such as  folder/document.jpg . String Yes

ci-process CI's processing capability, which is fixed at  OCR  for OCR. String Yes

type

OCR recognition type. Valid values:  general  (general print 
recognition),  accurate  (high-precision print recognition), 
 efficient  (simplified print recognition),  fast  (high-speed 
print recognition),  handwriting  (handwriting recognition). 
Default value:  general .

String No

language-type

Language type. This parameter takes effect only if  type  is 
 general . The language can be automatically recognized or 
manually specified. Chinese-English mix (  zh ) is selected by 
default. Mixed characters in English and each supported language 
can be recognized together. For valid values, see Recognizable 
language types.

String No

ispdf

Whether to enable PDF recognition. This parameter takes effect 
only if  type  is  general  or  fast . Valid values:  true , 
 false . Default value:  false . After this feature is enabled, 
images and PDF files can be recognized at the same time.

Boolean No

pdf-
pagenumber

Page number of the PDF page to be recognized. This parameter 
takes effect only if  type  is  general  or  fast , the 
uploaded file is a PDF, and  ispdf  is  true . Only one single 
PDF page can be recognized. Default value: 1.

Integer No

isword

Whether to return the word information after recognition. This 
parameter takes effect only if  type  is  general  or 
 accurate . Valid values:  true ,  false . Default value: 
 false .

Boolean No

enable-word-
polygon

Whether to output four-point word coordinates. This parameter 
takes effect only if  type  is  handwriting . Valid values: 
 true ,  false . Default value:  false .

Boolean No

Recognizable language types

Value Language Value Language

zh Chinese-English mix rus Russian
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zh_rare English, digits, rare Chinese characters, traditional Chinese characters, 
special symbols

ita Italian

auto Automatic hol Dutch

mix Multi-language swe Swedish

jap Japanese fin Finnish

kor Korean dan Danish

spa Spanish nor Norwegian

fre French hun Hungarian

ger German tha Thai

por Portuguese hi Hindi

vie Vietnamese ara Arabic

may Malay

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49351
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

  <TextDetections>

    <DetectedText></DetectedText>

    <Confidence></Confidence>

    <Polygon>

      <X></X>

      <Y></Y>

    </Polygon>

    <ItemPolygon>

      <X></X>

      <Y></Y>
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      <Width></Width>

      <Height></Height>

    </ItemPolygon>

    <Words>

      <Confidence></Confidence>

      <Character></Character>

      <WordCoordPoint>

        <WordCoordinate>

          <X></X>

          <Y></Y>

        </WordCoordinate>

      </WordCoordPoint>

    </Words>

  </TextDetections>

  <Language></Language>

  <Angel></Angel>

  <PdfPageSize></PdfPageSize>

  <RequestId></RequestId>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

TextDetections Response
Information of the recognized text, including the text line 
content, confidence, text line coordinates, and text line 
coordinates after rotation correction.

Container

Language Response
Detected language. For more information on the supported 
languages, see the description of the  language-type  input 
parameter.

String

Angel Response
Image rotation angle in degrees. 0° indicates horizontal text, a 
positive value indicates clockwise rotation, and a negative value 
indicates anticlockwise rotation.

Float

PdfPageSize Response Total number of PDF pages to be returned if the image is a 
PDF. Default value: 0.

Integer

RequestId Response Unique ID of the request. Each request returns a unique ID. The String
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 RequestId  is required to troubleshoot issues.

 TextDetections  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

DetectedText TextDetections Recognized text line content. String

Confidence TextDetections Confidence between 0 and 100. Integer

Polygon TextDetections
Text line coordinates, which are represented by the 
coordinates of vertices. Note: This field may return null, 
indicating that no valid values can be obtained.

Container

ItemPolygon TextDetections
Pixel coordinates of the text line in the image after rotation 
correction, which is in the format of (Abscissa of the top-left 
corner, ordinate of the top-left corner, width, height).

Container

Words TextDetections
Information of the recognized words (including characters 
and confidence). Supported recognition types are 
 general  and  accurate .

Container

WordPolygon TextDetections

Array of word coordinates, which are represented by the 
coordinates of four vertices. 
Note: This field may return null, indicating that no valid 
values can be obtained. The supported recognition type is 
 handwriting .

Container

 Polygon  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

X Polygon Abscissa. Integer

Y Polygon Ordinate. Integer

 ItemPolygon  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

X ItemPolygon Abscissa of the top-left 
corner.

Integer

Y ItemPolygon Ordinate of the top-left 
corner.

Integer
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Width ItemPolygon Width. Integer

Height ItemPolygon Height. Integer

 Words  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

Confidence Words Confidence between 0 and 100. Integer

Character Words Recognized word information. String

WordCoordPoint Words
Four-point coordinates of the word in the input image. Supported 
recognition types are  general  and  accurate . Container

 WordCoordPoint  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

WordCoordinate WordCoordPoint
Coordinates of the word in the input image, which are 
represented by the coordinates of four vertices and 
returned clockwise starting from the top-left vertex.

Container

 WordCoordinate  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

X WordCoordinate Abscissa. Integer

Y WordCoordinate Ordinate. Integer

 WordPolygon  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

LeftTop WordPolygon Coordinates of the top-left vertex. Container

RightTop WordPolygon Coordinates of the top-right vertex. Container

RightBottom WordPolygon Coordinates of the bottom-right vertex. Container

LeftBottom WordPolygon Coordinates of the bottom-left vertex. Container

 LeftTop ,  RightTop ,  RightBottom , and  LeftBottom  have the following sub-nodes:
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Node Name (Keyword) Parent Node Description Type

X WordCoordinate Abscissa. Integer

Y WordCoordinate Ordinate. Integer

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353
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GET /<ObjectKey>?ci-process=OCR&type=general&language-type=zh&ispdf=true&isword=tru

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-image

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<Response>

    <Angel>359.99</Angel>

    <Language>mix</Language>

    <PdfPageSize>0</PdfPageSize>
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    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TextDetections>

        <Confidence>99</Confidence>

        <DetectedText>Hey you</DetectedText>

        <ItemPolygon>

            <Height>64</Height>

            <Width>123</Width>

            <X>140</X>

            <Y>167</Y>

        </ItemPolygon>

        <Polygon>

            <X>140</X>

            <Y>167</Y>

        </Polygon>

        <Polygon>

            <X>263</X>

            <Y>167</Y>

        </Polygon>

        <Polygon>

            <X>263</X>

            <Y>231</Y>

        </Polygon>

        <Polygon>

            <X>140</X>

            <Y>231</Y>

        </Polygon>

        <Words>

            <Character>Hey</Character>

            <Confidence>99</Confidence>

            <WordCoordPoint>

                <WordCoordinate>

                    <X>212</X>

                    <Y>167</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>341</X>

                    <Y>167</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>341</X>

                    <Y>231</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>212</X>

                    <Y>231</Y>

                </WordCoordinate>

            </WordCoordPoint>
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        </Words>

        <Words>

            <Character>You</Character>

            <Confidence>99</Confidence>

            <WordCoordPoint>

                <WordCoordinate>

                    <X>341</X>

                    <Y>167</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>263</X>

                    <Y>167</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>263</X>

                    <Y>231</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>341</X>

                    <Y>230</Y>

                </WordCoordinate>

            </WordCoordPoint>

        </Words>

    </TextDetections>

    <TextDetections>

        <Confidence>99</Confidence>

        <DetectedText>Bye bye</DetectedText>

        <ItemPolygon>

            <Height>43</Height>

            <Width>245</Width>

            <X>526</X>

            <Y>1444</Y>

        </ItemPolygon>

        <Polygon>

            <X>526</X>

            <Y>1444</Y>

        </Polygon>

        <Polygon>

            <X>771</X>

            <Y>1444</Y>

        </Polygon>

        <Polygon>

            <X>771</X>

            <Y>1487</Y>

        </Polygon>

        <Polygon>

            <X>526</X>
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            <Y>1487</Y>

        </Polygon>

        <Words>

            <Character>Bye</Character>

            <Confidence>99</Confidence>

            <WordCoordPoint>

                <WordCoordinate>

                    <X>564</X>

                    <Y>1444</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>608</X>

                    <Y>1444</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>608</X>

                    <Y>1487</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>564</X>

                    <Y>1487</Y>

                </WordCoordinate>

            </WordCoordPoint>

        </Words>

        <Words>

            <Character>Bye</Character>

            <Confidence>99</Confidence>

            <WordCoordPoint>

                <WordCoordinate>

                    <X>608</X>

                    <Y>1444</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>641</X>

                    <Y>1444</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>641</X>

                    <Y>1487</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>608</X>

                    <Y>1487</Y>

                </WordCoordinate>

            </WordCoordPoint>

        </Words>

    </TextDetections>
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</Response>
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Speech Recognition
Job APIs
Submitting Speech Recognition Job
Last updated：2024-02-18 15:49:30

Feature Description

This API (  CreateSpeechJobs ) is used to submit a speech recognition job.

Request

Sample request
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POST /asr_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

  <Tag>SpeechRecognition</Tag>

  <Input>

    <Object></Object>

  </Input>

  <Operation>

    <SpeechRecognition></SpeechRecognition>

    <Output>

      <Region></Region>

      <Bucket></Bucket>

      <Object></Object>

    </Output>

  </Operation>

  <QueueId></QueueId>

</Request>

The nodes are as described below:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Tag Request Job type, which currently can only 
be `SpeechRecognition`.

String Yes

Input Request Speech file to be manipulated Container Yes

Operation Request Operation rule Container Yes

QueueId Request ID of the queue which the job is in String Yes

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Speech file key in COS. 
`Bucket` is specified by 

String Yes
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`Host`.

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

SpeechRecognition Request.Operation
Job type parameter, which takes 
effect only if  Tag  is 
 SpeechRecognition .

Container No

Output Request.Operation Result output address Container Yes

SpeechRecognition has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

EngineModelType Request.Operation.Speech

Recognition

Engine model type.

Phone call scenarios:

• 8k_zh: 8 kHz, for Mandarin in 
general scenarios (available for 
dual-channel audio).

• 8k_zh_s: 8 kHz, for Mandarin 
with speaker separation 
(available for mono-channel 
audio only).

Non-phone call scenarios:

• 16k_zh: 16 kHz, for Mandarin 
in general scenarios.

• 16k_zh_video: 16 kHz, for 
Mandarin in audio/video 
scenarios.

• 16k_en: 16 kHz, for English.

• 16k_ca: 16 kHz, for 
Cantonese.

String Yes

ChannelNum
Request.Operation.Speech

Recognition

Number of speech sound 
channels. 1: mono; 2: dual (for 
the 8k_zh engine only).

Integer Yes

ResTextFormat Request.Operation.Speech

Recognition

Format of the returned 
recognition result. 0: recognition 

Integer Yes
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result text, including the list of 
segment timestamps; 1: 
recognition result details, 
including the list of word 
timestamps (generally used to 
generate subtitles and for the 
16k Mandarin engine only).

FilterDirty
Request.Operation.Speech

Recognition

Whether to filter restricted words 
(for the Mandarin engine only). 0 
(default value): does not filter; 1: 
filters; 2: replaces restricted 
words with "*".

Integer No

FilterModal Request.Operation.Speech

Recognition

Whether to filter interjections (for 
the Mandarin engine only). 0 
(default value): does not filter; 1: 
filters; 2: filters strictly.

Integer No

ConvertNumMode
Request.Operation.Speech

Recognition

Whether to intelligently convert 
Chinese numbers to Arabic 
numerals (for the Mandarin 
engine only). 0: directly outputs 
Chinese numbers; 1 (default 
value): intelligently converts 
based on the scenario.

Integer No

 Output  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output Result filename String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

https://intl.cloud.tencent.com/document/product/1045/43610
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The response body returns application/xml data. The following contains all the nodes:

<Response>

  <JobsDetail>

    <Code></Code>

    <Message></Message>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

    <QueueId></QueueId>

    <Tag><Tag>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 424
of 2300

    <Input>

      <Object></Object>

    </Input>

    <Operation>

      <SpeechRecognition></SpeechRecognition>

      <Output>

        <Region></Region>

        <Bucket></Bucket>

        <Object></Object>

      </Output>

      <MediaInfo>

      </MeidaInfo>

    </Operation>

  </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is meaningful only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error description, which is meaningful only if 
 State  is  Failed  String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job type: SpeechRecognition String

State Response.JobsDetail Job status. Valid values: Submitted, Running, 
Success, Failed, Pause, Cancel

String

CreationTime Response.JobsDetail Job creation time String
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QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:


Same as the  Request.Input  node in the request.

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

TemplateId Response.JobsDetail.Operation Job template ID String

Output Response.JobsDetail.Operation File output address Container

MediaInfo Response.JobsDetail.Operation
Transcoding output video information. This 
node will not be returned if there is no 
output video.

Container

 Output  has the following sub-nodes:


Same as the  Request.Operation.Output  node in the request.

 SpeechRecognition  has the following sub-nodes:


Same as the  Request.Operation.SpeechRecognition  node in the request.

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

https://intl.cloud.tencent.com/document/product/1045/43611
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Querying Specified Speech Recognition Job
Last updated：2024-02-18 15:49:30

Feature Description

This API (  DescribeSpeechJob ) is used to query a specified speech recognition job.

Request

Sample request
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GET /asr_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 

Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity.

https://intl.cloud.tencent.com/document/product/436/7778
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Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request does not have a request body.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers. 

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

  <JobsDetail></JobsDetail>

  <NonExistJobIds></NonExistJobIds>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container
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 Response  has the following sub-nodes:

Node Name (Keyword) Parent 
Node

Description Type

JobsDetail Response
Job details. Same as  Response.JobsDetail  in 
 CreateSpeechJobs .

Container

NonExistJobIds Response List of non-existing job IDs queried. If all jobs exist, 
this node will not be returned.

String

SpeechRecognitionResult Response
Returned speech recognition result details when the 
job type is  SpeechRecognition  and the status 
is  success .

Container

 SpeechRecognitionResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Result Response.SpeechRecognitionResult Recognition result Container

ResultDetail Response.SpeechRecognition.ResultDetail

Recognition result 
details, including the time 
offsets of words in each 
sentence (generally used 
to generate subtitles). 
This field will not be 
empty if 
 ResTextFormat  in 
the recognition request is 
 1 .
Note: This field may 
return null, indicating that 
no valid values can be 
obtained.

Array of 
SentenceDetail

AudioTime Response.SpeechRecognition.audioTime Speech duration double

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

https://intl.cloud.tencent.com/document/product/1045/43611
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Pulling Speech Recognition Jobs in Batches
Last updated：2024-02-18 15:49:31

Feature Description

The API (  DescribeSpeechJobs ) is used to pull speech recognition jobs that meet specified conditions.

Request

Sample request
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GET /asr_jobs?size=&states=&queueId=&startCreationTime=&endCreationTime= HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 

Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity.

https://intl.cloud.tencent.com/document/product/436/7778
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Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request does not have a request body.

Request parameters

The parameters are as described below:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

queueId None ID of the queue from which jobs are pulled. String Yes

tag None Job type: SpeechRecognition. String Yes

orderByTime None  Desc  (default) or  Asc . String No

nextToken None Context token for pagination. String No

size None Maximum number of jobs that can be pulled. The 
default value is 10. The maximum value is 100.

Integer No

states None

Status of the jobs to pull. If you enter multiple job 
statuses, separate them by comma. Valid values: All 
(default), Submitted, Running, Success, Failed, 
Pause, Cancel.

String No

startCreationTime None
Start time of the time range for job pulling in the 
format of  %Y-%m-%dT%H:%m:%S%z . String No

endCreationTime None
End time of the time range for job pulling in the format 
of  %Y-%m-%dT%H:%m:%S%z . String No

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers. 

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

  <JobsDetail></JobsDetail>

  <NextToken></NextToken>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container
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 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

JobsDetail Response
Job details. Same as  Response.JobsDetail  in 
 CreateSpeechJobs .

Container

NextToken Response Context token for pagination String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

https://intl.cloud.tencent.com/document/product/1045/43611
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Queue APIs
Querying Speech Recognition Queue
Last updated：2024-02-18 15:49:31

Feature Description

This API (  DescribeSpeechQueues ) is used to query speech recognition queues.

Request

Sample request
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GET /asrqueue HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 438
of 2300

When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Request parameters

Name	 Type Description Required

queueIds string Queue ID. If you enter multiple IDs, separate them by comma. No

state string

1. Active: Jobs in the queue will be scheduled and executed by 
the speech recognition service. 
2.  Paused: The queue is paused, and jobs in it will no longer be 
scheduled and executed. All jobs in the queue will remain in the 
`Paused` status, while jobs being executed will continue without 
being affected.

No

pageNumber string Page number No

pageSize string Number of entries per page No

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers. 

Response body

The response body returns application/xml data. The following contains all the nodes when  pageNumber  and 

 pageSize  are specified:

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>A</QueueId>

        <Name></Name>

        <State>Active</State>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>
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        <UpdateTime></UpdateTime>

        <CreateTime></CreateTime>

        <NotifyConfig>

            <Url></Url>

            <Type></Type>

            <State></State>

            <Event></Event>

        </NotifyConfig>

    </QueueList>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

RequestId Response Unique ID of the request. String

TotalCount Response Total number of queues Int

PageNumber Response
Current page number. Same as  pageNumber  in the 
request.

Int

PageSize Response
Number of entries per page. Same as  pageSize  in 
the request.

Int

QueueList Response Queue array Container

 QueueList  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

QueueId Response.QueueList Queue ID String

Name Response.QueueList Queue name String

State Response.QueueList Current status:  Active  or  Paused  String

NotifyConfig Response.QueueList Callback configuration Container

MaxSize Response.QueueList Maximum length of the queue Int
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MaxConcurrent Response.QueueList Maximum number of concurrent jobs in the 
current queue

Int

UpdateTime Response.QueueList Update time String

CreateTime Response.QueueList Creation time String

 NotifyConfig  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Url Response.QueueList.NotifyConfig Callback address String

State Response.QueueList.NotifyConfig Switch status:  On  or  Off  String

Type Response.QueueList.NotifyConfig Callback type: Url String

Event Response.QueueList.NotifyConfig The event that triggered the 
callback

String

The response body returns application/xml data. The following contains all the nodes when  queueIds  is 

specified:
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<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <QueueList>

        <QueueId>A</QueueId>

        <Name></Name>

        <State>Active</State>

        <NotifyConfig>

            <Url></Url>

        </NotifyConfig>

    </QueueList>

    <NonExistPIDs>
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        <QueueID>B</QueueID>

        <QueueID>C</QueueID>

    </NonExistPIDs>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

RequestId Response Unique ID of the request. String

QueueList Response
Queue array. Same as  QueueList  described 
above.

Container

NonExistPIDs Response List of non-existing queue IDs Container

 NonExistPIDs  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

QueueID Response.NonExistPIDs Queue ID String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

https://intl.cloud.tencent.com/document/product/1045/43611
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Updating Speech Recognition Queue
Last updated：2024-02-18 15:49:31

Feature Description

This API (  UpdateSpeechQueue ) is used to update a speech recognition queue.

Request

Sample request
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PUT /asrqueue/p8eb46b8cc1a94bc09512d16c5c4f4d3a HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/43609


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 447
of 2300

<Request>

    <Name>Queue Name</Name>

    <QueueID></QueueID>

    <State></State>

    <NotifyConfig>

        <Type></Type>

        <Url></Url>

        <Event></Event>

    </NotifyConfig>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required Constraints

Name Request Template 
name

String Yes Length limit: 100 characters

QueueID Request Channel ID String Yes -

State Request Channel status String Yes

 1. Active: Jobs in the channel 
will be scheduled and 
executed by the speech 
recognition service. 
Paused: The channel is 
paused, and jobs in it will no 
longer be scheduled and 
executed. All jobs in the 
channel will remain in the 
`Submitted` status, while jobs 
being executed will continue 
without being affected.      

NotifyConfig Request Notification 
channel

Container Yes Third-party callback URL
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 NotifyConfig  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required Constraints

Url Request.NotifyConfig Callback configuration String No Length limit: 
100 characters

Type Request.NotifyConfig Callback type. General 
callback: Url

String No Length limit: 
100 characters

Event Request.NotifyConfig Callback event String No Length limit: 
100 characters

State Request.NotifyConfig Callback switch: `Off` or 
`On`

String No Length limit: 
100 characters

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers. 

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Queue>

        <QueueId></QueueId>

        <Name></Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>mts-topic-1</Url>

            <Type></Type>

            <Event></Event>

        </NotifyConfig>
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        <CreateTime></CreateTime>

        <UpdateTime></UpdateTime>

    </Queue>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RequestId Response Unique ID of the request. String

Queue Response

Queue information. Same 
as 
 Response.QueueList  
in 
[DescribeSpeechQueues].

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

https://intl.cloud.tencent.com/document/product/1045/43611


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 451
of 2300

Search by Image
Enabling Search by Image
Last updated：2024-02-18 15:49:31

Overview

This API is used to enable the search by image feature for a bucket.

Request

Sample request
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POST /ImageSearchBucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request parameters

This API has no request parameter.

Request headers

This API only uses Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/436/7728
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<Request>

    <MaxCapacity>10000</MaxCapacity>

    <MaxQps>10</MaxQps>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes
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 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

MaxCapacity Request Maximum capacity of the image library Int Yes

MaxQps Request
Maximum QPS of the image library. Default 
value:  10  Int No

Note: 
 The capacity of the image library cannot be modified after being set.

Response

Response headers

This API only returns Common Response Headers.

Response body

This response has no response body.

Error codes

This API returns common error responses and error codes. For more information, see Error Codes.

Examples

Request

https://intl.cloud.tencent.com/document/product/436/7729
https://intl.cloud.tencent.com/document/product/436/7730


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 456
of 2300

POST /ImageSearchBucket HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 50

Content-Type: application/xml

<Request>

    <MaxCapacity>10000</MaxCapacity>

    <MaxQps>10</MaxQps>

</Request>
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Response

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****
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Adding Images to a Library
Last updated：2024-02-18 15:49:31

Overview

This API is used to add an image to an image library.

Request

Sample request
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POST /<ObjectKey>?ci-process=ImageSearch&action=AddImage HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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 Authorization: Auth String (For more information, please see Request Signature.)

Request parameters

This API has no request parameter.

Request headers

This API only uses Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/436/7728
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<Request>

    <EntityId>apple</EntityId>

    <CustomContent>myapple</CustomContent>

    <Tags>{"key1":"val1","key2":"val2"}</Tags>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

EntityId Request
Entity ID, which can be up to 64 characters. If the 
 EntityId  already exists, this request adds the 
image to it.

String Yes

CustomContent Request
Custom content, which can be up to 4,096 
characters. The content set will be returned when 
the image is queried.

String No

Tags Request Custom tags. The value is a JSON string containing 
up to 10 key:value pairs.

String No

Response

Response headers

This API only returns Common Response Headers.

Response body

This response has no response body.

Error codes

This API returns common error responses and error codes. For more information, please see Error Codes.

Samples

https://intl.cloud.tencent.com/document/product/436/7729
https://intl.cloud.tencent.com/document/product/436/7730
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Request

POST /<ObjectKey>?ci-process=ImageSearch&action=AddImage HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&q-si

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Content-Length: 100

Content-Type: application/xml

<Request>

    <EntityId>apple</EntityId>

    <CustomContent>myapple</CustomContent>
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    <Tags>{"key1":"val1","key2":"val2"}</Tags>

</Request>

Response

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci
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x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 465
of 2300

Search by Image APIs
Last updated：2024-02-18 15:49:30

Overview

This API is used to search for images.

Request

Sample request
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GET /<ObjectKey>?ci-process=ImageSearch&action=SearchImage&MatchThreshold=&Offset= 

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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 Authorization: Auth String (For more information, please see Request Signature.)

Request parameters

The nodes are described as follows:

Node Name 
(Keyword)

Description Type Required

MatchThreshold
Only images scoring higher than the value of 
 MatchThreshold  will be returned. Default value:  0  Int No

Offset Starting number. Default value:  0  Int No

Limit
Number of images to return. Default value:  10 . Maximum value: 
 100 

Int No

Filter Uses image tags to filter images. You can use AND and OR to set 
multiple conditions (>, >=, <, <=, =, !=).

String No

Request headers

This API only uses Common Request Headers.

Request body

This request does not have a request body.

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/436/7728
https://intl.cloud.tencent.com/document/product/436/7729
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<Response>

    <Count>2</Count>

    <ImageInfos>

        <EntityId>apple</EntityId>

        <PicName>ObjectKey1</PicName>

        <Score>99</Score>

        <CustomContent>XXX</CustomContent>

        <Tags>{"key1":"value1","key2":"value2"}</Tags>

    </ImageInfos>

    <ImageInfos>

        <EntityId>apple</EntityId>
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        <PicName>ObjectKey2</PicName>

        <Score>90</Score>

        <CustomContent>XXX</CustomContent>

        <Tags>{"key1":"value1","key2":"value2"}</Tags>

    </ImageInfos>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RequestId Response Unique ID of the request String

Count Response Number of images 
returned

Int

ImageInfos Response Image information Container

 ImageInfos  is an array. Each of its items includes the following nodes:

Node Name (Keyword) Parent Node Description Type

EntityId ImageInfos Entity ID String

CustomContent ImageInfos Custom content set for the image String

Tags ImageInfos Custom tags. The value is a JSON string. String

PicName ImageInfos Image name String

Score ImageInfos Similarity score Int

Error codes

This API returns common error responses and error codes. For more information, please see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/436/7730


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 470
of 2300

GET /<ObjectKey>?ci-process=ImageSearch&action=SearchImage&MatchThreshold=10&Offset

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&q-si

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 150

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Count>2</Count>

    <ImageInfos>
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        <EntityId>apple</EntityId>

        <PicName>ObjectKey</PicName>

        <Score>99</Score>

        <CustomContent>XXX</CustomContent>

        <Tags>{"key1":"value1","key2":"value2"}</Tags>

    </ImageInfos>

    <ImageInfos>

        <EntityId>apple</EntityId>

        <PicName>ObjectKey2</PicName>

        <Score>90</Score>

        <CustomContent>XXX</CustomContent>

        <Tags>{"key1":"value1","key2":"value2"}</Tags>

    </ImageInfos>

</Response>
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Deleting Library Images
Last updated：2024-02-18 15:49:30

Overview

This API is used to delete images from an image library.

Request

Sample request
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POST /<ObjectKey>?ci-process=ImageSearch&action=DeleteImage HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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 Authorization: Auth String (For more information, please see Request Signature.)

Request parameters

This API has no request parameter.

Request headers

This API only uses Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/436/7728
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<Request>

    <EntityId>apple</EntityId>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

EntityId Request Entity ID String Yes

Response

Response headers

This API only returns Common Response Headers.

Response body

This response has no response body.

Error codes

This API returns common error responses and error codes. For more information, please see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/436/7729
https://intl.cloud.tencent.com/document/product/436/7730
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POST /<ObjectKey>?ci-process=ImageSearch&action=DeleteImage HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Content-Length: 20

Content-Type: application/xml

<Request>

    <EntityId>apple</EntityId>

</Request>
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Response

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****
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Queue APIs
Querying Queue
Last updated：2024-02-18 15:49:30

Feature Description

This API is used to search for an AI-based content recognition queue.

Request

Sample request
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GET /ai_queue HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Request parameters

Parameter 
(Keyword)

Description Type Required

queueIds Queue ID. If you enter multiple IDs, separate them by comma. String No

state

1.  Active : Jobs in the queue will be scheduled and executed by 
the media processing service. 
2.  Paused : The queue is paused, and jobs in it will no longer be 
scheduled and executed. All jobs in the queue will remain in the 
 Paused  status, while jobs being executed will not be affected.

String No

pageNumber Page number. Default value:  1 . String No

pageSize Number of entries per page. Default value:  10 . String No

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers. 

Response body

The response body returns application/xml data. The following contains all the nodes when  pageNumber  and 

 pageSize  are specified:

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p23f69f4779e64b18aa61e70d5416c071</QueueId>

        <Name>queue-ai-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>
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            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>AIProcess</Category>

    </QueueList>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

RequestId Response Unique ID of the request. String

TotalCount Response Total number of queues Int

PageNumber Response
Current page number, which is the same as 
 pageNumber  in the request. Int

PageSize Response
Number of entries per page, which is the same as 
 pageSize  in the request. Int

QueueList Response Queue array Container 
array

NonExistPIDs Response List of IDs of non-existent queues String array

 QueueList  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

QueueId Response.QueueList Queue ID String

Name Response.QueueList Queue name String
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State Response.QueueList Current status:  Active  or  Paused  String

NotifyConfig Response.QueueList Callback configuration Container

MaxSize Response.QueueList Maximum length of the queue Int

MaxConcurrent Response.QueueList Maximum number of concurrent jobs in the 
current queue

Int

Category Response.QueueList Queue type String

UpdateTime Response.QueueList Update time String

CreateTime Response.QueueList Creation time String

 NotifyConfig  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Url Response.QueueList.NotifyConfig Callback address String

State Response.QueueList.NotifyConfig Switch status:  On  or  Off  String

Type Response.QueueList.NotifyConfig Callback type: Url String

Event Response.QueueList.NotifyConfig
Job completed:  TaskFinish ; 
workflow completed: 
 WorkflowFinish 

String

ResultFormat Response.QueueList.NotifyConfig Callback type:  XML  or  JSON . String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request 1: Searching for the specified queue

https://intl.cloud.tencent.com/document/product/1045/33700
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GET /ai_queue?queueIds=p23f69f4779e64b18aa61e70d5416c071,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response 1
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x

<Response>

    <RequestId>NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x</RequestId>

    <QueueList>
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        <QueueId>p23f69f4779e64b18aa61e70d5416c071</QueueId>

        <Name>queue-ai-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>AIProcess</Category>

    </QueueList>

    <NonExistPIDs>A</NonExistPIDs>

    <NonExistPIDs>B</NonExistPIDs>

</Response>

Request 2: Querying the list of queues
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GET /ai_queue?pageSize=10&pageNumber=1&category=CateAll HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response 2
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x

<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>1</TotalCount>
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    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p23f69f4779e64b18aa61e70d5416c071</QueueId>

        <Name>queue-ai-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>AIProcess</Category>

    </QueueList>

</Response>
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Updating Queue
Last updated：2024-02-18 15:49:31

Feature Description

This API is used to update the AI-based content recognition queue.

Request

Sample request
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PUT /ai_queue/<queueId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Name>My-Queue-AI</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

The nodes are as described below:

Node Name 
(Keyword)

Parent 
Node

Description Type Required Default 
Value

Constraints

Request None Response 
container

Container Yes None None

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required Default 
Value

Constraints

Name Request Queue name, which can 
contain up to 128 bytes.

String Yes None None

State Request

1. Active: Jobs in the 
queue will be scheduled 
and executed by the 
media processing 
service. 
2.   Paused : The 
queue is paused, and 
jobs in it will no longer be 
scheduled and executed. 
All jobs in the queue will 
remain in the  Paused  
status, while jobs being 
executed will not be 
affected.

String Yes None None

NotifyConfig Request Callback configuration Container Yes None None
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 NotifyConfig  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Default 
Value

Constraints

State Request.NotifyConfig

Callback 
status: 
 Off  or 
 On .

String No Off On/Off

Event Request.NotifyConfig Callback 
event

String
Yes if 
 State  
is  On 

None

Job completion: 
 TaskFinish ; 
workflow completio
 WorkflowFinis

ResultFormat Request.NotifyConfig Callback 
format

String No XML JSON/XML

Type Request.NotifyConfig
Callback 
type String

Yes if 
 State  
is  On 

None  Url  or  TDMQ 

Url Request.NotifyConfig Callback 
address

String

Yes if 
 State  
is  On  
and 
 Type  
is  Url 

None
The callback addre
cannot be a private
network address.

MqMode Request.NotifyConfig
TDMQ 
queue 
mode

String

Yes if 
 State  
is  On  
and 
 Type  
is 
 TDMQ 

Queue
Topic: Topic 
subscription 
Queue: Queue serv

MqRegion Request.NotifyConfig
TDMQ 
region String

Yes if 
 State  
is  On  
and 
 Type  
is 
 TDMQ 

None

Valid values:  sh  
(Shanghai),  bj  
(Beijing),  gz  
(Guangzhou),  cd 
(Chengdu),  hk  
(Hong Kong, China

MqName Request.NotifyConfig TDMQ String Yes if None None
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topic name  State  
is  On  
and 
 Type  
is 
 TDMQ 

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers. 

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>p23f69f4779e64b18aa61e70d5416c071</QueueId>

        <Name>My-Queue-AI</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>
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            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RequestId Response Unique ID of the request String

Queue Response Queue information Container

 Queue  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

QueueId Response.Queue Queue ID String

Name Response.Queue Queue name String

State Response.Queue Current status:  Active  or  Paused . String

NotifyConfig Response.Queue
Callback configuration, which is the same as 
 Request.NotifyConfig . Container

MaxSize Response.Queue Maximum length of the queue Int

MaxConcurrent Response.Queue Maximum number of concurrent jobs in the current 
queue

Int

Category Response.Queue Queue type String

UpdateTime Response.Queue Update time String

CreateTime Response.Queue Creation time String

Error codes
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There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

PUT /ai_queue/p23f69f4779e64b18aa61e70d5416c071 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

https://intl.cloud.tencent.com/document/product/1045/33700
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Content-Length: 162

Content-Type: application/xml

<Request>

    <Name>My-Queue-AI</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>
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        <QueueId>p23f69f4779e64b18aa61e70d5416c071</QueueId>

        <Name>My-Queue-AI</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>
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Service Configuration
Enabling AI-Based Content Recognition
Last updated：2024-02-18 15:49:30

Feature Description

This API is used to activate the AI-based content recognition service and generate a queue.

Request

Sample request
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POST /ai_bucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <RequestId>NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x</RequestId>

    <AiBucket>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-09T16:23:11+0800></CreateTime>

    </AiBucket>

</Response>

The nodes are as described below:
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Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RequestId Response Unique ID of the request String

AiBucket Response Bucket information Container

 AiBucket  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

BucketId Response.AiBucket Bucket ID. String

Name Response.AiBucket
Bucket name, which is 
the same as 
 BucketId .

String

Region Response.AiBucket Region. String

CreateTime Response.AiBucket Creation time. String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/33700
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POST /ai_bucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x

<Response>

    <RequestId>NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x</RequestId>

    <AiBucket>
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        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-09T16:23:11+0800></CreateTime>

    </AiBucket>

</Response>
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Querying AI-Based Content Recognition
Last updated：2024-02-18 15:49:31

Feature Description

This API is used to query the status of the AI-based content recognition service.

Request

Sample request
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GET /ai_bucket HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Request parameters

Parameter Description Type Required

regions
Region information, such as  ap-shanghai  and  ap-beijing . 
To specify multiple regions, separate them by comma. For more 
information, see Regions and Domain Names.

string No

bucketNames Bucket name. To specify multiple bucket names, separate them by 
comma. Exact search is supported.

string No

bucketName Bucket name prefix for prefix search. string No

pageNumber Page number. Default value:  1 . String No

pageSize Number of entries per page. Default value:  10 . String No

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
https://intl.cloud.tencent.com/document/product/1045/33423
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <RequestId>NjJmMzY1Y2NfOTBmYTUwNjRfNTA5YV8y</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>5</PageSize>

    <AiBucketList>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-08T16:23:11+0800></CreateTime>

    </AiBucketList>
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    <AiBucketList>

        <BucketId>test-1-1234567890</BucketId>

        <Name>test-1-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-09T16:23:11+0800></CreateTime>

    </AiBucketList>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

RequestId Response Unique ID of the request. String

TotalCount Response Total number of media buckets. Int

PageNumber Response
Current page number, which is the same as  pageNumber  
in the request.

Int

PageSize Response
Number of entries per page, which is the same as 
 pageSize  in the request. Int

AiBucketList Response Media bucket list. Container

 AiBucketList  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

BucketId Response.AiBucketList Bucket ID. String

Name Response.AiBucketList
Bucket name, which is the same as 
 BucketId . String

Region Response.AiBucketList Region. String

CreateTime Response.AiBucketList Creation time. String

Error codes
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There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

GET /ai_bucket?regions=ap-chongqing&pageSize=5&bucketName=t HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

https://intl.cloud.tencent.com/document/product/1045/49353
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Content-Length: 0

Content-Type: application/xml

Response

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT
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Server: tencent-ci

x-ci-request-id: NjJmMzY1Y2NfOTBmYTUwNjRfNTA5YV8y

<Response>

    <RequestId>NjJmMzY1Y2NfOTBmYTUwNjRfNTA5YV8y</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>5</PageSize>

    <AiBucketList>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-08T16:23:11+0800></CreateTime>

    </AiBucketList>

    <AiBucketList>

        <BucketId>test-1-1234567890</BucketId>

        <Name>test-1-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime2022-08-09T16:23:11+0800></CreateTime>

    </AiBucketList>

</Response>
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Smart Audio
Smart Audio API List
Last updated：2024-02-18 17:02:09

Job APIs

Job is an abstract concept. Smart voice has many types of jobs, such as text to speech and audio noise cancellation.

A job contains three key pieces of information: input, output, and parameters. Input and output control the input file 
when the job is executed and the target file after the job is executed, and parameters control the detailed 

configurations for executing specific features.

Workflow APIs

A workflow in smart voice refers to the process of automatically processing the specified uploaded file by configuring 
multiple job operations. For more information on calls, see Workflow APIs.

Batch Operation APIs

A batch operation is to execute a single job or automatically perform operations configured in a workflow on the 
specified existing file. For more information on calls, see Triggering Batch Data Processing Job.

Features Job API

Smart voice

Audio noise cancellation Submitting Audio Noise Cancellation Job﻿

Voice/Sound separation Submitting Voice/Sound Separation Job﻿

Text to speech Submitting Text-to-Speech Job﻿

Speech recognition Submitting Speech Recognition Job﻿

https://intl.cloud.tencent.com/document/product/1045/43618
https://intl.cloud.tencent.com/document/product/1045/48921
https://intl.cloud.tencent.com/document/product/1045/48933
https://intl.cloud.tencent.com/document/product/1045/48946
https://intl.cloud.tencent.com/document/product/1045/48942
https://intl.cloud.tencent.com/document/product/1045/49789
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Speech Bucket APIs
Querying Speech Recognition Activation
Status
Last updated：2024-02-18 17:02:09

Feature Description

This API (  DescribeSpeechBuckets ) is used to query whether the speech recognition feature is enabled for a 

bucket.

Request

Sample request
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GET /asrbucket HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity .

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Request parameters

Name Type Description Required

regions string Region. To specify multiple regions, separate them by comma. 
Valid values: All, ap-shanghai, ap-beijing.

No

bucketNames string Bucket name. To specify multiple bucket names, separate them 
by comma. Exact search is supported.

No

bucketName string Bucket name prefix for prefix search. No

pageNumber string Page number No

pageSize string Number of entries per page No

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <AsrBucketList>

        <BucketId></BucketId>

        <Region></Region>

        <CreateTime></CreateTime>

    </AsrBucketList>

</Response>
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The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

RequestId Response Unique ID of the request. String

TotalCount Response Total number of media buckets. Int

PageNumber Response
Current page number. Same as  pageNumber  in the 
request.

Int

PageSize Response
Number of entries per page. Same as  pageSize  in 
the request.

Int

AsrBucketList Response Speech bucket list Container

 AsrBucketList  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

BucketId Response.AsrBucketList Bucket ID. String

Name Response.AsrBucketList Bucket name. Same as  BucketId . String

Region Response.AsrBucketList Bucket region. String

CreateTime Response.AsrBucketList Creation time. String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

https://intl.cloud.tencent.com/document/product/1045/43611
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Media Processing
Media Processing API List
Last updated：2024-02-18 17:02:09

Job APIs

Job is an abstract concept. Media processing includes many types of jobs, such as transcoding, screenshot, and 
media information query.

A job contains three key pieces of information: input, output, and parameters. Input and output control the input file 

when the job is executed and the target file after the job is executed, and parameters control the detailed 
configurations for executing specific features.

A job can be either sync or async:
Sync job: Jobs can be submitted synchronously for execution.
Async job: Jobs are queued in the media processing queue in order of submission and priority.

Feature Job API

Basic 
processing

Audio/Video transcoding Submitting Audio/Video Transcoding Job﻿

Top speed codec transcoding Submitting Top Speed Codec Transcoding 
Job﻿

Video-to-animated image conversion Submitting Video-to-Animated Image 
Conversion Job﻿

Video frame capturing Submitting Video Frame Capturing Job﻿

Audio/Video remuxing Submitting Remuxing Job﻿

Audio/Video splicing Submitting Video Splicing Job﻿

Media information query Submitting Media Information Query Job﻿

Image quality enhancement (including functions 
such as hyper-differentiation rate, interpolation, 
color enhancement, etc.)

Submitting Image quality enhancement Job﻿

Video quality scoring Submitting Video Quality Scoring Job﻿

Copyright 
protection

Digital watermark Submitting Digital Watermark Adding Job﻿

https://intl.cloud.tencent.com/document/product/1045/48941
https://intl.cloud.tencent.com/document/product/1045/49782
https://intl.cloud.tencent.com/document/product/1045/49569
https://intl.cloud.tencent.com/document/product/1045/48938
https://intl.cloud.tencent.com/document/product/1045/48936
https://intl.cloud.tencent.com/document/product/1045/48929
https://intl.cloud.tencent.com/document/product/1045/48932
https://intl.cloud.tencent.com/document/product/1045/48944
https://intl.cloud.tencent.com/document/product/1045/48934
https://intl.cloud.tencent.com/document/product/1045/48930
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Smart 
editing

Video tagging Submitting Video Tagging Job﻿

Video montage Submitting Video Montage Job﻿

Intelligent thumbnail Submitting Intelligent Thumbnail Job﻿

Smart 
voice

Audio noise cancellation Submitting Audio Noise Cancellation Job﻿

Voice/Sound separation Submitting Voice/Sound Separation Job﻿

Text to speech Submitting Text-to-Speech Job﻿

Speech recognition Submitting Speech Recognition Job﻿

Sync jobs

Video frame capturing Getting Media File Screenshot﻿

Media information query Getting Media File Information﻿

Private M3U8 GetPrivateM3U8﻿

Template APIs

For media processing features such as audio/video transcoding, audio/video splicing, video frame capturing, and 
video-to-animated image conversion, you need to specify a template when creating a job or workflow in CI. The 
template page provides preset templates, and you can also customize templates based on your business needs. For 
more information on media processing templates, see Media Processing.

Workflow APIs

A workflow in media processing refers to the process of automatically processing the specified uploaded file by 

configuring multiple job operations. For more information on calls, see Workflow APIs.

Batch Operation APIs

A batch operation is to execute a single job or automatically perform operations configured in a workflow on the 
specified existing file. For more information on calls, see Batch Job APIs.

https://intl.cloud.tencent.com/document/product/1045/48945
https://intl.cloud.tencent.com/document/product/1045/48943
https://intl.cloud.tencent.com/document/product/1045/48937
https://intl.cloud.tencent.com/document/product/1045/48933
https://intl.cloud.tencent.com/document/product/1045/48946
https://intl.cloud.tencent.com/document/product/1045/48942
https://intl.cloud.tencent.com/document/product/1045/49789
https://intl.cloud.tencent.com/document/product/1045/49539
https://intl.cloud.tencent.com/document/product/1045/49541
https://intl.cloud.tencent.com/document/product/1045/49542
https://intl.cloud.tencent.com/document/product/1045/49899
https://intl.cloud.tencent.com/document/product/1045/43618
https://intl.cloud.tencent.com/document/product/1045/47027
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Media Processing Service Configuration APIs
Querying Media Processing Service
Last updated：2024-02-18 17:02:09

Feature Description

This API (  DescribeMediaBuckets ) is used to query buckets with media processing enabled.

Request

Sample request



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 528
of 2300

GET /mediabucket HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Request parameters

Parameter Description Type Required

regions
Region information, such as  ap-shanghai  and  ap-beijing . 
To specify multiple regions, separate them by comma. For more 
information, see Regions and Domain Names.

string No

bucketNames Bucket name. To specify multiple bucket names, separate them by 
comma. Exact search is supported.

string No

bucketName Bucket name prefix for prefix search. string No

pageNumber Page number. string No

pageSize Number of entries per page. string No

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
https://intl.cloud.tencent.com/document/product/1045/33423
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <MediaBucketList>

        <BucketId></BucketId>

        <Region></Region>

        <CreateTime></CreateTime>

    </MediaBucketList>

</Response>
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The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

RequestId Response Unique ID of the request. String

TotalCount Response Total number of media buckets. Int

PageNumber Response
Current page number, which is the same as  pageNumber  
in the request.

Int

PageSize Response
Number of entries per page, which is the same as 
 pageSize  in the request. Int

MediaBucketList Response Media bucket list. Container

 MediaBucketList  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

BucketId Response.MediaBucketList Bucket ID. String

Name Response.MediaBucketList
Bucket name, which is the same as 
 BucketId . String

Region Response.MediaBucketList Bucket region. String

CreateTime Response.MediaBucketList Creation time. String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353
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GET /mediabucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host: ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>
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      <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

      <TotalCount>1</TotalCount>

      <PageNumber>1</PageNumber>

      <PageSize>10</PageSize>

      <MediaBucketList>

            <BucketId></BucketId>

            <Region></Region>

            <CreateTime></CreateTime>

      </MediaBucketList>

      <MediaBucketList>

            <BucketId></BucketId>

            <Region></Region>

            <CreateTime></CreateTime>

      </MediaBucketList>

</Response>
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Binding Media Processing Service
Last updated：2024-02-18 17:02:09

Feature Description

This API (  CreateMediaBucket ) is used to bind a media bucket (i.e., authorizing the media processing service 

role to access the bucket).

Request

Sample request
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POST /mediabucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
https://intl.cloud.tencent.com/document/product/1045/49352


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 538
of 2300

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <MediaBucket>

        <BucketId></BucketId>

        <Region></Region>

        <CreateTime></CreateTime>

    </MediaBucket>

</Response>

The nodes are as described below:
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Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

RequestId Response Unique ID of the request String

MediaBucket Response
Media bucket details, which are the same as 
 Response.MediaBucketList  in 
DescribeMediaBuckets.

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49940
https://intl.cloud.tencent.com/document/product/1045/49353
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POST /mediabucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <MediaBucket>
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        <BucketId>examplebucket-1250000000</BucketId>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </MediaBucket>

</Response>
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Unbinding Media Processing Service
Last updated：2024-02-18 17:02:09

Feature Description

This API (  DELETEMediaBucket ) is used to unbind a media bucket (objects in the bucket will not be deleted).

Request

Sample request
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DELETE /mediabucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

</Response>

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

https://intl.cloud.tencent.com/document/product/1045/49353
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Request

DELETE /mediabucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

</Response>
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Media Bucket APIs
Querying Media Processing Activation Status
Last updated：2024-02-18 17:02:09

Feature Description

This API is used to query buckets with media processing enabled.

Request

Sample request
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GET /mediabucket HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Request parameters

Parameter Description Type Required

regions
Region information, such as  ap-shanghai  and  ap-beijing . 
To specify multiple regions, separate them with commas. For more 
information, see Regions and Domain Names.

string No

bucketNames Bucket name. To specify multiple bucket names, separate them with 
commas. Exact search is supported.

string No

bucketName Bucket name prefix for prefix search. string No

pageNumber Page number. string No

pageSize Number of entries per page. string No

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/33423
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <MediaBucketList>

        <BucketId></BucketId>

        <Region></Region>

        <CreateTime></CreateTime>

    </MediaBucketList>

</Response>
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The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

RequestId Response Unique ID of the request. String

TotalCount Response Total number of media buckets. Int

PageNumber Response
Current page number, which is the same as  pageNumber  
in the request.

Int

PageSize Response
Number of entries per page, which is the same as 
 pageSize  in the request. Int

MediaBucketList Response Media bucket list. Container

 MediaBucketList  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

BucketId Response.MediaBucketList Bucket ID. String

Name Response.MediaBucketList
Bucket name, which is the same as 
 BucketId . String

Region Response.MediaBucketList Bucket region. String

CreateTime Response.MediaBucketList Creation time. String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/43611
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GET /mediabucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host: ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>
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      <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

      <TotalCount>1</TotalCount>

      <PageNumber>1</PageNumber>

      <PageSize>10</PageSize>

      <MediaBucketList>

            <BucketId></BucketId>

            <Region></Region>

            <CreateTime></CreateTime>

      </MediaBucketList>

      <MediaBucketList>

            <BucketId></BucketId>

            <Region></Region>

            <CreateTime></CreateTime>

      </MediaBucketList>

</Response>
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Activating Media Processing
Last updated：2024-02-18 17:02:09

Feature Description

This API (  CreateMediaBucket ) is used to bind a media bucket (i.e., authorizing the media processing service 

role to access the bucket).

Request

Sample request
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POST /mediabucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <MediaBucket>

        <BucketId></BucketId>

        <Region></Region>

        <CreateTime></CreateTime>

    </MediaBucket>

</Response>

The nodes are as described below:
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Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

RequestId Response Unique ID of the request String

MediaBucket Response
Media bucket details. Same as 
 Response.MediaBucketList  in DescribeMediaBuckets. Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/43671
https://intl.cloud.tencent.com/document/product/1045/43611
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POST /mediabucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 564
of 2300

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <MediaBucket>
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        <BucketId>examplebucket-1250000000</BucketId>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </MediaBucket>

</Response>
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CreateMediaBucket
Last updated：2024-02-18 17:02:09

Feature Description

This API (  CreateMediaBucket ) is used to bind a media bucket (i.e., authorizing the media processing service 

role to access the bucket).

Request

Sample request
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POST /mediabucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <MediaBucket>

        <BucketId></BucketId>

        <Region></Region>

        <CreateTime></CreateTime>

    </MediaBucket>

</Response>

The nodes are as described below:
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Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

RequestId Response Unique ID of the request String

MediaBucket Response
Media bucket details. Same as 
 Response.MediaBucketList  in 
DescribeMediaBuckets.

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/43671
https://intl.cloud.tencent.com/document/product/1045/43611
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POST /mediabucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 572
of 2300

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <MediaBucket>
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        <BucketId>examplebucket-1250000000</BucketId>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </MediaBucket>

</Response>
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Queue APIs
Searching for Media Processing Queue
Last updated：2024-02-18 17:02:09

Feature Description

This API is used to search for a media processing queue.

Request

Sample request
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GET /queue HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Request parameters

Parameter 
(Keyword)

Description Type Required

queueIds Queue ID. If you enter multiple IDs, separate them by comma. String No

state

1. Active: Jobs in the queue will be scheduled and executed by the 
media processing service. 
2. Paused: The queue is paused, and jobs in it will no longer be 
scheduled and executed. All jobs in the queue will remain in the 
Paused status, while jobs being executed will not be affected.

String No

category

1. CateAll: All types. 
2. Transcoding: Media processing queue. 
3. SpeedTranscoding: Media processing and accelerated transcoding 
queue. 
4.  Default value:  Transcoding .

String No

pageNumber Page number. Default value:  1 . String No

pageSize Number of entries per page. Default value:  10 . String No

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers. 

Response body

The response body returns application/xml data. The following contains all the nodes when  pageNumber  and 

 pageSize  are specified:

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>queue-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>
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            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>Transcoding</Category>

    </QueueList>

    <QueueList>

        <QueueId>pbf17a810dce74c18a641b663aede6803</QueueId>

        <Name>queue-speed-transcoding-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>SpeedTranscoding</Category>

    </QueueList>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

RequestId Response Unique ID of the request. String

TotalCount Response Total number of queues Int

PageNumber Response
Current page number, which is the same as 
 pageNumber  in the request. Int
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PageSize Response Number of entries per page, which is the same as 
 pageSize  in the request.

Int

QueueList Response Queue array Container 
array

NonExistPIDs Response List of IDs of non-existent queues String array

 QueueList  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

QueueId Response.QueueList Queue ID String

Name Response.QueueList Queue name String

State Response.QueueList Current status:  Active  or  Paused  String

NotifyConfig Response.QueueList Callback configuration Container

MaxSize Response.QueueList Maximum length of the queue Int

MaxConcurrent Response.QueueList Maximum number of concurrent jobs in the 
current queue

Int

Category Response.QueueList Queue type String

UpdateTime Response.QueueList Update time String

CreateTime Response.QueueList Creation time String

 NotifyConfig  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Url Response.QueueList.NotifyConfig Callback address String

State Response.QueueList.NotifyConfig Switch status:  On  or  Off  String

Type Response.QueueList.NotifyConfig Callback type: Url String

Event Response.QueueList.NotifyConfig
Job completed:  TaskFinish ; 
workflow completed: 
 WorkflowFinish 

String

ResultFormat Response.QueueList.NotifyConfig Callback type:  XML  or  JSON . String
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Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request 1: Searching for the specified queue

https://intl.cloud.tencent.com/document/product/1045/33700
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GET /queue?queueIds=p4a17eeea29334bf499b7e20e2fbfd99d,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response 1

HTTP/1.1 200 OK

Content-Type: application/xml
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Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x

<Response>

    <RequestId>NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x</RequestId>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>queue-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>Transcoding</Category>

    </QueueList>

    <NonExistPIDs>A</NonExistPIDs>

    <NonExistPIDs>B</NonExistPIDs>

</Response>

Request 2: Querying the list of queues
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GET /queue?pageSize=10&pageNumber=1&category=CateAll HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response 2
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x

<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>2</TotalCount>
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    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>queue-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>Transcoding</Category>

    </QueueList>

    <QueueList>

        <QueueId>pbf17a810dce74c18a641b663aede6803</QueueId>

        <Name>queue-speed-transcoding-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>SpeedTranscoding</Category>

    </QueueList>

</Response>
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Updating Media Processing Queue
Last updated：2024-02-18 17:02:09

Feature Description

This API is used to update a media processing queue.

Request

Sample request
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PUT /queue/<queueId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Name>My-Queue-Media</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

The nodes are as described below:

Node Name 
(Keyword)

Parent 
Node

Description Type Required Default 
Value

Constraints

Request None Response 
container

Container Yes None None

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required Default 
Value

Constraints

Name Request Queue name, which can 
contain up to 128 bytes.

String Yes None None

State Request

1. Active: Jobs in the 
queue will be scheduled 
and executed by the 
media processing 
service. 
2. Paused: The queue is 
paused, and jobs in it will 
no longer be scheduled 
and executed. All jobs in 
the queue will remain in 
the Paused status, while 
jobs being executed will 
not be affected.

String Yes None None

NotifyConfig Request Callback configuration Container Yes None None

 NotifyConfig  has the following sub-nodes:
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Node Name 
(Keyword)

Parent Node Description Type Required Default 
Value

Constraints

State Request.NotifyConfig

Callback 
status: 
 Off  or 
 On .

String No Off On/Off

Event Request.NotifyConfig Callback 
event

String
Yes if 
 State  
is  On 

None

Job completion: 
 TaskFinish ; 
workflow completio
 WorkflowFinis

ResultFormat Request.NotifyConfig Callback 
format

String No XML JSON/XML

Type Request.NotifyConfig
Callback 
type String

Yes if 
 State  
is  On 

None  Url  or  TDMQ 

Url Request.NotifyConfig Callback 
address

String

Yes if 
 State  
is  On  
and 
 Type  
is  Url 

None
The callback addre
cannot be a private
network address.

MqMode Request.NotifyConfig
TDMQ 
queue 
mode

String

Yes if 
 State  
is  On  
and 
 Type  
is 
 TDMQ 

Queue
Topic: Topic 
subscription
Queue: Queue serv

MqRegion Request.NotifyConfig
TDMQ 
region String

Yes if 
 State  
is  On  
and 
 Type  
is 
 TDMQ 

None

Valid values:  sh  
(Shanghai),  bj  
(Beijing),  gz  
(Guangzhou),  cd 
(Chengdu),  hk  
(Hong Kong, China

MqName Request.NotifyConfig TDMQ 
topic name

String Yes if 
 State  
is  On  

None None
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and 
 Type  
is 
 TDMQ 

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers. 

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-Media</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>
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            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RequestId Response Unique ID of the request String

Queue Response Queue information Container

 Queue  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

QueueId Response.Queue Queue ID String

Name Response.Queue Queue name String

State Response.Queue Current status:  Active  or  Paused . String

NotifyConfig Response.Queue
Callback configuration, which is the same as 
 Request.NotifyConfig . Container

MaxSize Response.Queue Maximum length of the queue Int

MaxConcurrent Response.Queue Maximum number of concurrent jobs in the current 
queue

Int

Category Response.Queue Queue type String

UpdateTime Response.Queue Update time String

CreateTime Response.Queue Creation time String

Error codes
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There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

PUT /queue/p4a17eeea29334bf499b7e20e2fbfd99d HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

https://intl.cloud.tencent.com/document/product/1045/33700
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Content-Length: 162

Content-Type: application/xml

<Request>

    <Name>My-Queue-Media</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>
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        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-Media</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>
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Sync Media Processing Service
Getting Media Screenshot
Getting Media File Screenshot
Last updated：2024-02-18 17:02:09

Feature Description

This API (  GetSnapshot ) is used to get a screenshot of a media file at some time point.

Instructions

This API is in sync mode. For the async mode, see Submitting Screenshot Job.

Sample Request

1. Via GET request

https://intl.cloud.tencent.com/document/product/1045/48938
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GET /<ObjectKey>?ci-process=snapshot&time=1&format=jpg HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

2. Via adding parameters to URL



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 600
of 2300

https://<BucketName-APPID>.cos.<Region>.myqcloud.com/for-test.mp4?ci-process=snapsh

Note: 

Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.
<ObjectKey> is the bucket object.

Request headers

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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This API only uses common request headers. For more information, see Common Request Headers.

Request parameters

The parameters are described as follows:

Parameter Description Type Required

ci-process Operation type, which is fixed at  snapshot . String Yes

time Screenshot time point in seconds. float Yes

width Screenshot width. Default value:  0 . Int No

height

Screenshot height. Default value:  0 .If  width  and  height  are 
both  0 , the width and height of the video are used. If one of them is 
 0 , the other value is used to automatically adapt to the aspect ratio 
of the video.

Int No

format
Screenshot format. Valid values:  jpg ,  png . Default value: 
 jpg .

String No

rotate

Image rotation method
auto: Rotate automatically according to the video rotation information.
off: Do not rotate.
Default value:  auto .

String No

mode

Frame capturing method
keyframe: Capture the last keyframe before the specified time point.
exactframe: Capture the frame at a specified time point.
Default value:  exactframe .

String No

Request body

This request does not have a request body.

Response

Response headers

This response contains common response headers. For more information, see Common Response Headers.

Response body

The response body is the screenshot file content.

Error codes

https://intl.cloud.tencent.com/document/product/436/7728
https://intl.cloud.tencent.com/document/product/436/7729
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There are no special error messages for this request operation. For common error messages, see Error Codes.

Samples

Request 1. GET request

GET /for-test.mp4?ci-process=snapshot&time=1.5 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Mar 2016 09:45:46 GMT

https://intl.cloud.tencent.com/document/product/436/46214
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Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUjfG****-si

Content-Length: 0

Request 2. Adding parameters to URL

https://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/for-test.mp4?ci-proces

Response
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HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 266005

Connection: keep-alive

Date: Fri, 10 Mar 2016 09:45:46 GMT

Server: tencent-ci

x-cos-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZmNw==

<Image content>
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Getting Media File Screenshot (CI Domain
Name)
Last updated：2024-02-18 17:02:09

Feature Description

This API (  GenerateSnapshot ) is used to get a screenshot of a media file at some time point. All output 

screenshots are in JPEG format.

Request

Sample request
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POST /snapshot HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

Nodes of the request body for this API are as follows:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

  <Input>

    <Object></Object>

  </Input>

  <Time></Time>

  <Width></Width>

  <Height></Height>

  <Mode></Mode>

  <Rotate></Rotate>

  <Format></Format>

  <Output>

    <Region></Region>

    <Bucket></Bucket>

    <Object></Object>

  </Output>

</Request>

The nodes are as described below:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Request None
 Generate Snapshot  request 
container

Container Yes

 Request  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent 
Node Description Type Required

Input Request Media file location information. Container Yes

Time Request Screenshot time point in seconds. Float Yes

Output Request Screenshot storage location information. Container Yes

Width Request Screenshot width. Default value: 0. Int No

Height Request

Screenshot height. Default value: 0.
If  Width  and  Height  are both  0 , the width and 
height of the video are used. 
If one of them is  0 , the other value is used to 
automatically adapt to the aspect ratio of the video.

Int No

Format Request Screenshot format. Valid values: jpg, png. Default value: 
jpg.

String No



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 610
of 2300

Mode Request

Frame capturing method:
keyframe: Capture the last keyframe before the specified 
time point.
exactframe: Capture the frame at a specified time point.
Default value: exactframe

String No

Rotate Request

Image rotation method:
auto: Rotate automatically according to the video rotation 
information.
off: Do not rotate.
Default value: auto

String No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Filename String Yes

 Output  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Region Request.Output Bucket region String Yes

Bucket Request.Output File bucket String Yes

Object Request.Output Filename String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

  <Output>

    <Region></Region>

    <Bucket></Bucket>

    <Object></Object>

  </Output>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type
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Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Output Request Screenshot storage location information Container

 Output  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.Output Bucket region String

Bucket Response.Output File bucket String

Object Response.Output Filename String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/43611
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POST /snapshot HTTP/1.1

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Date: Fri, 10 Mar 2016 09:45:46 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUj****&q-si

Content-Length: 552

Content-Type: application/xml

<Request>

  <Input>

    <Object>video-for-test.mp4</Object>

  </Input>
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  <Time>10</Time>

  <Output>

    <Region>ap-beijing</Region>

    <Bucket>ci-output-1250000000</Bucket>

    <Object>snapshot/video-for-test-snapshot.jpg</Object>

  </Output>

</Request>

Response

HTTP/1.1 200 OK
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Content-Type: application/xml

Content-Length: 266

Connection: keep-alive

Date: Fri, 10 Mar 2016 09:45:46 GMT

Server: tencent-ci

x-ci-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZm****

<Response>

  <Output>

    <Region>ap-beijing</Region>

    <Bucket>ci-output-1250000000</Bucket>

    <Object>snapshot/video-for-test-snapshot.jpg</Object>

  </Output>

</Response>
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GenerateSnapshot
Last updated：2024-02-18 17:02:09

Feature Description

This API (  GenerateSnapshot ) is used to get a screenshot of a media file at some time point. All output 

screenshots are in JPEG format.

Request

Sample request
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POST /snapshot HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

Nodes of the request body for this API are as follows:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

  <Input>

    <Object></Object>

  </Input>

  <Time></Time>

  <Width></Width>

  <Height></Height>

  <Mode></Mode>

  <Rotate></Rotate>

  <Format></Format>

  <Output>

    <Region></Region>

    <Bucket></Bucket>

    <Object></Object>

  </Output>

</Request>

The nodes are as described below:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Request None
 Generate Snapshot  request 
container

Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Input Request Media file location information. Container Yes

Time Request Screenshot time point in seconds. Float Yes

Output Request Screenshot storage location information. Container Yes

Width Request Screenshot width. Default value: 0. Int No

Height Request

Screenshot height. Default value: 0.
If Width and Height are both 0, the width and height 
of the video are used.
If one of them is 0, the other value is used to 
automatically adapt to the aspect ratio of the video.

Int No

Format Request Screenshot format. Valid values: jpg, png. Default 
value: jpg.

String No
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Mode Request Frame capturing method:
keyframe: Capture the last keyframe before the 
specified time point.
exactframe: Capture the frame at a specified time 
point.
Default value: exactframe.

String No

Rotate Request

Image rotation method.
auto: Rotate automatically according to the video 
rotation information.
off: Do not rotate.
Default value: auto.

String No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Filename String Yes

 Output  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Region Request.Output Bucket region String Yes

Bucket Request.Output File bucket String Yes

Object Request.Output Filename String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

  <Output>

    <Region></Region>

    <Bucket></Bucket>

    <Object></Object>

  </Output>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type
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Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Output Request Screenshot storage location information Container

 Output  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.Output Bucket region String

Bucket Response.Output File bucket String

Object Response.Output Filename String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/43611
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POST /snapshot HTTP/1.1

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Date: Fri, 10 Mar 2016 09:45:46 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUj****&q-si

Content-Length: 552

Content-Type: application/xml

<Request>

  <Input>

    <Object>video-for-test.mp4</Object>

  </Input>
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  <Time>10</Time>

  <Output>

    <Region>ap-beijing</Region>

    <Bucket>ci-output-1250000000</Bucket>

    <Object>snapshot/video-for-test-snapshot.jpg</Object>

  </Output>

</Request>

Response

HTTP/1.1 200 OK
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Content-Type: application/xml

Content-Length: 266

Connection: keep-alive

Date: Fri, 10 Mar 2016 09:45:46 GMT

Server: tencent-ci

x-ci-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZm****

<Response>

  <Output>

    <Region>ap-beijing</Region>

    <Bucket>ci-output-1250000000</Bucket>

    <Object>snapshot/video-for-test-snapshot.jpg</Object>

  </Output>

</Response>
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Getting Media Information
Getting Media File Information
Last updated：2024-02-18 17:02:09

Feature Description

This API is used to get media file information.

Request

Sample request
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GET /<ObjectKey>?ci-process=videoinfo HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity .

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request parameters

The parameters are as described below:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

ci-process None
Operation type, which is fixed at 
 videoinfo . String Yes

Request body

This request does not have a request body.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/436/7728
https://intl.cloud.tencent.com/document/product/436/7729
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<Response>

      <MediaInfo>

         <Stream>

            <Video>

                <Index></Index>

                <CodecName></CodecName>

                <CodecLongName></CodecLongName>

                <CodecTimeBase></CodecTimeBase>

                <CodecTagString></CodecTagString>

                <CodecTag></CodecTag>

                <ColorPrimaries></ColorPrimaries>
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                <ColorRange></ColorRange>

                <ColorTransfer></ColorTransfer>

                <Profile></Profile>

                <Width></Width>

                <Height></Height>

                <HasBFrame></HasBFrame>

                <RefFrames></RefFrames>

                <Sar></Sar>

                <Dar></Dar>

                <PixFormat></PixFormat>

                <FieldOrder></FieldOrder>

                <Level></Level>

                <Fps></Fps>

                <AvgFps></AvgFps>

                <Timebase></Timebase>

                <StartTime></StartTime>

                <Duration></Duration>

                <Bitrate></Bitrate>

                <NumFrames></NumFrames>

                <Language></Language>

            </Video>

            <Audio>

                <Index></Index>

                <CodecName></CodecName>

                <CodecLongName></CodecLongName>

                <CodecTimeBase></CodecTimeBase>

                <CodecTagString></CodecTagString>

                <CodecTag></CodecTag>

                <SampleFmt></SampleFmt>

                <SampleRate></SampleRate>

                <Channel></Channel>

                <ChannelLayout></ChannelLayout>

                <Timebase></Timebase>

                <StartTime></StartTime>

                <Duration></Duration>

                <Bitrate></Bitrate>

                <Language></Language>

            </Audio>

            <Subtitle>

                <Index></Index>

                <Language></Language>

            </Subtitle>

         </Stream>

         <Format>

            <NumStream></NumStream>

            <NumProgram></NumProgram>

            <FormatName></FormatName>
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            <FormatLongName></FormatLongName>

            <StartTime></StartTime>

            <Duration></Duration>

            <Bitrate></Bitrate>

            <Size></Size>

         </Format>

      </MediaInfo>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

MediaInfo Response Media details. Container

 MediaInfo  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Stream Response.MediaInfo Stream information. Container

Format Response.MediaInfo Format information. Container

 Stream  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Video Response.MediaInfo.Stream Video information. Container

Audio Response.MediaInfo.Stream Audio information. Container

Subtitle Response.MediaInfo.Stream Subtitle information. Container

 Format  has the following sub-nodes (certain nodes may not be returned during video information query):

Node Name 
(Keyword)

Parent Node Description Type

NumStream Response.MediaInfo.Format Number of streams (including videos, audios, 
and subtitles).

Int
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NumProgram Response.MediaInfo.Format Response.MediaInfo.Format Int

FormatName Response.MediaInfo.Format Container format name. String

FormatLongName Response.MediaInfo.Format Detailed name of the container format. String

StartTime Response.MediaInfo.Format Start time in seconds. Float

Duration Response.MediaInfo.Format Duration in seconds. Float

Bitrate Response.MediaInfo.Format Bitrate in kbps. Int

Size Response.MediaInfo.Format Size in bytes. Int

 Video  has the following sub-nodes (certain nodes may not be returned during video information query):

Node Name 
(Keyword)

Parent Node Description Type

Index Response.MediaInfo.Stream.Video Stream number. Int

CodecName Response.MediaInfo.Stream.Video Codec format name. String

CodecLongName Response.MediaInfo.Stream.Video Detailed name of the codec format. String

CodecTimeBase Response.MediaInfo.Stream.Video Codec timebase. String

CodecTagString Response.MediaInfo.Stream.Video Codec tag name. String

CodecTag Response.MediaInfo.Stream.Video Codec tag. String

ColorPrimaries Response.MediaInfo.Stream.Video Color primaries. String

ColorRange Response.MediaInfo.Stream.Video Color range. String

ColorTransfer Response.MediaInfo.Stream.Video Color channel. String

Profile Response.MediaInfo.Stream.Video Video codec profile. String

Height Response.MediaInfo.Stream.Video Video height in px. Int

Width Response.MediaInfo.Stream.Video Video width in px. Int

HasBFrame Response.MediaInfo.Stream.Video Whether B-frames exist. 1: Yes; 0: No. Int

RefFrames Response.MediaInfo.Stream.Video Number of reference frames for video 
codec.

Int

Sar Response.MediaInfo.Stream.Video Sample aspect ratio. String
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Dar Response.MediaInfo.Stream.Video Display aspect ratio. String

PixFormat Response.MediaInfo.Stream.Video Pixel format. String

FieldOrder Response.MediaInfo.Stream.Video Field order. String

Level Response.MediaInfo.Stream.Video Video codec level. Int

Fps Response.MediaInfo.Stream.Video Video frame rate. Float

AvgFps Response.MediaInfo.Stream.Video Average frame rate. String

Timebase Response.MediaInfo.Stream.Video Timebase. String

StartTime Response.MediaInfo.Stream.Video Video start time in seconds. Float

Duration Response.MediaInfo.Stream.Video Video duration in seconds. Float

Bitrate Response.MediaInfo.Stream.Video Bitrate in kbps. Float

NumFrames Response.MediaInfo.Stream.Video Total number of frames. Int

Language Response.MediaInfo.Stream.Video Language. String

 Audio  has the following sub-nodes (certain nodes may not be returned during video information query):

Node Name 
(Keyword)

Parent Node Description Type

Index Response.MediaInfo.Stream.Audio Stream number. Int

CodecName Response.MediaInfo.Stream.Audio Codec format name. String

CodecLongName Response.MediaInfo.Stream.Audio Detailed name of the codec 
format.

String

CodecTimeBase Response.MediaInfo.Stream.Audio Codec timebase. String

CodecTagString Response.MediaInfo.Stream.Audio Codec tag name. String

CodecTag Response.MediaInfo.Stream.Audio Codec tag. String

SampleFmt Response.MediaInfo.Stream.Audio Sample format. String

SampleRate Response.MediaInfo.Stream.Audio Sample rate. Int

Channel Response.MediaInfo.Stream.Audio Number of channels. Int
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ChannelLayout Response.MediaInfo.Stream.Audio Channel layout. String

Timebase Response.MediaInfo.Stream.Audio Timebase. String

StartTime Response.MediaInfo.Stream.Audio Audio start time in seconds. Float

Duration Response.MediaInfo.Stream.Audio Audio duration in seconds. Float

Bitrate Response.MediaInfo.Stream.Audio Bitrate in kbps. Float

Language Response.MediaInfo.Stream.Audio Language. String

 Subtitle  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Index Response.MediaInfo.Stream.Subtitle Stream number. Int

Language Response.MediaInfo.Stream.Subtitle
Language.  und  indicates no 
query result.

String

Error codes

There are no special error messages for this request operation. For common error messages, see Error Codes.

Samples

Request
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GET /for-test.mp4?ci-process=videoinfo HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Mar 2016 09:45:46 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUjfG****-si

Content-Length: 0

Response



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 636
of 2300

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Fri, 10 Mar 2016 09:45:46 GMT

Server: tencent-ci

x-cos-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZmNw==

<Response>
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        <MediaInfo>

                <Format>

                        <Bitrate>1014.950000</Bitrate>

                        <Duration>10.125000</Duration>

                        <FormatLongName>QuickTime / MOV</FormatLongName>

                        <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                        <NumProgram>0</NumProgram>

                        <NumStream>2</NumStream>

                        <Size>1284547</Size>

                        <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                        <Audio>

                                <Bitrate>70.451000</Bitrate>

                                <Channel>1</Channel>

                                <ChannelLayout>mono</ChannelLayout>

                                <CodecLongName>AAC (Advanced Audio Coding)</CodecLo

                                <CodecName>aac</CodecName>

                                <CodecTag>0x6134706d</CodecTag>

                                <CodecTagString>mp4a</CodecTagString>

                                <CodecTimeBase>1/44100</CodecTimeBase>

                                <Duration>0.440294</Duration>

                                <Index>1</Index>

                                <Language>und</Language>

                                <SampleFmt>fltp</SampleFmt>

                                <SampleRate>44100</SampleRate>

                                <StartTime>0.000000</StartTime>

                                <Timebase>1/44100</Timebase>

                        </Audio>

                        <Subtitle/>

                        <Video>

                                <AvgFps>24/1</AvgFps>

                                <Bitrate>938.164000</Bitrate>

                                <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 pa

                                <CodecName>h264</CodecName>

                                <CodecTag>0x31637661</CodecTag>

                                <CodecTagString>avc1</CodecTagString>

                                <CodecTimeBase>1/12288</CodecTimeBase>

                                <ColorPrimaries>unknown</ColorPrimaries>

                                <ColorRange>unknown</ColorRange>

                                <ColorTransfer>unknown</ColorTransfer>

                                <Dar>40:53</Dar>

                                <Duration>0.124416</Duration>

                                <Fps>24.500000</Fps>

                                <HasBFrame>2</HasBFrame>

                                <Height>1280</Height>

                                <Index>0</Index>
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                                <Language>und</Language>

                                <Level>32</Level>

                                <NumFrames>243</NumFrames>

                                <PixFormat>yuv420p</PixFormat>

                                <Profile>High</Profile>

                                <RefFrames>1</RefFrames>

                                <Sar>25600:25599</Sar>

                                <StartTime>0.000000</StartTime>

                                <Timebase>1/12288</Timebase>

                                <Width>966</Width>

                        </Video>

                </Stream>

        </MediaInfo>

</Response>
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Private M3U8
GetPrivateM3U8
Last updated：2024-02-18 17:02:09

Feature Description

This API (  GetPrivateM3U8 ) is used to get the download authorization for M3U8 and TS resources (requests are 

forwarded to CI by COS).

Request

Sample request
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GET /<ObjectKey>?ci-process=pm3u8&expires= HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.
<ObjectKey> is the bucket object.

Request parameters

The parameters are as described below:

Parameter Description Type Required

ci-process Operation type, which is fixed at  pm3u8 . String Yes

expires Relative validity period of the download credential for the private TS 
resource URL in seconds. Value range: [3600, 43200].

String Yes

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request does not have a request body.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body is the screenshot file content.

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
https://intl.cloud.tencent.com/document/product/1045/49352
https://intl.cloud.tencent.com/document/product/1045/49353
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GET /for-test.pm3u8?ci-process=pm3u8&expires=3600 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Mar 2016 09:45:46 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUjfG****-si

Content-Length: 0

Response
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HTTP/1.1 200 OK

Content-Type: application/x-mpegURL

Content-Length: 266005

Connection: keep-alive

Date: Fri, 10 Mar 2016 09:45:46 GMT

Server: tencent-ci

x-cos-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZm****

<M3U8 file content>
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Content Moderation
Audio Moderation
Submitting Audio Moderation Task
Last updated：2024-02-19 14:59:07

Feature Overview

This interface is used to submit an audio moderation task. The audio moderation functions asynchronously. You can 
submit an audio moderation task to moderate your audio files. Subsequently, the moderation results can be retrieved 
through the querying audio moderation job result or audio moderation callback content.

This interface supports the following operations:
Note:
Moderation of audio files stored in Tencent Cloud's COS is supported.
Moderation of audio URLs hosted by the third-party cloud storage providers is supported.
Automatic detection of audio files from two dimensions of ASR and erotic moaning is supported. It uses the deep 

learning technology to identify violations in the audio.
Setting a callback address to receive the detection results or actively polling the querying audio moderation job result 
to obtain the detailed moderation results is supported.
Recognition of a variety of violations such as instances of pornography and advertising is supported.
Setting custom policy based on different business scenarios is supported.

Authorization Guidelines

The action is set to  ci:CreateAuditingAudioJob  for the authorization policy. See all actions for more details.

Activation of Services

It is required to activate CI and bind a bucket before the use of this function. For more details, please refer to binding a 
bucket.

Use Limits

https://intl.cloud.tencent.com/document/product/1045/48267
https://intl.cloud.tencent.com/document/product/1045/48268
https://intl.cloud.tencent.com/document/product/1045/48267
https://intl.cloud.tencent.com/document/product/1045/52107
https://intl.cloud.tencent.com/document/product/598/57084
https://intl.cloud.tencent.com/document/product/1045/33436
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Before using API, please confirm all the relevant limitations. For more details, see Use Limits.
Audio file size: File size < 600MB.
Audio file duration: Less than 3 hours.

Audio bitrate type: 128–256 Kbps.
Audio file formats: MP3, WAV, AAC, FLAC, AMR, 3GP, M4A, WMA, OGG, APE.
Default concurrent API calls: 10.
Languages for audio content: Mandarin, English, and Cantonese.
When a video file is entered, the separation of the audio track of a video file for independent moderation of the audio 

content is supported.

Note on Fees

Each moderation scenario is billed separately. For instance, if you choose to moderate both pornographic and 
advertising content, moderating one audio file will incur two moderation charges.
Invocation of API will lead to audio moderation fees and COS read request fees.
If the audio is a low-frequency storage type in COS, invoking the moderation will generate COS low-frequency data 
retrieval fees.

Audio files of the CAS or Deep CAS storage class in COS are not supported for moderation. To moderate these types 
of files, you need to first restore them as detailed in POST Object restore.

SDK Recommendation

The CI SDK has capabilities such as a complete demo, automated integration, and signature calculation. The SDK 
allows for a more convenient and swift way to invoke API. Refer to SDK documentation for more information.

Request

Sample Request

https://intl.cloud.tencent.com/document/product/1045/33425
https://intl.cloud.tencent.com/document/product/1045/49488
https://intl.cloud.tencent.com/document/product/436/40100
https://intl.cloud.tencent.com/document/product/436/40097
https://intl.cloud.tencent.com/document/product/436/12633
https://intl.cloud.tencent.com/document/product/1045/45578


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 646
of 2300

POST /audio/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note:
Authorization: Auth String (please refer to request signature for detailed information).

https://intl.cloud.tencent.com/document/product/436/7778
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When utilizing the feature via a sub-account, it is required to assign the relevant permission. For more details, please 
refer to the authorization granularity details document.

Request Headers

This API only utilizes the common request headers. For more information, please refer to common request headers.

Request Body

The implementation of this request action requires the following request body:

<Request>

https://intl.cloud.tencent.com/document/product/1045/58195
https://intl.cloud.tencent.com/document/product/1045/43609
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    <Input>

        <Object></Object>

        <Url></Url>

        <DataId></DataId>

    </Input>

    <Conf>

        <Callback></Callback>

        <BizType></BizType>

    </Conf>

</Request>

The specific data is described as follows:

Node Name (Keyword) Parent 
Node

Description Type Required or 
Not

Request No The specific configuration item 
for AAS.

Container Yes

The specific data for the Container type Request is described as follows:

Node Name (Keyword) Parent 
Node

Description Type Required or Not

Input Request Content with need of 
moderation.

Container Yes

Conf Request Moderation of rule 
configuration.

Container Yes

The specific data for the Container type Input is described as follows:

Node 
Name 
(Keyword)

Parent Node Description Type
Required 
or Not

Object Request.Input

Name of the audio file stored in the COS bucket. 
For instance, the file audio.mp3 in the test directory 
is named test/audio.mp3. Either Object or Url can 
be selected. 

String No

Url Request.Input

URL of the audio file, such as 
'http://examplebucket-1250000000.cos.ap-
shanghai.myqcloud.com/audio.mp3'. Either Object 
or Url can be selected.

String No

DataId Request.Input This field in the moderation result will return the String No
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original content, with a length limit of 512 bytes. 
You can use this field to uniquely identify the data 
that needs moderation. 

UserInfo Request.Input User Business field. Container No

Content of UserInfo in the Container Node:

Node Name 
(Keyword)

Parent Node Description Type Required or 
Not

TokenId Request.Input.UserInfo
User Business TokenId, 
which can contain up to 128 
bytes.

String No

Nickname Request.Input.UserInfo
User Business Nickname, 
which can contain up to 128 
bytes.

String No

DeviceId Request.Input.UserInfo
User Business DeviceId, 
which can contain up to 128 
bytes.

String No

AppId Request.Input.UserInfo User Business AppId, which 
can contain up to 128 bytes.

String No

Room Request.Input.UserInfo User Business Room, which 
can contain up to 128 bytes.

String No

IP Request.Input.UserInfo User Business IP, which can 
contain up to 128 bytes.

String No

Type Request.Input.UserInfo User Business Type, which 
can contain up to 128 bytes.

String No

ReceiveTokenId Request.Input.UserInfo
User Business 
ReceiveTokenId, which can 
contain up to 128 bytes.

String No

Gender Request.Input.UserInfo User Business Gender, which 
can contain up to 128 bytes.

String No

Level Request.Input.UserInfo User Business Level, which 
can contain up to 128 bytes.

String No

Role Request.Input.UserInfo User Business Role, which 
can contain up to 128 bytes.

String No
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The specific data for the Container type Conf is described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required 
or Not

BizType Request.Conf

The only identifier for a moderation policy. 
You can configure your desired moderation 
scenarios on the moderation policy page on 
the console, such as pornography and 
advertising. Configuration guide: setting 
moderation policy. You can obtain BizType 
on the console. When BizType is entered, 
this moderation request will be moderated 
according to the scenarios configured in that 
moderation policy. When BizType is not 
entered, the default moderation policy will be 
automatically applied.

String No

Callback Request.Conf

The moderation result will be sent to your 
callback address in the form of callback, 
supporting the address beginning with 
 http://  or  https:// , such as: 
 http://www.callback.com .

String No

CallbackVersion Request.Conf

The structure of the callback content. Valid 
values: Simple (The callback content 
includes basic information) and Detail (The 
callback content includes detailed 
information). The default value is Simple.

string No

CallbackType Request.Conf

The callback segment type. Valid values: 1 
(Callback for all the audio segments) and 2 
(Callback for violation audio segments). The 
default value is 1. 

Integer No

Freeze Request.Conf

This field allows settings of various scores 
given by the moderation result to 
automatically block audio files. It is only 
effective when the audio under review in 
 input  is  object .

Container No

The specific data for the Freeze type Container is described as follows:   

Node 
Name 
(Keyword)

Parent Node Description Type
Required 
or Not

https://intl.cloud.tencent.com/document/product/1045/52107
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PornScore Request.Conf.Freeze Its value ranges from 0 to 100, which 
indicates that the freeze operation will be 
carried out automatically when the 
pornography moderation result equals or 
exceeds the given number. If the 
PornScore is not entered, the automatic 
freeze operation will not occur. The default 
value is null.

Integer No

AdsScore Request.Conf.Freeze

Its value ranges from 0 to 100, which 
indicates that the freeze operation will be 
carried out automatically when the 
advertising moderation result equals or 
exceeds the given number. If the AdsScore 
is not entered, the automatic freeze 
operation will not occur. The default value is 
null.

Integer No

For freeze parameters in other moderation scenarios, please contact service staff for consultation. 

Response

Response headers

This API only returns common response headers. For more information, see common response headers.

Response body   

The response body returns application/xml data. The content containing the complete node data is shown as 
follows:

https://console.intl.cloud.tencent.com/workorder/category
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <JobsDetail>

        <DataId></DataId>

        <JobId></JobId>

        <State></State>

        <CreationTime></CreationTime>

    </JobsDetail>

    <RequestId></RequestId>

</Response>

The specific data is as follows:
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Node Name 
(Keyword)

Parent Node Description Type

Response No The specific response content returned by 
AAS.  

Container

Content of the Container node Response:

Node Name 
(Keyword)

Parent Node Description Type

JobsDetail Response Detailed information of the AAS task. Container

RequestId Response

Whenever a request is sent, the server will 
automatically create an ID for the request, which 
can help locate problems more quickly when it 
encounters problems.

String

Contents of the Container Node JobsDetail:

Node Name 
(Keyword)

Parent Node Description Type

DataId Response.JobsDetail The only business identifier added in the request. String

JobId Response.JobsDetail ID of the AAS task. String

State Response.JobsDetail State of the AAS task, the value of which can be 
Submitted, Success, Failed, or Auditing.  

String

CreationTime Response.JobsDetail Creation time of the AAS task. String

Error Code

There are no special error messages for this request operation. For ordinary error messages, please refer to the error 

codes document.

Actual Case

Request

https://intl.cloud.tencent.com/document/product/1045/33700
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POST /audio/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Input>

        <Object>a.mp3</Object>

        <DataId>123-fdrsg-123</DataID>

    </Input>
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    <Conf>

        <DetectType>Porn,Ads</DetectType>

        <Callback>http://callback.com/</Callback>

    </Conf>

</Request>

Response

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230
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Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <DataId>123-fdrsg-123</DataID>

        <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

        <State>Submitted</State>

        <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

    </JobsDetail>

    <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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Text Moderation
Synchronized Moderation of Text Content
Last updated：2024-02-19 14:59:07

Feature Overview

This API is designed for the direct moderation of text content, operating on a synchronous request basis.
The following lists the characteristics of this API:
Note:

Plaintext needs to be Base64-encoded (UTF8 encoding only) before direct moderation is implemented.
Recognition of multiple non-compliant scenes is supported, including pornographic, illegal, and advertising scenes.
Setting Moderation Policy supports diverse business scenarios.

Authorization Guidelines

In the authorization policy, set action to  ci:CreateAuditingTextJob . View all actions.

Service Activation

Cloud Infinite (CI) needs to be enabled with buckets bound before you use this function. For details, see Bind Bucket.

Prerequisites

Before using this API, check all relevant limitations. For details, see Specifications and Limits.

Pricing

Each moderation scene is billed separately. For example, if you select moderation for both pornographic and 
advertising scenes, moderating one piece of text will result in charges for two moderation actions.
Length limit: Plaintext needs to be Base64-encoded before direct moderation is implemented. The original text length 
before encoding must not exceed 10,000 UTF8-encoded characters.

https://intl.cloud.tencent.com/document/product/1045/52107
https://intl.cloud.tencent.com/document/product/598/57084
https://intl.cloud.tencent.com/document/product/1045/33436
https://intl.cloud.tencent.com/document/product/1045/33425
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Language support in text moderation: Currently, the system supports detection in Chinese, mixed Chinese and 
English, and Arabic numerals.
Default concurrency for the API: 100.

SDK Recommendation

The CI SDK offers complete demo, automated integration, signature calculations, and other capabilities. The SDK 
allows for a more convenient and swift way to call APIs. Click here to view SDK documentation.

Request

Request Example

https://intl.cloud.tencent.com/document/product/1045/45578
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POST /text/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note:
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Authorization: Auth String (For more information, see Request Signature.)
When it is used through a sub-account, related permissions need to be assigned. For details, see Authorization 
Granularity Details.

Request Header

This API only uses common request headers. For details, see Common Request Headers.

Request Body

The implementation of this request action requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/58195
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

  <Input>

    <Content></Content>

    <DataId></DataId>

  </Input>

  <Conf>

    <Callback></Callback>

    <CallbackVersion></CallbackVersion>

    <CallbackType></CallbackType>

    <BizType></BizType>

    <Freeze>

      <PornScore></PornScore>

    </Freeze>

  </Conf>

</Request>

The following details the data description:

Node Name 
(Keyword)

Parent 
Node

Description Type Required or Not

Request No The specific configuration item for 
text moderation.

Container Yes

The data description for Request of the Container type is as follows:

Node Name 
(Keyword)

Parent Node Description Type Required or Not

Input Request Content requiring 
moderation.

Container Yes

Conf Request Configuration of moderation 
rules.

Container Yes

The data description for Input of the Container type is as follows:

Node Name 
(Keyword)

Parent Node Description Type Required 
or Not

Content Request.Input When the input is plaintext, it should first be 
Base64-encoded. The text length before 
encoding cannot exceed 10,000 UTF-8 
encoded characters. If this length limit is 
exceeded, the API will return an error.Note: 
Currently, detection and moderation are 

String No
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supported in Chinese, mixed Chinese and 
English, and Arabic numerals. If you need to 
implement moderation in other languages, 
please contact us.

DataId Request.Input

This field in the moderation result will return 
the original content, with a length limit of 512 
bytes. You can use this field to uniquely 
identify the data to be moderated.

String No

UserInfo Request.Input User business field. Container No

UserInfo content of the Container node:

Node Name 
(Keyword)

Description Type Required 
or Not

TokenId It usually indicates account information, limited to 128 bytes in 
length.

String No

Nickname It usually indicates nickname information, limited to 128 bytes in 
length.

String No

DeviceId It usually indicates device information, limited to 128 bytes in 
length.

String No

AppId It usually indicates a unique identifier for the App, limited to 128 
bytes in length.

String No

Room It usually indicates room number information, limited to 128 bytes 
in length.

String No

IP It usually indicates IP address information, limited to 128 bytes in 
length.

String No

Type It usually indicates the business type, limited to 128 bytes in 
length.

String No

ReceiveTokenId It usually indicates the user account for receiving messages, 
limited to 128 bytes in length.

String No

Gender It usually indicates gender data, limited to 128 bytes in length. String No

Level It usually indicates level information, limited to 128 bytes in 
length.

String No

Role It usually indicates role details, limited to 128 bytes in length. String No

https://console.intl.cloud.tencent.com/workorder/category
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The data description for Conf in the Container type is as follows:

Node Name 
(Keyword)

Parent Node Description Type Required 
or Not

BizType Request.Conf

It indicates a unique identifier for the 
moderation policy. You can set the scenes 
you want to moderate, such as pornography, 
advertising, or illegal content, through the 
moderation policy page on the console. 
Follow these guidelines to configure: Setting 
Moderation Policy. BizType can be obtained 
from the console. When you specify BizType, 
this moderation request will enable 
moderation according to the scenes 
configured in the policy. If BizType is left 
blank, the default moderation policy will be 
applied automatically.

String No

Callback Request.Conf

The moderation results can be sent to your 
callback address in a callback form. It 
supports addresses starting with  http:// 
 or  https:// , such as: 
 http://www.callback.com . When 
Input is set to Content, this parameter is not 
effective, and results will be returned directly.

String No

CallbackVersion Request.Conf

The structure of the callback content. Valid 
values: Simple (the callback content includes 
basic information), Detail (the callback 
content includes detailed information). The 
default value is Simple.

String No

CallbackType Request.Conf

The type of callback segment. Valid values: 1 
(all text segments are recalled), 2 (non-
compliant text segments are recalled). The 
default value is 1.

Integer No

Freeze Request.Conf

This field allows you to automatically block 
text files based on the different scores given 
according to the moderation results. It is 
effective only when the text moderated in 
input is object.

Container No

The data description for Freeze of the Container type is as follows:

https://intl.cloud.tencent.com/document/product/1045/52107
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Node Name 
(Keyword)

Parent Node Description Type Required 
or Not

PornScore Request.Conf.Freeze

The value range is [0,100]. A block 
operation will be carried out 
automatically when the 
pornographic content moderation 
score equals or exceeds the given 
score. If it is left blank, an automatic 
block operation will not occur. The 
default value is null.

Integer No

AdsScore Request.Conf.Freeze

The value range is [0,100]. A block 
operation will be carried out 
automatically when the advertising 
moderation score equals or exceeds 
the specified score. If it is left blank, 
an automatic block operation will not 
occur. The default value is null.

Integer No

IllegalScore Request.Conf.Freeze

The value range is [0,100]. A block 
operation will be carried out 
automatically if the illegal content 
moderation result equals or exceeds 
this score. If it is left blank, an 
automatic block operation will not 
occur. The default value is null.

Integer No

AbuseScore Request.Conf.Freeze

The value range is [0,100]. A block 
operation will be carried out 
automatically if the verbal abuse 
moderation result equals or exceeds 
this score. If it is left blank, an 
automatic block operation will not 
occur. The default value is null.

Integer No

For block parameters in other moderation scenarios, please contact our service team.

Response

Response Header

This API only returns common response headers. For more information, see Common Response Headers.

https://console.intl.cloud.tencent.com/workorder/category
https://intl.cloud.tencent.com/document/product/1045/43610
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Response Body

The response body returns application/xml data. The following displays complete node data:

<Response>

  <JobsDetail>

    <DataId></DataId>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

    <Code>Success</Code>

    <Message>Success</Message>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 666
of 2300

    <SectionCount></SectionCount>

    <Result>1</Result>

    <ContextText></ContextText>

    <PornInfo>

      <HitFlag></HitFlag>

      <Count></Count>

    </PornInfo>

    <Section>

      <StartByte></StartByte>

      <PornInfo>

        <HitFlag></HitFlag>

        <Score></Score>

        <Keywords></Keywords>

      </PornInfo>

    </Section>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

The specific data content is as follows:

Node Name (Keyword) Parent 
Node

Description Type

Response No The specific response content returned by text 
moderation.

Container

`Response` content of the Container node:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Detailed information of text moderation. Container

RequestId Response
When a request is send, the server automatically 
creates an ID specific to the request, assisting in 
locating encountered problems.

String

JobsDetail contents of the Container type:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail Error code. It is returned only if State is Failed. For 
more information, see Error Codes.

String

DataId Response.JobsDetail Unique business identifier added in the request. String

https://intl.cloud.tencent.com/document/product/1045/33700
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Message Response.JobsDetail Error description. It is returned only when State is 
Failed.

String

JobId Response.JobsDetail Task ID of this text moderation operation. String

CreationTime Response.JobsDetail Creation time of the text moderation. String

State Response.JobsDetail
Status of the text moderation. Valid values include 
Success (moderation succeeded) and Failed 
(moderation failed).

String

Content Response.JobsDetail The submitted text moderation content, which is 
returned in Base64 encoding.

String

ContextText Response.JobsDetail

When the text context correlation moderation 
capability is activated, this field, along with the 
current text under moderation and its associated 
text, will be returned in their original forms.Note: 
When you use the context correlation capabilities, 
it is necessary to incorporate the UserInfo field 
during the initiation of a text moderation operation. 
It indicates that the correlated context is specific 
to a particular user ID, and the text content 
uploaded by different user IDs will not be 
correlated.To enable context correlation 
capabilities, please contact our service team for 
activation.

String

Label Response.JobsDetail

This field returns the moderation results which 
correspond to the malicious tag with the 
highest priority and are recommended by the 
model. It is recommended that you handle 
different types of violations and suggested values 
based on the business requirements. Returned 
values include: Normal: normal, Porn: 
pornography, Ads:  advertising, along with other 
types of unsafe or inappropriate content.

String

Result Response.JobsDetail

This field indicates the moderation result of the 
current assessment. You can perform subsequent 
operations based on the results. Valid values: 0 
(normal), 1 (sensitive and non-compliant files), 
and 2 (possibly sensitive, with manual moderation 
recommended).

Integer

SectionCount Response.JobsDetail The number of content segments for text 
moderation. The value is fixed at 1.

Integer

https://console.intl.cloud.tencent.com/workorder/category
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PornInfo Response.JobsDetail The moderation result of the pornographic 
content moderation scene.

Container

AdsInfo Response.JobsDetail The moderation result of the advertising content 
moderation scene.

Container

IllegalInfo Response.JobsDetail The moderation result of the illegal content 
moderation scene.

Container

AbuseInfo Response.JobsDetail The moderation result of the abusive content 
moderation scene.

Container

Section Response.JobsDetail The specific result information of text moderation. Container 
Array

UserInfo Response.JobsDetail User business field. Container

ListInfo Response.JobsDetail Account whitelist/blacklist results. Container

PornInfo, AdsInfo, IllegalInfo, and AbuseInfo content of the Container node:

Node Name 
(Keyword)

Parent Node Description Type

HitFlag Response.JobsDetail.*Info

It is used to return moderation results of the 
corresponding scene. Returned values: 0: 
normal, 1: confirmed as violation content of 
the current scene, 2: suspected as violation 
content of the current scene.

Integer

Count Response.JobsDetail.*Info The number of segments that match the 
moderation classification.

Integer

Section Content of the Container node:

Node Name 
(Keyword)

Parent Node Description Type

StartByte Response.JobsDetail.Section
The location within the text where the 
segment begins (that is, 10 represents the 
11th UTF-8 character). It starts from 0.

Integer

Label Response.JobsDetail.Section This field returns the moderation results 
which correspond to the malicious tag 
with the highest priority and are 
recommended by the model. It is 

String
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recommended that you handle different 
types of violations and suggested values 
based on the business requirements. 
Returned values include: Normal: normal, 
Porn: pornography, Ads:  advertising, 
along with other types of unsafe or 
inappropriate content.

Result Response.JobsDetail.Section

This field indicates the moderation result 
of the current assessment. You can 
perform subsequent operations based on 
the results. Valid values: 0 (normal), 1 
(sensitive and non-compliant files), and 2 
(possibly sensitive, with manual 
moderation recommended).

Integer

PornInfo Response.JobsDetail.Section
The moderation result of the 
pornographic content moderation 
scene.

Container

AdsInfo Response.JobsDetail.Section The moderation result of the advertising 
content moderation scene.

Container

IllegalInfo Response.JobsDetail.Section The moderation result of the illegal 
content moderation scene.

Container

AbuseInfo Response.JobsDetail.Section The moderation result of the abusive 
content moderation scene.

Container

PornInfo, AdsInfo, IllegalInfo, and AbuseInfo content of the Container node:

Node Name 
(Keyword)

Parent Node Description Type

HitFlag Response.JobsDetail.Section.*Info

It is used to return moderation results 
of the corresponding scene. Returned 
values: 0: normal, 1: confirmed as 
violation content of the current scene, 
2: suspected as violation content of 
the current scene.

Integer

Score Response.JobsDetail.Section.*Info
The moderation result score within 
this segment. Higher scores indicate 
more sensitive content.

Integer

Keywords Response.JobsDetail.Section.*Info Keywords matched under the current 
moderation scene. Multiple keywords 

String
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are separated by ",".

LibResults Response.JobsDetail.Section.*Info

This field is used to return results 
identified through the risk library. Note: 
This field is not returned when no 
samples within the risk library have 
been matched.

Container 
Array

SubLabel Response.JobsDetail.Section.*Info

This field indicates the specific sub-
tags matched in the moderation. For 
example: the SexBehavior sub-tag 
under Porn. Note: This field may 
return null, indicating that no specific 
sub-tags are matched.

String

`LibResults` content of the `Container` node:

Node Name 
(Keyword)

Parent Node Description Type

LibType Response.JobsDetail.Section.*Info.LibResults

Type of the matched risk 
library. Valid values include 
1 (preset white library and 
black library) and 2 (custom 
risk library).

Integer

LibName Response.JobsDetail.Section.*Info.LibResults Name of the matched risk 
library.

String

Keywords Response.JobsDetail.Section.*Info.LibResults

Keywords matched in the 
library. This parameter may 
return multiple values, 
indicating multiple 
keywords matched.

String 
Array

UserInfo content in the Container node:

Node Name 
(Keyword)

Description Type Required or 
Not

TokenId It usually indicates account information, limited to 128 bytes in 
length.

String No

Nickname It usually indicates nickname information, limited to 128 bytes in 
length.

String No
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DeviceId It usually indicates device information, limited to 128 bytes in 
length.

String No

AppId It usually indicates a unique identifier for the App, limited to 128 
bytes in length.

String No

Room It usually indicates room number information, limited to 128 
bytes in length.

String No

IP It usually indicates IP address information, limited to 128 bytes 
in length.

String No

Type It usually indicates the business type, limited to 128 bytes in 
length.

String No

ReceiveTokenId It usually indicates the user account for receiving messages, 
limited to 128 bytes in length.

String No

Gender It usually indicates gender data, limited to 128 bytes in length. String No

Level It usually indicates level information, limited to 128 bytes in 
length.

String No

Role It usually indicates role details, limited to 128 bytes in length. String No

ListInfo content of the Container node:

Node Name (Keyword) Parent Node Description Type

ListResults Response.JobsDetail.ListInfo Result of all match lists. Container 
Array

ListResults content of the Container node:

Node Name 
(Keyword)

Parent Node Description Type

ListType Response.JobsDetail.ListInfo.ListResults
Type of match list. Valid values 
include 0 (whitelist) and 1 
(blacklist).

Integer

ListName Response.JobsDetail.ListInfo.ListResults Name of the match list. String

Entity Response.JobsDetail.ListInfo.ListResults The matched entry on the list. String

Error Code
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There is no specific error information for this request operation. For common error information, see Error Codes.

Examples

Request

POST /text/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

https://intl.cloud.tencent.com/document/product/1045/33700
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Content-Length: 166

Content-Type: application/xml

<Request>

  <Input>

    <Content>54uZ5Ye75omL</Content>

  </Input>

  <Conf>

    <BizType>b81d45f94b91a683255e9a9506f45a11</BizType>

  </Conf>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

    <Content>54uZ5Ye75omL</Content>
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    <State>Success</State>

    <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

    <SectionCount>1</SectionCount>

    <Label>Illegal</Label>

    <Result>2</Result>

    <PornInfo>

      <HitFlag>0</HitFlag>

      <Count>0</Count>

    </PornInfo>

    <Section>

      <StartByte>0</StartByte>

      <Label>Illegal</Label>

      <Result>2</Result>

      <PornInfo>

        <HitFlag>0</HitFlag>

        <Score>0</Score>

        <Keywords/>

      </PornInfo>

    </Section>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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File Preview
Querying File Preview Feature Status
Last updated：2024-02-19 16:02:58

Overview

This API (  DescribeDocProcessBuckets ) is used to query the buckets with the file preview feature enabled.

Request

Sample request
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GET /docbucket?pageNumber=1&pageSize=2 HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (See Request Signature for details.)

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses Common Request Headers.

Request body

The request body of this request is empty.

Request parameters

Name Description Type Required

regions
Region. Separate multiple regions by comma. Valid values:  All , 
 ap-shanghai ,  ap-beijing .

string No

bucketNames Bucket name. Separate multiple bucket names by comma. Exact 
search is supported.

string No

bucketName Bucket name prefix. Prefix search is supported. string No

pageNumber Page number. string No

pageSize Number of entries per page. string No

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

        <TotalCount>1</TotalCount>

        <RequestId>RequestId</RequestId>

        <PageNumber>1</PageNumber>

        <PageSize>2</PageSize>

        <DocBucketList>

                <Name>BucketName-APPID</Name>

                <CreateTime>Time</CreateTime>

                <Region>Region</Region>

                <AliasBucketId/>

                <BucketId>BucketName-APPID</BucketId>
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        </DocBucketList>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

RequestId Response Unique ID of the request String

TotalCount Response Total number of buckets with file preview enabled. Int

PageNumber Response
Current page number. Same as  pageNumber  in the 
request.

Int

PageSize Response
Number of records per page. Same as  pageSize  in 
the request.

Int

DocBucketList Response List of buckets with file preview enabled. Container

 DocBucketList  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

BucketId Response.DocBucketList Bucket ID. String

Name Response.DocBucketList
Bucket name, which is the same as 
 BucketId . String

Region Response.DocBucketList Region. String

CreateTime Response.DocBucketList Creation time. String

AliasBucketId Response.DocBucketList Bucket alias. String

Error codes

No special error message will be returned for this request. For the common error messages, please see Error Codes.

https://intl.cloud.tencent.com/document/product/1045/33700
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Examples

Request

GET /docbucket?regions=ap-chongqing HTTP/1.1

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: cos-python-sdk-v5.3.2

Host: ci.ap-chongqing.myqcloud.com
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Content-Type: application/xml

Authorization: Authorization

Response

HTTP/1.1 200 OK

Date: Mon, 27 Jul 2020 07:00:43 GMT

Content-Type: application/xml

Content-Length: 843

Connection: keep-alive

Server: tencent-ci
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x-ci-request-id: NWYxZTdiOWJfYzc2OTQzNjRfM2Qz****

<?xml version="1.0" encoding="utf-8"?>

<Response>

        <TotalCount>3</TotalCount>

        <RequestId>NWYxZTdiOWJfYzc2OTQzNjRfM2Qz****</RequestId>

        <PageNumber>1</PageNumber>

        <PageSize>10</PageSize>

        <DocBucketList>

                <Name>examplebucket-1250000000</Name>

                <CreateTime>2020-07-27T10:54:42+0800</CreateTime>

                <Region>ap-chongqing</Region>

                <AliasBucketId/>

                <BucketId>examplebucket-1250000000</BucketId>

        </DocBucketList>

        <DocBucketList>

                <Name>examplebucket-1250000000</Name>

                <CreateTime>2020-07-24T22:42:26+0800</CreateTime>

                <Region>ap-chongqing</Region>

                <AliasBucketId/>

                <BucketId>examplebucket-1250000000</BucketId>

        </DocBucketList>

</Response>
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File Transcoding
Sync Request API
Last updated：2024-02-19 16:02:58

Overview

The file preview feature allows generating images from multiple types of files for preview and performing basic 
processing operations on the output images synchronously. It addresses the display problems of file content on 
webpages and enables easy online file preview on PC, app, and other terminals. It is widely suitable for diverse 

business scenarios, such as online education, enterprise OA, and website transcoding.
Note：
To use this feature, you need to click File Processing on the management page of a bucket in the CI console, find 
the File Preview configuration item, and toggle it on. Then, you can call a specific file preview API to preview files in 
the bucket synchronously or asynchronously.

File preview is a paid feature. For billing details, see File Processing Fees.Upon the initial generation of document 
preview to image usage in each account, Cloud Infinite will issue a free quota resource package for document 
preview to image conversion, encompassing 6000 pages and valid for two months. Normal billing will commence once 
the usage exceeds the quota or the resource package expires.
The conversion logic of file transcoding is the same as that of local printing. If you need to change the conversion 
orientation (such as outputting an Excel file with many columns horizontally to one page), you need to change the 

source file print settings.

Request

Sample request

https://console.intl.cloud.tencent.com/ci
https://intl.cloud.tencent.com/document/product/1045/49490
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GET /<ObjectKey>?ci-process=doc-preview&page=<page>&srcType=<srcType>&ImageParams=<

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Note:

Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.
For private buckets, the request needs to carry the signature for file download.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API only uses Common Request Headers.

Common request parameters

Parameter Description Type Required

ObjectKey Object name, such as  folder/document.pdf . String Yes

ci-process
CI's processing capability, which is fixed at  doc-preview  for file 
preview.

String Yes

srcType
Source data type. Currently, the file conversion feature determines the 
source data type according to the file extension of the COS object. If the 
object has no extension, you can set this value.

String No

page
Number of the page to be converted, which is counted from 1 by default. 
For spreadsheets,  page  indicates to convert the xth image in the xth 
sheet.

Int No

dstType

Type of the output target file. Valid values: 
png 
jpg 
pdf (the page number cannot be selected, and the  page  parameter 
does not take effect) 
If the input file format cannot be recognized, the  jpg  format will be 
used by default.

String No

password Password to open the Office file. If you need to convert a password-
protected file, set this field.

String No

comment
Whether to hide comments and apply track changes. 0: hide comments 
and apply track changes; 1: show comments and track changes. Default 
value: 0.

Int No

Parameters for spreadsheet files (Excel)

Header Description Type Required

sheet Sheet parameter, indicating to convert the xth sheet. Default 
value: 1.

Int No

excelPaperDirection Paper orientation of the spreadsheet. 0: vertical; other values: 
horizontal. Default value: 0.

Int No

excelPaperSize Paper (canvas) size. Valid values: 0 (A4), 1 (A2), 2 (A0). Default Int No

https://intl.cloud.tencent.com/document/product/1045/43609
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value: 0. This parameter should be used together with 
 excelRow  or  excelCol .

Parameters for transcoding to .png/.jpg images

Name Description Type Required

ImageParams

Processing parameters for the output image. All parameters of basic 
image processing are supported. To specify multiple parameters, 
separate them with pipeline operators. In this way, the image can be 
processed by multiple parameters in sequence in the same request.

String No

quality
Quality of the generated preview image. Value range: [1, 100]. Default 
value: 100. For example, if the value is 100, the quality of the 
generated image will be 100%.

Int No

scale
Scaling parameter of the preview image. Value range: [10, 200]. 
Default value: 100. For example, if the value is 200, the image will be 
scaled up (enlarged) by 200%.

Int No

imageDpi
Renders the image based on the specified DPI. This parameter works 
together with  scale . Value range: 96–600. Default value: 96. The 
width of the output image must be less than 65500 px.

Int No

Note:
Currently supported input file types include:

Presentation files: PPTX, PPT, POT, POTX, PPS, PPSX, DPS, DPT, PPTM, POTM, PPSM.
Text files: DOC, DOT, WPS, WPT, DOCX, DOTX, DOCM, DOTM.
Spreadsheet files: XLS, XLT, ET, ETT, XLSX, XLTX, CSV, XLSB, XLSM, XLTM, ETS.

A spreadsheet file may be split into multiple pages, with multiple images generated.
Other files: PDF, LRC, C, CPP, H, ASM, S, JAVA, ASP, BAT, BAS, PRG, CMD, RTF, TXT, LOG, XML, HTM, HTML.

The input file size cannot exceed 200 MB.
The number of pages in the input file cannot exceed 5,000.
The synchronous interface is suitable for PDF files within a hundred pages or for previewing a few pages. For larger 
files, it is recommended to utilize the asynchronous interface.

Request body

The request body of this request is empty.

Response

https://intl.cloud.tencent.com/document/product/1045/33694
https://intl.cloud.tencent.com/document/product/1045/33727
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Response headers

This API only returns Common Response Headers.

Response parameter description

Parameter Description Type

X-Total-
Page

Total number of pages in the file (or images converted from sheets in the 
spreadsheet file) returned in the HTTP header. This value will be empty in case of 
an exception.

Int

Content-
Type

Different values will be returned based on the actual image format, such as 
 image/jpeg  and  image/webp . String

X-ErrNo The error code returned in case of an exception, which can be viewed in the HTTP 
header.

String

X-Total-
Sheet

Total number of sheets in the spreadsheet file returned in the HTTP header. Int

X-Sheet-
Name

Name of the current sheet in the spreadsheet file returned in the HTTP header. String

Error codes

No special error message will be returned for this request. For the common error messages, please see Error Codes.

Examples

Sample 1: Previewing a general file

Request

https://intl.cloud.tencent.com/document/product/1045/43610
https://intl.cloud.tencent.com/document/product/1045/33700
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GET /sample.pdf?ci-process=doc-preview&page=1 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-shanghai.myqcloud.com

Response 1: Preview succeeds
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HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

X-Total-Page: 100

[Image data after transcoding]

Response 2: The file does not exist
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HTTP/1.1 404 OK

Connection: close

Content-Length: 455

Content-Type: application/xml

Date: Thu, 09 Apr 2020 13:44:52 GMT

X-ErrNo: -3004

Response 3: The specified page does not exist
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HTTP/1.1 404 OK

Connection: close

Content-Length: 455

Content-Type: application/xml

Date: Thu, 09 Apr 2020 13:44:52 GMT

X-ErrNo: -3013

Sample 2: Previewing a file and processing the image by scaling it and adding a text watermark

Request
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GET /sample.pdf?ci-process=doc-preview&page=1&ImageParams=imageMogr2/thumbnail/!50p

Host: examplebucket-1250000000.cos.ap-shanghai.myqcloud.com

Response 1: Preview succeeds
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HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

X-Total-Page: 100

[Image data after transcoding]

Response 2: The file does not exist
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HTTP/1.1 404 OK

Connection: close

Content-Length: 455

Content-Type: application/xml

Date: Thu, 09 Apr 2020 13:44:52 GMT

X-ErrNo: -3004

Response 3: The specified page does not exist



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 696
of 2300

HTTP/1.1 404 OK

Connection: close

Content-Length: 455

Content-Type: application/xml

Date: Thu, 09 Apr 2020 13:44:52 GMT

X-ErrNo: -3013
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Async Processing Job APIs
Submitting File Transcoding Job
Last updated：2024-02-19 16:02:58

Overview

This API (  CreateDocProcessJobs ) is used to submit a file transcoding job.

Note: 
Currently supported input file types include:

Presentation files: PPTX, PPT, POT, POTX, PPS, PPSX, DPS, DPT, PPTM, POTM, PPSM.
Text files: DOC, DOT, WPS, WPT, DOCX, DOTX, DOCM, DOTM.
Spreadsheet files: XLS, XLT, ET, ETT, XLSX, XLTX, CSV, XLSB, XLSM, XLTM, ETS.

   A spreadsheet file may be split into multiple pages, with multiple images generated.
Other files: PDF, LRC, C, CPP, H, ASM, S, JAVA, ASP, BAT, BAS, PRG, CMD, RTF, TXT, LOG, XML, HTM, HTML.

The input file size cannot exceed 200 MB.
The number of pages in the input file cannot exceed 5,000.
Job records are retained for one month. Save them in time. We recommend you configure callbacks to query job 
results.

Request

Sample request
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POST /doc_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

  <Tag></Tag>

  <Input>

    <Object></Object>

  </Input>

  <Operation>

    <Output>

      <Region></Region>

      <Bucket></Bucket>

      <Object></Object>

    </Output>

    <DocProcess>

       <StartPage></StartPage>

       <EndPage></EndPage>

       <TgtType></TgtType>

    </DocProcess>

  </Operation>

  <QueueId></QueueId>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description API Type Required

Request N/A Request container Container Supported

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description API Type Required

Tag Request Job type, which currently can 
only be `DocProcess`.

String Supported

Input Request The object to be processed Container Supported

Operation Request Operation rule Container Supported

QueueId Request

Queue ID of the job, which is 
automatically generated after 
the preview service is activated. 
Use the API for querying file 
transcoding queue to get it, or 
query it in the bucket in the CI 
console.

String Supported

https://intl.cloud.tencent.com/document/product/1045/47935
https://console.intl.cloud.tencent.com/ci


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 701
of 2300

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description API Type Required

Object Request.Input
File URL in COS. 
`Bucket` is 
specified by `Host`.

String Supported

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

DocProcess Request.Operation
Task type parameter, which takes effect 
only if  Tag  is  DocProcess . Container Yes

Output Request.Operation Result output address Container Yes

 DocProcess  has the following sub-nodes:

Common request parameters

Node 
Name 
(Keyword)

Parent Node Description Type Required

SrcType Request.Operation.DocProcess

Source data type. Currently, the file 
conversion feature determines the 
source data type according to the 
file extension of the COS object. If 
the object has no extension, you can 
set this value.

String Yes

TgtType Request.Operation.DocProcess

Type of the output target file. Valid 
values: jpg, png, pdf. If the input file 
format cannot be recognized, the 
 jpg  format will be used by 
default. You cannot specify pages 
for the  pdf  format.

String No

StartPage Request.Operation.DocProcess Starts conversion from page X. A 
spreadsheet file may be split into 
multiple pages, with multiple images 

Int No



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 702
of 2300

generated, and  StartPage  
indicates to start the conversion 
from page X of the specified 
 SheetId . Default value: 1.

EndPage Request.Operation.DocProcess

Ends conversion on page X. A 
spreadsheet file may be split into 
multiple pages, with multiple images 
generated, and  EndPage  
indicates to end the conversion on 
page X of the specified 
 SheetId . Default value: -1 
(converting all pages).

Int No

Parameters for spreadsheet files (Excel)

Node Name 
(Keyword)

Parent Node Description Type Required

SheetId Request.Operation.DocProcess
Sheet parameter, indicating to 
convert the xth sheet. Default 
value: 0 (converting all sheets).

Int No

PaperDirection Request.Operation.DocProcess

Paper orientation of the 
spreadsheet. 0: vertical; other 
values: horizontal. Default value: 
0.

Int No

PaperSize Request.Operation.DocProcess
Page (canvas) size. Valid values: 
0 (A4), 1 (A2), 2 (A0). Default 
value: 0.

Int No

Parameters for transcoding to .png/.jpg images

Node Name 
(Keyword)

Parent Node Description Type Required

ImageParams Request.Operation.DocProcess Processing parameters for the 
output image. All parameters of 
basic image processing are 
supported. To specify multiple 
parameters, separate them by 
pipeline operator. In this way, the 
image can be processed by 

String No

https://intl.cloud.tencent.com/document/product/1045/33694
https://intl.cloud.tencent.com/document/product/1045/33727
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multiple parameters in sequence 
in the same request.

Quality Request.Operation.DocProces

Quality of the generated preview 
image. Value range: [1-100]. 
Default value: 100. For example, 
if the value is 100, the quality of 
the generated image will be 
100%.

Int No

Zoom Request.Operation.DocProces

Scaling parameter of the preview 
image. Value range: [10-200]. 
Default value: 100. For example, 
if the value is 200, the image will 
be scaled up (enlarged) by 200%.

Int No

ImageDpi Request.Operation.DocProcess

Renders the image according to 
the specified DPI. This parameter 
works together with  Zoom . 
Value range: 96–600. Default 
value: 96. The width of the output 
image must be less than 65500 
px.

Int No

PicPagination Request.Operation.DocProcess

Whether to convert to a single 
long image. When this parameter 
is set to 1, up to 20 standard 
pages can be converted to a 
single long image, and more 
pages will cause an error. The 
page range can be controlled by 
 StartPage  and  EndPage . 
The default value is 0, indicating 
to output images by page. This 
parameter will take effect only if 
 TgtType  is  png  or  jpg .

Int No

 Output  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes
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Object Request.Operation.Output Output file path.
For non-spreadsheet files, the output 
file name must include the ${Number} 
or ${Page} parameter. If there are 
multiple output files, ${Number} indicates 
that serial numbers start from 1, and 
${Page} indicates that serial numbers are 
the same as preview page numbers.
 ${Number}  indicates that serial 
numbers start from 1 for multiple output 
files; for example, if the input parameter is 
abc_${Number}.jpg to preview pages 5–6 
in the file, then output file names will be 
abc_1.jpg and abc_2.jpg.
 ${Page}  indicates that serial numbers 
are the same as preview page numbers for 
multiple output files; for example, if the input 
parameter is abc_${Page}.jpg to preview 
pages 5–6 in the file, then the output file 
names will be abc_5.jpg and abc_6.jpg.
For spreadsheet files, the output file 
path must include the ${SheetID} 
placeholder, and the output file name 
must include the ${Number} 
parameter.
For example, if the input parameter is 
 /${SheetID}/abc_${Number}.jpg , 
then the corresponding number of folders 
will be generated first according to the 
number of Excel sheets to be converted, 
and then the corresponding number of 
image files will be generated in these 
folders.

String Yes

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

        <JobsDetail>

                <Code></Code>

                <CreationTime></CreationTime>

                <EndTime></EndTime>

                <Input>

                    <Object></Object>

                </Input>

                <JobId></JobId>

                <Message/>

                <Operation>
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                    <DocProcess>

                        <SrcType></SrcType>

                        <TgtType></TgtType>

                        <StartPage></StartPage>

                        <EndPage></EndPage>

                        <ImageParams></ImageParams>

                    </DocProcess>

                    <Output>

                        <Bucket></Bucket>

                        <Object></Object>

                        <Region></Region>

                    </Output>

                </Operation>

                <QueueId></QueueId>

                <State></State>

                <Tag></Tag>

        </JobsDetail>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  
is  Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job type: DocProcess String

State Response.JobsDetail Job status. Valid values:  Submitted , String
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 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

CreationTime Response.JobsDetail Job creation time String

QueueId Response.JobsDetail Queue ID of the job String

Input Response.JobsDetail Input file path of the job Container

Operation Response.JobsDetail Operation rule. Up to 6 operation rules are 
supported.

Container

 Input  has the following sub-nodes:


Same as the  Request.Input  node in the request.

 Operation  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

DocProcess Response.JobsDetail.Operation File preview job parameter Container

Output Response.JobsDetail.Operation File output address Container

 DocProcess  has the following sub-nodes:


Same as the  Request.Operation.DocProcess  node in the request.

 Output  has the following sub-nodes:


Same as the  Request.Operation.Output  node in the request.

Error codes

No special error message will be returned for this request. For the common error messages, please see Error Codes.

Examples

Request

https://intl.cloud.tencent.com/document/product/1045/33700
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POST /doc_jobs HTTP/1.1

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: cos-python-sdk-v5.3.2

Host: examplebucket-1250000000.ci.ap-chongqing.myqcloud.com

Content-Type: application/xml

Content-Length: 546

Authorization: Authorization

<?xml version="1.0" encoding="UTF-8" ?>
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<Request>

    <Input>

        <Object>1.doc</Object>

    </Input>

    <Operation>

      <Output>

          <Region>ap-chongqing</Region>

          <Object>big/test-${Number}</Object>

          <Bucket>examplebucket-1250000000</Bucket>

      </Output>

      <DocProcess>

          <TgtType>png</TgtType>

          <StartPage>1</StartPage>

          <EndPage>-1</EndPage>

          <ImageParams>watermark/1/image/aHR0cDovL3Rlc3QwMDUtMTI1MTcwNDcwOC5jb3MuYX

      </DocProcess>

    </Operation>

    <Tag>DocProcess</Tag>

    <QueueId>p532fdead78444e649e1a4467c1cd19d3</QueueId>

</Request>

Response



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 710
of 2300

HTTP/1.1 200 OK

Date: Mon, 27 Jul 2020 07:20:08 GMT

Content-Type: application/xml

Content-Length: 863

Connection: keep-alive

Server: tencent-ci

x-ci-request-id: NWYxZTgwMjhfYzc2OTQzNjRfMzUx****

<?xml version="1.0" encoding="utf-8"?>

<Response>

        <JobsDetail>
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                <Code>Success</Code>

                <CreationTime>2020-07-27T15:20:08+0800</CreationTime>

                <EndTime>-</EndTime>

                <Input>

                        <Object>1.doc</Object>

                </Input>

                <JobId>d99b3127ecfd911eab5e60dedb7c395dd</JobId>

                <Message/>

                <Operation>

                        <DocProcess>

                                <EndPage>5001</EndPage>

                                <ImageParams>watermark/1/image/aHR0cDovL3Rlc3QwMDUt

                                <SrcType/>

                                <StartPage>1</StartPage>

                                <TgtType>png</TgtType>

                        </DocProcess>

                        <Output>

                                <Bucket>examplebucket-1250000000</Bucket>

                                <Object>big/test-${Number}</Object>

                                <Region>ap-chongqing</Region>

                        </Output>

                </Operation>

                <QueueId>p532fdead78444e649e1a4467c1cd19d3</QueueId>

                <State>Submitted</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

</Response>
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Querying Specified File Transcoding Job
Last updated：2024-02-19 16:02:58

Overview

This API (  DescribeDocProcessJob ) is used to query a specified file transcoding job.

Request

Note: 
File preview job records are retained for one month. Save them in time. We recommend you configure callbacks to 

query job results.

Sample request
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GET /doc_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Note: 

Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API only uses Common Request Headers.

Request body

This request does not have a request body.

Response

Response headers

This API only returns Common Response Headers. 

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

        <JobsDetail>

                <Code></Code>

                <CreationTime></CreationTime>

                <EndTime></EndTime>

                <Input>

                        <Object></Object>

                </Input>

                <JobId></JobId>

                <Message> </Message>

                <Operation>
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                        <DocProcess>

                                <EndPage></EndPage>

                                <ImageParams></ImageParams>

                                <SrcType></SrcType>

                                <StartPage></StartPage>

                                <TgtType></TgtType>

                        </DocProcess>

                        <DocProcessResult>

                                <FailPageCount></FailPageCount>

                                <PageInfo>

                                        <PageNo></PageNo>

                                        <TgtUri></TgtUri>

                                </PageInfo>

                                <SuccPageCount></SuccPageCount>

                                <TaskId></TaskId>

                                <TgtType></TgtType/>

                                <TotalPageCount></TotalPageCount>

                        </DocProcessResult>

                        <Output>

                                <Bucket></Bucket>

                                <Object></Object>

                                <Region></Region>

                        </Output>

                </Operation>

                <QueueId></QueueId>

                <State></State>

                <Tag></Tag>

        </JobsDetail>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

JobsDetail Response
Job details, which is the same as the 
 Response.JobsDetail  node in the 
CreateDocProcessJobs API.

Container

NonExistJobIds Response List of non-existing job IDs queried. If all jobs exist, this node 
will not be returned.

String

https://intl.cloud.tencent.com/document/product/1045/47932
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 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

DocProcess Response.JobsDetail.Operation

File preview job parameter, which is the 
same as the 
 Request.Operation.DocProcess  
node in the CreateDocProcessJobs API.

Container

DocProcessResult Response.JobsDetail.Operation
Returned file preview job result details 
when the job type is  DocProcess  and 
the status is  success .

Container

Output Response.JobsDetail.Operation

Result output address, which is the same 
as the 
 Request.Operation.Output  node 
in the CreateDocProcessJobs API.

Container

 DocProcessResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

PageInfo Response.JobsDetail.Operation.DocProcessResult Preview job result 
details

Container

TgtType Response.JobsDetail.Operation.DocProcessResult Target preview result 
format

String

TotalPageCount Response.JobsDetail.Operation.DocProcessResult Total number of 
preview results

Int

SuccPageCount Response.JobsDetail.Operation.DocProcessResult
Number of 
successful preview 
results

Int

FailPageCount Response.JobsDetail.Operation.DocProcessResult Number of failed 
preview results

Int

TotalSheetCount Response.JobsDetail.Operation.DocProcessResult

Total number of 
sheets in the preview 
job (for Excel source 
files only)

Int

 PageInfo  has the following sub-nodes:

https://intl.cloud.tencent.com/document/product/1045/47932
https://intl.cloud.tencent.com/document/product/1045/47932
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Node 
Name 
(Keyword)

Parent Node Description Type

PageNo Response.JobsDetail.Operation.DocProcessResult.PageInfo

Page number of 
the preview result 
(or  SheetId  
for Excel source 
files)

Container

TgtUri Response.JobsDetail.Operation.DocProcessResult.PageInfo
COS bucket path 
of the preview 
result

Int

X-
SheetPics Response.JobsDetail.Operation.DocProcessResult.PageInfo

Total number of 
images generated 
from the current 
sheet (for Excel 
source files only)

Int

PicIndex Response.JobsDetail.Operation.DocProcessResult.PageInfo

Number of the 
current preview 
result in the entire 
source file (for 
Excel source files 
only)

Int

PicNum Response.JobsDetail.Operation.DocProcessResult.PageInfo

Number of the 
current preview 
result in the sheet 
(for Excel source 
files only)

Int

Error codes

No special error message will be returned for this request. For the common error messages, please see Error Codes.

Examples

Request

https://intl.cloud.tencent.com/document/product/1045/33700


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 719
of 2300

GET /doc_jobs/d13cfd584cd9011ea820b597ad1785a2f HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

1. Response for a non-Excel file
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<Response>

        <JobsDetail>

                <Code>Success</Code>

                <CreationTime>2020-07-24T17:28:47+0800</CreationTime>

                <EndTime>2020-07-24T17:28:49+0800</EndTime>

                <Input>

                        <Object>1.doc</Object>

                </Input>

                <JobId>d13cfd584cd9011ea820b597ad1785a2f</JobId>

                <Message/>

                <Operation>
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                        <DocProcess>

                                <EndPage>0</EndPage>

                                <ImageParams/>

                                <SrcType/>

                                <StartPage>2</StartPage>

                                <TgtType>png</TgtType>

                        </DocProcess>

                        <DocProcessResult>

                                <FailPageCount>0</FailPageCount>

                                <PageInfo>

                                        <PageNo>2</PageNo>

                                        <TgtUri>big/test-1</TgtUri>

                                </PageInfo>

                                <SuccPageCount>1</SuccPageCount>

                                <TaskId/>

                                <TgtType/>

                                <TotalPageCount>2</TotalPageCount>

                        </DocProcessResult>

                        <Output>

                                <Bucket>examplebucket-1250000000</Bucket>

                                <Object>big/test-${Number}</Object>

                                <Region>ap-chongqing</Region>

                        </Output>

                </Operation>

                <QueueId>p50882922b848464fadd222d771438328</QueueId>

                <State>Success</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

</Response>

2. Response for an Excel file
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<Response>

        <JobsDetail>

                <Code>Success</Code>

                <CreationTime>2020-12-03T19:54:10+0800</CreationTime>

                <EndTime>2020-12-03T19:54:13+0800</EndTime>

                <Input>

                        <Object>1.xlsx</Object>

                </Input>

                <JobId>d13cfd584cd9011ea820b597ad1785a2f</JobId>

                <Message/>

                <Operation>
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                        <DocProcess>

                                <Comments>0</Comments>

                                <DocPassword/>

                                <EndPage>2</EndPage>

                                <ImageParams/>

                                <PaperDirection>0</PaperDirection>

                                <PaperSize>0</PaperSize>

                                <Quality>100</Quality>

                                <SheetId>0</SheetId>

                                <SrcType/>

                                <StartPage>1</StartPage>

                                <TgtType/>

                                <Zoom>100</Zoom>

                        </DocProcess>

                        <DocProcessResult>

                                <FailPageCount>0</FailPageCount>

                                <PageInfo>

                                        <PageNo>1</PageNo>

                                        <PicIndex>1</PicIndex>

                                        <PicNum>1</PicNum>

                                        <TgtUri>mark2/1/test-1.jpg</TgtUri>

                                        <X-SheetPics>2</X-SheetPics>

                                </PageInfo>

                                <PageInfo>

                                        <PageNo>1</PageNo>

                                        <PicIndex>2</PicIndex>

                                        <PicNum>2</PicNum>

                                        <TgtUri>mark2/1/test-2.jpg</TgtUri>

                                        <X-SheetPics>2</X-SheetPics>

                                </PageInfo>

                                <SuccPageCount>6</SuccPageCount>

                                <TaskId/>

                                <TgtType/>

                                <TotalPageCount>6</TotalPageCount>

                                <TotalSheetCount>3</TotalSheetCount>

                        </DocProcessResult>

                        <Output>

                                <Bucket>markjrzhang-1251704708</Bucket>

                                <Object>mark/${SheetID}/pic-${Page}.jpg</Object>

                                <Region>ap-chongqing</Region>

                        </Output>

                </Operation>

                <QueueId>p5fdbba9a9b83479f84538d5beb*****</QueueId>

                <State>Success</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

</Response>
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Pulling Eligible File Transcoding Jobs
Last updated：2024-02-19 16:02:57

Feature Description

The API (  DescribeDocProcessJobs ) is used to pull file transcoding jobs that meet specified conditions, such as 

status and creation time.

Request

Sample request
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GET /doc_jobs?queueId=<queueId>&tag=DocProcess HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 

Authorization: Auth String (for more information, see Request Signature).

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/43609
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Request body

This request does not have a request body.

Request parameters

The parameters are as described below:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

queueId None ID of the queue from which jobs are pulled. String Yes

tag None Job type: DocProcess. String Yes

orderByTime None  Desc  (default) or  Asc . String No

nextToken None Context token for pagination. String No

size None
Maximum number of jobs that can be pulled. 
The default value is 10. The maximum value is 
100.

Integer No

states None

Status of the jobs to pull. If you enter multiple 
job statuses, separate them by comma. Valid 
values: All (default), Submitted, Running, 
Success, Failed, Pause, Cancel.

String No

startCreationTime None
Start time of the time range for job pulling in 
the format of  %Y-%m-%dT%H:%m:%S%z . String No

endCreationTime None
End time of the time range for job pulling in the 
format of  %Y-%m-%dT%H:%m:%S%z . String No

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers. 

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

  <JobsDetail></JobsDetail>

  <NextToken></NextToken>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container
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 Response  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent 
Node Description Type

JobsDetail Response
Job details. Same as  Response.JobsDetail  in 
CreateDocProcessJobs.

Container

NextToken Response Context token for pagination String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/47932
https://intl.cloud.tencent.com/document/product/1045/43611
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GET /doc_jobs/queueId=QueueId&tag=DocProcess HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Response
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<Response>

        <JobsDetail>

                <Code>Success</Code>

                <CreationTime>2020-07-20T10:43:17+0800</CreationTime>

                <EndTime>-</EndTime>

                <Input>

                        <Object>1.docx</Object>

                </Input>

                <JobId>JobId</JobId>

                <Message/>

                <Operation>
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                        <DocProcess>

                                <EndPage>1</EndPage>

                                <ImageParams>ImageParams</ImageParams>

                                <SrcType/>

                                <StartPage>1</StartPage>

                                <TgtType>png</TgtType>

                        </DocProcess>

                        <Output>

                                <Bucket>BucketId</Bucket>

                                <Object>file/test-${Page}.jpg</Object>

                                <Region>Region</Region>

                        </Output>

                </Operation>

                <QueueId>QueueId</QueueId>

                <State>Submitted</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

        <JobsDetail>

                <Code>Success</Code>

                <CreationTime>2020-07-20T10:43:17+0800</CreationTime>

                <EndTime>-</EndTime>

                <Input>

                        <Object>test.docx</Object>

                </Input>

                <JobId>JobId</JobId>

                <Message/>

                <Operation>

                        <DocProcess>

                                <EndPage>1</EndPage>

                                <ImageParams>ImageParams</ImageParams>

                                <SrcType/>

                                <StartPage>1</StartPage>

                                <TgtType>png</TgtType>

                        </DocProcess>

                        <Output>

                                <Bucket>BucketId</Bucket>

                                <Object>file/test-${Page}.jpg</Object>

                                <Region>Region</Region>

                        </Output>

                </Operation>

                <QueueId>QueueId</QueueId>

                <State>Submitted</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

        <NextToken>19193</NextToken>

</Response>
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Async Processing Queue APIs
Querying File Transcoding Queue
Last updated：2024-02-19 16:02:58

Feature Description

This API (  DescribeDocProcessQueues ) is used to query file transcoding queues.

Request

Sample request



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 735
of 2300

GET /docqueue?pageNumber=1&pageSize=2 HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Request parameters

Parameter Description Type Required

queueIds Queue ID. If you enter multiple IDs, separate them by comma. string No

state

1. Active: Jobs in the queue will be scheduled and executed by the file 
preview service. 
2.  Paused: The queue is paused, and jobs in it will no longer be 
scheduled and executed. All jobs in the queue will remain in the 
 Paused  status, while jobs being executed will continue without 
being affected.

String No

pageNumber Page number. Default value: the first page. string No

pageSize Number of entries per page. Default value:  10 . string No

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers. 

Response body

The response body returns application/xml data.
Response body 1: The following contains all the nodes when  pageNumber  and  pageSize  are specified.

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

        <TotalCount>1</TotalCount>

        <RequestId>RequestId</RequestId>

        <PageNumber>1</PageNumber>

        <PageSize>2</PageSize>

        <QueueList>

                <QueueId>QueueId</QueueId>

                <Name>QueueName</Name>

                <State>Active</State>

                <NotifyConfig>

                        <Url>url</Url>
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                        <Event>Event</Event>

                        <Type/></Type>

                        <State>Off</State>

                </NotifyConfig>

                <MaxSize>10000</MaxSize>

                <MaxConcurrent>10</MaxConcurrent>

                <CreateTime>CreateTime</CreateTime>

                <UpdateTime>UpdateTime</UpdateTime>

                <BucketId>BucketId</BucketId>

                <Category>DocProcess</Category>

        </QueueList>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

RequestId Response Unique ID of the request. String

TotalCount Response Total number of queues Int

PageNumber Response
Current page number, which is the same as  pageNumber  in 
the request.

Int

PageSize Response
Number of entries per page, which is the same as  pageSize  
in the request.

Int

QueueList Response Queue array Container

 QueueList  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

QueueId Response.QueueList Queue ID String

Name Response.QueueList Queue name String

State Response.QueueList Current status:  Active  or  Paused  String

NotifyConfig Response.QueueList Callback configuration Container
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MaxSize Response.QueueList Maximum length of the queue Int

MaxConcurrent Response.QueueList Maximum number of concurrent jobs in the 
current queue

Int

UpdateTime Response.QueueList Update time String

CreateTime Response.QueueList Creation time String

 NotifyConfig  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Url Response.QueueList.NotifyConfig Callback address String

State Response.QueueList.NotifyConfig Switch status:  On  or  Off  String

Type Response.QueueList.NotifyConfig Callback type: Url String

Event Response.QueueList.NotifyConfig The event that triggered the 
callback

String

Response body 2: The following contains all the nodes when  queueIds  is specified.
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<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <QueueList>

        <QueueId>A</QueueId>

        <Name></Name>

        <State>Active</State>

        <NotifyConfig>

            <Url></Url>

        </NotifyConfig>

    </QueueList>

    <NonExistPIDs>
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        <QueueID>B</QueueID>

        <QueueID>C</QueueID>

    </NonExistPIDs>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

RequestId Response Unique ID of the request. String

QueueList Response
Queue array, which is same as  QueueList  
described above.

Container

NonExistPIDs Response List of non-existing queue IDs Container

 NonExistPIDs  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

QueueID Response.NonExistPIDs Queue ID String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/43611
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GET /docqueue?pageNumber=1&pageSize=2 HTTP/1.1

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: cos-python-sdk-v5.3.2

Host: examplebucket-1250000000.ci.ap-chongqing.myqcloud.com

Content-Type: application/xml

Authorization: Authorization

Response
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HTTP/1.1 200 OK

Date: Mon, 27 Jul 2020 07:29:28 GMT

Content-Type: application/xml

Content-Length: 677

Connection: keep-alive

Server: tencent-ci

x-ci-request-id: NWYxZTgyNTdfYzc2OTQzNjRfMzUx****

<?xml version="1.0" encoding="utf-8"?>

<Response>

        <TotalCount>1</TotalCount>
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        <RequestId>NWYxZTgyNTdfYzc2OTQzNjRfMzUx****</RequestId>

        <PageNumber>1</PageNumber>

        <PageSize>2</PageSize>

        <QueueList>

                <QueueId>p2505d57bdf4c4329804b58a6a5fb1572</QueueId>

                <Name>queue-doc-process-1</Name>

                <State>Active</State>

                <NotifyConfig>

                        <Url/>

                        <Event/>

                        <Type/>

                        <State>Off</State>

                </NotifyConfig>

                <MaxSize>10000</MaxSize>

                <MaxConcurrent>10</MaxConcurrent>

                <CreateTime>2020-07-24T22:42:27+0800</CreateTime>

                <UpdateTime>2020-07-24T22:42:27+0800</UpdateTime>

                <BucketId>examplebucket-1250000000.</BucketId>

                <Category>DocProcessing</Category>

        </QueueList>

</Response>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 745
of 2300

Updating File Transcoding Queue
Last updated：2024-02-19 16:02:57

Overview

This API (  UpdateDocProcessQueue ) is used to update a file transcoding queue.

Request

Sample request
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PUT /docqueue/p8eb46b8cc1a94bc09512d16c5c4f4d3a HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Name>Queue Name</Name>

    <QueueID></QueueID>

    <State></State>

    <NotifyConfig>

        <Type></Type>

        <Url></Url>

        <Event></Event>

    </NotifyConfig>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description API Type Required

Request N/A Request container Container Supported

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description API Type Required Constraints

Name Request Queue 
Name

String Supported Length limit: 100 characters

QueueID Request Queue ID String Supported N/A

State Request
Queue 
status String Supported

1. Active: Jobs in the queue will 
be scheduled and executed by 
the file preview service.
2. Paused: The queue is 
paused, and jobs in it will no 
longer be scheduled and 
executed. All jobs in the queue 
will remain in the `Submitted` 
status, while jobs being 
executed will continue without 
being affected.      

NotifyConfig Request Notification 
channel

Container Supported Third-party callback URL

 NotifyConfig  has the following sub-nodes:
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Node 
Name 
(Keyword)

Parent Node Description API 
Type

Required Constraints

Url Request.NotifyConfig Callback 
configuration

String No Length limit: 100 
characters

Type Request.NotifyConfig
Callback type, 
normal callback: 
URL

String No
Length limit: 100 
characters

Event Request.NotifyConfig
Callback event: The 
file preview job is 
completed.

String No
Length limit: 100 
characters

State Request.NotifyConfig Callback switch: Off, 
On

String No Length limit: 100 
characters

Response

Response headers

This API only returns Common Response Headers. 

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Queue>

        <QueueId></QueueId>

        <Name></Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>mts-topic-1</Url>

            <Type></Type>

            <Event></Event>

        </NotifyConfig>
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        <CreateTime></CreateTime>

        <UpdateTime></UpdateTime>

    </Queue>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

RequestId Response Unique ID of the request String

Queue Response
Queue information. For more information, see 
 Response.QueueList  in DescribeDocProcessQueues. Container

Error codes

No special error message will be returned for this request. For the common error messages, please see Error Codes.

Examples

Request

https://intl.cloud.tencent.com/document/product/1045/47935
https://intl.cloud.tencent.com/document/product/1045/33700
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PUT /docqueue/p2505d57bdf4c4329804b58a6a5fb1572 HTTP/1.1

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: cos-python-sdk-v5.3.2

Host: examplebucket-1250000000.ci.ap-chongqing.myqcloud.com

Content-Type: application/xml

Content-Length: 279

Authorization: Authorization

<?xml version="1.0" encoding="UTF-8" ?>
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<Request>

    <QueueId>p2505d57bdf4c4329804b58a6a5fb1572</QueueId>

    <State>Active</State>

    <Name>markjrzhang4</Name>

    <NotifyConfig>

        <Url>http://google.com/</Url>

    <State>On</State>

        <Type>Url</Type>

        <Event>TransCodingFinish</Event>

    </NotifyConfig>

</Request>[!http]

Response
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HTTP/1.1 200 OK

Date: Mon, 27 Jul 2020 08:22:41 GMT

Content-Type: application/xml

Content-Length: 641

Connection: keep-alive

Server: tencent-ci

x-ci-request-id: NWYxZThlZDBfYzc2OTQzNjRfMzUxYV8x****

<?xml version="1.0" encoding="utf-8"?>

<Response>

        <RequestId>NWYxZThlZDBfYzc2OTQzNjRfMzUxYV8x****</RequestId>
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        <Queue>

                <QueueId>p2505d57bdf4c4329804b58a6a5fb1572</QueueId>

                <Name>markjrzhang4</Name>

                <State>Active</State>

                <NotifyConfig>

                        <Url>http://example.com/</Url>

                        <Event>TransCodingFinish</Event>

                        <Type>Url</Type>

                        <State>On</State>

                </NotifyConfig>

                <MaxSize>10000</MaxSize>

                <MaxConcurrent>10</MaxConcurrent>

                <CreateTime>2020-07-24T22:42:27+0800</CreateTime>

                <UpdateTime>2020-07-27T16:22:40+0800</UpdateTime>

                <BucketId>test007-1251704708</BucketId>

                <Category>DocProcessing</Category>

        </Queue>

</Response>
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File-to-HTML Conversion
Getting Started
Last updated：2024-02-19 16:02:57

Overview

The file-to-HTML conversion feature allows you to generate HTML pages for preview from multiple types of files. It 
enables easy online file preview on PC, app, and other terminals. It is widely suitable for diverse business scenarios, 
such as online education, enterprise OA, online knowledge base, and online file preview.

Note: 
CI encapsulates the preview JS-SDK, so you can connect to the HTML preview service with only one URL.
If you want to use it in mini programs, see FAQs.
To connect to a CDN domain name, you need to enable Advanced Cache Expiration Settings in CDN as 
instructed in Node Caching Rule Configuration (Legacy).

Request

Sample request

https://intl.cloud.tencent.com/document/product/1045/33430
https://intl.cloud.tencent.com/document/product/228/35317
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GET /<ObjectKey>?ci-process=doc-preview&dstType=html HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Request headers

This API only uses Common Request Headers.

Request parameters

Name Description Type Required

https://intl.cloud.tencent.com/document/product/1045/43609


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 758
of 2300

ObjectKey Object name, such as  folder/document.pdf . String Yes

ci-process
CI's processing capability, which is fixed at  doc-preview  for 
file preview in HTML.

String Yes

dstType Output target file type, which is fixed at  html  for HTML preview. String Yes

srcType Source file type as listed below. String No

sign

Object download signature, which must be URL-encoded. If the 
previewed object is privately readable, the signature needs to be 
passed in. 
For more information, see Request Signature.

String No

copyable
Whether the file content is copyable. Valid values:  1  (yes),  0  
(no).

String No

htmlParams

Custom configuration parameters in JSON structure, which must 
be URL-safe Base64-encoded as described in FAQs. Default 
configuration: { commonOptions: { isShowTopArea: true, 
isShowHeader: true } }. For supported configurations, see Custom 
Configuration Overview.

String No

htmlwaterword Watermark text, which must be URL-safe Base64-encoded as 
described in FAQs and is empty by default.

String No

htmlfillstyle
Watermark RGBA (color and transparency), which must be URL-
safe Base64-encoded as described in FAQs and is 
 rgba(192,192,192,0.6)  by default.

String No

htmlfront
Watermark text style, which must be URL-safe Base64-encoded as 
described in FAQs and is  bold 20px Serif  by default. String No

htmlrotate
Rotation angle of the watermark text in degrees. Value range: 0–
360. Default value:  315 . String No

htmlhorizontal Horizontal spacing of the watermark text in px. Default value:  50 . String No

htmlvertical Vertical spacing of the watermark text in px. Default value:  100 . String No

Note: 
Currently supported input file types include:

Presentation files: PPTX, PPT, POT, POTX, PPS, PPSX, DPS, DPT, PPTM, POTM, PPSM.
Text files: DOC, DOT, WPS, WPT, DOCX, DOTX, DOCM, DOTM.
Spreadsheet files: XLS, XLT, ET, ETT, XLSX, XLTX, CSV, XLSB, XLSM, XLTM, ETS.

https://intl.cloud.tencent.com/document/product/1045/33452
https://intl.cloud.tencent.com/document/product/1045/33430
https://intl.cloud.tencent.com/document/product/436/49416
https://intl.cloud.tencent.com/document/product/1045/33430
https://intl.cloud.tencent.com/document/product/1045/33430
https://intl.cloud.tencent.com/document/product/1045/33430
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Other files: PDF, LRC, C, CPP, H, ASM, S, JAVA, ASP, BAT, BAS, PRG, CMD, RTF, TXT, LOG, XML, HTM, HTML.
The input file size cannot exceed 200 MB.
The number of pages in the input file cannot exceed 5,000.

Request body

The request body of this request is empty.

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body of this API request is the HTML preview content.

Error codes

No special error message will be returned for this request. For the common error messages, please see Error Codes.

Examples

Sample 1: Simple preview

To preview the PPT file with the  test.pptx  ObjectKey in the  examples-1258125638  bucket online, the final 

URL is as follows:

https://intl.cloud.tencent.com/document/product/1045/43610
https://intl.cloud.tencent.com/document/product/1045/33700
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https://examples-1258125638.cos.ap-guangzhou.myqcloud.com/test.pptx?ci-process=doc-

Note: 

You can also implement more custom features through JS-SDK. For more information, see Custom Configuration 
Overview.
Open the link directly in a browser to view the generated preview page. For slides, you can also perform full-screen 
slideshow, which supports animation, trigger, and other effects and provides virtual laser pointer, speaker 
mode, and other features.

https://intl.cloud.tencent.com/document/product/1045/47939
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Sample 2: Watermark + preview with custom configurations

Preview the PPT file with the  test.pptx  ObjectKey in the  examples-1258125638  bucket online.

1. Make it uncopyable by setting  copyable  to  0 .

2. Set the test watermark, which is URL-safe Based64-encoded into  htmlwaterword=dGVzdAog .

3. Set custom configuration parameters.  htmlParams  is {"mode":"normal","commonOptions":

{"isShowHeader":false,"isShowTopArea":true},"pptOptions":{"isSlidesStatusPlay": true}}, which is URL-safe Base64-
encoded into 
 htmlParams=eyJtb2RlIjoibm9ybWFsIiwiY29tbW9uT3B0aW9ucyI6eyJpc1Nob3dIZWFkZXIiOmZhbHNl

LCJpc1Nob3dUb3BBcmVhIjp0cnVlfSwicHB0T3B0aW9ucyI6eyJpc1NsaWRlc1N0YXR1c1BsYXkiOiB0cnVl

fX0= .

The final URL is as follows:
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https://examples-1258125638.cos.ap-guangzhou.myqcloud.com/test.pptx?ci-process=doc-

Open the link directly in a browser to view the generated preview page. For slides, you can also perform full-screen 

slideshow, which supports animation, trigger, and other effects and provides virtual laser pointer, speaker 
mode, and other features.
The preview link can also be embedded in a business webpage as an iframe as follows:
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<!DOCTYPE html>

<html>

<head>

    <meta charset="utf-8">

    <meta name="viewport"

        content="width=device-width, initial-scale=1.0, maximum-scale=1.0, minimum-

    <meta http-equiv="Content-Type" content="text/html; charset=UTF-8">

    <meta http-equiv="X-UA-Compatible" content="IE=edge,chrome=1">

    <meta http-equiv="Content-Security-Policy" content="upgrade-insecure-requests">

    <meta name="keywords" content="COS, file preview">
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    <meta name="description" content="">

    <title>Tencent Cloud - COS - file preview</title>

    <style>

        html,

        body {

            padding: 0;

            margin: 0;

            height: 100%;

            touch-action: manipulation;

        }

    </style>

</head>

<body>

    <iframe src="https://examples-1258125638.cos.ap-guangzhou.myqcloud.com/test.ppt

</body>

</html>
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Custom Configuration Overview
Last updated：2024-02-19 16:02:57

Feature Overview

By using the JS-SDK, you can customize capabilities such as UI, page status, and event listener to deliver a better 
webpage experience.

Architecture
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Operating Environments

Platform Supported Browsers
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iOS Safari, QQ built-in browser, QQ Mini Program, WeChat built-in browser, and WeChat Mini 
Program

Android QQ built-in browser, QQ Mini Program, WeChat built-in browser, and WeChat Mini Program

Windows Chrome, QQ Browser (non-compatibility mode), Edge, Firefox, and Internet Explorer 11

macOS Chrome, Safari, QQ Browser, Edge, and Firefox

Instructions

1. Download a package

Download the latest version of the JS-SDK package. For earlier versions, see Release Notes.

2. Import the JS-SDK

On the page that needs to call the JS-SDK, import it as follows. In the sample code,  ${version}  indicates the 

version number and should be replaced with the actual version number of your downloaded package.

https://cos-doc-preview-js-sdk-1253960454.file.myqcloud.com/sdk-v0.1.1.zip
https://intl.cloud.tencent.com/document/product/1045/47943
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<script src="sdk-${version}.js"></script>

3. Get the online file preview URL

Option 1. Use the JS-SDK (on v0.1.1 or later) to get

Use the JS-SDK (on v0.1.1 or later) to get the online file preview URL as follows:



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 769
of 2300

var url = await COSDocPreviewSDK.getPreviewUrl( {

      objectUrl: 'https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/tes

      credentials: {      // If the preview file is private, the request needs to c

          secretId: '',

          secretKey: '',

          authorization: 'q-sign-algorithmxxxxxxxxxxxxxxx',

      },

      copyable: 0,  // Whether the file content can be copied

      htmlwaterword: ''  // Watermark content

})

console.log(url)
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The configuration items are described as follows:

Configuration Item Description Required

objectUrl
The URL of the object that needs to be previewed, such as 
 https://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/test.pptx .
Yes

credentials

If the object to be previewed is private, you need to pass in 
 credentials  as the access credential. You can pass in the 
calculated request signature (  authorization ) or your 
 secretId  and  secretKey  (not recommended as placing a 
permanent key on the frontend has security risks).

No

credentials.authorization Object download signature. For more information, see Request 
Signature.

No

credentials.secretId
Your  secretId , which can be obtained on the Manage API Key 
page in the CAM console.

No

credentials.secretKey
Your  secretKey , which can be obtained on the Manage API Key 
page in the CAM console.

No

copyable
Whether the file content is copyable. Valid values:  1  (yes),  0  
(no).

No

htmlwaterword Watermark text, which must be URL-safe Base64-encoded as 
described in FAQs and is empty by default.

No

htmlfillstyle
Watermark RGBA (color and transparency), which must be URL-safe 
Base64-encoded as described in FAQs and is 
 rgba(192,192,192,0.6)  by default.

No

htmlfront
Watermark text style, which must be URL-safe Base64-encoded as 
described in FAQs and is  bold 20px Serif  by default. No

htmlrotate Rotation angle in degrees. Value range: 0–360. Default value:  315 . No

htmlhorizontal Horizontal spacing of the watermark text in px. Default value:  50 . No

htmlvertical Vertical spacing of the watermark text in px. Default value:  100 . No

Option 2. Directly request to get

Sample request

https://intl.cloud.tencent.com/document/product/1045/33452
https://intl.cloud.tencent.com/document/product/1045/33452
https://console.intl.cloud.tencent.com/cam/capi
https://console.intl.cloud.tencent.com/cam/capi
https://intl.cloud.tencent.com/document/product/1045/33430
https://intl.cloud.tencent.com/document/product/1045/33430
https://intl.cloud.tencent.com/document/product/1045/33430
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GET /<ObjectKey>?ci-process=doc-preview&dstType=html&weboffice_url=1&sign=AuthStrin

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Request parameters

Parameter Description Required

ci-process Preview parameter, which is fixed at  doc-preview . Yes
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dstType Preview type. To generate HTML files for preview, enter  html . Yes

weboffice_url
Whether to get the preview URL. Valid values:  1  (return the preview URL 
and token information);  2  (return the token information only). If this 
parameter is not specified, the file will be directly previewed.

No

tokenuid

Whether to get the token. A token will be generated and returned along with 
its validity period based on the information passed in such as  tokenuid  
and file information. If this parameter is not specified, the token information 
won't be returned.

No

sign
Object download signature, which must be URL-encoded. If the previewed 
object is privately readable, the signature needs to be passed in. 
For more information, see Request Signature.

No

copyable Whether the file content is copyable. Valid values:  1  (yes),  0  (no). No

htmlwaterword Watermark text, which must be URL-safe Base64-encoded as described in 
FAQs and is empty by default.

No

htmlfillstyle
Watermark RGBA (color and transparency), which must be URL-safe 
Base64-encoded as described in FAQs and is 
 rgba(192,192,192,0.6)  by default.

No

htmlfront
Watermark text style, which must be URL-safe Base64-encoded as described 
in FAQs and is  bold 20px Serif  by default. No

htmlrotate Rotation angle in degrees. Value range: 0–360. Default value:  315 . No

htmlhorizontal Horizontal spacing of the watermark text in px. Default value:  50 . No

htmlvertical Vertical spacing of the watermark text in px. Default value:  100 . No

Sample response

https://intl.cloud.tencent.com/document/product/1045/33452
https://intl.cloud.tencent.com/document/product/1045/33430
https://intl.cloud.tencent.com/document/product/1045/33430
https://intl.cloud.tencent.com/document/product/1045/33430
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HTTP/1.1 200 OK

Content-Type: text/html

Content-Length: 478

Date: Thu, 25 Feb 2021 07:44:37 GMT

Status: 200 OK

x-cos-request-id: NjAzNzU1NjVfY2MxZTIzMDlfNzc5NF8yMDQ5****

{

        "PreviewUrl": "https://prvsh.myqcloud.com/office/p/xxxx?_w_provider=XXX"



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 774
of 2300

}

4. Initialize

During initialization, the JS-SDK will create an iframe under the configured mount node and automatically initialize 
relevant data and events.

var demo = COSDocPreviewSDK.config({

    url: 'Online file preview URL',  // The online preview URL of the file obtained

})

// If special processing needs to be performed on the iframe, you can get the DOM o
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console.log(demo.iframe)

// File open result

demo.on('fileOpen', function(data) {

    console.log(data.success)

})

5. Configure the mount node

The mount node is the node mounted when the JS-SDK inserts the iframe. It is configurable during initialization.

<div class="custom-mount"></div>
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var demo = COSDocPreviewSDK.config({

    url: 'Online file preview URL',    // The online preview URL of the file obtain

    mount: document.querySelector('.custom-mount')    // Mount node. By default, th

})

After initialization is completed, the JS-SDK will automatically insert an iframe under the mount node.
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<div class="custom-mount">

    <iframe src="..."></iframe>

</div>

6. Authenticate the token

If no token is used, the signature validity period will be used for authentication by default. Once the signature expires, 
the file cannot be previewed.




Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 778
of 2300

If a token is used for authentication, token authentication and refresh can be performed continuously during preview, 
and you can control the preview authorization on your own.

Token authentication and renewal can be completed in the following three steps. For more information, see the demo.
1. Get the token.

Request sample

https://github.com/tencentyun/cos-demo/blob/main/doc-preview/token-refresh-preview.html
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GET /<ObjectKey>?ci-process=doc-preview&dstType=html&weboffice_url=2&tokenuid=test&

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Sample Response
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HTTP/1.1 200 OK

Content-Type: text/html

Content-Length: 108

Date: Tue, 21 Jun 2022 10:41:10 GMT

Status: 200 OK

x-cos-request-id: NjJiMWEwNDZfMTgyMjYyNjRfYmRlYl9iNTAw****

{

 Token: "ChAJj2vNRiHTc8reToMmJ7T2EJ7FxpUGGhS1mPJanpN03u8PSB17/YKBA/Vo****"
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 TokenExpireTime: "1655808670"

}

2. Set the token.
Note: 
 To avoid frequent token refresh, we recommend you set  timeout  to over 10 minutes. To prevent the refresh 

request from timing out, the JS-SDK will refresh the token several minutes in advance.

var demo = COSDocPreviewSDK.config({

    url: 'Online file preview URL',  // The online preview URL of the file obtained

})
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// Set the token

demo.setToken({

  token: 'yourToken', // Enter the obtained token

  timeout: 10 * 60 * 1000, // Timeout period of the token in milliseconds. To avoid

});

3. Configure the  refreshToken  method to automatically refresh the token upon timeout.


The  refreshToken  method needs to request the token refresh method encapsulated on your server. The 

server can encapsulate the above token acquisition method (for more information, see Get the token).

Taking the server method  http://your.server.com/refreshToken  as an example, configure 

 refreshToken  as follows:
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// Get the token

const refreshToken = () => {

  // Call the method encapsulated on the server to get the token information

  const tokenInfo = await $.get('http://your.server.com/refreshToken')

  // `Promise` or `return { token, timeout }` can be returned.

  return {

    token: tokenInfo.token, // The token to be set, which is required.

    timeout: 10 * 60 * 1000, //  The token timeout period in milliseconds, which is

  };

};
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var demo = COSDocPreviewSDK.config({

    url: 'Online file preview URL',  

    refreshToken    // Automatic token refresh method

})

// Set the token

demo.setToken({

  token: 'yourToken', // Enter the obtained token

  timeout: 10 * 60 * 1000   // Token timeout period in milliseconds

});

Examples

For the sample code of online preview of a text file, see the DOC file preview demo at GitHub.
For the sample code of online preview of a presentation file, see the PPT file preview demo at GitHub.
For the sample code of online preview of a spreadsheet file, see the Excel file preview demo at GitHub.
For the sample code of online preview of a PDF file, see the PDF file preview demo at GitHub.
For the sample code of token authentication and renewal, see the token authentication and renewal demo at GitHub.

https://github.com/tencentyun/cos-demo/blob/main/doc-preview/doc-to-html-preview.html
https://github.com/tencentyun/cos-demo/blob/main/doc-preview/ppt-to-html-preview.html
https://github.com/tencentyun/cos-demo/blob/main/doc-preview/xls-to-html-preview.html
https://github.com/tencentyun/cos-demo/blob/main/doc-preview/pdf-to-html-preview.html
https://github.com/tencentyun/cos-demo/blob/main/doc-preview/token-refresh-preview.html
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Configuration Item Description
Last updated：2024-02-19 16:02:58

Display Mode

Enable different display modes by initializing the configuration option class:

var demo = COSDocPreviewSDK.config({
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    mode: 'normal', 

})

The configuration options are as described below:

 mode  Value Description Default Option

normal Normal mode, with all functional UIs shown Yes

simple Simple mode, with no header and toolbar shown No

Custom Configuration Options

When initializing the JS-SDK, by configuring different options for different types of files, you can enable or disable 
specific configurations in a file and control its status when it is opened.
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COSDocPreviewSDK.config({

    // Common option, which is applicable to all types of files.

    commonOptions: {

      isShowTopArea: false, // Hide the top area (header and toolbar).

      isShowHeader: false // Hide the header area.

    },

    // Word file configurations.

    wordOptions: {

      isShowDocMap: false,

      isBestScale: true
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    },

    // PDF file configurations.

    pdfOptions: {

      isShowComment: true,

      isInSafeMode: false

    },

    // Presentation file configurations.

    pptOptions: {

      isShowBottomStatusBar: true

    }

})

Common configuration items:  commonOptions 

Configuration Item Description Default Value

isShowTopArea Whether to show the top area (header and toolbar) false

isShowHeader Whether to show the header area false

isBrowserViewFullscreen Whether to enable full screen mode in the browser area false

isIframeViewFullscreen Whether to enable full screen mode in the iframe area false

Text file configuration items:  wordOptions 

Configuration Item Description Default 
Value

isShowDocMap Whether to enable the directory feature, which is enabled by default. true

isBestScale Whether to display the file at the best scale by default (for PC) when 
the file is opened

true

isShowBottomStatusBar Whether to show the bottom status bar (for PC) false

PDF file configuration items:  pdfOptions 

Configuration Item Description Default 
Value

isShowComment Whether to show annotations, which are shown by default. true

isInSafeMode Whether to enable the safe mode (text cannot be selected or copied and 
links cannot be opened). It is disabled by default.

false

isShowBottomStatusBar Whether to show the bottom status bar (for PC) false
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Presentation file configuration items:  pptOptions 

Configuration Item Description Default Value

isShowBottomStatusBar Whether to show the bottom status bar (for PC) false

Component Status Settings

Page components can be hidden or disabled through the  commandBars  option.
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COSDocPreviewSDK.config({

    // Common option, which is applicable to all types of files.

    commandBars: [

      {

        cmbId: 'Print', // Component ID

        attributes:{

          visible: false, // Whether to show the component. Valid values: `false` (

          enable: false, // Whether to enable the component. Default value: `true`.

        },

      },

    ]

})

The list of currently available components is as follows:

Component ID Description Scope of 
Application

Print Print feature and the Ctrl + P shortcut for print All files

MobileHeader Top toolbar in the client All files

WriterHoverToolbars Bottom toolbar in the client Word files

DownloadImg Download icon when the image is double-clicked Presentation files

PlayComponentToolbar Toolbar in the top-right corner when in full screen mode Presentation files

PlayContextCheckImage Right click during playback - View original image Presentation files

FloatMenuCheckImage Floating menu bar when the image is selected - View 
original image

Presentation files

WPPMobileCommentButton Comment button on the bottom toolbar in the client Presentation files

PDFMobilePageBar Page number in the client PDF files
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Advanced Features
Last updated：2024-02-19 16:02:58

The JS-SDK provides advanced features to directly manipulate files. Below is the call process of advanced features:

1. Wait for a file to be loaded
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await demo.ready() // You can call an advanced API only after the demo is ready. Th

2. Get the file object

// Text

const wordApp = demo.WordApplication()

// Spreadsheet
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const excelApp = demo.ExcelApplication()

// Presentation

const pptApp = demo.PPTApplication()

// PDF

const pdfApp = demo.PDFApplication()

// Automatic recognition

const app = demo.Application

3. Use advanced features

Below is the sample code of using advanced features on text, spreadsheet, presentation, and PDF files. For the 

specific formats supported for each file type, see Specifications and Limits.

Text file

Get the total number of pages

https://intl.cloud.tencent.com/document/product/1045/33425
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  /*

  * @param: WdInformation: {

  *      wdNumberOfPagesInDocument: 4

  *  }

  * @return: {PagesCount: number, End: boolean}

  */

  const app = demo.WordApplication()

  const {Enum} = app

  let totalPages = await app.ActiveDocument.Range.Information(Enum.WdInformation.wd

  if (totalPages.End) {

    // Getting the total number of pages is an async operation. The obtained number
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    console.log("All pages are loaded. There are ", totalPages.PagesCount, " pages 

  }

Get the current page

  /*

  * @param: WdInformation: {

  *      wdActiveEndPageNumber: 3

  *  }

  * @return: number

  */

  const app = demo.WordApplication()
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  const {Enum} = app

  let currentPage = await app.ActiveDocument.Selection.Information(Enum.WdInformati

Go to the specified page

  /*

  * @param: { What?: WdGoToItem, Which?: WdGoToDirection.wdGoToAbsolute, Count?: nu

  * WdGoToItem: {

  *      wdGoToPage: 1,

  *  }

  *  WdGoToDirection: {

  *      wdGoToAbsolute: 1
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  *  }

  * @return: number Return the target page number

  */

  const app = demo.WordApplication()

  const {Enum} = app

  const page = await app.ActiveDocument.Selection.GoTo(Enum.WdGoToItem.wdGoToPage, 

  // Or

  const page = await app.ActiveDocument.Selection.GoTo({

    What: Enum.WdGoToItem.wdGoToPage,

    Which: Enum.WdGoToDirection.wdGoToAbsolute,

    Count: 10

  })

Set whether to show comments
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  /*

  * @param: bool

  * Valid values: `true` (yes); `false` (no).

  */

  // Hide comments.

  demo.WordApplication().ActiveDocument.ActiveWindow.View.ShowComments = false

Set whether to show the table of contents
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  /*

  * @param: bool

  * Valid values: `true` (yes); `false` (no).

  */

  // Hide the table of contents.

  demo.WordApplication().ActiveDocument.ActiveWindow.DocumentMap = false

Zoom the view
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  /*

  * @return: number

  */

  await demo.WordApplication().ActiveDocument.ActiveWindow.View.Zoom.Percentage  //

  /*

  * @param : 50 <= number <= 300 (The zoom level is between 50% and 300%.)

  */

  demo.WordApplication().ActiveDocument.ActiveWindow.View.Zoom.Percentage = 100  //
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Spreadsheet file

Get the names of all sheets

const app = demo.ExcelApplication()

const Names = []

const count = await app.Sheets.Count;

for(let index = 1; index <= count; index++) {

  Names.push(await app.Sheets.Item(index).Name);

}

console.log(Names)
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Get the name of the current sheet

const app = demo.ExcelApplication()

const name = await app.ActiveSheet.Name

Switch to the specified sheet
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const app = demo.ExcelApplication()

const sheetIndex = 1 // Sheet number, which starts from 1.

app.Sheets.Item(sheetIndex).Activate() // Switch the sheet.

Zoom the view
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  /*

  * @return: number

  */

  await demo.ExcelApplication().ActiveWorkbook.ActiveSheetView.Zoom	 // Read the

  /*

  * @param : 10 <= number <= 500 (The zoom level is between 10% and 500%.)

  */

  demo.ExcelApplication().ActiveWorkbook.ActiveSheetView.Zoom = 100	 // Set the 

Presentation file
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Get the total number of pages

  /*

  * @return: number

  */

  let totalPages = await demo.PPTApplication().ActivePresentation.Slides.Count

Get the current page
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  /*

  * @return: number

  */

  let totalPages = await demo.PPTApplication().ActivePresentation.SlideShowWindow.V

Go to the specified page
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  /*

  * @param: number

  */

  await demo.PPTApplication().ActivePresentation.SlideShowWindow.View.GotoSlide(3)	

Start a slide show
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await demo.PPTApplication().ActivePresentation.SlideShowSettings.Run()

Exit the slide show
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await demo.PPTApplication().ActivePresentation.SlideShowWindow.View.Exit()

Play the next animation
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  await demo.PPTApplication().ActivePresentation.SlideShowWindow.View.GotoNextClick

Play the previous animation
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  await demo.PPTApplication().ActivePresentation.SlideShowWindow.View.GotoPreClick(

Get the play status
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  /*

  * @return: string ('preview' | 'play')

  */

  let currentState = await demo.PPTApplication().ActivePresentation.SlideShowWindow

Zoom the view
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  /*

  * @return: number

  */

  await demo.PPTApplication().ActivePresentation.View.Zoom	 // Read the view zo

  /*

  * @param : 1 <= number <= 400 (The zoom level is between 1% and 400%.)

  */

  demo.PPTApplication().ActivePresentation.View.Zoom = 100	 // Set the view zoo

PDF file
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Get the total number of pages

  /*

  * @return: number

  */

  let totalPages = await demo.PDFApplication().ActivePDF.PagesCount

Get the current page
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  /*

  * @return: number

  */

  let totalPages = await demo.PDFApplication().ActivePDF.CurrentPage

Go to the specified page
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  /*

  * @param : { PageNum: number }

  */

  let PageNum = 10

  await demo.PDFApplication().ActivePDF.JumpToPage({PageNum})

Set the page rendering mode
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  /*

  * 1: Single-page mode

  * 0: Multi-page mode

  */

  demo.PDFApplication().ActivePDF.PageMode = 1	   // Set the single-page mode.

Set whether to show the table of contents
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  /*

  * true: Show the table of contents

  * false: Hide the table of contents

  */

  demo.PDFApplication().ActivePDF.DocumentMap = true	 // Show the table of conten

Zoom the view
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  /*

  * @return: number

  */

  await demo.PDFApplication().ActivePDF.Zoom  // Read the view zoom level.

  /*

  * @param : 1 <= number <= 400 (The zoom level is between 1% and 400%.)

  */

  demo.PDFApplication().ActivePDF.Zoom = 100  // Set the view zoom level.

Listen on events
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You can use the  on  method of the instance to listen on events.

demo.on('Event name', function(data) {

    // do something...

})

Event Description

fileOpen The file was opened successfully or failed to be opened.

error An error occurred, and an error code was returned.
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fileStatus The file was saved, and a  status  value was returned. Valid values:  0  (the file had no 
updates);  1  (the version was saved successfully);  2  (the file was empty and couldn't be 
saved);  3  (the space was full);  4  (the file was being saved);  5  (the file failed to be saved); 
 6  (the file updates were being saved; this status will be triggered when the file content is 
modified);  7  (the change to the file content was saved successfully).
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Release Notes
Last updated：2024-02-19 16:02:58

v0.2.1

Download address: sdk-v0.2.1.zip
Supported COS v5 signature authentication
Supported token authentication and refresh

Supported listening on the video playback status in PPT files

v0.1.1

Download address: sdk-v0.1.1.zip
Supported online preview
Supported COS v4 signature authentication

https://cos-doc-preview-js-sdk-1253960454.file.myqcloud.com/sdk-v0.2.1.zip
https://cos-doc-preview-js-sdk-1253960454.file.myqcloud.com/sdk-v0.1.1.zip
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File Processing
Hash Calculation
Sync Request for Hash Calculation
Last updated：2024-02-19 16:02:57

Overview

This API uses a sync GET request to perform hash calculation and return a calculated hash value in real time.

Billing Description

Calling the API will incur hash calculation fees and COS read request fees as described in Request Fees.
If the files are stored in COS STANDARD_IA storage class, calling the API will incur STANDARD_IA data retrieval 

fees as described in Data Retrieval Fees.
Processing is not supported for files stored in the ARCHIVE or DEEP ARCHIVE storage classes. To process these 
files, you first need to restore them as instructed in POST Object restore.

Restrictions

File size: Calculation on files that are less than 128 MB is supported. For files that are greater than 128 MB, use Async 
API for Hash Calculation.

Request timeout period: 10 seconds
Calling the API requires a signature. For more information, see Request Signature.
This API can be used in Beijing, Shanghai, Guangzhou, Chengdu, Hong Kong (China), Singapore, and Silicon Valley 
regions.

Request

Sample request

https://intl.cloud.tencent.com/document/product/436/40100
https://intl.cloud.tencent.com/document/product/436/40097
https://intl.cloud.tencent.com/document/product/436/12633
https://intl.cloud.tencent.com/document/product/1045/52867
https://intl.cloud.tencent.com/document/product/436/7778
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GET /for-test.mp4?ci-process=filehash&type=md5 HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Note: 
Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API only uses Common Request Headers.

Request parameters

The parameters are described as follows:

Node Name 
(Keyword)

Description Type Required

ci-process
Operation type. It is fixed at  filehash  for hash 
calculation.

String Yes

type
Supported hash algorithm. Valid values:  md5 ,  sha1 , 
 sha256 

String Yes

addtoheader

Whether to automatically add the calculated hash value to 
the custom header in the file. Format: x-cos-meta-
md5/sha1/sha256
Valid values:  true ,  false . If this parameter is left 
empty, it is  false  by default.

String No

Request body

This request does not have a request body.

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/436/7728
https://intl.cloud.tencent.com/document/product/436/7729
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<Response>

    <FileHashCodeResult>

        <MD5>0fe771ba515b0525552f59290a50c0ef</MD5>

        <FileSize>1048576</FileSize>

    </FileHashCodeResult>

    <Input>

        <Bucket>test-1234567890</Bucket>

        <Object>wg.txt</Object>

        <Region>ap-chongqing</Region>

    </Input>

</Response>
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The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

FileHashCodeResult Response File hash result Container

Input Response Basic information of the input 
file

Container

 FileHashCodeResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

MD5 Response.FileHashCodeResult
This field is returned if  type  in the 
request is  md5 .

String

SHA1 Response.FileHashCodeResult
This field is returned if  type  in the 
request is  sha1 .

String

SHA256 Response.FileHashCodeResult
This field is returned if  type  in the 
request is  sha256 .

String

FileSize Response.FileHashCodeResult File size Int

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Region of the bucket String

Bucket Response.JobsDetail.Input Bucket where the input file resides String

Object Response.JobsDetail.Input Name of the input file in the bucket String

Error codes

There are no specific error messages for this request operation. For common error messages, see Error Codes.

https://intl.cloud.tencent.com/document/product/436/46214
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Examples

Request

GET /for-test.mp4?ci-process=filehash&type=md5 HTTP/1.1

Host: test-1234567890.cos.ap-beijing.myqcloud.com

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUjfG****-si

Content-Length: 0

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-cos

x-cos-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZmNw==

<Response>

    <FileHashCodeResult>

        <MD5>0fe771ba515b0525552f59290a50c0ef</MD5>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 830
of 2300

        <FileSize>1048576</FileSize>

        <LastModified>2022-06-27T15:23:12+0800</LastModified>

        <Etag>"ee8de918d05640145b18f70f4c3aa602"</Etag>

    </FileHashCodeResult>

    <Input>

        <Bucket>test-1234567890</Bucket>

        <Object>wg.txt</Object>

        <Region>ap-chongqing</Region>

    </Input>

</Response>
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Submitting Hash Calculation Job
Last updated：2024-02-19 16:02:57

Overview

This API adopts a POST request method. You can submit a job to perform hash calculation and asynchronously 
return a calculated hash value.

Billing Description

Calling the API will incur hash calculation fees and COS read request fees as described in Request Fees.

If the files are stored in COS STANDARD_IA storage class, calling the API will incur STANDARD_IA data retrieval 
fees as described in Data Retrieval Fees.
Calculation is not supported for files stored in the ARCHIVE or DEEP ARCHIVE storage classes. To calculate hash 
values for these files, you first need to restore them as instructed in POST Object restore.
This API can be used in Beijing, Shanghai, Guangzhou, Chengdu, Hong Kong (China), Singapore, and Silicon Valley 

regions.

Restrictions

Supported file size: Calculation on files that are less than 50 GB is supported.
Calling the API requires a signature. For more information, see Request Signature.

Request

Sample request

https://intl.cloud.tencent.com/document/product/436/40100
https://intl.cloud.tencent.com/document/product/436/40097
https://intl.cloud.tencent.com/document/product/436/12633
https://intl.cloud.tencent.com/document/product/436/7778
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POST /file_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 833
of 2300

Authorization: Auth String (For more information, see Request Signature.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/436/7728
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<Request>

    <Tag>FileHashCode</Tag>

    <Input>

        <Object>input/test.mp4</Object>

    </Input>

    <Operation>

        <FileHashCodeConfig>

            <Type>MD5</Type>

            <AddToHeader>true</AddToHeader>

        </FileHashCodeConfig>

        <UserData>This is my data.</UserData>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://test.test.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request
Job type. It is  FileHashCode  for hash 
calculation by default.

String Yes

Input Request Information about the file to be operated Container Yes

Operation Request Hash calculation rule Container Yes

QueueId Request ID of the queue where the job is in String Yes

CallBackFormat Request
Job callback format, which can be  JSON  or 
 XML  (default). It takes priority over that of 
the queue.

String No

CallBackType Request
Job callback type, which can be  Url  
(default) or  TDMQ . It takes priority over that 
of the queue.

String No

CallBack Request Job callback address. It takes priority over that 
of the queue.

String No
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CallBackMqConfig Request

TDMQ configuration for job callback as 
described in Structure > CallBackMqConfig, 
which is required if  CallBackType  is 
 TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Filename, which is the full name of the file in 
the bucket.

String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

FileHashCodeConfig Request.Operation Hash calculation rule Container Yes

UserData Request.Operation
The user information passed 
through, which is printable ASCII 
codes of up to 1,024 in length.

String No

 FileHashCodeConfig  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Type Request.Operation.FileHashCodeConfig
Hash algorithm. Valid 
values:  MD5 ,  SHA1 , 
 SHA256 

String Yes

AddToHeader Request.Operation.FileHashCodeConfig Whether to add the 
calculated hash value to 
the custom header in the 
file. Valid values: 
 true ,  false  
(default)
The custom header 
varies depending on 
 Type . For example, if 
 Type  is  MD5 , the 
custom header is  x-
cos-meta-md5 .

String No

https://intl.cloud.tencent.com/document/product/1045/49945
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Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/436/7729


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 837
of 2300

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileHashCode</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileHashCodeConfig>

                <Type>MD5</Type>

                <AddToHeader>true</AddToHeader>

            </FileHashCodeConfig>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes: 

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail Error message, which is returned only if  State  is String
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 Failed 

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail
Job type. It is  FileHashCode  for hash calculation 
by default.

String

State Response.JobsDetail

Job status. Valid values:  Submitted  (submitted), 
 Running  (running),  Success  (successful), 
 Failed  (failed),  Pause  (paused),  Cancel  
(canceled)

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue where the job is in String

Input Response.JobsDetail Information about the file for which hash calculation is 
performed

Container

Operation Response.JobsDetail Hash calculation rule Container

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Region Response.JobsDetail.Input Region of the bucket String

Bucket Response.JobsDetail.Input Bucket where the file resides String

Object Response.JobsDetail.Input Name of the file for which hash calculation is 
performed

String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description

UserData Response.JobsDetail.Operation The user information passed through.

FileHashCodeConfig Response.JobsDetail.Operation
Same as 
 Request.Operation.FileHashCodeConfig  
in the request.
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FileHashCodeResult Response.JobsDetail.Operation File hash information obtained, which will not be 
returned when the job is not completed.

 FileHashCodeResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

MD5 Response.JobsDetail.Operation.FileHashCodeResult MD5 calculation result String

SHA1 Response.JobsDetail.Operation.FileHashCodeResult SHA1 calculation 
result

String

SHA256 Response.JobsDetail.Operation.FileHashCodeResult SHA256 calculation 
result

String

FileSize Response.JobsDetail.Operation.FileHashCodeResult File size Int

LastModified Response.JobsDetail.Operation.FileHashCodeResult Time when the file was 
last modified

String

Etag Response.JobsDetail.Operation.FileHashCodeResult File ETag String

Error codes

There are no specific error messages for this request operation. For common error messages, see Error Codes.

Examples

Request

https://intl.cloud.tencent.com/document/product/436/46214
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POST /file_jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>FileHashCode</Tag>

    <Input>

        <Object>input/test.mp4</Object>

    </Input>
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    <Operation>

        <FileHashCodeConfig>

            <Type>MD5</Type>

            <AddToHeader>true</AddToHeader>

        </FileHashCodeConfig>

        <UserData>This is my data.</UserData>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileHashCode</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileHashCodeConfig>

                <Type>MD5</Type>

                <AddToHeader>true</AddToHeader>

            </FileHashCodeConfig>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>
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Querying Hash Calculation Result
Last updated：2024-02-19 16:02:58

Overview

This API is used to query the result of a specified hash calculation job.

Request

Sample request
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GET /file_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API only uses Common Request Headers.

Request body

This request does not have a request body.

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileHashCode</Tag>
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        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileHashCodeConfig>

                <Type>MD5</Type>

                <AddToHeader>true</AddToHeader>

            </FileHashCodeConfig>

            <FileHashCodeResult>

                <MD5>xxxxxxxx</MD5>

                <FileSize>123</FileSize>

                <LastModified>2022-06-27T15:23:11+0800</LastModified>

                <Etag>xxxxxx</Etag>

            </FileHashCodeResult>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

JobsDetail Response Job details Container

NonExistJobIds Response List of non-existing job IDs queried. If all jobs exist, this 
node is not returned.

String

For specific parameter values, see  JobsDetail  in Hash Calculation.

Error codes

No special error message will be returned for this request. For the common error messages, see Error Codes.

Examples

https://intl.cloud.tencent.com/document/product/1045/52867
https://intl.cloud.tencent.com/document/product/1045/33700
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Request

GET /file_jobs/f93984788066911ed89ed352d4d9d2084 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileHashCode</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileHashCodeConfig>

                <Type>MD5</Type>

                <AddToHeader>true</AddToHeader>

            </FileHashCodeConfig>

            <FileHashCodeResult>

                <MD5>xxxxxxxx</MD5>

                <FileSize>123</FileSize>

                <LastModified>2022-06-27T15:23:11+0800</LastModified>

                <Etag>xxxxxx</Etag>

            </FileHashCodeResult>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>
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File Decompression
Submitting File Decompression Job
Last updated：2024-02-19 16:02:57

Overview

This API adopts a POST request method. You can submit a job to perform file decompression and asynchronously 
return decompressed files.

Billing Description

Calling the API will incur file decompression fees and COS read request fees as described in Request Fees.

If the files are stored in COS STANDARD_IA storage class, calling the API will incur STANDARD_IA data retrieval 
fees as described in Data Retrieval Fees.
Decompression is not supported for files stored in the ARCHIVE or DEEP ARCHIVE storage classes. To decompress 
these files, you first need to restore them as instructed in POST Object restore.

Restrictions

Supported file size: Decompression on a file that is less than 5 TB is supported.

File decompression adopts streaming decompression. The system outputs the decompressed files while 
decompressing them. If some files are corrupted during the decompression, the decompression operation stops, and 
some decompressed files are retained.
Calling the API requires a signature. For more information, see Request Signature.
This API can be used in Beijing, Shanghai, Guangzhou, Chengdu, Hong Kong (China), Singapore, and Silicon Valley 
regions.

Request

Sample request

https://intl.cloud.tencent.com/document/product/436/40100
https://intl.cloud.tencent.com/document/product/436/40097
https://intl.cloud.tencent.com/document/product/436/12633
https://intl.cloud.tencent.com/document/product/436/7778
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POST /file_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (For more information, see Request Signature.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/436/7728
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<Request>

    <Tag>FileUncompress</Tag>

    <Input>

        <Object>input/test.zip</Object>

    </Input>

    <Operation>

        <FileUncompressConfig>

            <Prefix>output/</Prefix>

            <PrefixReplaced>1</PrefixReplaced>

        </FileUncompressConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

        </Output>

        <UserData>This is my data.</UserData>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request
Job type. It is  FileUncompress  for file 
decompression by default.

String Yes

Input Request Information about the file to be operated Container Yes

Operation Request File decompression rule. Container Yes

QueueId Request ID of the queue where the job is in String Yes

CallBackFormat Request
Job callback format, which can be  JSON  or 
 XML  (default). It takes priority over that of 
the queue.

String No

CallBackType Request Job callback type, which can be  Url  String No
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(default) or  TDMQ . It takes priority over that 
of the queue.

CallBack Request Job callback address. It takes priority over 
that of the queue.

String No

CallBackMqConfig Request

TDMQ configuration for job callback as 
described in Structure > CallBackMqConfig, 
which is required if  CallBackType  is 
 TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input File name, which is the full name of the file in 
the bucket.

String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

FileUncompressConfig Request.Operation File decompression rule Container Yes

UserData Request.Operation
The user information passed 
through, which is printable ASCII 
codes of up to 1,024 in length.

String No

Output Request.Operation
Information about the bucket 
where the decompressed file is 
stored

Container Yes

 FileUncompressConfig  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Prefix Request.Operation.FileUncompressConfig Prefix of the input file 
after decompression. 
If this parameter is 
left empty, the file is 
stored in the root 
directory of the 
bucket by default.

String No

https://intl.cloud.tencent.com/document/product/1045/49945
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PrefixReplaced Request.Operation.FileUncompressConfig

Whether to replace 
the prefix of the 
directory of the 
decompressed file. 
Valid values:
- 0: No additional 
prefix is added. The 
decompressed files 
are saved in the 
directory specified by 
Prefix (the name of 
the compressed 
package is not 
retained, and the file 
in the compressed 
package is saved to 
the specified directory 
only).
- 1: The name of the 
compressed package 
is used as the prefix. 
The decompressed 
files are saved in the 
directory specified by 
Prefix.
- 2: The full directory 
of the compressed 
package is used as 
the prefix. If Prefix is 
not specified, the file 
is decompressed to 
the current directory 
(including the name 
of the compressed 
package) of the 
compressed 
package.
- Default value: 0

String No

Note: 
Sample:

If the compressed package is named  test.zip , contains the  image.jpg  file, and is stored in the  123  

directory in bucket A, the full directory of the compressed package is  123/test.zip .
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Decompress the package to bucket A with  Prefix  set to  456 . The storage directory of the decompressed file 

varies depending on the value of  PrefixReplaced :


 0 : The  image.jpg  file is stored in the  456  directory and its full directory is  456/image.jpg .


 1 : The  image.jpg  file is stored in the  456  directory with prefix  test  and its full directory is 

 456/test/image.jpg .


 2 : The  image.jpg  file is stored in the  456  directory with prefix  123/test  and its full directory is 

 456/123/test/image.jpg .

 Output  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Bucket where the decompressed 
files are stored

String Yes

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/436/7729
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileUncompress</Tag>
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        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.zip</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileUncompressConfig>

                <Prefix>output/</Prefix>

                <PrefixReplaced>1</PrefixReplaced>

            </FileUncompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes: 

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail
Job type. It is  FileUncompress  for file 
decompression by default.

String
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State Response.JobsDetail Job status. Valid values:  Submitted  (submitted), 
 Running  (running),  Success  (successful), 
 Failed  (failed),  Pause  (paused),  Cancel  
(canceled)

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue where the job is in String

Input Response.JobsDetail Information about the file to be decompressed Container

Operation Response.JobsDetail File decompression rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Region of the bucket String

Bucket Response.JobsDetail.Input Bucket where the file resides String

Object Response.JobsDetail.Input Name of the file to be decompressed String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description

UserData Response.JobsDetail.Operation The user information passed through.

Output Response.JobsDetail.Operation
Same as  Request.Operation.Output  in the
request.

FileUncompressConfig Response.JobsDetail.Operation
Same as 
 Request.Operation.FileUncompressConf

in the request.

FileUncompressResult Response.JobsDetail.Operation File decompression result, which will not be returned
when the job is not completed.

 FileUncompressResult  has the following sub-nodes:

Node Parent Node Description Type
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Name 
(Keyword)

Region Response.JobsDetail.Operation.FileUncompressResult
Region of the bucket 
where the decompressed 
file is stored

String

Bucket Response.JobsDetail.Operation.FileUncompressResult
Bucket where the 
decompressed file is 
stored

String

FileCount Response.JobsDetail.Operation.FileUncompressResult Number of decompressed 
files

String

Error codes

There are no specific error messages for this request operation. For common error messages, see Error Codes.

Examples

Request

https://intl.cloud.tencent.com/document/product/436/46214
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POST /file_jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>FileUncompress</Tag>

    <Input>

        <Object>input/test.zip</Object>

    </Input>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 864
of 2300

    <Operation>

        <FileUncompressConfig>

            <Prefix>output/</Prefix>

            <PrefixReplaced>1</PrefixReplaced>

        </FileUncompressConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

        </Output>

        <UserData>This is my data.</UserData>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileUncompress</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.zip</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileUncompressConfig>

                <Prefix>output/</Prefix>

                <PrefixReplaced>1</PrefixReplaced>

            </FileUncompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>
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Querying File Decompression Result
Last updated：2024-02-19 16:02:57

Overview

This API is used to query the result of a specified file decompression job.

Request

Sample request
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GET /file_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (For more information, see Request Signature.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API only uses Common Request Headers.

Request body

This request does not have a request body.

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileUncompress</Tag>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 871
of 2300

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.zip</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileUncompressConfig>

                <Prefix>output/</Prefix>

                <PrefixReplaced>1</PrefixReplaced>

            </FileUncompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

JobsDetail Response Job details Container

NonExistJobIds Response List of non-existing job IDs queried. If all jobs exist, this node 
is not returned.

String

For specific parameter values, see  JobsDetail  in File Decompression.

Error codes

No special error message will be returned for this request. For the common error messages, see Error Codes.

Examples

Request

https://intl.cloud.tencent.com/document/product/1045/52870
https://intl.cloud.tencent.com/document/product/1045/33700
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GET /file_jobs/f93984788066911ed89ed352d4d9d2084 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileUncompress</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.zip</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileUncompressConfig>

                <Prefix>output/</Prefix>

                <PrefixReplaced>1</PrefixReplaced>

            </FileUncompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>
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Multi-File Zipping
Submitting Multi-File Zipping Job
Last updated：2024-02-19 16:02:57

Overview

The multi-file zipping feature uses a POST request to zip multiple files into a compressed file such as a ZIP file. You 
can submit a job to zip multiple files and asynchronously return the compressed file.  

Billing Description

Calling the API will incur multi-file zipping fees and COS read request fees as described in Request Fees.

If the files are stored in COS STANDARD_IA storage class, calling the API will incur STANDARD_IA data retrieval 
fees as described in Data Retrieval Fees.
Zipping is not supported for files stored in the ARCHIVE or DEEP ARCHIVE storage classes. To zip these files, you 
first need to restore them as instructed in POST Object restore.

Restrictions

Supported file quantity: At most 10,000 files can be zipped.

Supported file size: The total size of the compressed file is less than 50 GB.
Calling the API requires a signature. For more information, see Request Signature.
This API can be used in Beijing, Shanghai, Guangzhou, Chengdu, Hong Kong (China), Singapore, and Silicon Valley 
regions.

Request

Sample request

https://intl.cloud.tencent.com/document/product/436/40100
https://intl.cloud.tencent.com/document/product/436/40097
https://intl.cloud.tencent.com/document/product/436/12633
https://intl.cloud.tencent.com/document/product/436/7778
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POST /file_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (For more information, see Request Signature.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/436/7728
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<Request>

    <Tag>FileCompress</Tag>

    <Operation>

        <FileCompressConfig>

            <Prefix>test/</Prefix>

            <Format>zip</Format>

            <Flatten>0</Flatten>

        </FileCompressConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/test.zip</Object>

        </Output>

        <UserData>This is my data.</UserData>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request
Job type. It is  FileCompress  for multi-file 
zipping by default.

String Yes

Operation Request File zipping rule. Container Yes

QueueId Request ID of the queue where the job is in String Yes

CallBackFormat Request
Job callback format, which can be  JSON  or 
 XML  (default). It takes priority over that of the 
queue.

String No

CallBackType Request
Job callback type, which can be  Url  
(default) or  TDMQ . It takes priority over that of 
the queue.

String No
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CallBack Request Job callback address. It takes higher priority 
over that of the queue.

String No

CallBackMqConfig Request

TDMQ configuration for job callback as 
described in Structure > CallBackMqConfig, 
which is required if  CallBackType  is 
 TDMQ .

Container No

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

FileCompressConfig Request.Operation File zipping rule Container Yes

UserData Request.Operation
The user information passed 
through, which is printable ASCII 
codes of up to 1,024 in length.

String No

Output Request.Operation Address where the compressed file 
is stored

Container Yes

 FileCompressConfig  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type

Flatten Request.Operation.FileCompressConfig

Whether to remove the directory structure of 
the original file during file zipping. Valid 
values:
-  0 : No. After file zipping, the original 
directory structure is retained.
-  1 : Yes. After file zipping, the original 
directory structure is removed and all files 
are at the same level.
Assume that the original file URL is 
 https://domain/source/test.mp4  
and the original file directory is 
 source/test.mp4 . If this parameter is 
set to  1 , the file directory in the ZIP file is 
 test.mp4 . If this parameter is set to 
 0 , the file directory in the ZIP file is 
 source/test.mp4 .

String

https://intl.cloud.tencent.com/document/product/1045/49945
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Format Request.Operation.FileCompressConfig Zipping type. Valid values:  zip ,  tar , 
 tar.gz 

String

UrlList Request.Operation.FileCompressConfig

Files to be zipped can be sorted into an 
index file. The backend zips the files into a 
compressed file according to the file URL 
provided in the index file. The index file must 
be saved in the current bucket, and this field 
must provide the object address of the index 
file, for example,  /test/index.csv .
Index file format: Only CVS files in which one 
URL occupies one row (only files in the 
bucket are supported) are supported. If 
there are multiple columns, the first column 
is used as the URL by default. The number 
of files cannot exceed 10,000 and the total 
size cannot exceed 50 GB. Otherwise, the 
job will fail.

String

Prefix Request.Operation.FileCompressConfig

Files with a specified prefix in the bucket can 
be zipped. To zip files in a specified 
directory, add / to the directory. For 
example, to zip files in the  test  directory, 
set this parameter to  test/ . The number 
of files cannot exceed 10,000 and the total 
size cannot exceed 50 GB. Otherwise, the 
job will fail.

String

Key Request.Operation.FileCompressConfig

Multiple files in the bucket can be zipped. 
The number of files cannot exceed 1,000 
and the total size cannot exceed 50 GB. 
Otherwise, the job will fail.

String 
array

Note: 

Only one of UrlList, Prefix, and Key can be selected. They cannot all be empty or do not take effect at the same time. If 
multiple parameters are specified, the parameter with the highest priority prevails according to the priority UrlList > 
Prefix > Key.
 Output  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Bucket where the compressed file String Yes
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is stored

Object Request.Operation.Output Name of the compressed file String Yes

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/436/7729
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileCompress</Tag>
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        <Operation>

            <FileCompressConfig>

                <Prefix>test/</Prefix>

                <Format>zip</Format>

                <Flatten>0</Flatten>

            </FileCompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/test.zip</Object>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes: 

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail
Job type. It is  FileCompress  for multi-file zipping 
by default.

String

State Response.JobsDetail Job status. Valid values:  Submitted  (submitted), 
 Running  (running),  Success  (successful), 

String
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 Failed  (failed),  Pause  (paused),  Cancel  
(canceled)

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue where the job is in String

Operation Response.JobsDetail Multi-file zipping rule Container

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description

UserData Response.JobsDetail.Operation The user information passed through.

Output Response.JobsDetail.Operation
Same as  Request.Operation.Output  in the 
request.

FileCompressConfig Response.JobsDetail.Operation
Same as 
 Request.Operation.FileCompressConfig  
in the request.

FileCompressResult Response.JobsDetail.Operation Multi-file zipping result, which will not be returned 
when the job is not completed.

 FileCompressResult  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type

Region Response.JobsDetail.Operation.FileCompressResult Region of the bucket where 
the compressed file is stored

String

Bucket Response.JobsDetail.Operation.FileCompressResult Bucket where the 
compressed file is stored

String

Object Response.JobsDetail.Operation.FileCompressResult Name of the compressed file String

Error codes

There are no specific error messages for this request operation. For common error messages, see Error Codes.

https://intl.cloud.tencent.com/document/product/436/46214
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Examples

Request

POST /file_jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml
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<Request>

    <Tag>FileCompress</Tag>

    <Operation>

        <FileCompressConfig>

            <Prefix>test/</Prefix>

            <Format>zip</Format>

            <Flatten>0</Flatten>

        </FileCompressConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/test.zip</Object>

        </Output>

        <UserData>This is my data.</UserData>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileCompress</Tag>

        <Operation>

            <FileCompressConfig>

                <Prefix>test/</Prefix>

                <Format>zip</Format>

                <Flatten>0</Flatten>

            </FileCompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/test.zip</Object>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>
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Querying Multi-File Zipping Result
Last updated：2024-02-19 16:02:57

Overview

This API is used to query the result of a specified multi-file zipping job.

Request

Sample request
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GET /file_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (For more information, see Request Signature.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API only uses Common Request Headers.

Request body

This request does not have a request body.

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileCompress</Tag>
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        <Operation>

            <FileCompressConfig>

                <Prefix>test/</Prefix>

                <Format>zip</Format>

                <Flatten>0</Flatten>

            </FileCompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/test.zip</Object>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

JobsDetail Response Job details Container

NonExistJobIds Response List of non-existing job IDs queried. If all jobs exist, this node 
is not returned.

String

For specific parameter values, see  JobsDetail  in Multi-File Zipping.

Error codes

No special error message will be returned for this request. For the common error messages, see Error Codes.

Examples

Request

https://intl.cloud.tencent.com/document/product/1045/52873
https://intl.cloud.tencent.com/document/product/1045/33700
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GET /file_jobs/f93984788066911ed89ed352d4d9d2084 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileCompress</Tag>

        <Operation>

            <FileCompressConfig>

                <Prefix>test/</Prefix>

                <Format>zip</Format>

                <Flatten>0</Flatten>

            </FileCompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/test.zip</Object>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>
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Job and Workflow
Workflow APIs
Create a workflow
Last updated：2024-02-27 15:15:38

Overview

Create a workflow

Request

Sample request
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POST /workflow HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses Common Request Headers.

Request body

This request requires the following request body:
Request body 1
Request body 2
Screen capturing and transcoding the input video file, performing remuxing and intelligent thumbnail 

generation on the output file, and then performing image processing on the generated thumbnail.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158
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                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>
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                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Request>

Adaptive bitrate streaming
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<Request>

    <MediaWorkflow>

        <Name>workflow-2</Name>

        <State>Active</State>

        <Topology>

            <Dependencies>

                <Start>StreamPackConfig_1581665960532</Start>

                <StreamPackConfig_1581665960532>VideoStream_1581665960536,VideoStre

                <VideoStream_1581665960536>StreamPack_1581665960538</VideoStream_15

                <VideoStream_1581665960537>StreamPack_1581665960538</VideoStream_15

                <StreamPack_1581665960538>End</StreamPack_1581665960538>
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            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>input/workflow-2</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <StreamPackConfig_1581665960532>

                    <Type>StreamPackConfig</Type>

                    <Operation>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${InputPath}/${InputName}._${RunId}.${ext}</Obj

                        </Output>

                        <StreamPackConfig>

                            <PackType>HLS</PackType>

                            <IgnoreFailedStream>true</IgnoreFailedStream>

                        </StreamPackConfig>

                    </Operation>

                </StreamPackConfig_1581665960532>

                <VideoStream_1581665960536>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_1/video.m3u8</Object>

                        </Output>
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                    </Operation>

                </VideoStream_1581665960536>

                <VideoStream_1581665960537>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606bgfdg2148c4ab182f55163ba7bj</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_2/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960537>

                <StreamPack_1581665960538>

                    <Type>StreamPack</Type>

                    <Operation>

                        <StreamPackInfo>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960536</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960537</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                        </StreamPackInfo>

                    </Operation>

                </StreamPack_1581665960538>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

MediaWorkflow Request Workflow node Container Yes

 MediaWorkflow  has the following sub-nodes:
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Node 
Name 
(Keyword)

Parent Node Description Type Required Constraints

Name Request.MediaWorkflow Workflow name String Yes

The value can be 
up to 128 
characters in length 
and contain 
Chinese 
characters, letters, 
digits, dashes (–), 
and underscores 
(_).

State Request.MediaWorkflow Workflow 
status

String No Paused/Active

Topology Request.MediaWorkflow Topology 
information

Container Yes None

 Topology  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Constraint

Dependencies Request.MediaWorkflow.Topology Node 
dependencies.

Container Yes None

Nodes Request.MediaWorkflow.Topology Node list. Container Yes None

 Nodes  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

Start Request.MediaWorkflow.Topology.Nodes Start node Container Supporte

Animation_*** Request.MediaWorkflow.Topology.Nodes
Animated 
image type 
node

Container No

Snapshot_*** Request.MediaWorkflow.Topology.Nodes Screenshot 
type node

Container No
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SmartCover_*** Request.MediaWorkflow.Topology.Nodes
Intelligent 
thumbnail 
node

Container No

Transcode_*** Request.MediaWorkflow.Topology.Nodes
Transcoding 
node Container No

Concat_*** Request.MediaWorkflow.Topology.Nodes Audio/Video 
splicing node

Container No

VoiceSeparate_*** Request.MediaWorkflow.Topology.Nodes
Voice/Sound 
separation 
node

Container No

VideoMontage_*** Request.MediaWorkflow.Topology.Nodes
Video 
montage 
node

Container No

StreamPackConfig_*** Request.MediaWorkflow.Topology.Nodes Adaptive 
bitrate 
streaming 
node

Container No
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VideoStream_*** Request.MediaWorkflow.Topology.Nodes
Video 
substream 
node

Container No

StreamPack_*** Request.MediaWorkflow.Topology.Nodes

Adaptive 
bitrate 
streaming 
packaging 
node

Container No

SDRtoHDR_*** Request.MediaWorkflow.Topology.Nodes
SDR-to-HDR 
node Container No

VideoProcess_*** Request.MediaWorkflow.Topology.Nodes
Video 
processing 
node

Container No

SCF_*** Request.MediaWorkflow.Topology.Nodes
SCF function 
node Container No



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 909
of 2300

SuperResolution_*** Request.MediaWorkflow.Topology.Nodes Super 
resolution 
node

Container No

Segment_*** Request.MediaWorkflow.Topology.Nodes
Audio/Video 
remuxing 
node

Container No

PicProcess_*** Request.MediaWorkflow.Topology.Nodes
Image 
processing 
node

Container No

Tts_*** Request.MediaWorkflow.Topology.Nodes Text-to-
speech node

Container No

SpeechRecognition_*** Request.MediaWorkflow.Topology.Nodes
Speech 
recognition 
node

Container No

VideoEnhance_*** Request.MediaWorkflow.Topology.Nodes
Video 
enhancement 
node

Container No

Condition_*** Request.MediaWorkflow.Topology.Nodes
Conditional 
judgment 
node

Container No

MediaInfo_*** Request.MediaWorkflow.Topology.Nodes Media Container No
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information 
acquisition 
node

AIRecognition_*** Request.MediaWorkflow.Topology.Nodes
AI 
recognition 
node

Container No

SegmentVideoBody_*** Request.MediaWorkflow.Topology.Nodes
Video portrait 
matting node Container No

 Start  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.Start Node type

Input Request.MediaWorkflow.Topology.Nodes.Start
Input information. For more information, see 
Structure > 
MediaWorkflow_Topology_Nodes_Start_Input.

 Animation\\_\\*\\*\\*  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.Animation_*** Node type

Operation Request.MediaWorkflow.Topology.Nodes.Animation_*** Operation rule. For more information, se
MediaWorkflow_Topology_Nodes_Anim

 Snapshot\\_\\*\\*\\*  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.Snapshot_*** Node type

https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49945
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Operation Request.MediaWorkflow.Topology.Nodes.Snapshot_*** Operation rule. For more information, see
MediaWorkflow_Topology_Nodes_Snap

SmartCover_*** has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.SmartCover_*** Node type

Operation Request.MediaWorkflow.Topology.Nodes.SmartCover_*** Operation rule. For more information, s
MediaWorkflow_Topology_Nodes_Sm

Transcode_*** has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.Transcode_*** Node type

Operation Request.MediaWorkflow.Topology.Nodes.Transcode_*** Operation rule. For more information, se
MediaWorkflow_Topology_Nodes_Tra

 Concat\\_\\*\\*\\*  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.Concat_*** Node type

Operation Request.MediaWorkflow.Topology.Nodes.Concat_*** Operation rule. For more information, see S
MediaWorkflow_Topology_Nodes_Concat_

 VoiceSeparate\\_\\*\\*\\*  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.VoiceSeparate_*** Node type

Operation Request.MediaWorkflow.Topology.Nodes.VoiceSeparate_*** Operation rule. For more informatio
MediaWorkflow_Topology_Nodes_

https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49945
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 VideoMontage\\_\\*\\*\\*  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.VideoMontage_*** Node type

Operation Request.MediaWorkflow.Topology.Nodes.VideoMontage_*** Operation rule. For more informatio
MediaWorkflow_Topology_Nodes_

StreamPackConfig_*** has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.StreamPackConfig_*** Node type

Operation Request.MediaWorkflow.Topology.Nodes.StreamPackConfig_*** Operation rule. For more inform
MediaWorkflow_Topology_Nod

 VideoStream\\_\\*\\*\\*  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.VideoStream_*** Node type

Operation Request.MediaWorkflow.Topology.Nodes.VideoStream_*** Operation rule. For more information,
MediaWorkflow_Topology_Nodes_V

StreamPack_*** has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.StreamPack_*** Node type

Operation Request.MediaWorkflow.Topology.Nodes.StreamPack_*** Operation rule. For more information, 
MediaWorkflow_Topology_Nodes_Vi

 SDRtoHDR\\_\\*\\*\\*  has the following sub-nodes:

https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49945
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Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.SDRtoHDR_*** Node type

Operation Request.MediaWorkflow.Topology.Nodes.SDRtoHDR_*** Operation rule. For more information, s
MediaWorkflow_Topology_Nodes_SD

 VideoProcess\\_\\*\\*\\*  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.VideoProcess_*** Node type

Operation Request.MediaWorkflow.Topology.Nodes.VideoProcess_*** Operation rule. For more information
MediaWorkflow_Topology_Nodes_V

 SCF\\_\\*\\*\\*  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.SCF_*** Node type

Operation Request.MediaWorkflow.Topology.Nodes.SCF_*** Operation rule. For more information, see Stru
MediaWorkflow_Topology_Nodes_SCF_***_

 SuperResolution\\_\\*\\*\\*  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.SuperResolution_*** Node type

Operation Request.MediaWorkflow.Topology.Nodes.SuperResolution_*** Operation rule. For more informat
MediaWorkflow_Topology_Nodes

 Segment\\_\\*\\*\\*  has the following sub-nodes:

Node 
Name 

Parent Node Description

https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49945


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 914
of 2300

(Keyword)

Type Request.MediaWorkflow.Topology.Nodes.Segment_*** Node type

Operation Request.MediaWorkflow.Topology.Nodes.Segment_*** Operation rule. For more information, see
MediaWorkflow_Topology_Nodes_Segm

PicProcess_*** has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.PicProcess_*** Node type

Operation Request.MediaWorkflow.Topology.Nodes.PicProcess_*** Operation rule. For more information, s
MediaWorkflow_Topology_Nodes_Pic

Tts_*** has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.Tts_*** Node type

Operation Request.MediaWorkflow.Topology.Nodes.Tts_*** Operation rule. For more information, see Struc
MediaWorkflow_Topology_Nodes_Tts_***_Op

SpeechRecognition_*** has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Type Request.MediaWorkflow.Topology.Nodes.SpeechRecognition_*** Node type

Operation Request.MediaWorkflow.Topology.Nodes.SpeechRecognition_*** Operation rule. For more inform
MediaWorkflow_Topology_No

VideoEnhance_*** has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Requ

https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49945
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Type Request.MediaWorkflow.Topology.Nodes.VideoEnhance_*** Node type String Yes

Operation Request.MediaWorkflow.Topology.Nodes.VideoEnhance_***

Operation 
rule. For 
more 
information, 
see 
Structure.

Container Yes

Condition_*** has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required

Type Request.MediaWorkflow.Topology.Nodes.Condition_*** Node type String Yes

Operation Request.MediaWorkflow.Topology.Nodes.Condition_***

Operation 
rule. For 
more 
information, 
see 
Structure.

Container Yes

MediaInfo_*** has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required

Type Request.MediaWorkflow.Topology.Nodes.MediaInfo_*** Node type String Yes

AIRecognition_*** has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required

Type Request.MediaWorkflow.Topology.Nodes.AIRecognition_*** Node type String Yes

SegmentVideoBody_*** has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type

https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49945
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Type Request.MediaWorkflow.Topology.Nodes.SegmentVideoBody_*** Node type String

Operation Request.MediaWorkflow.Topology.Nodes.SegmentVideoBody_***

Operation 
rule. For 
more 
information, 
see 
Structure.

Container

The dependencies of workflow nodes are as follows:

Workflow Node 
Type

Linkable Node Types

Start Snapshot,Animation,SmartCover,Transcode,Concat,VoiceSeparate,VideoMontage,Stream

Snapshot PicProcess,SCF,End

Animation SCF,End

SmartCover PicProcess,SCF,End

Transcode Snapshot,Animation,SmartCover,Concat,VideoMontage,SDRtoHDR,VideoProcess,SCF,Se

Concat Transcode,Snapshot,Animation,SmartCover,SDRtoHDR,VideoProcess,SCF,Segment,Vide

VoiceSeparate SCF,SpeechRecognition,End

VideoMontage Snapshot,Animation,SDRtoHDR,VideoProcess,SCF,SuperResolution,VideoEnhance,Segm

StreamPackConfig VideoStream

VideoStream StreamPack

StreamPack End

SDRtoHDR Transcode,Concat,VideoMontage,VoiceSeparate,SmartCover,Animation,VideoProcess,SC

VideoProcess Transcode,Concat,VideoMontage,VoiceSeparate,SmartCover,Animation,SDRtoHDR,SCF,

SCF SDRtoHDR,Snapshot,Transcode,Concat,VideoMontage,VoiceSeparate,SmartCover,Anima

SuperResolution VideoMontage,Transcode,SmartCover,Animation,Snapshot,SCF,Segment,SDRtoHDR,Vide

Segment VideoEnhance,SegmentVideoBody, End

PicProcess SCF,End

Tts SCF,Transcode,End

https://intl.cloud.tencent.com/document/product/1045/49945
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SpeechRecognition SCF,Tts,End

VideoEnhance Transcode,VideoMontage,SmartCover,Animation,Snapshot,SCF,Segment,SpeechRecogni

MediaInfo Condition,End

Condition Transcode,HighSpeedHd,SuperResolution,VideoProcess,Animation,Snapshot,VideoMonta

AIRecognition End

SegmentVideoBody End

Wildcards supported by workflow are as follows:

Wildcard Description

${InputPath} Input file path (excluding the filename)

${InputName} Input filename (excluding the extension)

${InputNameAndExt} Input filename (including the extension)

${RunId} Instance ID

${Ext} Codec extension

${Jobid} Job ID

${Number}
Product index counting from 0. It is supported only for  Snapshot , 
 SmartCover , and  Segment  nodes.

${Time} Screenshot time point in milliseconds. It is supported only for the  Snapshot  node.

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:
Response body 1
Response body 2

https://intl.cloud.tencent.com/document/product/1045/49945
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Screen capturing and transcoding the input video file, performing remuxing and intelligent thumbnail 
generation on the output file, and then performing image processing on the generated thumbnail.

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>
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        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>
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                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>
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        </Topology>

    </MediaWorkflow>

</Response>

Adaptive bitrate streaming

<Response>

    <MediaWorkflow>

        <Name>workflow-2</Name>

        <State>Active</State>

        <WorkflowId>w93aa43ba105347169fa093ed857b2a90</WorkflowId>

        <BucketId>test-1234567890</BucketId>
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        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>

        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>StreamPackConfig_1581665960532</Start>

                <StreamPackConfig_1581665960532>VideoStream_1581665960536,VideoStre

                <VideoStream_1581665960536>StreamPack_1581665960538</VideoStream_15

                <VideoStream_1581665960537>StreamPack_1581665960538</VideoStream_15

                <StreamPack_1581665960538>End</StreamPack_1581665960538>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>input/workflow-2</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <StreamPackConfig_1581665960532>

                    <Type>StreamPackConfig</Type>

                    <Operation>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${InputPath}/${InputName}._${RunId}.${ext}</Obj

                        </Output>

                        <StreamPackConfig>

                            <PackType>HLS</PackType>

                            <IgnoreFailedStream>true</IgnoreFailedStream>

                        </StreamPackConfig>

                    </Operation>

                </StreamPackConfig_1581665960532>
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                <VideoStream_1581665960536>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_1/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960536>

                <VideoStream_1581665960537>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606bgfdg2148c4ab182f55163ba7bj</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_2/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960537>

                <StreamPack_1581665960538>

                    <Type>StreamPack</Type>

                    <Operation>

                        <StreamPackInfo>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960536</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960537</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                        </StreamPackInfo>

                    </Operation>

                </StreamPack_1581665960538>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container
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 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RequestId Response Unique ID of the request String

MediaWorkflow Response Workflow array. Container

 MediaWorkflow  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Name Response.MediaWorkflow Workflow name. String

WorkflowId Response.MediaWorkflow Workflow ID String

State Response.MediaWorkflow Workflow status. String

CreateTime Response.MediaWorkflow Creation time. String

UpdateTime Response.MediaWorkflow Update time. String

Topology Response.MediaWorkflow
Topology information, which is the same as 
 Request.MediaWorkflow.Topology  in 
the request.

Container

Error codes

No special error message will be returned for this request. For the common error messages, please see Error Codes.

Examples

Request 1
Response 1
Request 2
Response 2
Screen capturing and transcoding the input video file, performing remuxing and intelligent thumbnail 

generation on the output file, and then performing image processing on the generated thumbnail.

https://intl.cloud.tencent.com/document/product/1045/33700
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POST /workflow HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <Topology>
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            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>
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                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>
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</Request>

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x

<Response>
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    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>

        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>
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                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>
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                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Response>

Adaptive bitrate streaming
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POST /workflow HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <MediaWorkflow>

        <Name>workflow-2</Name>

        <State>Active</State>

        <Topology>
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            <Dependencies>

                <Start>StreamPackConfig_1581665960532</Start>

                <StreamPackConfig_1581665960532>VideoStream_1581665960536,VideoStre

                <VideoStream_1581665960536>StreamPack_1581665960538</VideoStream_15

                <VideoStream_1581665960537>StreamPack_1581665960538</VideoStream_15

                <StreamPack_1581665960538>End</StreamPack_1581665960538>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>input/workflow-2</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <StreamPackConfig_1581665960532>

                    <Type>StreamPackConfig</Type>

                    <Operation>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${InputPath}/${InputName}._${RunId}.${ext}</Obj

                        </Output>

                        <StreamPackConfig>

                            <PackType>HLS</PackType>

                            <IgnoreFailedStream>true</IgnoreFailedStream>

                        </StreamPackConfig>

                    </Operation>

                </StreamPackConfig_1581665960532>

                <VideoStream_1581665960536>

                    <Type>VideoStream</Type>

                    <Operation>
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                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_1/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960536>

                <VideoStream_1581665960537>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606bgfdg2148c4ab182f55163ba7bj</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_2/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960537>

                <StreamPack_1581665960538>

                    <Type>StreamPack</Type>

                    <Operation>

                        <StreamPackInfo>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960536</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960537</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                        </StreamPackInfo>

                    </Operation>

                </StreamPack_1581665960538>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Request>
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf95s=

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf95s=</RequestId>

    <MediaWorkflow>
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        <Name>workflow-2</Name>

        <State>Active</State>

        <WorkflowId>w93aa43ba105347169fa093ed857b2a90</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>

        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>StreamPackConfig_1581665960532</Start>

                <StreamPackConfig_1581665960532>VideoStream_1581665960536,VideoStre

                <VideoStream_1581665960536>StreamPack_1581665960538</VideoStream_15

                <VideoStream_1581665960537>StreamPack_1581665960538</VideoStream_15

                <StreamPack_1581665960538>End</StreamPack_1581665960538>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>input/workflow-2</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <StreamPackConfig_1581665960532>

                    <Type>StreamPackConfig</Type>

                    <Operation>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${InputPath}/${InputName}._${RunId}.${ext}</Obj

                        </Output>

                        <StreamPackConfig>

                            <PackType>HLS</PackType>
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                            <IgnoreFailedStream>true</IgnoreFailedStream>

                        </StreamPackConfig>

                    </Operation>

                </StreamPackConfig_1581665960532>

                <VideoStream_1581665960536>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_1/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960536>

                <VideoStream_1581665960537>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606bgfdg2148c4ab182f55163ba7bj</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_2/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960537>

                <StreamPack_1581665960538>

                    <Type>StreamPack</Type>

                    <Operation>

                        <StreamPackInfo>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960536</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960537</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                        </StreamPackInfo>

                    </Operation>

                </StreamPack_1581665960538>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Response>
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Querying Workflow
Last updated：2024-02-27 15:15:38

Feature Description

This API is used to query a workflow.

Request

Sample request
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GET /workflow HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Request parameters

Parameter 
(Keyword)

Description Type Required

ids Workflow ID. If you enter multiple IDs, separate them by 
comma.

string No

name Workflow name string No

pageNumber Page number. string No

pageSize Number of entries per page. string No

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <RequestId>NjJmMWZiZTFfOTBmYTUwNjRfNjVmNl8x</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <MediaWorkflowList>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>
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        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>
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                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>
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        </Topology>

    </MediaWorkflowList>

    <MediaWorkflowList>

        <Name>workflow-2</Name>

        <State>Active</State>

        <WorkflowId>w93aa43ba105347169fa093ed857b2a90</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>StreamPackConfig_1581665960532</Start>

                <StreamPackConfig_1581665960532>VideoStream_1581665960536,VideoStre

                <VideoStream_1581665960536>StreamPack_1581665960538</VideoStream_15

                <VideoStream_1581665960537>StreamPack_1581665960538</VideoStream_15

                <StreamPack_1581665960538>End</StreamPack_1581665960538>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>input/workflow-2</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <StreamPackConfig_1581665960532>

                    <Type>StreamPackConfig</Type>

                    <Operation>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${InputPath}/${InputName}._${RunId}.${ext}</Obj
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                        </Output>

                        <StreamPackConfig>

                            <PackType>HLS</PackType>

                            <IgnoreFailedStream>true</IgnoreFailedStream>

                        </StreamPackConfig>

                    </Operation>

                </StreamPackConfig_1581665960532>

                <VideoStream_1581665960536>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_1/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960536>

                <VideoStream_1581665960537>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606bgfdg2148c4ab182f55163ba7bj</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_2/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960537>

                <StreamPack_1581665960538>

                    <Type>StreamPack</Type>

                    <Operation>

                        <StreamPackInfo>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960536</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960537</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                        </StreamPackInfo>

                    </Operation>

                </StreamPack_1581665960538>

            </Nodes>

        </Topology>

    </MediaWorkflowList>
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</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

RequestId Response Unique ID of the request. String

TotalCount Response Total number of workflows Int

PageNumber Response
Current page number, which is the same as 
 pageNumber  in the request. Int

PageSize Response
Number of entries per page, which is the same as 
 pageSize  in the request. Int

MediaWorkflowList Response Workflow array Container

 MediaWorkflowList  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Constraints

Name Response.MediaWorkflowList Workflow 
name.

String Yes

The value can 
contain up to 
128 letters, 
digits, hyphens, 
and 
underscores.

WorkflowId Response.MediaWorkflowList Workflow ID String Yes Unique 
workflow ID

State Response.MediaWorkflowList Workflow 
status

String Yes 1. Active
2. Paused

CreateTime Response.MediaWorkflowList Creation 
time

String Yes None

UpdateTime Response.MediaWorkflowList Update time String Yes None
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Topology Response.MediaWorkflowList Topology 
information

Container Yes Same as 
Topology in the 
workflow 
creation API.﻿

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request 1: Workflow ID

https://intl.cloud.tencent.com/document/product/1045/43733
https://intl.cloud.tencent.com/document/product/1045/49353
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GET /workflow?ids=wc666d0b9f9dd47ae9137a096252d49f7,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response 1
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

        <MediaWorkflowList>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 950
of 2300

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>
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                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>
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                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflowList>

    <NonExistIDs>A</NonExistIDs>

    <NonExistIDs>B</NonExistIDs>

</Response>

Request 2: Workflow list
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GET /workflow?pageNumber=1&pageSize=10 HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response 2
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TotalCount>2</TotalCount>
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    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <MediaWorkflowList>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>
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                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>
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                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflowList>

    <MediaWorkflowList>

        <Name>workflow-2</Name>

        <State>Active</State>

        <WorkflowId>w93aa43ba105347169fa093ed857b2a90</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>StreamPackConfig_1581665960532</Start>

                <StreamPackConfig_1581665960532>VideoStream_1581665960536,VideoStre

                <VideoStream_1581665960536>StreamPack_1581665960538</VideoStream_15

                <VideoStream_1581665960537>StreamPack_1581665960538</VideoStream_15

                <StreamPack_1581665960538>End</StreamPack_1581665960538>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>input/workflow-2</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>
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                </Start>

                <StreamPackConfig_1581665960532>

                    <Type>StreamPackConfig</Type>

                    <Operation>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${InputPath}/${InputName}._${RunId}.${ext}</Obj

                        </Output>

                        <StreamPackConfig>

                            <PackType>HLS</PackType>

                            <IgnoreFailedStream>true</IgnoreFailedStream>

                        </StreamPackConfig>

                    </Operation>

                </StreamPackConfig_1581665960532>

                <VideoStream_1581665960536>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_1/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960536>

                <VideoStream_1581665960537>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606bgfdg2148c4ab182f55163ba7bj</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_2/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960537>

                <StreamPack_1581665960538>

                    <Type>StreamPack</Type>

                    <Operation>

                        <StreamPackInfo>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960536</VideoSt

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960537</VideoSt
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                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                        </StreamPackInfo>

                    </Operation>

                </StreamPack_1581665960538>

            </Nodes>

        </Topology>

    </MediaWorkflowList>

</Response>
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Deleting Workflow
Last updated：2024-02-27 15:15:38

Feature Description

This API is used to delete a workflow.

Request

Sample request
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DELETE /workflow/<WorkflowId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 962
of 2300

When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

    <WorkflowId>A</WorkflowId>

<Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container
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 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RequestId Response Unique ID of the request String

WorkflowId Response ID of the deleted workflow String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353
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DELETE /workflow/we59a9648e62e48ffb25e4b41f3721799 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

    <WorkflowId>we59a9648e62e48ffb25e4b41f3721799</WorkflowId>
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<Response>
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Updating Workflow
Last updated：2024-02-27 15:15:38

Feature Description

This API is used to update a workflow.

Request

Sample request
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PUT /workflow/<WorkflowId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body: 

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>
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                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>25</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>
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                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Request>

The nodes are described as follows:

Node 
Name 
(Keyword)

Parent Node Description Type Required

Request None Same as Request in the workflow creation API.﻿ Container Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43733
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>

        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>

        <Topology>

            <Dependencies>
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                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>
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                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>25</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Response>
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The nodes are as described below:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Response None Same as Response in the workflow creation 
API.﻿

Container Yes

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request 1: Updating the workflow configuration

https://intl.cloud.tencent.com/document/product/1045/43733
https://intl.cloud.tencent.com/document/product/1045/49353
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PUT /workflow/wc666d0b9f9dd47ae9137a096252d49f7 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <Topology>
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            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>
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                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>25</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Request>
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Response 1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x

<Response>
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    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>

        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15816659

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_158

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>
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                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</Spr

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>25</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>
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                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Response>

Request 2: Disabling a workflow
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PUT /workflow/wc666d0b9f9dd47ae9137a096252d49f7?paused HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Response 2
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HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWRiMDlfOTBmYTUwNjRfNWYzMl80

Request 3: Enabling a workflow
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PUT /workflow/wc666d0b9f9dd47ae9137a096252d49f7?active HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Response 3
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HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWRiMDlfOTBmYTUwNjRfNWYzMl80
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Testing Workflow
Last updated：2024-02-27 15:15:38

Feature Description

This API is used to test a workflow.

Request

Sample request
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POST /triggerworkflow?workflowId=xxx&object=xxx HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 991
of 2300

When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request parameters

Field Description Type Required

workflowId ID of the workflow to trigger String Yes

object Name of the object that requires workflow processing, which needs 
to be URL-encoded.

String Yes

name Batch data processing job name, which can contain up to 128 letters, 
digits, hyphens, and underscores and is empty by default

String No

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

    <InstanceId>i6fc78ca77d6011eba0ac5254008618d9=</InstanceId>

<Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container
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 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RequestId Response Unique ID of the request String

InstanceId Response Instance ID String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 994
of 2300

POST /triggerworkflow?workflowId=we59a9648e62e48ffb25e4b41f3721799&object=test.mp4 

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

    <InstanceId>i6fc78ca77d6011eba0ac5254008618d9=</InstanceId>
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<Response>
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Workflow Callback
Last updated：2024-02-27 15:15:38

Feature Description

CI supports user-defined callback URLs. With a workflow enabled, after each instance is executed, the system sends 
an HTTP POST request with the body containing notification content to a user-defined callback URL. You can use the 
configured callback URL to learn about the processing progress and status of the workflow instance so that you can 

perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>WorkflowFinish</EventName>

    <WorkflowExecution>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <WorkflowName>workflow-3</WorkflowName>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <State>Success</State>

        <BucketId>test-1234567890</BucketId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09 14:54:17+0800</CreateTime>

        <CosHeaders>
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            <Key>Content-Type</Key>

            <Value>video/mp4</Value>

        </CosHeaders>

        <CosHeaders>

            <Key>x-cos-request-id</Key>

            <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

        </CosHeaders>

        <Tasks>

            <Type>Snapshot</Type>

            <CreateTime>2022-08-09 14:54:40+0800</CreateTime>

            <EndTime>2022-08-09 14:54:42+0800</EndTime>

            <State>Success</State>

            <JobId>j23c11e1e17b011edaab4ab15ec33d076</JobId>

            <Name>Snapshot_1581665960536</Name>

            <TemplateId>t07740e32081b44ad7a0aea03adcffd54a</TemplateId>

            <TemplateName>snapshot_1280*720_3</TemplateName>

        </Tasks>

        <Tasks>

            <Type>Transcode</Type>

            <CreateTime>2022-08-09 14:54:18+0800</CreateTime>

            <EndTime>2022-08-09 14:54:39+0800</EndTime>

            <State>Success</State>

            <JobId>j168668b217b011ed8efb27bb229e2d11</JobId>

            <Name>Transcode_1581665960537</Name>

            <TemplateId>t01e57db1c2d154d2fb57aa5de9313a897</TemplateId>

            <TemplateName>MP4-265-SD</TemplateName>

        </Tasks>

    </WorkflowExecution>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response Fixed value:  WorkflowFinish . String

WorkflowExecution Response Workflow details Container

 WorkflowExecution  has the following sub-nodes:

Node Name Parent Node Description Type
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(Keyword)

WorkflowId Response.WorkflowExecution Workflow ID String

WorkflowName Response.WorkflowExecution Workflow name String

RunId Response.WorkflowExecution Workflow instance ID String

State Response.WorkflowExecution

Instance status. The value can be 
 Success  or  Failed . As long as one 
job is in  Failed  status, the instance is 
regarded as  Failed .

String

BucketId Response.WorkflowExecution Bucket of the processed file String

Object Response.WorkflowExecution Name of the file processed by the instance String

CreateTime Response.WorkflowExecution Instance creation time String

CosHeaders Response.WorkflowExecution
List of custom headers configured during 
object upload. If no list is configured, this 
node will not be included.

Container 
array

Tasks Response.WorkflowExecution Job information list Container 
array

 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.WorkflowExecution.CosHeaders Name of the custom header String

Value Response.WorkflowExecution.CosHeaders Value of the custom header String

 Tasks  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Type Response.WorkflowExecution.Tasks Job type String

Createtime Response.WorkflowExecution.Tasks Job creation time String

StartTime Response.WorkflowExecution.Tasks Job start time String

EndTime Response.WorkflowExecution.Tasks Job end time String
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State Response.WorkflowExecution.Tasks Job status. Valid values: 
 Success ,  Failed .

String

JobId Response.WorkflowExecution.Tasks Job ID String

Name Response.WorkflowExecution.Tasks Name of the job node in the workflow String

TemplateId Response.WorkflowExecution.Tasks Job template ID String

TemplateName Response.WorkflowExecution.Tasks Job template name String

Samples

Sample 1 (XML)
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<Response>

    <EventName>WorkflowFinish</EventName>

    <WorkflowExecution>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <WorkflowName>workflow-3</WorkflowName>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <State>Success</State>

        <BucketId>test-1234567890</BucketId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09 14:54:17+0800</CreateTime>

        <CosHeaders>
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            <Key>Content-Type</Key>

            <Value>video/mp4</Value>

        </CosHeaders>

        <CosHeaders>

            <Key>x-cos-request-id</Key>

            <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

        </CosHeaders>

        <Tasks>

            <Type>Snapshot</Type>

            <CreateTime>2022-08-09 14:54:40+0800</CreateTime>

            <EndTime>2022-08-09 14:54:42+0800</EndTime>

            <State>Success</State>

            <JobId>j23c11e1e17b011edaab4ab15ec33d076</JobId>

            <Name>Snapshot_1581665960536</Name>

            <TemplateId>t07740e32081b44ad7a0aea03adcffd54a</TemplateId>

            <TemplateName>snapshot_1280*720_3</TemplateName>

        </Tasks>

        <Tasks>

            <Type>Transcode</Type>

            <CreateTime>2022-08-09 14:54:18+0800</CreateTime>

            <EndTime>2022-08-09 14:54:39+0800</EndTime>

            <State>Success</State>

            <JobId>j168668b217b011ed8efb27bb229e2d11</JobId>

            <Name>Transcode_1581665960537</Name>

            <TemplateId>t01e57db1c2d154d2fb57aa5de9313a897</TemplateId>

            <TemplateName>MP4-265-SD</TemplateName>

        </Tasks>

    </WorkflowExecution>

</Response>

Sample 2 (JSON)
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{

    "EventName": "WorkflowFinish",

    "WorkflowExecution": {

        "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

        "WorkflowName": "workflow-3",

        "RunId": "i166ee19017b011eda8a5525400c540df",

        "State": "Success",

        "BucketId": "test-1234567890",

        "Object": "wk-test/game.mp4",

        "CreateTime": "2022-08-09 14:54:17+0800",

        "CosHeaders": [{
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                "Key": "Content-Type",

                "Value": "video/mp4"

            },

            {

                "Key": "x-cos-request-id",

                "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

            }

        ],

        "Tasks": [{

                "Type": "Snapshot",

                "CreateTime": "2022-08-09 14:54:40+0800",

                "EndTime": "2022-08-09 14:54:42+0800",

                "State": "Success",

                "JobId": "j23c11e1e17b011edaab4ab15ec33d076",

                "Name": "Snapshot_1581665960536",

                "TemplateId": "t07740e32081b44ad7a0aea03adcffd54a",

                "TemplateName": "snapshot_1280*720_3"

            },

            {

                "Type": "Transcode",

                "CreateTime": "2022-08-09 14:54:18+0800",

                "EndTime": "2022-08-09 14:54:39+0800",

                "State": "Success",

                "JobId": "j168668b217b011ed8efb27bb229e2d11",

                "Name": "Transcode_1581665960537",

                "TemplateId": "t01e57db1c2d154d2fb57aa5de9313a897",

                "TemplateName": "MP4-265-SD"

            }

        ]

    }

}
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Workflow Instance
Getting Workflow Instance Details
Last updated：2024-02-27 15:15:38

Feature Description

This API is used to get the details of a workflow instance.

Request

Sample request
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GET /workflowexecution/<RunId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <RequestId>NjJmMjA5MjZfZWM0YTYyNjRfN2U3ZF8yNzk1</RequestId>

    <WorkflowExecution>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Name>workflow-1</Name>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <CreateTime>2022-08-09T14:54:17+08:00</CreateTime>

        <Object>wk-test/game.mp4</Object>

        <State>Success</State>

        <Topology>

            <Dependencies>
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                <Start>Transcode_1581665960537</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960537>Snapshot_1581665960536</Transcode_15816659

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>/wk-test</ObjectPrefix>

                        <ExtFilter>

                            <State>On</State>

                            <Video>false</Video>

                            <Audio>false</Audio>

                            <ContentType>false</ContentType>

                            <Custom>true</Custom>

                            <CustomExts>mp4</CustomExts>

                            <AllFile>false</AllFile>

                            <Image>false</Image>

                        </ExtFilter>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t07740e32081b44ad7a0aea03adcffd54a</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>snapshot-${number}.jpg</Object>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960537>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t01e57db1c2d154d2fb57aa5de9313a897</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>trans1.mp4</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960537>

            </Nodes>

        </Topology>
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        <Tasks>

            <Type>Snapshot</Type>

            <JobId>j23c11e1e17b011edaab4ab15ec33d076</JobId>

            <CreateTime>2022-08-09T14:54:40+08:00</CreateTime>

            <Name>Snapshot_1581665960536</Name>

            <State>Success</State>

            <StartTime>2022-08-09T14:54:40+08:00</StartTime>

            <EndTime>2022-08-09T14:54:42+08:00</EndTime>

            <Code>Success</Code>

            <Message></Message>

        </Tasks>

        <Tasks>

            <Type>Transcode</Type>

            <JobId>j168668b217b011ed8efb27bb229e2d11</JobId>

            <CreateTime>2022-08-09T14:54:18+08:00</CreateTime>

            <Name>Transcode_1581665960537</Name>

            <State>Success</State>

            <StartTime>2022-08-09T14:54:18+08:00</StartTime>

            <EndTime>2022-08-09T14:54:39+08:00</EndTime>

            <Code>Success</Code>

            <Message>success</Message>

        </Tasks>

    </WorkflowExecution>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RequestId Response Request ID String

WorkflowExecution Response Workflow instance 
details

Container

 WorkflowExecution  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

WorkflowId Response.WorkflowExecution Workflow ID String



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1012
of 2300

WorkflowName Response.WorkflowExecution Workflow name String

RunId Response.WorkflowExecution Workflow instance ID String

CreateTime Response.WorkflowExecution Creation time String

Object Response.WorkflowExecution COS object address String

State Response.WorkflowExecution Workflow instance status String

Topology Response.WorkflowExecution Same as Topology in the workflow 
creation API.﻿

Container

Tasks Response.WorkflowExecution Workflow instance job Container 
array

 Tasks  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Type Response.WorkflowExecution.Tasks Job node type String

State Response.WorkflowExecution.Tasks Job status String

JobId Response.WorkflowExecution.Tasks Job ID String

CreateTime Response.WorkflowExecution.Tasks Job creation time String

StartTime Response.WorkflowExecution.Tasks Job start time String

EndTime Response.WorkflowExecution.Tasks Job end time String

Code Response.WorkflowExecution.Tasks Job error code String

Message Response.WorkflowExecution.Tasks Job error message String

Name Response.WorkflowExecution.Tasks Workflow node name String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/43733
https://intl.cloud.tencent.com/document/product/1045/33700
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GET /workflowexecution/i166ee19017b011eda8a5525400c540df HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjJmMjA5MjZfZWM0YTYyNjRfN2U3ZF8yNzk1</RequestId>

    <WorkflowExecution>
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        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Name>workflow-1</Name>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <CreateTime>2022-08-09T14:54:17+08:00</CreateTime>

        <Object>wk-test/game.mp4</Object>

        <State>Success</State>

        <Topology>

            <Dependencies>

                <Start>Transcode_1581665960537</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960537>Snapshot_1581665960536</Transcode_15816659

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>/wk-test</ObjectPrefix>

                        <ExtFilter>

                            <State>On</State>

                            <Video>false</Video>

                            <Audio>false</Audio>

                            <ContentType>false</ContentType>

                            <Custom>true</Custom>

                            <CustomExts>mp4</CustomExts>

                            <AllFile>false</AllFile>

                            <Image>false</Image>

                        </ExtFilter>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicPr

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t07740e32081b44ad7a0aea03adcffd54a</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>snapshot-${number}.jpg</Object>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960537>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t01e57db1c2d154d2fb57aa5de9313a897</TemplateId>

                        <Output>
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                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>trans1.mp4</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960537>

            </Nodes>

        </Topology>

        <Tasks>

            <Type>Snapshot</Type>

            <JobId>j23c11e1e17b011edaab4ab15ec33d076</JobId>

            <CreateTime>2022-08-09T14:54:40+08:00</CreateTime>

            <Name>Snapshot_1581665960536</Name>

            <State>Success</State>

            <StartTime>2022-08-09T14:54:40+08:00</StartTime>

            <EndTime>2022-08-09T14:54:42+08:00</EndTime>

            <Code>Success</Code>

            <Message></Message>

        </Tasks>

        <Tasks>

            <Type>Transcode</Type>

            <JobId>j168668b217b011ed8efb27bb229e2d11</JobId>

            <CreateTime>2022-08-09T14:54:18+08:00</CreateTime>

            <Name>Transcode_1581665960537</Name>

            <State>Success</State>

            <StartTime>2022-08-09T14:54:18+08:00</StartTime>

            <EndTime>2022-08-09T14:54:39+08:00</EndTime>

            <Code>Success</Code>

            <Message>success</Message>

        </Tasks>

    </WorkflowExecution>
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Getting Workflow Instance List
Last updated：2024-02-27 15:15:38

Feature Description

This API is used to get the list of workflow instances.

Request

Sample request
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GET /workflowexecution HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Request parameters

Parameter 
(Keyword)

Description Type Required

workflowId Workflow ID String Yes

name Filename String No

orderByTime  Desc  (default) or  Asc  String No

size
Maximum number of jobs that can be pulled. The default value is 
 10 . The maximum value is  100 . String No

states

Workflow instance status. If you enter multiple statuses, separate 
them by comma.
 Valid values:  All ,  Success ,  Failed ,  Running , 
 Cancel . Default value:  All .

String No

startCreationTime
Start time of the time range for job pulling in the format of  %Y-
%m-%dT%H:%m:%S%z 

String No

endCreationTime
End time of the time range for job pulling in the format of  %Y-
%m-%dT%H:%m:%S%z 

String No

nextToken Context token for pagination String No

jobId Batch data processing job ID, which is used to scan the workflow 
instance executed accordingly.

String No

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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Response body

The response body returns application/xml data. The following contains all the nodes:

<Response>

    <RequestId>NjJmMjEyMmFfZWM0YTYyNjRfN2U2NV8yNmI0</RequestId>

    <WorkflowExecutionList>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09T14:54:17+08:00</CreateTime>

        <State>Success</State>
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    </WorkflowExecutionList>

    <WorkflowExecutionList>

        <RunId>i769bd26517af11ed917f525400a3c59f</RunId>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09T14:49:49+08:00</CreateTime>

        <State>Success</State>

    </WorkflowExecutionList>

    <NextToken>115716</NextToken>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

WorkflowExecutionList Response Workflow instance 
details

Container

RequestId Response Request ID String

NextToken Response Context token for 
pagination

String

 WorkflowExecutionList  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.WorkflowExecutionList Workflow instance 
ID

String

WorkflowId Response.WorkflowExecutionList Workflow ID String

State Response.WorkflowExecutionList Workflow instance 
status

String

CreateTime Response.WorkflowExecutionList Creation time String

Object Response.WorkflowExecutionList COS object 
address

String

Error codes
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There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

GET /workflowexecution?workflowId=web6ac56c1ef54dbfa44d7f4103203be9 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

https://intl.cloud.tencent.com/document/product/1045/33700
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Response

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMjEyMmFfZWM0YTYyNjRfN2U2NV8yNmI0
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<Response>

    <RequestId>NjJmMjEyMmFfZWM0YTYyNjRfN2U2NV8yNmI0</RequestId>

    <WorkflowExecutionList>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09T14:54:17+08:00</CreateTime>

        <State>Success</State>

    </WorkflowExecutionList>

    <WorkflowExecutionList>

        <RunId>i769bd26517af11ed917f525400a3c59f</RunId>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09T14:49:49+08:00</CreateTime>

        <State>Success</State>

    </WorkflowExecutionList>

    <NextToken>115716</NextToken>

</Response>
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Job APIs
Media Processing
Submitting Media Processing Job
Submitting Video-to-Animated Image
Conversion Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit an animated image job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>Animation</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.gif</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Tag Request Job type: Animation String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request
Job callback format, which can be  JSON  
or  XML  (default value). It has a higher 
priority than that of the queue.

String No

CallBackType Request Job callback type, which can be  Url  
(default value) or  TDMQ . It has a higher 
priority than that of the queue.

String No
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CallBack Request

Job callback address, which has a higher 
priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

String No

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required if 
 CallBackType  is  TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Media filename String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Animation Request.Operation Job type parameter Container No

TemplateId Request.Operation Template ID String No

Output Request.Operation Result output address Container Yes

UserData Request.Operation
The user information passed through, which 
is printable ASCII codes of up to 1,024 in 
length.

String No

JobLevel Request.Operation
Job priority. The greater the value, the 
higher the priority. Valid values:  0 ,  1 , 
 2 . Default value:  0 .

String No

Note: 

 TemplateId  is used first. If  TemplateId  is unavailable,  Animation  is used.

 Animation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Container Request.Operation.Animation Same as Request.Container in 
the animated image template 

Container No

https://intl.cloud.tencent.com/document/product/1045/49945
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creation API 
CreateMediaTemplate.

Video Request.Operation.Animation

Same as Request.Video in the 
animated image template 
creation API 
CreateMediaTemplate.

Container No

TimeInterval Request.Operation.Animation

Same as Request.TimeInterval in 
the animated image template 
creation API 
CreateMediaTemplate.

Container No

 Output  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output Output result filename String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49906
https://intl.cloud.tencent.com/document/product/1045/49906
https://intl.cloud.tencent.com/document/product/1045/49906
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Animation</Tag>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>animation_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job type: Animation String

State Response.JobsDetail Job status. Valid values:  Submitted , String
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 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

TemplateId Response.JobsDetail.Operation Job template ID String

TemplateName Response.JobsDetail.Operation
Job template name, which will be returned 
if  TemplateId  exists. String

Animation Response.JobsDetail.Operation
Same as 
 Request.Operation.Animation  
in the request.

Container

Output Response.JobsDetail.Operation
Same as 
 Request.Operation.Output  in 
the request.

Container

MediaInfo Response.JobsDetail.Operation
Media information of the output file, which 
will not be returned when the job is not 
completed.

Container
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MediaResult Response.JobsDetail.Operation Basic information of the output file, which 
will not be returned when the job is not 
completed.

Container

UserData Response.JobsDetail.Operation The user information passed through. String

JobLevel Response.JobsDetail.Operation Job priority String

 MediaInfo  has the following sub-nodes:


Same as the  Response.MediaInfo  node in the GenerateMediaInfo API.

 MediaResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

OutputFile Response.Operation.MediaResult Basic information of the 
output file.

Container

 OutputFile  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Bucket Response.Operation.MediaResult.OutputFile Bucket of the output file. String

Region Response.Operation.MediaResult.OutputFile Bucket region of the 
output file.

String

ObjectName Response.Operation.MediaResult.OutputFile Output filename. There 
may be multiple values.

String array

Md5Info Response.Operation.MediaResult.OutputFile MD5 information of the 
output file.

Container 
array

 Md5Info  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info Output filename. String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info MD5 value of the 
output file.

Container

Error codes

https://intl.cloud.tencent.com/document/product/1045/48569
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There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Using the animated image template ID

Request

POST /jobs HTTP/1.1

https://intl.cloud.tencent.com/document/product/1045/33700
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Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Animation</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.gif</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Animation</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>animation_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

Using the animated image processing parameter

Request
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POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Animation</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>
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    <Operation>

        <Animation>

            <Container>

                <Format>gif</Format>

            </Container>

            <Video>

                <Codec>gif</Codec>

                <Width>1280</Width>

                <Height>960</Height>

                <Fps>15</Fps>

                <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

            </Video>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </Animation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.gif</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:12+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Animation</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Animation>

                <Container>

                    <Format>gif</Format>

                </Container>

                <Video>

                    <Codec>gif</Codec>

                    <Width>1280</Width>

                    <Height>960</Height>

                    <Fps>15</Fps>

                    <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

                </Video>

                <TimeInterval>

                    <Start>0</Start>

                    <Duration>60</Duration>

                </TimeInterval>

            </Animation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Submitting Video Splicing Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit a splicing job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>Concat</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job tag: Concat String Yes

Input Request Information of the media file to be processed Container No

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request
Job callback format, which can be  JSON  or 
 XML  (default value). It has a higher priority 
than that of the queue.

String No

CallBackType Request Job callback type, which can be  Url  
(default value) or  TDMQ . It has a higher 
priority than that of the queue.

String No
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CallBack Request

Job callback address, which has a higher 
priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

String No

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required if 
 CallBackType  is  TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Media filename String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

ConcatTemplate Request.Operation Splicing parameter. Container No

TemplateId Request.Operation Template ID String No

Output Request.Operation Result output address Container Yes

JobLevel Request.Operation
Job priority. The greater the value, the 
higher the priority. Valid values:  0 , 
 1 ,  2 . Default value:  0 .

String No

Note: 

 TemplateId  is used first. If  TemplateId  is unavailable,  ConcatTemplate  is used.

 ConcatTemplate  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

ConcatFragment Request.Operation.ConcatTemplate Splicing node
Container 
array

Audio Request.Operation.ConcatTemplate Audio parameter. Same as 
Request.ConcatTemplate.Audio in 

Container

https://intl.cloud.tencent.com/document/product/1045/49945
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the splicing template creation API 
CreateMediaTemplate.

Video Request.Operation.ConcatTemplate

Video parameter. Same as 
Request.ConcatTemplate.Video in 
the splicing template creation API 
CreateMediaTemplate.

Container

Container Request.Operation.ConcatTemplate

Container format. Same as 
Request.ConcatTemplate.Container 
in the splicing template creation API 
CreateMediaTemplate.

Container

AudioMix Request.Operation.ConcatTemplate
Audio mix parameter as described 
in Structure.

Container 
array

Index Request.Operation.ConcatTemplate
Index of the Input node in the 
ConcatFragment sequence String

DirectConcat Request.Operation.ConcatTemplate
Simple splicing (without 
transcoding). Other video and audio 
parameters become invalid.

String

 ConcatFragment  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Default 
Value

Constraints

Url
Request.Operation.

ConcatTemplate.

ConcatFragment

Splicing 
object 
address

String Yes None

Same as the 
address of 
the bucket 
object file.

FragmentIndex
Request.Operation.

ConcatTemplate.

ConcatFragment

Index 
position of 
the spliced 
object

String No 0
An integer 
greater than 
or equal to 0

StartTime Request.Operation.
 Start time String No Video [0, video 

https://intl.cloud.tencent.com/document/product/1045/49907
https://intl.cloud.tencent.com/document/product/1045/49907
https://intl.cloud.tencent.com/document/product/1045/49907
https://intl.cloud.tencent.com/document/product/1045/49945
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ConcatTemplate.

ConcatFragment

start time duration]
Unit: Second

EndTime
Request.Operation.

ConcatTemplate.

ConcatFragment

End time String No
Video 
end time

[0, video 
duration]
Unit: Second

 Output  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output Output result filename String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Concat</Tag>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>concat_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job tag: Concat String

State Response.JobsDetail Job status. Valid values:  Submitted , String
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 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

TemplateId Response.JobsDetail.Operation Job template ID String

TemplateName Response.JobsDetail.Operation
Job template name, which will be returned if 
 TemplateId  exists. String

ConcatTemplate Response.JobsDetail.Operation
Same as 
 Request.Operation.ConcatTemplate  
in the request.

Conta

Output Response.JobsDetail.Operation
Same as  Request.Operation.Output  
in the request.

Conta

MediaInfo Response.JobsDetail.Operation Media information of the output file, which will 
not be returned when the job is not completed.

Conta

MediaResult Response.JobsDetail.Operation Basic information of the output file, which will 
not be returned when the job is not completed.

Conta
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UserData Response.JobsDetail.Operation The user information passed through. String

JobLevel Response.JobsDetail.Operation Job priority String

 MediaInfo  has the following sub-nodes:


Same as the  Response.MediaInfo  node in the GenerateMediaInfo API.

 MediaResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

OutputFile Response.Operation.MediaResult Basic information of the output 
file.

Container

 OutputFile  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Bucket Response.Operation.MediaResult.OutputFile Bucket of the output file. String

Region Response.Operation.MediaResult.OutputFile Bucket region of the output 
file.

String

ObjectName Response.Operation.MediaResult.OutputFile Output filename. There 
may be multiple values.

String array

Md5Info Response.Operation.MediaResult.OutputFile MD5 information of the 
output file.

Container 
array

 Md5Info  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info Output filename. String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info MD5 value of the 
output file.

Container

Error codes

For common error messages, see Error Codes.

https://intl.cloud.tencent.com/document/product/1045/48569
https://intl.cloud.tencent.com/document/product/1045/33700


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1054
of 2300

Samples

Request 1. Using the splicing template ID

Request

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-sig

Host:test-123456789.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml
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<Request>

    <Tag>Concat</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Concat</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>concat_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

Request 2. Using the splicing parameter

Request
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POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-sig

Host:test-123456789.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Concat</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>
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    <Operation>

        <ConcatTemplate>

            <ConcatFragment>

                <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/start.mp4<

            </ConcatFragment>

            <ConcatFragment>

                <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/end.mp4</U

            </ConcatFragment>

            <Audio>

                <Codec>mp3</Codec>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height>720</Height>

                <Fps>30</Fps>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMix>

        </ConcatTemplate>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>
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Response

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c5d</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Concat</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <ConcatTemplate>

                <ConcatFragment>

                    <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/start.

                </ConcatFragment>

                <ConcatFragment>

                    <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/end.mp

                </ConcatFragment>

                <Audio>

                    <Codec>mp3</Codec>

                </Audio>

                <Video>

                    <Codec>H.264</Codec>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Height>720</Height>

                    <Fps>30</Fps>

                </Video>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <AudioMix>

                    <AudioSource>https://test-123456789.cos.ap-chongqing.myqcloud.c

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>

                    <EffectConfig>

                        <EnableStartFadein>true</EnableStartFadein>

                        <StartFadeinTime>3</StartFadeinTime>

                        <EnableEndFadeout>false</EnableEndFadeout>

                        <EndFadeoutTime>0</EndFadeoutTime>

                        <EnableBgmFade>true</EnableBgmFade>
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                        <BgmFadeTime>1.7</BgmFadeTime>

                    </EffectConfig>

                </AudioMix>

                <Index>1</Index>

            </ConcatTemplate>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

Request 3. Splicing multiple files

Request
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POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-sig

Host:test-123456789.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Concat</Tag>

    <Operation>

        <ConcatTemplate>

            <ConcatFragment>
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                <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/start.mp4<

                <FragmentIndex>0</FragmentIndex>

                <StartTime>0</StartTime>

                <EndTime>6</EndTime>

            </ConcatFragment>

            <ConcatFragment>

                <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/middle.mp4

                <FragmentIndex>1</FragmentIndex>

            </ConcatFragment>

            <ConcatFragment>

                <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/end.mp4</U

                <FragmentIndex>2</FragmentIndex>

                <StartTime>5</StartTime>

                <EndTime>10</EndTime>

            </ConcatFragment>

            <Container>

                <Format>mp4</Format>

            </Container>

        </ConcatTemplate>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c5d</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Concat</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <ConcatTemplate>

                <ConcatFragment>

                    <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/start.

                    <StartTime>0</StartTime>

                    <EndTime>6</EndTime>

                </ConcatFragment>

                <ConcatFragment>

                    <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/middle

                </ConcatFragment>

                <ConcatFragment>

                    <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/end.mp

                    <StartTime>5</StartTime>

                    <EndTime>10</EndTime>

                </ConcatFragment>

                <Container>

                    <Format>mp4</Format>

                </Container>

            </ConcatTemplate>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Submitting Digital Watermark Adding Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit a digital watermark adding job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>DigitalWatermark</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job tag: DigitalWatermark String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request Job callback format, which can be  JSON  or 
 XML  (default value). It has a higher priority 
than that of the queue.

String No
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CallBackType Request
Job callback type, which can be  Url  (default 
value) or  TDMQ . It has a higher priority than 
that of the queue.

String No

CallBack Request

Job callback address, which has a higher priority 
than that of the queue. If it is set to  no , no 
callbacks will be generated at the callback 
address of the queue.

String No

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required if 
 CallBackType  is  TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Media filename String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Output Request.Operation Result output address Container Yes

DigitalWatermark Request.Operation Digital watermark configuration Container Yes

JobLevel Request.Operation
Job priority. The greater the value, the 
higher the priority. Valid values:  0 , 
 1 ,  2 . Default value:  0 .

String No

UserData Request.Operation
The user information passed through, 
which is printable ASCII codes of up to 
1,024 in length.

String No

 DigitalWatermark  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required Constraints

Message Request.Operation.DigitalWatermark The string 
embedded 

string Yes It can contain 
up to 64 

https://intl.cloud.tencent.com/document/product/1045/49945
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by the 
digital 
watermark

letters, digits, 
underscores 
(_), hyphens 
(-), and 
asterisks (*).

Type Request.Operation.DigitalWatermark Watermark 
type

String Yes Text

Version Request.Operation.DigitalWatermark Watermark 
version

String Yes V1

 Output  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output Output result filename String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>DigitalWatermark</Tag>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  
is  Failed 

String

JobId Response.JobsDetail Job ID String
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Tag Response.JobsDetail Job tag: DigitalWatermark String

State Response.JobsDetail
Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Ty

Output Response.JobsDetail.Operation
Same as  Request.Operation.Output  in 
the request.

Co

DigitalWatermark Response.JobsDetail.Operation
Same as 
 Request.Operation.DigitalWatermark  
in the request.

Co

MediaInfo Response.JobsDetail.Operation Media information of the output file, which will not 
be returned when the job is not completed.

Co

MediaResult Response.JobsDetail.Operation Basic information of the output file, which will not 
be returned when the job is not completed.

Co

UserData Response.JobsDetail.Operation The user information passed through. Str

JobLevel Response.JobsDetail.Operation Job priority Str
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 MediaInfo  has the following sub-nodes:


Same as the  Response.MediaInfo  node in the  GenerateMediaInfo  API.

 MediaResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

OutputFile Response.Operation.MediaResult Basic information of the output 
file.

Container

 OutputFile  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Bucket Response.Operation.MediaResult.OutputFile Bucket of the output file. String

Region Response.Operation.MediaResult.OutputFile Bucket region of the 
output file.

String

ObjectName Response.Operation.MediaResult.OutputFile Output filename. There 
may be multiple values.

String array

Md5Info Response.Operation.MediaResult.OutputFile MD5 information of the 
output file.

Container 
array

 Md5Info  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info Output filename. String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info MD5 value of the 
output file.

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353
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POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>DigitalWatermark</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>
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    <Operation>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>DigitalWatermark</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Submitting Digital Watermark Extracting Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit a digital watermark extracting job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>ExtractDigitalWatermark</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <ExtractDigitalWatermark>

            <Type>Text</Type>

            <Version>V1</Version>

        </ExtractDigitalWatermark>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job tag: ExtractDigitalWatermark String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request
Job callback format, which can be  JSON  or 
 XML  (default value). It has a higher priority 
than that of the queue.

String No

CallBackType Request
Job callback type, which can be  Url  
(default value) or  TDMQ . It has a higher 
priority than that of the queue.

String No

CallBack Request Job callback address, which has a higher String No
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priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required if 
 CallBackType  is  TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

Object Request.Input Media filename String Yes

 Operation  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

ExtractDigitalWatermark Request.Operation Digital watermark extraction 
configuration

Container Yes

JobLevel Request.Operation

Job priority. The greater the 
value, the higher the priority. 
Valid values:  0 ,  1 ,  2 . 
Default value:  0 .

String No

UserData Request.Operation

The user information passed 
through, which is printable 
ASCII codes of up to 1,024 in 
length.

String No

 ExtractDigitalWatermark  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required Constraints

Type Request.Operation.ExtractDigitalWatermark Watermark 
type

String Yes Text

Version Request.Operation.ExtractDigitalWatermark Watermark 
version

String Yes V1

Response

https://intl.cloud.tencent.com/document/product/1045/49945
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Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

https://intl.cloud.tencent.com/document/product/1045/49352
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        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>ExtractDigitalWatermark</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <ExtractDigitalWatermark>

                <Type>Text</Type>

                <Version>V1</Version>

            </ExtractDigitalWatermark>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String
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Tag Response.JobsDetail Job tag: ExtractDigitalWatermark String

State Response.JobsDetail
Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

ExtractDigitalWatermark Response.JobsDetail.Operation Digital watermark configuration Container

UserData Response.JobsDetail.Operation The user information passed 
through.

String

JobLevel Response.JobsDetail.Operation Job priority String

 ExtractDigitalWatermark  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Message Response.JobsDetail.Operation.ExtractDigitalWatermark The extracted digital 
watermark string

string

Type Response.JobsDetail.Operation.ExtractDigitalWatermark Watermark type String
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Version Response.JobsDetail.Operation.ExtractDigitalWatermark Watermark version String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353
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POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>ExtractDigitalWatermark</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <ExtractDigitalWatermark>

            <Type>Text</Type>

            <Version>V1</Version>

        </ExtractDigitalWatermark>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>ExtractDigitalWatermark</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <ExtractDigitalWatermark>

                <Type>Text</Type>

                <Version>V1</Version>

            </ExtractDigitalWatermark>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Submitting Media Information Query Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit a media information query job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>MediaInfo</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job tag: MediaInfo String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request
Job callback format, which can be  JSON  or 
 XML  (default value). It has a higher priority 
than that of the queue.

String No

CallBackType Request
Job callback type, which can be  Url  
(default value) or  TDMQ . It has a higher 
priority than that of the queue.

String No

CallBack Request

Job callback address, which has a higher 
priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

String No

CallBackMqConfig Request TDMQ configuration for job callback as Container No
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described in Structure, which is required if 
 CallBackType  is  TDMQ .

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

UserData Request.Operation The user information passed through, which is 
printable ASCII codes of up to 1,024 in length.

String No

JobLevel Request.Operation
Job priority. The greater the value, the higher 
the priority. Valid values:  0 ,  1 ,  2 . 
Default value:  0 .

String No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Media filename String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>MediaInfo</Tag>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  
is  Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job tag: MediaInfo String

State Response.JobsDetail
Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String
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EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

MediaInfo Response.JobsDetail.Operation
Output video information, which will not 
be returned when the job is not 
completed.

Container

UserData Response.JobsDetail.Operation The user information passed through. String

JobLevel Response.JobsDetail.Operation Job priority String

 MediaInfo  has the following sub-nodes:


Same as the  Response.MediaInfo  node in the  GenerateMediaInfo  API.

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353
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POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>MediaInfo</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>
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    <Operation>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>MediaInfo</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Submitting Audio Noise Reduction Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit an audio noise reduction job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>NoiseReduction</Tag>

    <Input>

        <Object>input/demo.mp3</Object>

    </Input>

    <Operation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.wav</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job type: NoiseReduction String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request
Job callback format, which can be  JSON  or 
 XML  (default value). It has a higher priority 
than that of the queue.

String No

CallBackType Request
Job callback type, which can be  Url  (default 
value) or  TDMQ . It has a higher priority than 
that of the queue.

String No
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CallBack Request Job callback address, which has a higher 
priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

String No

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required if 
 CallBackType  is  TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input

Name of the media file on which to execute the audio 
noise reduction job.

1. Currently, only audio files within 10 MB in size are 
supported.

2. If the input is a video file or a multi-channel audio, 
only mono-channel audio streams will be retained.

3. M3U8 input audios are not supported.

String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Output Request.Operation Result output address Container Yes

JobLevel Request.Operation
Job priority. The greater the value, the 
higher the priority. Valid values:  0 ,  1 , 
 2 . Default value:  0 .

String No

UserData Request.Operation
The user information passed through, which 
is printable ASCII codes of up to 1,024 in 
length.

String No

 Output  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output Output result filename String Yes

https://intl.cloud.tencent.com/document/product/1045/49945
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Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>NoiseReduction</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.wav</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail Error code, which is returned only if  State  is String
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 Failed 

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job type: NoiseReduction String

State Response.JobsDetail
Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Output Response.JobsDetail.Operation
Same as 
 Request.Operation.Output  in the 
request.

Container

UserData Response.JobsDetail.Operation The user information passed through. String

JobLevel Response.JobsDetail.Operation Job priority String

Error codes



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1112
of 2300

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

https://intl.cloud.tencent.com/document/product/1045/49353
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Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>NoiseReduction</Tag>

    <Input>

        <Object>input/demo.mp3</Object>

    </Input>

    <Operation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.wav</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>NoiseReduction</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.wav</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Submitting Video Quality Scoring Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit a video quality analysis job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>QualityEstimate</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job tag: QualityEstimate String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request
Job callback format, which can be  JSON  or 
 XML  (default value). It has a higher priority 
than that of the queue.

String No

CallBackType Request
Job callback type, which can be  Url  (default 
value) or  TDMQ . It has a higher priority than 
that of the queue.

String No

CallBack Request

Job callback address, which has a higher priority 
than that of the queue. If it is set to  no , no 
callbacks will be generated at the callback 
address of the queue.

String No

CallBackMqConfig Request TDMQ configuration for job callback as Container No
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described in Structure, which is required if 
 CallBackType  is  TDMQ .

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

UserData Request.Operation
The user information passed through, which 
is printable ASCII codes of up to 1,024 in 
length.

String No

JobLevel Request.Operation
Job priority. The greater the value, the 
higher the priority. Valid values:  0 ,  1 , 
 2 . Default value:  0 .

String No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Media filename String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>QualityEstimate</Tag>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job tag: QualityEstimate String

State Response.JobsDetail
Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String
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EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

MediaInfo Response.JobsDetail.Operation
Output video information, which will not 
be returned when the job is not 
completed.

Container

QualityEstimate Response.JobsDetail.Operation Video analysis result, which will not be 
returned when the job is not completed.

Container

UserData Response.JobsDetail.Operation The user information passed through. String

 QualityEstimate  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type

Score Response.JobsDetail.Operation.QualityEstimate
Video quality score up to 10. If 
the score reaches 6, the video 
quality can be considered good.

String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

https://intl.cloud.tencent.com/document/product/1045/49353
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Samples

Request

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml
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<Request>

    <Tag>QualityEstimate</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>QualityEstimate</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Submitting SDR-to-HDR Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit an SDR-to-HDR job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>SDRtoHDR</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <SDRtoHDR>

            <HdrMode>HLG</HdrMode>

        </SDRtoHDR>

        <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTemplateI

        <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTemplateI

        <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTemplateI

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job tag: SDRtoHDR String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request Job callback format, which can be  JSON  or 
 XML  (default value). It has a higher priority 
than that of the queue.

String No
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CallBackType Request
Job callback type, which can be  Url  
(default value) or  TDMQ . It has a higher 
priority than that of the queue.

String No

CallBack Request

Job callback address, which has a higher 
priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

String No

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required if 
 CallBackType  is  TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

Object Request.Input Media filename String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

SDRtoHDR Request.Operation SDR-to-HDR parameter Container Yes

Transcode Request.Operation

Transcoding template parameter. 
This node and 
 TranscodeTemplateId  
cannot be empty at the same 
time.

Container No

TranscodeTemplateId Request.Operation

Transcoding template ID. This 
node and  Transcode  cannot 
be empty at the same time. Use 
this node first.

String No

Watermark Request.Operation

Watermark template parameter. 
Same as 
 Request.Watermark  in the 
watermark template creation API 
CreateMediaTemplate. Up to 
three watermarks can be passed 
in.

Container 
array

No

https://intl.cloud.tencent.com/document/product/1045/49945#CallBackMqConfig
https://intl.cloud.tencent.com/document/product/1045/49917


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1133
of 2300

WatermarkTemplateId Request.Operation Watermark template ID. Up to 
three watermark template IDs can 
be passed in. If  Watermark  
and  WatermarkTemplateId  
exist at the same time, use 
 WatermarkTemplateId  first.

String 
array

No

Output Request.Operation Result output address Container Yes

UserData Request.Operation
The user information passed 
through, which is printable ASCII 
codes of up to 1,024 in length.

String No

JobLevel Request.Operation

Job priority. The greater the 
value, the higher the priority. Valid 
values:  0 ,  1 ,  2 . Default 
value:  0 .

String No

Note: 
To submit an SDR-to-HDR job, you must pass in the transcoding parameter. For the transcoding parameter, 
 TranscodeTemplateId  is used first, and if  TranscodeTemplateId  is unavailable,  Transcode  is used. 

For the watermark parameter,  WatermarkTemplateId  or  Watermark  can be used for configuration, and 

 WatermarkTemplateId  is used first.

 SDRtoHDR  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Constraints

HdrMode Request.Operation.SDRtoHDR HDR mode String Yes 1. HLG
2. HDR10

 Transcode  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

TimeInterval Request.Operation.Transcode

Same as Request.TimeInterval 
in the transcoding template 
creation API 
CreateMediaTemplate.

Container No

Container Request.Operation.Transcode Same as Request.Container in 
the transcoding template 
creation API 
CreateMediaTemplate.

Container No

https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
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Video Request.Operation.Transcode
Same as Request.Video in the 
transcoding template creation 
API CreateMediaTemplate.

Container No

Audio Request.Operation.Transcode
Same as Request.Audio in the 
transcoding template creation 
API CreateMediaTemplate.

Container No

TransConfig Request.Operation.Transcode

Same as Request.TransConfig in 
the transcoding template 
creation API 
CreateMediaTemplate.

Container No

AudioMix Request.Operation.Transcode Audio mix parameter as 
described in Structure.

Container 
array

No

 Output  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output Output result filename String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SDRtoHDR</Tag>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TranscodeTemplateId>t1460606b9752148c4ab182f55163ba7cd</TranscodeTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  
is  Failed 

String
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JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job tag: SDRtoHDR String

State Response.JobsDetail
Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

SDRtoHDR Response.JobsDetail.Operation
Same as 
 Request.Operation.SDRtoHDR  in 
the request.

Container

Output Response.JobsDetail.Operation
Same as 
 Request.Operation.Output  in the 
request.

Container

MediaInfo Response.JobsDetail.Operation
Media information of the output file, which 
will not be returned when the job is not 
completed.

Container
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MediaResult Response.JobsDetail.Operation Basic information of the output file, which will 
not be returned when the job is not 
completed.

Container

UserData Response.JobsDetail.Operation The user information passed through. String

JobLevel Response.JobsDetail.Operation Job priority String

 MediaInfo  has the following sub-nodes:


Same as the  Response.MediaInfo  node in the  GenerateMediaInfo  API.

 MediaResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

OutputFile Response.Operation.MediaResult Basic information of the output 
file.

Container

 OutputFile  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Bucket Response.Operation.MediaResult.OutputFile Bucket of the output file. String

Region Response.Operation.MediaResult.OutputFile Bucket region of the output 
file.

String

ObjectName Response.Operation.MediaResult.OutputFile Output filename. There may 
be multiple values.

String array

Md5Info Response.Operation.MediaResult.OutputFile MD5 information of the 
output file.

Container 
array

 Md5Info  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info Output filename. String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info MD5 value of the 
output file.

Container

Error codes
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There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

https://intl.cloud.tencent.com/document/product/1045/49353
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Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SDRtoHDR</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <SDRtoHDR>

            <HdrMode>HLG</HdrMode>

        </SDRtoHDR>

        <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTemplateI

        <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTemplateI

        <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTemplateI

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1141
of 2300

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SDRtoHDR</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TranscodeTemplateId>t1460606b9752148c4ab182f55163ba7cd</TranscodeTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Submitting Remuxing Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit a remuxing job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>Segment</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Segment>

            <Format>hls</Format>

            <Duration>5</Duration>

            <HlsEncrypt>

                <IsHlsEncrypt>true</IsHlsEncrypt>

                <UriKey>test-key</UriKey>

            </HlsEncrypt>

        </Segment>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out-${Number}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job tag: Segment String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request Job callback format, which can be  JSON  or String No
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 XML  (default value). It has a higher priority 
than that of the queue.

CallBackType Request
Job callback type, which can be  Url  (default 
value) or  TDMQ . It has a higher priority than 
that of the queue.

String No

CallBack Request

Job callback address, which has a higher 
priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

String No

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required if 
 CallBackType  is  TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Media filename String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Segment Request.Operation Remuxing parameter Container Yes

Output Request.Operation Result output address Container Yes

JobLevel Request.Operation
Job priority. The greater the value, the 
higher the priority. Valid values:  0 ,  1 , 
 2 . Default value:  0 .

String No

 Segment  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Ty

Format Request.Operation.Segment Container format Str

https://intl.cloud.tencent.com/document/product/1045/49945
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Duration Request.Operation.Segment Remuxing duration in seconds Str

TranscodeIndex Request.Operation.Segment

The stream number to be processed, which 
corresponds to 
 Response.MediaInfo.Stream.Video.Index  
and 
 Response.MediaInfo.Stream.Audio.Index  
in the media information. For more information, see 
Getting Media File Information.

Str

HlsEncrypt Request.Operation.Segment HLS encryption configuration Co

 HlsEncrypt  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Default 
Value

C

IsHlsEncrypt Request.Operation.Segment.HlsEncrypt

Whether to 
enable 
HLS 
encryption

String No false

1.
tr
2.
su
w
S
H

UriKey Request.Operation.Segment.HlsEncrypt
HLS 
encryption 
key

String No None

T
va
 

is

 Output  has the following sub-nodes:

Node Name Parent Node Description Type Required

https://intl.cloud.tencent.com/document/product/1045/49541
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(Keyword)

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output

Output result filename. If  Duration  
is configured and  Format  is not 
HLS or m3u8, the  ${Number}  
parameter must be included in the 
filename and used as the output 
sequence number of each audio/video 
segment after custom remuxing.

String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Segment</Tag>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Segment>

                <Format>hls</Format>

                <Duration>5</Duration>

                <HlsEncrypt>

                    <IsHlsEncrypt>true</IsHlsEncrypt>

                    <UriKey>test-key</UriKey>

                </HlsEncrypt>

            </Segment>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out-${Number}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <CallBack>http://callback.demo.com</CallBack>

        <CallBackFormat>JSON<CallBackFormat>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail Error code, which is returned only if  State  is 
 Failed 

String
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Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job tag: Segment String

State Response.JobsDetail
Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Segment Response.JobsDetail.Operation
Same as 
 Request.Operation.Segment  in the 
request.

Container

Output Response.JobsDetail.Operation
Same as 
 Request.Operation.Output  in the 
request.

Container

MediaInfo Response.JobsDetail.Operation Transcoding output video information. This Container
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node will not be returned when there is no 
output video.

MediaResult Response.JobsDetail.Operation
Basic information of the output file, which 
will not be returned when the job is not 
completed.

Container

UserData Response.JobsDetail.Operation The user information passed through. String

JobLevel Response.JobsDetail.Operation Job priority String

 MediaInfo  has the following sub-nodes:


Same as the  Response.MediaInfo  node in the  GenerateMediaInfo  API.

 MediaResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

OutputFile Response.Operation.MediaResult Basic information of the output 
file.

Container

 OutputFile  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Bucket Response.Operation.MediaResult.OutputFile Bucket of the output file. String

Region Response.Operation.MediaResult.OutputFile Bucket region of the output 
file.

String

ObjectName Response.Operation.MediaResult.OutputFile Output filename. There may 
be multiple values.

String array

Md5Info Response.Operation.MediaResult.OutputFile MD5 information of the 
output file.

Container 
array

 Md5Info  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info Output filename. String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info MD5 value of the 
output file.

Container
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Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request 1. MP4 remuxing

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

https://intl.cloud.tencent.com/document/product/1045/49353
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Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Segment</Tag>

    <Input>

        <Object>input/demo.mkv</Object>

    </Input>

    <Operation>

        <Segment>

            <Format>mp4</Format>

            <Duration>15</Duration>

        </Segment>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out-${Number}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response 1
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Segment</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mkv</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Segment>

                <Format>mp4</Format>

                <Duration>15</Duration>

            </Segment>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out-${Number}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <CallBack>http://callback.demo.com</CallBack>

        <CallBackFormat>JSON<CallBackFormat>

    </JobsDetail>

</Response>

Request 2. HLS remuxing and encryption
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POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Segment</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>
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    <Operation>

        <Segment>

            <Format>hls</Format>

            <Duration>5</Duration>

            <HlsEncrypt>

                <IsHlsEncrypt>true</IsHlsEncrypt>

                <UriKey>test-key</UriKey>

            </HlsEncrypt>

        </Segment>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out-${Number}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response 2
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Segment</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Segment>

                <Format>hls</Format>

                <Duration>5</Duration>

                <HlsEncrypt>

                    <IsHlsEncrypt>true</IsHlsEncrypt>

                    <UriKey>test-key</UriKey>

                </HlsEncrypt>

            </Segment>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <CallBack>http://callback.demo.com</CallBack>

        <CallBackFormat>JSON<CallBackFormat>

    </JobsDetail>

</Response>
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Submitting Intelligent Thumbnail Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit an intelligent thumbnail job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>SmartCover</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t16567cd58ade9411d952283873123b9b1</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${Number}.jpg</Object>

        </Output>   

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job tag: SmartCover String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request
Job callback format, which can be  JSON  or 
 XML  (default value). It has a higher priority 
than that of the queue.

String No

CallBackType Request Job callback type, which can be  Url  
(default value) or  TDMQ . It has a higher 
priority than that of the queue.

String No
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CallBack Request

Job callback address, which has a higher 
priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

String No

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required if 
 CallBackType  is  TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

Object Request.Input Media filename String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

TemplateId Request.Operation Intelligent thumbnail template ID String No

SmartCover Request.Operation Thumbnail configuration Container No

Output Request.Operation Result output address Container Yes

UserData Request.Operation
The user information passed through, 
which is printable ASCII codes of up to 
1,024 in length.

String No

JobLevel Request.Operation
Job priority. The greater the value, the 
higher the priority. Valid values:  0 , 
 1 ,  2 . Default value:  0 .

String No

Note: 

 If both  TemplateId  and  SmartCover  are set,  TemplateId  will be used first.

 SmartCover  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Default 
Value

Const

Format Request.Operation.SmartCover Thumbnail 
image type.

String Yes None png, j
webp

Width Request.Operation.SmartCover Thumbnail String Yes None 1. Val

https://intl.cloud.tencent.com/document/product/1045/49945
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image 
width

range
[128, 
2. Un

Height Request.Operation.SmartCover
Thumbnail 
image 
height

String Yes None

1. Val
range
[128, 
2. Un

Count Request.Operation.SmartCover
Number of 
thumbnails. String No 3

1. Val
range
10]

DeleteDuplicates Request.Operation.SmartCover
Whether to 
deduplicate 
thumbnails.

String No false true/fa

 Output  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output

Result filename. 
${Number} must be included in the 
filename.
 For example, if  Object  is  my-new-
cover-${Number}.jpg , and there 
are three result files, the output result 
filenames are as follows: 
my-new-cover-0.jpg
my-new-cover-1.jpg
my-new-cover-2.jpg

String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

https://intl.cloud.tencent.com/document/product/1045/49352
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The response body returns application/xml data. The following contains all the nodes:

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>
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        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SmartCover</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t16567cd58ade9411d952283873123b9b1</TemplateId>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

            </Output>   

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job tag: SmartCover String
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State Response.JobsDetail Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

SmartCover Response.JobsDetail.Operation
Same as 
 Request.Operation.SmartCover  in 
the request.

String

Output Response.JobsDetail.Operation
Same as 
 Request.Operation.Output  in the 
request.

Container

MediaResult Response.JobsDetail.Operation
Basic information of the output file, which will 
not be returned when the job is not 
completed.

Container

UserData Response.JobsDetail.Operation The user information passed through. String

JobLevel Response.JobsDetail.Operation Job priority String

 MediaResult  has the following sub-nodes:
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Node Name 
(Keyword)

Parent Node Description Type

OutputFile Response.Operation.MediaResult Basic information of the output 
file.

Container

 OutputFile  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Bucket Response.Operation.MediaResult.OutputFile Bucket of the output file. String

Region Response.Operation.MediaResult.OutputFile Bucket region of the output file. String

ObjectName Response.Operation.MediaResult.OutputFile Output filename. There may be 
multiple values.

String 
array

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request 1. Using the intelligent thumbnail template ID

https://intl.cloud.tencent.com/document/product/1045/49353
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POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SmartCover</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>
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    <Operation>

        <TemplateId>t16567cd58ade9411d952283873123b9b1</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${Number}.jpg</Object>

        </Output>   

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SmartCover</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t16567cd58ade9411d952283873123b9b1</TemplateId>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

            </Output>   

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

Request 2. Using the intelligent thumbnail parameter
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POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SmartCover</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>
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    <Operation>

        <SmartCover>

            <Format>jpg</Format>

            <Width>1280</Width>

            <Height>960</Height>

            <Count>5</Count>

            <DeleteDuplicates>true</DeleteDuplicates>

        </SmartCover>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${Number}.jpg</Object>

        </Output>   

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SmartCover</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <SmartCover>

                <Format>jpg</Format>

                <Width>1280</Width>

                <Height>960</Height>

                <Count>5</Count>

                <DeleteDuplicates>true</DeleteDuplicates>

            </SmartCover>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

            </Output>   

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel> 

        </Operation>

    </JobsDetail>

</Response>
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Submitting Video Frame Capturing Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit a screenshot job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>Snapshot</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/snapshot-${Number}.jpg</Object>

            <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job type: Snapshot String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request
Job callback format, which can be  JSON  or 
 XML  (default value). It has a higher priority 
than that of the queue.

String No

CallBackType Request Job callback type, which can be  Url  (default 
value) or  TDMQ . It has a higher priority than 
that of the queue.

String No
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CallBack Request

Job callback address, which has a higher 
priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

String No

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required if 
 CallBackType  is  TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Media filename String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Snapshot Request.Operation

Job type parameter. Same as 
 Request.Snapshot  in the screenshot 
template creation API 
CreateMediaTemplate.

Container No

TemplateId Request.Operation Template ID String No

Output Request.Operation Result output address Container Yes

UserData Request.Operation
The user information passed through, 
which is printable ASCII codes of up to 
1,024 in length.

String No

JobLevel Request.Operation
Job priority. The greater the value, the 
higher the priority. Valid values:  0 ,  1 , 
 2 . Default value:  0 .

String No

Note: 
 TemplateId  is used first. If  TemplateId  is unavailable,  Snapshot  is used.

 Output  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49909
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Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output

Result filename. ${Number} must be 
included in the filename. For 
example, you can set  Object  to 
 snapshot-${Number}.jpg .

String No

SpriteObject Request.Operation.Output

Image sprite name. ${Number} must 
be included in the filename. **For 
example, you can set 
 sprite-${Number}.jpg .** Only 
the .jpg format is supported.

String No

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Snapshot</Tag>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>snapshot_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${Number}.jpg</Object>

                <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job type: Snapshot String
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State Response.JobsDetail Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

TemplateId Response.JobsDetail.Operation Job template ID String

TemplateName Response.JobsDetail.Operation
Job template name, which will be 
returned if  TemplateId  exists. String

Snapshot Response.JobsDetail.Operation
Same as 
 Request.Operation.Snapshot  in 
the request.

Container

Output Response.JobsDetail.Operation
Same as 
 Request.Operation.Output  in 
the request.

Container

MediaResult Response.JobsDetail.Operation
Basic information of the output file, which 
will not be returned when the job is not 
completed.

Container



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1189
of 2300

UserData Response.JobsDetail.Operation The user information passed through. String

JobLevel Response.JobsDetail.Operation Job priority String

 MediaResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

OutputFile Response.Operation.MediaResult Basic information of the output 
file.

Container

 OutputFile  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Bucket Response.Operation.MediaResult.OutputFile Bucket of the output file. String

Region Response.Operation.MediaResult.OutputFile Bucket region of the output 
file.

String

ObjectName Response.Operation.MediaResult.OutputFile Output filename. There may 
be multiple values.

String array

Md5Info Response.Operation.MediaResult.OutputFile MD5 information of the 
output file.

Container 
array

 Md5Info  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info Output filename. String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info MD5 value of the 
output file.

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

https://intl.cloud.tencent.com/document/product/1045/49353
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Request 1. Using the screenshot template ID

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Snapshot</Tag>

    <Input>
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        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/snapshot-${Number}.jpg</Object>

            <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Snapshot</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>snapshot_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${Number}.jpg</Object>

                <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

Request 2. Using the screenshot processing parameter
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POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Snapshot</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>
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    <Operation>

        <Snapshot>

            <BlackLevel>0</BlackLevel>

            <Count>10</Count>

            <IsCheckBlack>false</IsCheckBlack>

            <IsCheckCount>false</IsCheckCount>

            <Mode>Interval</Mode>

            <PixelBlackThreshold>0</PixelBlackThreshold>

            <SnapshotOutMode>SnapshotAndSprite</SnapshotOutMode>

            <SpriteSnapshotConfig>

                <Color>Azure</Color>

                <Columns>3</Columns>

                <Lines>2</Lines>

            </SpriteSnapshotConfig>

            <Start>1</Start>

            <TimeInterval>2</TimeInterval>

        </Snapshot>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/snapshot-${Number}.jpg</Object>

            <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Snapshot</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Snapshot>

                <BlackLevel>0</BlackLevel>

                <Count>10</Count>

                <IsCheckBlack>false</IsCheckBlack>

                <IsCheckCount>false</IsCheckCount>

                <Mode>Interval</Mode>

                <PixelBlackThreshold>0</PixelBlackThreshold>

                <SnapshotOutMode>SnapshotAndSprite</SnapshotOutMode>

                <SpriteSnapshotConfig>

                    <Color>Azure</Color>

                    <Columns>3</Columns>

                    <Lines>2</Lines>

                </SpriteSnapshotConfig>

                <Start>1</Start>

                <TimeInterval>2</TimeInterval>

            </Snapshot>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${Number}.jpg</Object>

                <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Submitting Stream Separation Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit an audio/video stream separation job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>StreamExtract</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <StreamExtract>

                <Index>0</Index>

                <Object>output/out0.mp4</Object>

            </StreamExtract>

            <StreamExtract>

                <Index>1</Index>

                <Object>output/out1.mp4</Object>

            </StreamExtract>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Output>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job tag: StreamExtract String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request Job callback format, which can be  JSON  or String No



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1202
of 2300

 XML  (default value). It has a higher priority 
than that of the queue.

CallBackType Request
Job callback type, which can be  Url  
(default value) or  TDMQ . It has a higher 
priority than that of the queue.

String No

CallBack Request

Job callback address, which has a higher 
priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

String No

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required if 
 CallBackType  is  TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Media filename String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Output Request.Operation Result output address Container Yes

UserData Request.Operation
The user information passed through, which 
is printable ASCII codes of up to 1,024 in 
length.

String No

JobLevel Request.Operation
Job priority. The greater the value, the 
higher the priority. Valid values:  0 ,  1 , 
 2 . Default value:  0 .

String No

 Output  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

https://intl.cloud.tencent.com/document/product/1045/49945
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StreamExtract Request.Operation.Output Result file configuration. Up to ten 
streams can be configured.

Container Yes

 StreamExtract  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Index Request.Operation.Output.StreamExtract

Stream number, which corresponds to 
 Response.MediaInfo.Stream.Video.Index  
and 
 Response.MediaInfo.Stream.Audio.Index  
in the media information. For more information, see 
Getting Media File Information. If the input media 
format is  mxf , only video streams can be extracted.

Object Request.Operation.Output.StreamExtract Result output filename

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49541
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:11+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>StreamExtract</Tag>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Region>ap-chongqing</Region>

                <StreamExtract>

                    <Index>0</Index>

                    <Output>output/out0.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>1</Index>

                    <Output>output/out1.mp4</Output>

                </StreamExtract>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>  

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String
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JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job tag: StreamExtract String

State Response.JobsDetail
Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Output Response.JobsDetail.Operation
Same as 
 Request.Operation.Output  in the 
request.

Container

MediaResult Response.JobsDetail.Operation
Basic information of the output file, which 
will not be returned when the job is not 
completed.

Container

UserData Response.JobsDetail.Operation The user information passed through. String

JobLevel Response.JobsDetail.Operation Job priority String
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 MediaResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

OutputFile Response.Operation.MediaResult Basic information of the output 
file.

Container

 OutputFile  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Bucket Response.Operation.MediaResult.OutputFile Bucket of the output file. String

Region Response.Operation.MediaResult.OutputFile Bucket region of the output 
file.

String

ObjectName Response.Operation.MediaResult.OutputFile Output filename. There may 
be multiple values.

String array

Md5Info Response.Operation.MediaResult.OutputFile MD5 information of the 
output file.

Container 
array

 Md5Info  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info Output filename. String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info MD5 value of the 
output file.

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353
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POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>StreamExtract</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>
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    <Operation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <StreamExtract>

                <Index>0</Index>

                <Object>output/out0.mp4</Object>

            </StreamExtract>

            <StreamExtract>

                <Index>1</Index>

                <Object>output/out1.mp4</Object>

            </StreamExtract>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Output>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1211
of 2300

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:11+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>StreamExtract</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Region>ap-chongqing</Region>

                <StreamExtract>

                    <Index>0</Index>

                    <Output>output/out0.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>1</Index>

                    <Output>output/out1.mp4</Output>

                </StreamExtract>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Submitting Super Resolution Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit a super resolution job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>SuperResolution</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTemplateI

        <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTemplateI

        <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTemplateI

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job tag: SuperResolution String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1216
of 2300

CallBackFormat Request
Job callback format, which can be  JSON  
or  XML  (default value). It has a higher 
priority than that of the queue.

String No

CallBackType Request
Job callback type, which can be  Url  
(default value) or  TDMQ . It has a higher 
priority than that of the queue.

String No

CallBack Request

Job callback address, which has a higher 
priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

String No

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required if 
 CallBackType  is  TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Media filename String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

SuperResolution Request.Operation

Super resolution template 
parameter. This node and 
 TemplateId  cannot be empty 
at the same time.

Container No

TemplateId Request.Operation

Super resolution template ID, 
which is used first. This node and 
 SuperResolution  cannot be 
empty at the same time.

String No

Transcode Request.Operation

Transcoding template parameter. 
This node and 
 TranscodeTemplateId  
cannot be empty at the same time.

Container No

TranscodeTemplateId Request.Operation Transcoding template ID. This String No

https://intl.cloud.tencent.com/document/product/1045/49945
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node and  Transcode  cannot 
be empty at the same time. Use 
this node first.

Watermark Request.Operation

Watermark template parameter. 
Same as 
 Request.Watermark  in the 
watermark template creation API 
CreateMediaTemplate. Up to 
three watermarks can be passed 
in.

Container 
array

No

WatermarkTemplateId Request.Operation

Watermark template ID. Up to 
three watermark template IDs can 
be passed in. If  Watermark  
and  WatermarkTemplateId  
exist at the same time, use 
 WatermarkTemplateId  first.

String 
array No

DigitalWatermark Request.Operation Specifies the digital watermark 
parameter

Container No

Output Request.Operation Result output address Container Yes

UserData Request.Operation
The user information passed 
through, which is printable ASCII 
codes of up to 1,024 in length.

String No

JobLevel Request.Operation

Job priority. The greater the value, 
the higher the priority. Valid 
values:  0 ,  1 ,  2 . Default 
value:  0 .

String No

Note: 
 To submit a super resolution job, you must pass in the transcoding parameter. For the super resolution parameter, 
 TemplateId  is used first, and if  TemplateId  is unavailable,  SuperResolution  is used. For the 

transcoding parameter,  TranscodeTemplateId  is used first, and if  TranscodeTemplateId  is unavailable, 

 Transcode  is used. For the watermark parameter,  WatermarkTemplateId  or  Watermark  can be used 

for configuration, and  WatermarkTemplateId  is used first.

 SuperResolution  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Resolution Request.Operation.SuperResolution Same as String Yes

https://intl.cloud.tencent.com/document/product/1045/49917
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Request.Resolution in the 
super resolution template 
creation API 
CreateMediaTemplate.

EnableScaleUp Request.Operation.SuperResolution

Same as 
Request.EnableScaleUp in 
the super resolution 
template creation API 
CreateMediaTemplate.

String No

Version Request.Operation.SuperResolution

Same as Request.Version 
in the super resolution 
template creation API 
CreateMediaTemplate.

String No

 Transcode  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

TimeInterval Request.Operation.Transcode

Same as Request.TimeInterval 
in the transcoding template 
creation API 
CreateMediaTemplate.

Container No

Container Request.Operation.Transcode

Same as Request.Container in 
the transcoding template 
creation API 
CreateMediaTemplate.

Container No

Video Request.Operation.Transcode
Same as Request.Video in the 
transcoding template creation 
API CreateMediaTemplate.

Container No

Audio Request.Operation.Transcode
Same as Request.Audio in the 
transcoding template creation 
API CreateMediaTemplate.

Container No

TransConfig Request.Operation.Transcode

Same as Request.TransConfig in 
the transcoding template 
creation API 
CreateMediaTemplate.

Container No

AudioMix Request.Operation.Transcode Audio mix parameter as 
described in Structure.

Container 
array

No

https://intl.cloud.tencent.com/document/product/1045/49910
https://intl.cloud.tencent.com/document/product/1045/49910
https://intl.cloud.tencent.com/document/product/1045/49910
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49945
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 DigitalWatermark  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required

Message Request.Operation.DigitalWatermark

The string embedded by the 
digital watermark, which can 
contain up to 64 letters, digits, 
underscores (_), hyphens (-), 
and asterisks (*).

String Yes

Type Request.Operation.DigitalWatermark
Watermark type, which 
currently can be set to 
 Text  only.

String Yes

Version Request.Operation.DigitalWatermark
Watermark version, which 
currently can be set to  V1  
only.

String Yes

IgnoreError Request.Operation.DigitalWatermark

Whether to ignore the 
watermarking failure and 
continue the job. Valid values: 
 true ,  false  (default 
value).

string No

 Output  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output Output result filename String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SuperResolution</Tag>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

              <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

              <TemplateName>superresolution_demo</TemplateName>

              <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTem

              <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTem

              <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTem

              <DigitalWatermark>

                  <Type>Text</Type>

                  <Message>123456789ab</Message>

                  <State>Running</State>

                  <Version>V1</Version>

                  <IgnoreError>false</IgnoreError>

              </DigitalWatermark>

              <Output>

                  <Region>ap-chongqing</Region>

                  <Bucket>test-123456789</Bucket>

                  <Object>output/out.mp4</Object>

              </Output>

              <UserData>This is my data.</UserData>

              <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail Error code, which is returned only if  State  is String
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 Failed 

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job tag: SuperResolution String

State Response.JobsDetail
Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description

SuperResolution Response.JobsDetail.Operation
Same as 
 Request.Operation.SuperResolution  
in the request.

TemplateId Response.JobsDetail.Operation Job template ID

TemplateName Response.JobsDetail.Operation Job template name, which will be returned if 
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 TemplateId  exists.

Transcode Response.JobsDetail.Operation
Same as 
 Request.Operation.Transcode  in the 
request.

TranscodeTemplateId Response.JobsDetail.Operation Transcoding template ID.

Watermark Response.JobsDetail.Operation
Same as 
 Request.Operation.Watermark  in the 
request.

WatermarkTemplateId Response.JobsDetail.Operation Watermark template ID.

Output Response.JobsDetail.Operation
Same as  Request.Operation.Output  in 
the request.

MediaInfo Response.JobsDetail.Operation Media information of the output file, which will 
not be returned when the job is not completed.

MediaResult Response.JobsDetail.Operation Basic information of the output file, which will not 
be returned when the job is not completed.

DigitalWatermark Response.JobsDetail.Operation Digital watermark parameter.

UserData Response.JobsDetail.Operation The user information passed through.

JobLevel Response.JobsDetail.Operation Job priority

 MediaInfo  has the following sub-nodes:


Same as the  Response.MediaInfo  node in the  GenerateMediaInfo  API.

 MediaResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

OutputFile Response.Operation.MediaResult Basic information of the output 
file.

Container

 OutputFile  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Bucket Response.Operation.MediaResult.OutputFile Bucket of the output file. String
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Region Response.Operation.MediaResult.OutputFile Bucket region of the output 
file.

String

ObjectName Response.Operation.MediaResult.OutputFile Output filename. There may 
be multiple values.

String array

Md5Info Response.Operation.MediaResult.OutputFile MD5 information of the 
output file.

Container 
array

 Md5Info  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info Output filename. String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info MD5 value of the 
output file.

Container

 DigitalWatermark  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type

Message Response.Operation.DigitalWatermark

The string in the digital watermark 
successfully embedded in the video, which 
can contain up to 64 letters, digits, 
underscores (_), hyphens (-), and asterisks 
(*).

string

Type Response.Operation.DigitalWatermark
Watermark type, which currently can be set 
to  Text  only. String

Version Response.Operation.DigitalWatermark
Watermark version, which currently can be 
set to  V1  only. String

IgnoreError Response.Operation.DigitalWatermark
Whether to ignore the watermarking failure 
and continue the job. Valid values: 
 true ,  false  (default value).

string

State Response.Operation.DigitalWatermark
Whether the watermark is added 
successfully. Valid values:  Running , 
 Success ,  Failed .

string

Error codes



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1225
of 2300

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request 1. Using the super resolution template ID

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

https://intl.cloud.tencent.com/document/product/1045/49353
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Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SuperResolution</Tag>

    <Input>

        <Object>test.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTemplateI

        <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTemplateI

        <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTemplateI

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/sr.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response 1
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>je8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Submitted</State>

        <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SuperResolution</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>superresolution_demo</TemplateName>

            <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTempl

            <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTempl

            <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTempl

            <DigitalWatermark>

                <State>Running</State>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/sr.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

Request 2. Using the super resolution processing parameter
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POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SuperResolution</Tag>

    <Input>

        <Object>test.mp4</Object>

    </Input>
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    <Operation>

        <SuperResolution>

            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>

        </SuperResolution>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </Transcode>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>Watermark content</Text>

                <FontSize>30</FontSize>

                <FontType>simfang.ttf</FontType>

                <FontColor>0xRRGGBB</FontColor>
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                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/sr.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response 2
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>je8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Submitted</State>

        <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SuperResolution</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <SuperResolution>

                <Resolution>sdtohd</Resolution>

                <EnableScaleUp>true</EnableScaleUp>

                <Version>Enhance</Version>

            </SuperResolution>

            <Transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Profile>high</Profile>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                    <Preset>medium</Preset>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

                <TransConfig>

                    <AdjDarMethod>scale</AdjDarMethod>

                    <IsCheckReso>false</IsCheckReso>

                    <ResoAdjMethod>1</ResoAdjMethod>

                </TransConfig>

                <TimeInterval>

                    <Start>0</Start>

                    <Duration>60</Duration>

                </TimeInterval>

            </Transcode>
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            <Watermark>

                <Type>Text</Type>

                <LocMode>Absolute</LocMode>

                <Dx>128</Dx>

                <Dy>128</Dy>

                <Pos>TopRight</Pos>

                <StartTime>0</StartTime>

                <EndTime>100.5</EndTime>

                <Text>

                    <Text>Watermark content</Text>

                    <FontSize>30</FontSize>

                    <FontType>simfang.ttf</FontType>

                    <FontColor>0xRRGGBB</FontColor>

                    <Transparency>30</Transparency>

                </Text>

            </Watermark>

            <DigitalWatermark>

                <State>Running</State>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/sr.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Submitting Audio/Video Transcoding Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit a transcoding job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemplateI

        <RemoveWatermark>

            <Dx>150</Dx>

            <Dy>150</Dy>

            <Width>75</Width>

            <Height>75</Height>

        </RemoveWatermark>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required
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Tag Request Job tag: Transcode String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request
Job callback format, which can be  JSON  or 
 XML  (default value). It has a higher priority 
than that of the queue.

String No

CallBackType Request
Job callback type, which can be  Url  
(default value) or  TDMQ . It has a higher 
priority than that of the queue.

String No

CallBack Request

Job callback address, which has a higher 
priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

String No

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required if 
 CallBackType  is  TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Media filename String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

TemplateId Request.Operation Template ID String No

Transcode Request.Operation Transcoding template parameter Container No

WatermarkTemplateId Request.Operation
Watermark template ID. Multiple 
watermark template IDs can be 
passed in.

String No

Watermark Request.Operation Watermark template parameter. 
Same as 

Container No

https://intl.cloud.tencent.com/document/product/1045/49945
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 Request.Watermark  in the 
watermark template creation API 
CreateMediaTemplate.

RemoveWatermark Request.Operation
Whether to remove the 
watermark. This parameter is not 
supported for H.265 currently.

Container No

DigitalWatermark Request.Operation Specifies the digital watermark 
parameter

Container No

Output Request.Operation Result output address Container Yes

UserData Request.Operation
The user information passed 
through, which is printable ASCII 
codes of up to 1,024 in length.

String No

JobLevel Request.Operation

Job priority. The greater the value, 
the higher the priority. Valid 
values:  0 ,  1 ,  2 . Default 
value:  0 .

String No

Note: 
 For the transcoding parameter,  TemplateId  is used first, and if  TemplateId  is unavailable,  Transcode  

is used. For the watermark parameter,  WatermarkTemplateId  or  Watermark  can be used for configuration, 

and  WatermarkTemplateId  is used first.

 Transcode  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

TimeInterval Request.Operation.Transcode

Same as Request.TimeInterval 
in the transcoding template 
creation API 
CreateMediaTemplate.

Container No

Container Request.Operation.Transcode

Same as Request.Container in 
the transcoding template 
creation API 
CreateMediaTemplate.

Container No

Video Request.Operation.Transcode
Same as Request.Video in the 
transcoding template creation 
API CreateMediaTemplate.

Container No

Audio Request.Operation.Transcode Same as Request.Audio in the Container No

https://intl.cloud.tencent.com/document/product/1045/49917
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
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transcoding template creation 
API CreateMediaTemplate.

TransConfig Request.Operation.Transcode

Same as Request.TransConfig in 
the transcoding template 
creation API 
CreateMediaTemplate.

Container No

AudioMix Request.Operation.Transcode Audio mix parameter as 
described in Structure.

Container 
array

No

 RemoveWatermark  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Dx Request.Operation.RemoveWatermark
x-axis offset of the origin in 
the top-left corner. Value 
range: [1, 4096]

string Yes

Dy Request.Operation.RemoveWatermark
y-axis offset of the origin in 
the top-left corner. Value 
range: [1, 4096]

string Yes

Width Request.Operation.RemoveWatermark Width. Value range: [1, 
4096]

string Yes

Height Request.Operation.RemoveWatermark Height. Value range: [1, 
4096]

string Yes

 DigitalWatermark  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required

Message Request.Operation.DigitalWatermark

The string embedded by the 
digital watermark, which can 
contain up to 64 letters, digits, 
underscores (_), hyphens (-), 
and asterisks (*).

string Yes

Type Request.Operation.DigitalWatermark
Watermark type, which 
currently can be set to 
 Text  only.

String Yes

https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49945
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Version Request.Operation.DigitalWatermark Watermark version, which 
currently can be set to  V1  
only.

String Yes

IgnoreError Request.Operation.DigitalWatermark

Whether to ignore the 
watermarking failure and 
continue the job. Valid values: 
 true ,  false  (default 
value).

string Yes

 Output  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output Output result filename String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1244
of 2300

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container
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 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job tag: Transcode String

State Response.JobsDetail
Job status. Valid values:  Submitted ,  Running , 
 Success ,  Failed ,  Pause ,  Cancel .

String

Progress Response.JobsDetail
Task progress in percentage, which is returned only if 
 State  is  Submitted ,  Running , 
 Success , or  Pause . Value range: [0, 100].

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description
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TemplateId Response.JobsDetail.Operation Job template ID

TemplateName Response.JobsDetail.Operation
Job template name, which will be returned if 
 TemplateId  exists.

Transcode Response.JobsDetail.Operation
Same as 
 Request.Operation.Transcode  in the 
request.

Watermark Response.JobsDetail.Operation
Same as 
 Request.Operation.Watermark  in the 
request.

RemoveWatermark Response.JobsDetail.Operation
Same as 
 Request.Operation.RemoveWatermark  
in the request.

WatermarkTemplateId Response.JobsDetail.Operation Watermark template ID.

Output Response.JobsDetail.Operation
Same as  Request.Operation.Output  in 
the request.

MediaInfo Response.JobsDetail.Operation Media information of the output file, which will 
not be returned when the job is not completed.

MediaResult Response.JobsDetail.Operation Basic information of the output file, which will not 
be returned when the job is not completed.

DigitalWatermark Response.JobsDetail.Operation Digital watermark parameter.

UserData Response.JobsDetail.Operation The user information passed through.

JobLevel Response.JobsDetail.Operation Job priority

 MediaInfo  has the following sub-nodes:


Same as the  Response.MediaInfo  node in the  GenerateMediaInfo  API.

 MediaResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

OutputFile Response.Operation.MediaResult Basic information of the output 
file.

Container
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 OutputFile  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Bucket Response.Operation.MediaResult.OutputFile Bucket of the output file. String

Region Response.Operation.MediaResult.OutputFile Bucket region of the output 
file.

String

ObjectName Response.Operation.MediaResult.OutputFile Output filename. There may 
be multiple values.

String array

Md5Info Response.Operation.MediaResult.OutputFile MD5 information of the 
output file.

Container 
array

 Md5Info  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info Output filename. String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info MD5 value of the 
output file.

Container

 DigitalWatermark  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type

Message Response.Operation.DigitalWatermark

The string in the digital watermark 
successfully embedded in the video, which 
can contain up to 64 letters, digits, 
underscores (_), hyphens (-), and asterisks 
(*).

string

Type Response.Operation.DigitalWatermark
Watermark type, which currently can be set 
to  Text  only. String

Version Response.Operation.DigitalWatermark
Watermark version, which currently can be 
set to  V1  only. String

IgnoreError Response.Operation.DigitalWatermark
Whether to ignore the watermarking failure 
and continue the job. Valid values: 
 true ,  false  (default value).

string
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State Response.Operation.DigitalWatermark Whether the watermark is added 
successfully. Valid values:  Running , 
 Success ,  Failed .

string

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request 1. Using the transcoding template ID

https://intl.cloud.tencent.com/document/product/1045/49353


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1249
of 2300

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>
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    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemplateI

        <RemoveWatermark>

            <Dx>150</Dx>

            <Dy>150</Dy>

            <Width>75</Width>

            <Height>75</Height>

        </RemoveWatermark>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response 1
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:11+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

Request 2. Using the transcoding processing parameter
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POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>
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    <Operation>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMix>

        </Transcode>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>
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            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>Watermark content</Text>

                <FontSize>30</FontSize>

                <FontType>simfang.ttf</FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response 2
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Profile>high</Profile>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                    <Preset>medium</Preset>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

                <TransConfig>

                    <AdjDarMethod>scale</AdjDarMethod>

                    <IsCheckReso>false</IsCheckReso>

                    <ResoAdjMethod>1</ResoAdjMethod>

                </TransConfig>

                <TimeInterval>

                    <Start>0</Start>

                    <Duration>60</Duration>

                </TimeInterval>

                <AudioMix>

                    <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>

                    <EffectConfig>
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                        <EnableStartFadein>true</EnableStartFadein>

                        <StartFadeinTime>3</StartFadeinTime>

                        <EnableEndFadeout>false</EnableEndFadeout>

                        <EndFadeoutTime>0</EndFadeoutTime>

                        <EnableBgmFade>true</EnableBgmFade>

                        <BgmFadeTime>1.7</BgmFadeTime>

                    </EffectConfig>

                </AudioMix>

            </Transcode>

            <Watermark>

                <Type>Text</Type>

                <LocMode>Absolute</LocMode>

                <Dx>128</Dx>

                <Dy>128</Dy>

                <Pos>TopRight</Pos>

                <StartTime>0</StartTime>

                <EndTime>100.5</EndTime>

                <Text>

                    <Text>Watermark content</Text>

                    <FontSize>30</FontSize>

                    <FontType></FontType>

                    <FontColor>0xRRGGBB</FontColor>

                    <Transparency>30</Transparency>

                </Text>

            </Watermark>

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>
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</Response>
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Submitting Text-to-Speech Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit a text-to-speech job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>Tts</Tag>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <TtsConfig>

            <Input>Abed, I see a silver light. I wonder if it's frost around.</Inpu

            <InputType>Text</InputType>

        </TtsConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>demo.mp3</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job type: Tts String Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request
Job callback format, which can be  JSON  or 
 XML  (default value). It has a higher priority 
than that of the queue.

String No

CallBackType Request
Job callback type, which can be  Url  (default 
value) or  TDMQ . It has a higher priority than 
that of the queue.

String No
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CallBack Request Job callback address, which has a higher priority 
than that of the queue. If it is set to  no , no 
callbacks will be generated at the callback 
address of the queue.

String No

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required if 
 CallBackType  is  TDMQ .

Container No

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

TtsTpl Request.Operation Text-to-speech job parameter Container No

TemplateId Request.Operation Template ID String No

TtsConfig Request.Operation Text-to-speech job parameter Container Yes

Output Request.Operation Result output address Container Yes

UserData Request.Operation
The user information passed through, which 
is printable ASCII codes of up to 1,024 in 
length.

String No

JobLevel Request.Operation
Job priority. The greater the value, the 
higher the priority. Valid values:  0 ,  1 , 
 2 . Default value:  0 .

String No

Note: 
 TemplateId  is used first. If  TemplateId  is unavailable,  TtsTpl  is used.

 TtsTpl  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Mode Request.Operation.TtsTpl
Same as Request.Mode in the text-to-
speech template creation API 
CreateMediaTemplate.

String No

Codec Request.Operation.TtsTpl
Same as Request.Codec in the text-
to-speech template creation API 
CreateMediaTemplate.

String No

VoiceType Request.Operation.TtsTpl Same as Request.VoiceType in the String No

https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49913
https://intl.cloud.tencent.com/document/product/1045/49913
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text-to-speech template creation API 
CreateMediaTemplate.

Volume Request.Operation.TtsTpl
Same as Request.Volume in the text-
to-speech template creation API 
CreateMediaTemplate.

String No

Speed Request.Operation.TtsTpl
Same as Request.Speed in the text-
to-speech template creation API 
CreateMediaTemplate.

String No

 TtsConfig  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required

InputType Request.Operation.TtsConfig
Input type. Valid values:  Url , 
 Text .

String Yes

Input Request.Operation.TtsConfig

1. When InputType is URL, the value 
must be a valid COS address, and 
the file must be UTF-8 encoded and 
no more than 10 MB in size. If the 
synthesis method specified in the 
template is sync processing, the file 
can contain up to 300 UTF-8 
characters; if the method is async 
processing, the file can contain up to 
10,000 UTF-8 characters. 
2. When InputType is Text, the input 
can be up to 300 UTF-8 characters.

String Yes

 Output  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output Result filename. String Yes

https://intl.cloud.tencent.com/document/product/1045/49913
https://intl.cloud.tencent.com/document/product/1045/49913
https://intl.cloud.tencent.com/document/product/1045/49913
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Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

<Response>

    <JobsDetail>

https://intl.cloud.tencent.com/document/product/1045/49352
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        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Tts</Tag>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>tts_demo</TemplateName>

            <TtsConfig>

                <Input>Abed, I see a silver light. I wonder if it's frost around.</

                <InputType>Text</InputType>

            </TtsConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/tts.mp3</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String
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Message Response.JobsDetail Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job tag: Tts String

State Response.JobsDetail
Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Operation Response.JobsDetail Operation rule Container

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

TemplateId Response.JobsDetail.Operation Job template ID String

TemplateName Response.JobsDetail.Operation
Job template name, which will be returned 
if  TemplateId  exists. String

TtsTpl Response.JobsDetail.Operation
Same as 
 Request.Operation.TtsTpl  in 
the request.

Container

TtsConfig Response.JobsDetail.Operation
Same as 
 Request.Operation.TtsConfig  
in the request.

Container

Output Response.JobsDetail.Operation
Same as 
 Request.Operation.Output  in 
the request.

Container

MediaInfo Response.JobsDetail.Operation
Media information of the output file, which 
will not be returned when the job is not 
completed.

Container
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MediaResult Response.JobsDetail.Operation Basic information of the output file, which 
will not be returned when the job is not 
completed.

Container

UserData Response.JobsDetail.Operation The user information passed through. String

JobLevel Response.JobsDetail.Operation Job priority String

 MediaInfo  has the following sub-nodes:


 Same as the  Response.MediaInfo  node in the  GenerateMediaInfo  API.

 MediaResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

OutputFile Response.Operation.MediaResult Basic information of the output file. Container

 OutputFile  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Bucket Response.Operation.MediaResult.OutputFile Bucket of the output file. String

Region Response.Operation.MediaResult.OutputFile Bucket region of the output 
file.

String

ObjectName Response.Operation.MediaResult.OutputFile Output filename. There may 
be multiple values.

String array

Md5Info Response.Operation.MediaResult.OutputFile MD5 information of the 
output file.

Container 
array

 Md5Info  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info Output filename. String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info MD5 value of the 
output file.

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

https://intl.cloud.tencent.com/document/product/1045/49353
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Samples

Request 1. Using the text-to-speech template ID

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml
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<Request>

    <Tag>Tts</Tag>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <TtsConfig>

            <Input>Abed, I see a silver light. I wonder if it's frost around.</Inpu

            <InputType>Text</InputType>

        </TtsConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>demo.mp3</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1272
of 2300

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Tts</Tag>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>tts_demo</TemplateName>

            <TtsConfig>

                <Input>Abed, I see a silver light. I wonder if it's frost around.</

                <InputType>Text</InputType>

            </TtsConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/tts.mp3</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

Request 1. Using the text-to-speech parameter
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POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Tts</Tag>

    <Operation>

        <TtsTpl>

            <Codec>mp3</Codec>
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            <Mode>Sync</Mode>

            <Speed>100</Speed>

            <VoiceType>aixiaonan</VoiceType>

            <Volume>0</Volume>

        </TtsTpl>

        <TtsConfig>

            <Input>Abed, I see a silver light. I wonder if it's frost around.</Inpu

            <InputType>Text</InputType>

        </TtsConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>demo.mp3</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Tts</Tag>

        <Operation>

            <TtsTpl>

                <Codec>mp3</Codec>

                <Mode>Sync</Mode>

                <Speed>100</Speed>

                <VoiceType>aixiaonan</VoiceType>

                <Volume>0</Volume>

            </TtsTpl>

            <TtsConfig>

                <Input>Abed, I see a silver light. I wonder if it's frost around.</

                <InputType>Text</InputType>

            </TtsConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/tts.mp3</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Submitting Video Montage Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit a video montage job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>VideoMontage</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job tag: VideoMontage String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request
Job callback format, which can be  JSON  
or  XML  (default value). It has a higher 
priority than that of the queue.

String No

CallBackType Request
Job callback type, which can be  Url  
(default value) or  TDMQ . It has a higher 
priority than that of the queue.

String No
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CallBack Request Job callback address, which has a higher 
priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

String No

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required if 
 CallBackType  is  TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Media filename String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

VideoMontage Request.Operation Video montage template parameter Container No

TemplateId Request.Operation Template ID String No

Output Request.Operation Result output address Container Yes

UserData Request.Operation
The user information passed through, 
which is printable ASCII codes of up to 
1,024 in length.

String No

JobLevel Request.Operation
Job priority. The greater the value, the 
higher the priority. Valid values:  0 ,  1 , 
 2 . Default value:  0 .

String No

Note: 

 TemplateId  is used first. If  TemplateId  is unavailable,  VideoMontage  is used.

 VideoMontage  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

TimeInterval Request.Operation.Transcode Same as Request.TimeInterval 
in the transcoding template 

Container No

https://intl.cloud.tencent.com/document/product/1045/49945
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creation API 
CreateMediaTemplate.

Container Request.Operation.Transcode

Same as Request.Container in 
the transcoding template 
creation API 
CreateMediaTemplate.

Container No

Video Request.Operation.Transcode
Same as Request.Video in the 
transcoding template creation 
API CreateMediaTemplate.

Container No

Audio Request.Operation.Transcode
Same as Request.Audio in the 
transcoding template creation 
API CreateMediaTemplate.

Container No

TransConfig Request.Operation.Transcode

Same as Request.TransConfig in 
the transcoding template 
creation API 
CreateMediaTemplate.

Container No

AudioMix Request.Operation.Transcode Audio mix parameter as 
described in Structure.

Container 
array

No

 Output  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output Output result filename String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoMontage</Tag>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>videomontage_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job tag: VideoMontage String

State Response.JobsDetail Job status. Valid values:  Submitted , String
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 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

VideoMontage Response.JobsDetail.Operation
Same as 
 Request.Operation.VideoMontage  
in the request.

Container

TemplateId Response.JobsDetail.Operation Job template ID String

TemplateName Response.JobsDetail.Operation
Job template name, which will be returned if 
 TemplateId  exists. String

Output Response.JobsDetail.Operation
Same as 
 Request.Operation.Output  in the 
request.

Container

MediaInfo Response.JobsDetail.Operation Output video information, which will not be 
returned when the job is not completed.

Container

MediaResult Response.JobsDetail.Operation Basic information of the output file, which will Container
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not be returned when the job is not 
completed.

UserData Response.JobsDetail.Operation The user information passed through. String

JobLevel Response.JobsDetail.Operation Job priority String

 MediaInfo  has the following sub-nodes:


Same as the  Response.MediaInfo  node in the  GenerateMediaInfo  API.

 MediaResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

OutputFile Response.Operation.MediaResult Basic information of the output 
file.

Container

 OutputFile  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Bucket Response.Operation.MediaResult.OutputFile Bucket of the output file. String

Region Response.Operation.MediaResult.OutputFile Bucket region of the output 
file.

String

ObjectName Response.Operation.MediaResult.OutputFile Output filename. There may 
be multiple values.

String array

Md5Info Response.Operation.MediaResult.OutputFile MD5 information of the 
output file.

Container 
array

 Md5Info  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info Output filename. String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info MD5 value of the 
output file.

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

https://intl.cloud.tencent.com/document/product/1045/49353
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Samples

Sample 1. Using the video montage template ID

Request

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml
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<Request>

    <Tag>VideoMontage</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoMontage</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>videomontage_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

Sample 2. Using the video montage processing parameter

Request
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POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoMontage</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>
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    <Operation>

        <VideoMontage>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height></Height>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

            </AudioMix>

            <Duration>15</Duration>

        </VideoMontage>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoMontage</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <VideoMontage>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Height></Height>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

                <AudioMix>

                    <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>

                </AudioMix>

                <Duration>15</Duration>

            </VideoMontage>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Submitting Video Enhancement Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit a video enhancement job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>VideoProcess</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t156c107210e7243c5817354565d81b578</TemplateId>

        <TranscodeTemplateId>t1460606b9752148c4ab182f55163ba7cd</TranscodeTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemplateI

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job tag: VideoProcess String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes
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CallBackFormat Request
Job callback format, which can be  JSON  or 
 XML  (default value). It has a higher priority 
than that of the queue.

String No

CallBackType Request
Job callback type, which can be  Url  (default 
value) or  TDMQ . It has a higher priority than 
that of the queue.

String No

CallBack Request

Job callback address, which has a higher 
priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

String No

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required if 
 CallBackType  is  TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Media filename String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

VideoProcess Request.Operation

Video enhancement template 
parameter. This node and 
 TemplateId  cannot be 
empty at the same time.

Container No

TemplateId Request.Operation
Template ID. This node and 
 VideoProcess  cannot be 
empty at the same time.

String No

Transcode Request.Operation

Transcoding template parameter. 
This node and 
 TranscodeTemplateId  
cannot be empty at the same 
time.

Container No

TranscodeTemplateId Request.Operation Transcoding template ID. This String No

https://intl.cloud.tencent.com/document/product/1045/49945
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node and  Transcode  cannot 
be empty at the same time. Use 
this node first.

array

Watermark Request.Operation

Watermark template parameter. 
Same as 
 Request.Watermark  in the 
watermark template creation API 
CreateMediaTemplate. Up to 
three watermarks can be passed 
in.

Container 
array

No

WatermarkTemplateId Request.Operation

Watermark template ID. Up to 
three watermark template IDs 
can be passed in. If 
 Watermark  and 
 WatermarkTemplateId  
exist at the same time, use 
 WatermarkTemplateId  
first.

String No

DigitalWatermark Request.Operation Specifies the digital watermark 
parameter

Container No

Output Request.Operation Result output address Container Yes

JobLevel Request.Operation

Job priority. The greater the 
value, the higher the priority. 
Valid values:  0 ,  1 ,  2 . 
Default value:  0 .

String No

Note: 
 To submit a video enhancement job, you must pass in the transcoding parameter. For the video enhancement 
parameter,  TemplateId  is used first, and if  TemplateId  is unavailable,  VideoProcess  is used. For the 

transcoding parameter,  TranscodeTemplateId  is used first, and if  TranscodeTemplateId  is unavailable, 

 Transcode  is used. For the watermark parameter,  WatermarkTemplateId  or  Watermark  can be used 

for configuration, and  WatermarkTemplateId  is used first.

 VideoProcess  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description

ColorEnhance Request.Operation.VideoProcess Same as Request.ColorEnhance in the video 
enhancement template creation API 

https://intl.cloud.tencent.com/document/product/1045/49917
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CreateMediaTemplate.

MsSharpen Request.Operation.VideoProcess
Same as Request.MsSharpen in the video 
enhancement template creation API 
CreateMediaTemplate.

 Transcode  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

TimeInterval Request.Operation.Transcode

Same as Request.TimeInterval 
in the transcoding template 
creation API 
CreateMediaTemplate.

Container No

Container Request.Operation.Transcode

Same as Request.Container in 
the transcoding template 
creation API 
CreateMediaTemplate.

Container No

Video Request.Operation.Transcode
Same as Request.Video in the 
transcoding template creation 
API CreateMediaTemplate.

Container No

Audio Request.Operation.Transcode
Same as Request.Audio in the 
transcoding template creation 
API CreateMediaTemplate.

Container No

TransConfig Request.Operation.Transcode

Same as Request.TransConfig in 
the transcoding template 
creation API 
CreateMediaTemplate.

Container No

AudioMix Request.Operation.Transcode Audio mix parameter as 
described in Structure.

Container 
array

No

 DigitalWatermark  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required

Message Request.Operation.DigitalWatermark The string embedded by the 
digital watermark, which can 
contain up to 64 letters, digits, 

string Yes

https://intl.cloud.tencent.com/document/product/1045/49915
https://intl.cloud.tencent.com/document/product/1045/49915
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49945
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underscores (_), hyphens (-), 
and asterisks (*).

Type Request.Operation.DigitalWatermark
Watermark type, which 
currently can be set to 
 Text  only.

String Yes

Version Request.Operation.DigitalWatermark
Watermark version, which 
currently can be set to  V1  
only.

String Yes

IgnoreError Request.Operation.DigitalWatermark

Whether to ignore the 
watermarking failure and 
continue the job. Valid values: 
 true ,  false  (default 
value).

string Yes

 Output  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output Output result filename String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoProcess</Tag>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t156c107210e7243c5817354565d81b578</TemplateId>

            <TemplateName>videoprocess_demo</TemplateName>

            <TranscodeTemplateId>t1460606b9752148c4ab182f55163ba7cd</TranscodeTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail Error code, which is returned only if  State  is String
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 Failed 

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job tag: VideoProcess String

State Response.JobsDetail
Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

VideoProcess Response.JobsDetail.Operation
Same as 
 Request.Operation.VideoProcess  
in the request.

Containe

TemplateId Response.JobsDetail.Operation Job template ID String

TemplateName Response.JobsDetail.Operation Job template name, which will be returned if String
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 TemplateId  exists.

Output Response.JobsDetail.Operation
Same as 
 Request.Operation.Output  in the 
request.

Containe

DigitalWatermark Response.JobsDetail.Operation Digital watermark parameter. Containe

MediaInfo Response.JobsDetail.Operation
Media information of the output file, which 
will not be returned when the job is not 
completed.

Containe

MediaResult Response.JobsDetail.Operation
Basic information of the output file, which will 
not be returned when the job is not 
completed.

Containe

DigitalWatermark Response.JobsDetail.Operation Digital watermark parameter. Containe

UserData Response.JobsDetail.Operation The user information passed through. String

JobLevel Response.JobsDetail.Operation Job priority String

 MediaInfo  has the following sub-nodes:


Same as the  Response.MediaInfo  node in the  GenerateMediaInfo  API.

 MediaResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

OutputFile Response.Operation.MediaResult Basic information of the output 
file.

Container

 OutputFile  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Bucket Response.Operation.MediaResult.OutputFile Bucket of the output file. String

Region Response.Operation.MediaResult.OutputFile Bucket region of the output 
file.

String

ObjectName Response.Operation.MediaResult.OutputFile Output filename. There may 
be multiple values.

String array

Md5Info Response.Operation.MediaResult.OutputFile MD5 information of the 
output file.

Container 
array
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 Md5Info  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info Output filename. String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info MD5 value of the 
output file.

Container

 DigitalWatermark  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type

Message Response.Operation.DigitalWatermark

The string in the digital watermark 
successfully embedded in the video, which 
can contain up to 64 letters, digits, 
underscores (_), hyphens (-), and asterisks 
(*).

string

Type Response.Operation.DigitalWatermark
Watermark type, which currently can be set 
to  Text  only. String

Version Response.Operation.DigitalWatermark
Watermark version, which currently can be 
set to  V1  only. String

IgnoreError Response.Operation.DigitalWatermark
Whether to ignore the watermarking failure 
and continue the job. Valid values: 
 true ,  false  (default value).

string

State Response.Operation.DigitalWatermark
Whether the watermark is added 
successfully. Valid values:  Running , 
 Success ,  Failed .

string

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request 1. Using the video enhancement template ID

https://intl.cloud.tencent.com/document/product/1045/49353
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POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoProcess</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>
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    <Operation>

        <TemplateId>t156c107210e7243c5817354565d81b578</TemplateId>

        <TranscodeTemplateId>t1460606b9752148c4ab182f55163ba7cd</TranscodeTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemplateI

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1313
of 2300

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoProcess</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t156c107210e7243c5817354565d81b578</TemplateId>

            <TemplateName>videoprocess_demo</TemplateName>

            <TranscodeTemplateId>t1460606b9752148c4ab182f55163ba7cd</TranscodeTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

Request 2. Using the video enhancement processing parameter
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POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoProcess</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>
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    <Operation>

        <VideoProcess>

            <ColorEnhance>

                <Contrast>50</Contrast>

                <Correction>100</Correction>

                <Enable>true</Enable>

                <Saturation>100</Saturation>

            </ColorEnhance>

            <MsSharpen>

                <Enable>true</Enable>

                <SharpenLevel>5</SharpenLevel>

            </MsSharpen>

        </VideoProcess>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </Transcode>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>
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            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>Watermark content</Text>

                <FontSize>30</FontSize>

                <FontType>simfang.ttf</FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoProcess</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <VideoProcess>

                <ColorEnhance>

                    <Contrast>50</Contrast>

                    <Correction>100</Correction>

                    <Enable>true</Enable>

                    <Saturation>100</Saturation>

                </ColorEnhance>

                <MsSharpen>

                    <Enable>true</Enable>

                    <SharpenLevel>5</SharpenLevel>

                </MsSharpen>

            </VideoProcess>

            <Transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Profile>high</Profile>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                    <Preset>medium</Preset>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

                <TransConfig>

                    <AdjDarMethod>scale</AdjDarMethod>

                    <IsCheckReso>false</IsCheckReso>
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                    <ResoAdjMethod>1</ResoAdjMethod>

                </TransConfig>

                <TimeInterval>

                    <Start>0</Start>

                    <Duration>60</Duration>

                </TimeInterval>

            </Transcode>

            <Watermark>

                <Type>Text</Type>

                <LocMode>Absolute</LocMode>

                <Dx>128</Dx>

                <Dy>128</Dy>

                <Pos>TopRight</Pos>

                <StartTime>0</StartTime>

                <EndTime>100.5</EndTime>

                <Text>

                    <Text>Watermark content</Text>

                    <FontSize>30</FontSize>

                    <FontType>simfang.ttf</FontType>

                    <FontColor>0xRRGGBB</FontColor>

                    <Transparency>30</Transparency>

                </Text>

            </Watermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Submitting Video Tagging Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit a video tagging job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>VideoTag</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <VideoTag>

            <Scenario>Stream</Scenario>

        </VideoTag>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job tag: VideoTag String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request
Job callback format, which can be  JSON  or 
 XML  (default). It has a higher priority than 
that of the queue.

String No

CallBackType Request
Job callback type, which can be  Url  
(default) or  TDMQ . It has a higher priority 
than that of the queue.

String No

CallBack Request Job callback address, which has a higher 
priority than that of the queue. If it is set to 

String No
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 no , no callbacks will be generated at the 
callback address of the queue.

CallBackMqConfig Request

TDMQ configuration for job callback as 
described in Structure > CallBackMqConfig, 
which is required if  CallBackType  is 
 TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input

Name of the media file on which to perform the 
video tagging job. Currently, .mp4, .avi, .mkv, 
.wmv, .rmvb, .flv, and .mov formats are 
supported. For videos longer than 30 minutes, 
submit a ticket for assistance.

String Yes

 Operation  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required

VideoTag Request.Operation  VideoTag  job parameter Container Yes

JobLevel Request.Operation

Job priority. The greater the 
value, the higher the priority. 
Valid values:  0  (default), 
 1 ,  2 .

String No

UserData Response.JobsDetail.Operation The user information passed 
through.

String No

 VideoTag  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required Constraints

Scenario Request.Operation.VideoTag Scenario type. You 
can select the 
application 
scenario of the 

string Yes The current 
version is only 
adapted to the 

https://intl.cloud.tencent.com/document/product/1045/49945
https://console.intl.cloud.tencent.com/workorder/category
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video tag. The 
used algorithm, 
input, and output 
vary by scenario.

 Stream  
scenario

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoTag</Tag>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <VideoTag>

                <Scenario>Stream</Scenario>

            </VideoTag>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job tag: VideoTag String

State Response.JobsDetail
Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String
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StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

VideoTag Response.JobsDetail.Operation
Same as 
 Request.Operation.VideoTag  in 
the request.

Container

VideoTagResult Response.JobsDetail.Operation
Video tag analysis result, which will not 
be returned when the job is not 
completed.

Container

UserData Response.JobsDetail.Operation The user information passed through. String

JobLevel Response.JobsDetail.Operation Job priority String

 VideoTagResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

StreamData Response.JobsDetail.Operation.VideoTagResult
Result of the video tagging 
job in the  Stream  
scenario

Container
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 StreamData  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Data Response.JobsDetail.Operation.VideoTagResult.StreamData

Result list of 
the video 
tagging job in 
the  Stream  
scenario

Container

SubErrCode Response.JobsDetail.Operation.VideoTagResult.StreamData

Algorithm 
status code. 
 0 : Success. 
Other values: 
Exception.

String

SubErrMsg Response.JobsDetail.Operation.VideoTagResult.StreamData

Algorithm error 
message. 
 ok  indicates 
a success. If 
the request 
fails, the 
corresponding 
error is 
returned.

String

 Data  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Tags Response.JobsDetail.Operation.VideoTagResult.StreamData.Data

Video tag 
and video 
category 
information

Container

PersonTags Response.JobsDetail.Operation.VideoTagResult.StreamData.Data Person tag 
information

Container 
array

PlaceTags Response.JobsDetail.Operation.VideoTagResult.StreamData.Data Scene tag 
information

Container 
array

ActionTags Response.JobsDetail.Operation.VideoTagResult.StreamData.Data Action tag 
information

Container 
array

ObjectTags Response.JobsDetail.Operation.VideoTagResult.StreamData.Data Object tag Container 
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information array

 Tags  (video tag) has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type

Tag Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.Tags Tag name String

TagCls Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.Tags Tag 
category

String

Confidence Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.Tags

Tag model 
prediction 
score. 
Value 
range: [0, 
1].

Float

 Tags  (video category) has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type

Tag Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.Tags Video 
category

String

Confidence Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.Tags

Tag model 
prediction 
score. 
Value 
range: [0, 
1].

Float

 PersonTags  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Descriptio

Name Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags Person 
name

Confidence Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags Tag mode
prediction 
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score

Count Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags
Number o
person 
appearanc

DetailPerSecond Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags

Location a
time of 
person 
appearanc

 DetailPerSecond  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node

TimeStamp Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags.DetailPerSecond

Confidence Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags.DetailPerSecond

BBox Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags.DetailPerSecond

 BBox  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node

X1 Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags.DetailPerSecond.BB

Y1 Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags.DetailPerSecond.BB
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X2 Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags.DetailPerSecond.BB

Y2 Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PersonTags.DetailPerSecond.BB

 PlaceTags  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description

Tags Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PlaceTags
Video scene
 Response

StartTime Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PlaceTags Segment st

EndTime Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PlaceTags Segment en

StartIndex Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PlaceTags Segment st

EndIndex Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PlaceTags Segment en

ClipFrameResult Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.PlaceTags Top 1 single

 ActionTags  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

Tags Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.ActionTags
Video action tag i
 Response.Job

StartTime Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.ActionTags Segment start tim

EndTime Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.ActionTags Segment end time

 ObjectTags  has the following sub-nodes:

Node Parent Node Description
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Name 
(Keyword)

Objects Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.ObjectTags
Video object tag
 Response.Jo

TimeStamp Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.ObjectTags Timestamp of th

 Object  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Descrip

Name Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.ObjectTags.Objects Object 

Confidence Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.ObjectTags.Objects Tag mo

BBox Response.JobsDetail.Operation.VideoTagResult.StreamData.Data.ObjectTags.Objects
Relative
 Respo

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/33700
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POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoTag</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>
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    <Operation>

        <VideoTag>

            <Scenario>Stream</Scenario>

        </VideoTag>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoTag</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <VideoTag>

                <Scenario>Stream</Scenario>

            </VideoTag>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Submitting Voice/Sound Separation Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit a voice/sound separation job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>VoiceSeparate</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/backgroud.mp3</Object>

            <AuObject>output/audio.mp3</AuObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job type: VoiceSeparate String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request
Job callback format, which can be  JSON  
or  XML  (default value). It has a higher 
priority than that of the queue.

String No

CallBackType Request Job callback type, which can be  Url  
(default value) or  TDMQ . It has a higher 

String No
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priority than that of the queue.

CallBack Request

Job callback address, which has a higher 
priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

String No

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required if 
 CallBackType  is  TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Media filename String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

VoiceSeparate Request.Operation Transcoding template 
parameter

Container No

TemplateId Request.Operation Template ID String No

Output Request.Operation Result output address Container Yes

JobLevel Request.Operation

Job priority. The greater 
the value, the higher the 
priority. Valid values:  0 , 
 1 ,  2 . Default value: 
 0 .

String No

Note: 
 TemplateId  is used first. If  TemplateId  is unavailable,  VoiceSeparate  is used.

 VoiceSeparate  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

AudioMode Request.Operation.VoiceSeparate Same as 
Request.AudioMode in the 

Container No

https://intl.cloud.tencent.com/document/product/1045/49945#CallBackMqConfig
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voice/sound separation 
template creation API 
CreateMediaTemplate.

AudioConfig Request.Operation.VoiceSeparate

Same as 
Request.AudioConfig in the 
voice/sound separation 
template creation API 
CreateMediaTemplate.

Container No

 Output  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output

Background audio result 
filename. This node and 
 AuObject  cannot be empty 
at the same time.

String No

AuObject Request.Operation.AuObject

Voice/Sound result filename. 
This node and  Object  
cannot be empty at the same 
time.

String No

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49916
https://intl.cloud.tencent.com/document/product/1045/49916
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VoiceSeparate</Tag>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>voiceseparate_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.mp3</Object>

                <AuObject>output/audio.mp3</AuObject>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job type: VoiceSeparate String



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1346
of 2300

State Response.JobsDetail Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

TemplateId Response.JobsDetail.Operation Job template ID String

TemplateName Response.JobsDetail.Operation
Job template name, which will be returned if 
 TemplateId  exists. String

VoiceSeparate Response.JobsDetail.Operation
Same as 
 Request.Operation.VoiceSeparate  
in the request.

Containe

Output Response.JobsDetail.Operation
Same as  Request.Operation.Output  
in the request.

Containe

MediaInfo Response.JobsDetail.Operation Output video information, which will not be 
returned when the job is not completed.

Containe

MediaResult Response.JobsDetail.Operation Basic information of the output file, which will Containe
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not be returned when the job is not 
completed.

UserData Response.JobsDetail.Operation The user information passed through. String

JobLevel Response.JobsDetail.Operation Job priority String

 MediaInfo  has the following sub-nodes:


Same as the  Response.MediaInfo  node in the  GenerateMediaInfo  API.

 MediaResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

OutputFile Response.Operation.MediaResult Basic information of the output 
file.

Container

 OutputFile  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Bucket Response.Operation.MediaResult.OutputFile Bucket of the output file. String

Region Response.Operation.MediaResult.OutputFile Bucket region of the output 
file.

String

ObjectName Response.Operation.MediaResult.OutputFile Output filename. There may 
be multiple values.

String array

Md5Info Response.Operation.MediaResult.OutputFile MD5 information of the 
output file.

Container 
array

 Md5Info  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info Output filename. String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info MD5 value of the 
output file.

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

https://intl.cloud.tencent.com/document/product/1045/49353
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Samples

Request 1. Using the voice/sound separation template ID

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml
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<Request>

    <Tag>VoiceSeparate</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/backgroud.mp3</Object>

            <AuObject>output/audio.mp3</AuObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response 1
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VoiceSeparate</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>voiceseparate_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.mp3</Object>

                <AuObject>output/audio.mp3</AuObject>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

Request 2. Using the voice/sound separation parameter
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POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VoiceSeparate</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>
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    <Operation>

        <VoiceSeparate>

            <AudioConfig>

                    <Bitrate>500</Bitrate>

                    <Channels>2</Channels>

                    <Codec>mp3</Codec>

                    <Samplerate>44100</Samplerate>

            </AudioConfig>

            <AudioMode>AudioAndBackground</AudioMode>

        </VoiceSeparate>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/backgroud.mp3</Object>

            <AuObject>output/audio.mp3</AuObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1355
of 2300

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VoiceSeparate</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <VoiceSeparate>

                <AudioConfig>

                    <Bitrate>500</Bitrate>

                    <Channels>2</Channels>

                    <Codec>mp3</Codec>

                    <Samplerate>44100</Samplerate>

                </AudioConfig>

                <AudioMode>AudioAndBackground</AudioMode>

            </VoiceSeparate>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.mp3</Object>

                <AuObject>output/audio.mp3</AuObject>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Submitting Top Speed Codec Transcoding
Job
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit a top speed codec transcoding job.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemplateI

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job tag: Transcode String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes
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QueueId Request Queue ID of the job String Yes

CallBackFormat Request
Job callback format, which can be  JSON  or 
 XML  (default value). It has a higher priority 
than that of the queue.

String No

CallBackType Request
Job callback type, which can be  Url  
(default value) or  TDMQ . It has a higher 
priority than that of the queue.

String No

CallBack Request

Job callback address, which has a higher 
priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

String No

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required if 
 CallBackType  is  TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Media filename String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

TemplateId Request.Operation ID of the top speed codec 
transcoding template.

String No

WatermarkTemplateId Request.Operation
Watermark template ID. Multiple 
watermark template IDs can be 
passed in.

String No

Watermark Request.Operation

Watermark template parameter. 
Same as 
 Request.Watermark  in the 
watermark template creation API  
CreateMediaTemplate.

Container No

DigitalWatermark Request.Operation Specifies the digital watermark 
parameter

Container No

https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49917
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Output Request.Operation Result output address Container Yes

UserData Request.Operation
The user information passed 
through, which is printable ASCII 
codes of up to 1,024 in length.

String No

JobLevel Request.Operation

Job priority. The greater the value, 
the higher the priority. Valid 
values:  0 ,  1 ,  2 . Default 
value:  0 .

String No

Note: 
 For the watermark parameter,  WatermarkTemplateId  or  Watermark  can be used for configuration, and 

 WatermarkTemplateId  is used first.

 DigitalWatermark  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required

Message Request.Operation.DigitalWatermark

The string embedded by the 
digital watermark, which can 
contain up to 64 letters, 
digits, underscores (_), 
hyphens (-), and asterisks 
(*).

string Yes

Type Request.Operation.DigitalWatermark
Watermark type, which 
currently can be set to 
 Text  only.

String Yes

Version Request.Operation.DigitalWatermark
Watermark version, which 
currently can be set to  V1  
only.

String Yes

IgnoreError Request.Operation.DigitalWatermark

Whether to ignore the 
watermarking failure and 
continue the job. Valid 
values:  true ,  false  
(default value).

string Yes

 Output  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required
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Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output Output result filename String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1364
of 2300

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>high_993874</TemplateName>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type
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Code Response.JobsDetail Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job tag: Transcode String

State Response.JobsDetail
Job status. Valid values:  Submitted ,  Running , 
 Success ,  Failed ,  Pause ,  Cancel .

String

Progress Response.JobsDetail
Task progress in percentage, which is returned only if 
 State  is  Submitted ,  Running , 
 Success , or  Pause . Value range: [0, 100].

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

TemplateId Response.JobsDetail.Operation Job template ID String

TemplateName Response.JobsDetail.Operation Job template name, which will be String
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returned if  TemplateId  exists.

Watermark Response.JobsDetail.Operation
Same as 
 Request.Operation.Watermark  
in the request.

Contain
array

WatermarkTemplateId Response.JobsDetail.Operation Watermark template ID. String 
array

Output Response.JobsDetail.Operation
Same as 
 Request.Operation.Output  in 
the request.

Contain

MediaInfo Response.JobsDetail.Operation
Media information of the output file, 
which will not be returned when the job 
is not completed.

Contain

MediaResult Response.JobsDetail.Operation
Basic information of the output file, 
which will not be returned when the job 
is not completed.

Contain

DigitalWatermark Response.JobsDetail.Operation Digital watermark parameter. Contain

UserData Response.JobsDetail.Operation The user information passed through. String

JobLevel Response.JobsDetail.Operation Job priority. String

 MediaInfo  has the following sub-nodes:


Same as the  Response.MediaInfo  node in the  GenerateMediaInfo  API.

 MediaResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

OutputFile Response.Operation.MediaResult Basic information of the output 
file.

Container

 OutputFile  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Bucket Response.Operation.MediaResult.OutputFile Bucket of the output file. String

Region Response.Operation.MediaResult.OutputFile Bucket region of the output 
file.

String
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ObjectName Response.Operation.MediaResult.OutputFile Output filename. There may 
be multiple values.

String array

Md5Info Response.Operation.MediaResult.OutputFile MD5 information of the 
output file.

Container 
array

 Md5Info  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

ObjectName Response.Operation.MediaResult.OutputFile.Md5Info Output filename. String

Md5 Response.Operation.MediaResult.OutputFile.Md5Info MD5 value of the 
output file.

Container

 DigitalWatermark  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type

Message Response.Operation.DigitalWatermark

The string in the digital watermark 
successfully embedded in the video, which 
can contain up to 64 letters, digits, 
underscores (_), hyphens (-), and asterisks 
(*).

string

Type Response.Operation.DigitalWatermark
Watermark type, which currently can be set 
to  Text  only. String

Version Response.Operation.DigitalWatermark
Watermark version, which currently can be 
set to  V1  only. String

IgnoreError Response.Operation.DigitalWatermark
Whether to ignore the watermarking failure 
and continue the job. Valid values: 
 true ,  false  (default value).

string

State Response.Operation.DigitalWatermark
Whether the watermark is added 
successfully. Valid values:  Running , 
 Success ,  Failed .

string

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

https://intl.cloud.tencent.com/document/product/1045/49353
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Samples

Request

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml
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<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemplateI

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemplateI

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:11+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>high_993874</TemplateName>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Canceling Media Processing Job
CancelMediaJob
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to cancel a job. Only pending jobs can be canceled.

Request

Sample request
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PUT /jobs/<jobId>?cancel HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request does not have a request body.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

This request has no response body.

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49351
https://intl.cloud.tencent.com/document/product/1045/49352
https://intl.cloud.tencent.com/document/product/1045/49353
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PUT /jobs/jb57da17e29c111eda218713081fe2b05?cancel HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjY=
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Querying Media Processing Job
DescribeMediaJob
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to query a specified job.

Request

Sample request
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GET /jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request does not have a request body.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <JobsDetail>

    </JobsDetail>

    <NonExistJobIds></NonExistJobIds>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1381
of 2300

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

JobsDetail Response Job details Container 
array

NonExistJobIds Response List of non-existing job IDs queried. If all jobs exist, this 
node will not be returned.

String

The content of  JobsDetail  varies by job type. For more information, see the following documents:

Submitting Audio/Video Transcoding Job﻿

Submitting Top Speed Codec Transcoding Job﻿
Submitting Video-to-Animated Image Conversion Job﻿
Submitting Video Frame Capturing Job﻿
Submitting Intelligent Thumbnail Job﻿
Submitting Video Splicing Job﻿

Submitting Voice/Sound Separation Job﻿
Submitting Video Montage Job﻿
Submitting SDR-to-HDR Job﻿
Submitting Video Enhancement Job﻿
Submitting Super Resolution Job﻿
Submitting Remuxing Job﻿

Submitting Digital Watermark Adding Job﻿
Submitting Digital Watermark Extracting Job﻿
Submitting Video Tagging Job﻿
Submitting Media Information Query Job﻿
Submitting Stream Separation Job﻿

Submitting Video Quality Scoring Job﻿
Submitting Text-to-Speech Job﻿
Submitting Audio Noise Cancellation Job﻿

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request 1: Querying an ongoing job

https://intl.cloud.tencent.com/document/product/1045/48941
https://intl.cloud.tencent.com/document/product/1045/49782
https://intl.cloud.tencent.com/document/product/1045/49569
https://intl.cloud.tencent.com/document/product/1045/48938
https://intl.cloud.tencent.com/document/product/1045/48937
https://intl.cloud.tencent.com/document/product/1045/48929
https://intl.cloud.tencent.com/document/product/1045/48946
https://intl.cloud.tencent.com/document/product/1045/48943
https://intl.cloud.tencent.com/document/product/1045/48935
https://intl.cloud.tencent.com/document/product/1045/48944
https://intl.cloud.tencent.com/document/product/1045/48940
https://intl.cloud.tencent.com/document/product/1045/48936
https://intl.cloud.tencent.com/document/product/1045/48930
https://intl.cloud.tencent.com/document/product/1045/48931
https://intl.cloud.tencent.com/document/product/1045/48945
https://intl.cloud.tencent.com/document/product/1045/48932
https://intl.cloud.tencent.com/document/product/1045/48939
https://intl.cloud.tencent.com/document/product/1045/48934
https://intl.cloud.tencent.com/document/product/1045/48942
https://intl.cloud.tencent.com/document/product/1045/48933
https://intl.cloud.tencent.com/document/product/1045/33700
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GET /jobs/j8d121820f5e411ec926ef19d53ba9c6f HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        </Message>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Running</State>

        <Progress>30</Progress>

        <CreationTime>2022-06-27T15:23:12+0800</CreationTime>

        <StartTime>2022-06-27T15:23:13+0800</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

Request 2: Querying a successfully completed job
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GET /jobs/j9c0a4726f6ac11ec96aaa9b64ab18d00 HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:25:22 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjY=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        </Message>

        <JobId>j9c0a4726f6ac11ec96aaa9b64ab18d00</JobId>

        <State>Success</State>

        <Progress>100</Progress>

        <CreationTime>2022-06-27T15:23:12+0800</CreationTime>

        <StartTime>2022-06-27T15:23:13+0800</StartTime>

        <EndTime>2022-06-27T15:24:33+0800</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

            <MediaInfo>

                <Format>

                    <Bitrate>834.736000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>
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                    <Size>1424687</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>104.047000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653311</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>763.774000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>10</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>
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                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Region>ap-chongqing</Region>

                    <ObjectName>output/out.mp4</ObjectName>

                    <Md5Info>

                            <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                            <ObjectName>output/out.mp4</ObjectName>

                    </Md5Info>

                </OutputFile>

            </MediaResult>

        </Operation>

    </JobsDetail>

</Response>
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DescribeMediaJobs
Last updated：2024-02-27 15:42:23

Feature Description

The API is used to pull jobs that meet specified conditions.

Request

Sample request
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GET /jobs?size=&states=&queueId=&startCreationTime=&endCreationTime= HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request parameters

The nodes are as described below:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

queueId None ID of the queue from which jobs are pulled. String Yes

tag None Job tag String Yes

workflowId None ID of the workflow triggering this job String No

inventoryTriggerJobId None ID of the batch data processing job triggering 
this job

String No

inputObject None Name of the input file for this job, which 
currently supports only exact match.

String No

orderByTime None  Desc  (default) or  Asc  String No

nextToken None Context token for pagination String No

size None
Maximum number of jobs that can be pulled. 
The default value is  10 . The maximum 
value is  100 .

Integer No

states None

Status of the jobs to pull. If you enter multiple 
job statuses, separate them by comma. Valid 
values:  All  (default),  Submitted , 
 Running ,  Success ,  Failed , 
 Pause ,  Cancel .

String No

startCreationTime None
Start time of the time range for job pulling in 
the format of  %Y-%m-%dT%H:%m:%S%z , 
such as  2001-01-01T00:00:00+0800 

String No

endCreationTime None
End time of the time range for job pulling in 
the format of  %Y-%m-%dT%H:%m:%S%z , 
such as  2001-01-01T23:59:59+0800 

String No

Supported  tag  types are as follows:

Job type  tag 

Audio/Video transcoding Transcode

Video-to-animated image conversion Animation
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Screenshot Snapshot

Intelligent thumbnail SmartCover

Audio/Video splicing Concat

Voice/Sound separation VoiceSeparate

Video montage VideoMontage

SDR to HDR SDRtoHDR

Video enhancement VideoProcess

Super resolution SuperResolution

Audio/Video remuxing Segment

Digital watermark DigitalWatermark

Digital watermark extraction ExtractDigitalWatermark

Video tagging VideoTag

Media information query MediaInfo

Audio/Video stream separation StreamExtract

Video quality analysis QualityEstimate

Text to speech Tts

Audio noise cancellation NoiseReduction

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request does not have a request body.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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Response body

The response body returns application/xml data. The following contains all the nodes:

<Response>

    <JobsDetail>

        ...

    </JobsDetail>

    <NextToken></NextToken>

</Response>

The nodes are as described below:
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Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container array

NextToken Response Context token for 
pagination

String

The content of  JobsDetail  varies by job type. For more information, see the following documents:

Submitting Video Transcoding Job﻿
Submitting Top Speed Codec Transcoding Job﻿
Submitting Video-to-Animated Image Conversion Job﻿
Submitting Video Frame Capturing Job﻿
Submitting Intelligent Thumbnail Job﻿

Submitting Video Splicing Job﻿
Submitting Voice/Sound Separation Job﻿
Submitting Video Montage Job﻿
Submitting SDR-to-HDR Job﻿
Submitting Video Enhancement Job﻿

Submitting Super Resolution Job﻿
Submitting Remuxing Job﻿
Submitting Digital Watermark Adding Job﻿
Submitting Digital Watermark Extracting Job﻿
Submitting Video Tagging Job﻿

Submitting Media Information Query Job﻿
Submitting Stream Separation Job﻿
Submitting Video Quality Scoring Job﻿
Submitting Text-to-Speech Job﻿
Submitting Audio Noise Cancellation Job﻿

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

https://intl.cloud.tencent.com/document/product/1045/48941
https://intl.cloud.tencent.com/document/product/1045/49782
https://intl.cloud.tencent.com/document/product/1045/49569
https://intl.cloud.tencent.com/document/product/1045/48938
https://intl.cloud.tencent.com/document/product/1045/48937
https://intl.cloud.tencent.com/document/product/1045/48929
https://intl.cloud.tencent.com/document/product/1045/48946
https://intl.cloud.tencent.com/document/product/1045/48943
https://intl.cloud.tencent.com/document/product/1045/48935
https://intl.cloud.tencent.com/document/product/1045/48944
https://intl.cloud.tencent.com/document/product/1045/48940
https://intl.cloud.tencent.com/document/product/1045/48936
https://intl.cloud.tencent.com/document/product/1045/48930
https://intl.cloud.tencent.com/document/product/1045/48931
https://intl.cloud.tencent.com/document/product/1045/48945
https://intl.cloud.tencent.com/document/product/1045/48932
https://intl.cloud.tencent.com/document/product/1045/48939
https://intl.cloud.tencent.com/document/product/1045/48934
https://intl.cloud.tencent.com/document/product/1045/48942
https://intl.cloud.tencent.com/document/product/1045/48933
https://intl.cloud.tencent.com/document/product/1045/33700
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Request

GET /jobs?queueId=p2242ab62c7c94486915508540933a2c6&tag=Transcode HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        </Message>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Running</State>

        <Progress>30</Progress>

        <CreationTime>2022-06-27T15:23:12+0800</CreationTime>

        <StartTime>2022-06-27T15:23:13+0800</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        </Message>

        <JobId>j9c0a4726f6ac11ec96aaa9b64ab18d00</JobId>

        <State>Success</State>

        <Progress>100</Progress>
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        <CreationTime>2022-06-27T15:23:12+0800</CreationTime>

        <StartTime>2022-06-27T15:23:13+0800</StartTime>

        <EndTime>2022-06-27T15:24:33+0800</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTempl

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTempl

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

            <MediaInfo>

                <Format>

                    <Bitrate>834.736000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>1424687</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>
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                    <Audio>

                        <Bitrate>104.047000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653311</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>763.774000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>10</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>
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            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Region>ap-chongqing</Region>

                    <ObjectName>output/out.mp4</ObjectName>

                    <Md5Info>

                            <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                            <ObjectName>output/out.mp4</ObjectName>

                    </Md5Info>

                </OutputFile>

            </MediaResult>

        </Operation>

    </JobsDetail>

    <NextToken>225508</NextToken>

</Response>
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Media Processing Job Callback
Video-to-Animated Image Conversion
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>97624.424000</Bitrate>

                    <Duration>0.870000</Duration>

                    <FormatLongName>CompuServe Graphics Interchange Format (GIF)</F

                    <FormatName>gif</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>10616656</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.666667</AvgFps>

                        <CodecLongName>CompuServe GIF (Graphics Interchange Format)

                        <CodecName>gif</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/100</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>0.870000</Duration>

                        <Fps>15.083333</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>2258</Height>

                        <Index>0</Index>

                        <Level>-99</Level>

                        <NumFrames>7</NumFrames>

                        <PixFormat>bgra</PixFormat>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/100</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>
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                        <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                        <ObjectName>output/animation.gif</ObjectName>

                    </Md5Info>

                    <ObjectName>output/animation.gif</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.gif</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>template_name1512456</TemplateName>

            <UserData>This is my Animation job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>Animation</Tag>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the animated image job submitting API.﻿

If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name Parent Node Description Type

https://intl.cloud.tencent.com/document/product/1045/49569
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(Keyword)

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.

 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>97624.424000</Bitrate>

                    <Duration>0.870000</Duration>

                    <FormatLongName>CompuServe Graphics Interchange Format (GIF)</F

                    <FormatName>gif</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>10616656</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.666667</AvgFps>

                        <CodecLongName>CompuServe GIF (Graphics Interchange Format)

                        <CodecName>gif</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/100</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>0.870000</Duration>

                        <Fps>15.083333</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>2258</Height>

                        <Index>0</Index>

                        <Level>-99</Level>

                        <NumFrames>7</NumFrames>

                        <PixFormat>bgra</PixFormat>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/100</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>
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                        <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                        <ObjectName>output/animation.gif</ObjectName>

                    </Md5Info>

                    <ObjectName>output/animation.gif</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.gif</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>template_name1512456</TemplateName>

            <UserData>This is my Animation job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>Animation</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback triggered by a workflow
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>
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                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>97624.424000</Bitrate>

                    <Duration>0.870000</Duration>

                    <FormatLongName>CompuServe Graphics Interchange Format (GIF)</F

                    <FormatName>gif</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>10616656</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.666667</AvgFps>

                        <CodecLongName>CompuServe GIF (Graphics Interchange Format)

                        <CodecName>gif</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/100</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>0.870000</Duration>

                        <Fps>15.083333</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>2258</Height>
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                        <Index>0</Index>

                        <Level>-99</Level>

                        <NumFrames>7</NumFrames>

                        <PixFormat>bgra</PixFormat>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/100</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                        <ObjectName>output/animation.gif</ObjectName>

                    </Md5Info>

                    <ObjectName>output/animation.gif</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.gif</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>template_name1512456</TemplateName>

            <UserData>This is my Animation job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>Animation</Tag>

        <Workflow>

            <Name>Animation_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>
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Sample 3: Job callback in JSON format triggered by a workflow

{

    "EventName": "TaskFinish",

    "JobsDetail": {

        "Code": "Success",

        "CreationTime": "2022-06-30T15:29:42+0800",

        "EndTime": "2022-06-30T15:29:48+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",
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            "Region": "ap-chongqing",

            "CosHeaders": [{

                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j682b9662f84611ecb8546d80f2baf56f",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "97624.424000",

                    "Duration": "0.870000",

                    "FormatLongName": "CompuServe Graphics Interchange Format (GIF)

                    "FormatName": "gif",

                    "NumProgram": "0",

                    "NumStream": "1",

                    "Size": "10616656",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Video": {

                        "AvgFps": "14.666667",

                        "CodecLongName": "CompuServe GIF (Graphics Interchange Form

                        "CodecName": "gif",

                        "CodecTag": "0x0000",

                        "CodecTagString": "[0][0][0][0]",

                        "CodecTimeBase": "1/100",

                        "ColorPrimaries": "unknown",

                        "ColorRange": "unknown",

                        "ColorTransfer": "unknown",

                        "Duration": "0.870000",

                        "Fps": "15.083333",

                        "HasBFrame": "0",

                        "Height": "2258",
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                        "Index": "0",

                        "Level": "-99",

                        "NumFrames": "7",

                        "PixFormat": "bgra",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.000000",

                        "Timebase": "1/100",

                        "Width": "1280"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "3df1f845d2ffd20a525a93ec40014d90",

                        "ObjectName": "output/animation.gif"

                    },

                    "ObjectName": "output/animation.gif",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/animation.gif",

                "Region": "ap-chongqing"

            },

            "TemplateId": "t1f16e1dfbdc994105b31292d45710642a",

            "TemplateName": "template_name1512456",

            "UserData": "This is my Animation job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T15:29:43+0800",

        "State": "Success",

        "Tag": "Animation",

        "Workflow": {

            "Name": "Animation_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }

}
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Audio/Video Splicing
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:33:07+0800</CreationTime>

        <EndTime>2022-06-30T18:33:20+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j07f6263af86011ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>830.482000</Bitrate>

                    <Duration>70.413000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>7309593</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>32.020000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>70.412857</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.990016</AvgFps>

                        <Bitrate>803.112000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Dar>4:3</Dar>

                        <Duration>69.779778</Duration>

                        <Fps>15.000000</Fps>
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                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>32</Level>

                        <NumFrames>1046</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <Sar>1:1</Sar>

                        <StartTime>0.046000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>96322f8638d38480683e069e6b2ba1e9</Md5>

                        <ObjectName>output/concat.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/concat.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/concat.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t140325e8918ac423da53b7d78dbbab564</TemplateId>

            <TemplateName>template_name3544697</TemplateName>

            <UserData>This is my Concat job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:33:08+0800</StartTime>

        <State>Success</State>

        <Tag>Concat</Tag>

    </JobsDetail>

</Response>

The nodes are as described below:
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Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response Fixed value:  TaskFinish . String

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the splicing job submitting API.﻿
If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.
 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API

https://intl.cloud.tencent.com/document/product/1045/48929%22
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:33:07+0800</CreationTime>

        <EndTime>2022-06-30T18:33:20+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j07f6263af86011ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>830.482000</Bitrate>

                    <Duration>70.413000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>7309593</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>32.020000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>70.412857</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.990016</AvgFps>

                        <Bitrate>803.112000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Dar>4:3</Dar>

                        <Duration>69.779778</Duration>

                        <Fps>15.000000</Fps>
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                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>32</Level>

                        <NumFrames>1046</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <Sar>1:1</Sar>

                        <StartTime>0.046000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>96322f8638d38480683e069e6b2ba1e9</Md5>

                        <ObjectName>output/concat.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/concat.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/concat.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t140325e8918ac423da53b7d78dbbab564</TemplateId>

            <TemplateName>template_name3544697</TemplateName>

            <UserData>This is my Concat job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:33:08+0800</StartTime>

        <State>Success</State>

        <Tag>Concat</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback triggered by a workflow
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:33:07+0800</CreationTime>

        <EndTime>2022-06-30T18:33:20+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>
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                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j07f6263af86011ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>830.482000</Bitrate>

                    <Duration>70.413000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>7309593</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>32.020000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>70.412857</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>
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                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.990016</AvgFps>

                        <Bitrate>803.112000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Dar>4:3</Dar>

                        <Duration>69.779778</Duration>

                        <Fps>15.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>32</Level>

                        <NumFrames>1046</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <Sar>1:1</Sar>

                        <StartTime>0.046000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>96322f8638d38480683e069e6b2ba1e9</Md5>

                        <ObjectName>output/concat.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/concat.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1427
of 2300

                <Object>output/concat.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t140325e8918ac423da53b7d78dbbab564</TemplateId>

            <TemplateName>template_name3544697</TemplateName>

            <UserData>This is my Concat job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:33:08+0800</StartTime>

        <State>Success</State>

        <Tag>Concat</Tag>

        <Workflow>

            <Name>Concat_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

Sample 3: Job callback in JSON format triggered by a workflow
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{

    "EventName": "TaskFinish",

    "JobsDetail": {

        "Code": "Success",

        "CreationTime": "2022-06-30T18:33:07+0800",

        "EndTime": "2022-06-30T18:33:20+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{
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                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j07f6263af86011ecbdf419856486c0ab",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "830.482000",

                    "Duration": "70.413000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "7309593",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "32.020000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",

                        "Duration": "70.412857",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"
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                    },

                    "Video": {

                        "AvgFps": "14.990016",

                        "Bitrate": "803.112000",

                        "CodecLongName": "H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10

                        "CodecName": "h264",

                        "CodecTag": "0x31637661",

                        "CodecTagString": "avc1",

                        "CodecTimeBase": "1/90000",

                        "ColorPrimaries": "unknown",

                        "ColorRange": "unknown",

                        "ColorTransfer": "unknown",

                        "Dar": "4:3",

                        "Duration": "69.779778",

                        "Fps": "15.000000",

                        "HasBFrame": "2",

                        "Height": "960",

                        "Index": "0",

                        "Language": "und",

                        "Level": "32",

                        "NumFrames": "1046",

                        "PixFormat": "yuv420p",

                        "Profile": "High",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "Sar": "1:1",

                        "StartTime": "0.046000",

                        "Timebase": "1/90000",

                        "Width": "1280"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "96322f8638d38480683e069e6b2ba1e9",

                        "ObjectName": "output/concat.mp4"

                    },

                    "ObjectName": "output/concat.mp4",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/concat.mp4",

                "Region": "ap-chongqing"
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            },

            "TemplateId": "t140325e8918ac423da53b7d78dbbab564",

            "TemplateName": "template_name3544697",

            "UserData": "This is my Concat job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T18:33:08+0800",

        "State": "Success",

        "Tag": "Concat",

        "Workflow": {

            "Name": "Concat_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }

}
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Adding Digital Watermark
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:37:37+0800</CreationTime>

        <EndTime>2022-06-30T18:39:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>ja8de3b46f86011ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <DigitalWatermark>

                <Message>123456789ab</Message>

                <Type>Text</Type>

                <Version>V1</Version>

            </DigitalWatermark>

            <MediaInfo>

                <Format>

                    <Bitrate>2533.526000</Bitrate>

                    <Duration>215.638000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>68290577</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>256.050000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/48000</CodecTimeBase>

                        <Duration>215.637000</Duration>

                        <Index>1</Index>

                        <Language>eng</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>48000</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/48000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.000000</AvgFps>

                        <Bitrate>2272.528000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12288</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>
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                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>215.583333</Duration>

                        <Fps>24.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>1080</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>40</Level>

                        <NumFrames>5174</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12288</Timebase>

                        <Width>1920</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>043221daee3f4e15ff13f42329f15eb1</Md5>

                        <ObjectName>output/digital.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/digital.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/digital.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my DigitalWatermark job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:37:38+0800</StartTime>

        <State>Success</State>

        <SubTag>DigitalWatermark</SubTag>

        <Tag>DigitalWatermark</Tag>

    </JobsDetail>

</Response>
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The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the digital watermark job submitting API.
If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.
 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

https://intl.cloud.tencent.com/document/product/1045/48930#jobsDetail
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Sample 1: Job callback triggered by a job API

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:37:37+0800</CreationTime>

        <EndTime>2022-06-30T18:39:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>
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            <Region>ap-chongqing</Region>

        </Input>

        <JobId>ja8de3b46f86011ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <DigitalWatermark>

                <Message>123456789ab</Message>

                <Type>Text</Type>

                <Version>V1</Version>

            </DigitalWatermark>

            <MediaInfo>

                <Format>

                    <Bitrate>2533.526000</Bitrate>

                    <Duration>215.638000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>68290577</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>256.050000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/48000</CodecTimeBase>

                        <Duration>215.637000</Duration>

                        <Index>1</Index>

                        <Language>eng</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>48000</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/48000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.000000</AvgFps>

                        <Bitrate>2272.528000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>
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                        <CodecTimeBase>1/12288</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>215.583333</Duration>

                        <Fps>24.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>1080</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>40</Level>

                        <NumFrames>5174</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12288</Timebase>

                        <Width>1920</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>043221daee3f4e15ff13f42329f15eb1</Md5>

                        <ObjectName>output/digital.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/digital.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/digital.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my DigitalWatermark job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:37:38+0800</StartTime>

        <State>Success</State>

        <SubTag>DigitalWatermark</SubTag>

        <Tag>DigitalWatermark</Tag>

    </JobsDetail>
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</Response>

Sample 2: Job callback in JSON format triggered by a job API

{

    "EventName": "TaskFinish",

    "JobsDetail": {

        "Code": "Success",

        "CreationTime": "2022-06-30T18:37:37+0800",

        "EndTime": "2022-06-30T18:39:08+0800",
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        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing"

        },

        "JobId": "ja8de3b46f86011ec9452c1c27f56a659",

        "Operation": {

            "DigitalWatermark": {

                "Message": "123456789ab",

                "Type": "Text",

                "Version": "V1"

            },

            "MediaInfo": {

                "Format": {

                    "Bitrate": "2533.526000",

                    "Duration": "215.638000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "68290577",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "256.050000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/48000",

                        "Duration": "215.637000",

                        "Index": "1",

                        "Language": "eng",

                        "SampleFmt": "fltp",

                        "SampleRate": "48000",

                        "StartTime": "0.000000",

                        "Timebase": "1/48000"

                    },

                    "Video": {

                        "AvgFps": "24.000000",

                        "Bitrate": "2272.528000",

                        "CodecLongName": "H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10

                        "CodecName": "h264",

                        "CodecTag": "0x31637661",
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                        "CodecTagString": "avc1",

                        "CodecTimeBase": "1/12288",

                        "ColorPrimaries": "unknown",

                        "ColorRange": "unknown",

                        "ColorTransfer": "unknown",

                        "Duration": "215.583333",

                        "Fps": "24.000000",

                        "HasBFrame": "2",

                        "Height": "1080",

                        "Index": "0",

                        "Language": "und",

                        "Level": "40",

                        "NumFrames": "5174",

                        "PixFormat": "yuv420p",

                        "Profile": "High",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.000000",

                        "Timebase": "1/12288",

                        "Width": "1920"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "043221daee3f4e15ff13f42329f15eb1",

                        "ObjectName": "output/digital.mp4"

                    },

                    "ObjectName": "output/digital.mp4",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/digital.mp4",

                "Region": "ap-chongqing"

            },

            "UserData": "This is my DigitalWatermark job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T18:37:38+0800",

        "State": "Success",

        "SubTag": "DigitalWatermark",

        "Tag": "DigitalWatermark"

    }
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Extracting Digital Watermark
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:42:20+0800</CreationTime>

        <EndTime>2022-06-30T18:42:54+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>output/digital.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j515a494af86111ecb8546d80f2baf56f</JobId>

        <Message>done</Message>

        <Operation>

            <ExtractDigitalWatermark>

                <Message>123456789ab</Message>

                <Type>Text</Type>

                <Version>V1</Version>

            </ExtractDigitalWatermark>

            <UserData>This is my ExtractDigitalWatermark job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:42:21+0800</StartTime>

        <State>Success</State>

        <Tag>ExtractDigitalWatermark</Tag>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the digital watermark extracting job submitting API.

If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

https://intl.cloud.tencent.com/document/product/1045/48931#jobsDetail
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If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.
 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:42:20+0800</CreationTime>

        <EndTime>2022-06-30T18:42:54+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>output/digital.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j515a494af86111ecb8546d80f2baf56f</JobId>

        <Message>done</Message>

        <Operation>

            <ExtractDigitalWatermark>

                <Message>123456789ab</Message>

                <Type>Text</Type>

                <Version>V1</Version>

            </ExtractDigitalWatermark>

            <UserData>This is my ExtractDigitalWatermark job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:42:21+0800</StartTime>

        <State>Success</State>

        <Tag>ExtractDigitalWatermark</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback in JSON format triggered by a job API
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{

    "EventName": "TaskFinish",

    "JobsDetail": {

        "Code": "Success",

        "CreationTime": "2022-06-30T18:42:20+0800",

        "EndTime": "2022-06-30T18:42:54+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "output/digital.mp4",

            "Region": "ap-chongqing"

        },
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        "JobId": "j515a494af86111ecb8546d80f2baf56f",

        "Message": "done",

        "Operation": {

            "ExtractDigitalWatermark": {

                "Message": "123456789ab",

                "Type": "Text",

                "Version": "V1"

            },

            "UserData": "This is my ExtractDigitalWatermark job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T18:42:21+0800",

        "State": "Success",

        "Tag": "ExtractDigitalWatermark"

    }

}
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Getting Media Information
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:45:14+0800</CreationTime>

        <EndTime>2022-06-30T18:45:15+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>jb976c9e0f86111ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>834.736000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>1424687</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>104.047000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653311</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>763.774000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>0</HasBFrame>
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                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>10</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <UserData>This is my MediaInfo job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:45:15+0800</StartTime>

        <State>Success</State>

        <Tag>MediaInfo</Tag>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the media information query job submitting API.﻿

If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name Parent Node Description Type

https://intl.cloud.tencent.com/document/product/1045/48932
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(Keyword)

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.

 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:45:14+0800</CreationTime>

        <EndTime>2022-06-30T18:45:15+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>jb976c9e0f86111ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>834.736000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>1424687</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>104.047000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653311</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>763.774000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>0</HasBFrame>
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                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>10</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <UserData>This is my MediaInfo job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:45:15+0800</StartTime>

        <State>Success</State>

        <Tag>MediaInfo</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback in JSON format triggered by a job API
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{

    "EventName": "TaskFinish",

    "JobsDetail": {

        "Code": "Success",

        "CreationTime": "2022-06-30T18:45:14+0800",

        "EndTime": "2022-06-30T18:45:15+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing"

        },
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        "JobId": "jb976c9e0f86111ec9452c1c27f56a659",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "834.736000",

                    "Duration": "13.654000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "1424687",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "104.047000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",

                        "Duration": "13.653311",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"

                    },

                    "Video": {

                        "AvgFps": "25.000000",

                        "Bitrate": "763.774000",

                        "CodecLongName": "H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10

                        "CodecName": "h264",

                        "CodecTag": "0x31637661",

                        "CodecTagString": "avc1",

                        "CodecTimeBase": "1/12800",

                        "ColorPrimaries": "bt470bg",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte170m",

                        "Duration": "12.960000",

                        "Fps": "25.000000",

                        "HasBFrame": "0",

                        "Height": "960",

                        "Index": "0",
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                        "Language": "und",

                        "Level": "10",

                        "NumFrames": "324",

                        "PixFormat": "yuv420p",

                        "Profile": "High",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.000000",

                        "Timebase": "1/12800",

                        "Width": "544"

                    }

                }

            },

            "UserData": "This is my MediaInfo job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T18:45:15+0800",

        "State": "Success",

        "Tag": "MediaInfo"

    }

}
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Noise Reduction
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:47:18+0800</CreationTime>

        <EndTime>2022-06-30T18:47:30+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j035aca66f86211ec8a5a87e016101404</JobId>

        <Message>SUCCESS</Message>

        <Operation>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/nr.wav</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my NoiseReduction job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:47:20+0800</StartTime>

        <State>Success</State>

        <Tag>NoiseReduction</Tag>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the audio noise reduction job submitting API.﻿

If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

https://intl.cloud.tencent.com/document/product/1045/48933
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If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.
 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:47:18+0800</CreationTime>

        <EndTime>2022-06-30T18:47:30+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j035aca66f86211ec8a5a87e016101404</JobId>

        <Message>SUCCESS</Message>

        <Operation>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/nr.wav</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my NoiseReduction job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:47:20+0800</StartTime>

        <State>Success</State>

        <Tag>NoiseReduction</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback in JSON format triggered by a job API
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{

    "EventName": "TaskFinish",

    "JobsDetail": {

        "Code": "Success",

        "CreationTime": "2022-06-30T18:47:18+0800",

        "EndTime": "2022-06-30T18:47:30+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp3",

            "Region": "ap-chongqing"

        },
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        "JobId": "j035aca66f86211ec8a5a87e016101404",

        "Message": "SUCCESS",

        "Operation": {

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/nr.wav",

                "Region": "ap-chongqing"

            },

            "UserData": "This is my NoiseReduction job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T18:47:20+0800",

        "State": "Success",

        "Tag": "NoiseReduction"

    }

}



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1471
of 2300

Video Quality Scoring
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:06:27+0800</CreationTime>

        <EndTime>2022-06-30T19:06:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>jb01fe2f2f86411ec9ca1073b78d316d3</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>834736</Bitrate>

                    <Duration>13.654</Duration>

                    <NumStream>1</NumStream>

                    <Size>1424687</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>104047</Bitrate>

                        <Channel>2</Channel>

                        <CodecName>aac</CodecName>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000</AvgFps>

                        <Bitrate>763774</Bitrate>

                        <CodecName>h264</CodecName>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <Fps>25.000</Fps>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Level>1.000</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <Rotation>0</Rotation>

                        <StartTime>0.000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile/>

            </MediaResult>

            <QualityEstimate>
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                <Score>6.460358</Score>

            </QualityEstimate>

            <UserData>This is my QualityEstimate job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:06:28+0800</StartTime>

        <State>Success</State>

        <Tag>QualityEstimate</Tag>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the video quality analysis job submitting API.﻿
If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.

 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

https://intl.cloud.tencent.com/document/product/1045/48934#jobsDetail


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1475
of 2300

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1476
of 2300

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:06:27+0800</CreationTime>

        <EndTime>2022-06-30T19:06:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>jb01fe2f2f86411ec9ca1073b78d316d3</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>834736</Bitrate>

                    <Duration>13.654</Duration>

                    <NumStream>1</NumStream>

                    <Size>1424687</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>104047</Bitrate>

                        <Channel>2</Channel>

                        <CodecName>aac</CodecName>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000</AvgFps>

                        <Bitrate>763774</Bitrate>

                        <CodecName>h264</CodecName>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <Fps>25.000</Fps>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Level>1.000</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <Rotation>0</Rotation>

                        <StartTime>0.000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile/>

            </MediaResult>

            <QualityEstimate>
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                <Score>6.460358</Score>

            </QualityEstimate>

            <UserData>This is my QualityEstimate job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:06:28+0800</StartTime>

        <State>Success</State>

        <Tag>QualityEstimate</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback in JSON format triggered by a job API
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{

    "EventName": "TaskFinish",

    "JobsDetail": {

        "Code": "Success",

        "CreationTime": "2022-06-30T19:06:27+0800",

        "EndTime": "2022-06-30T19:06:34+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing"

        },
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        "JobId": "jb01fe2f2f86411ec9ca1073b78d316d3",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "834736",

                    "Duration": "13.654",

                    "NumStream": "1",

                    "Size": "1424687"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "104047",

                        "Channel": "2",

                        "CodecName": "aac",

                        "Duration": "13.653",

                        "Index": "1",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100"

                    },

                    "Video": {

                        "AvgFps": "25.000",

                        "Bitrate": "763774",

                        "CodecName": "h264",

                        "ColorPrimaries": "unknown",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte170m",

                        "Duration": "12.960",

                        "Fps": "25.000",

                        "Height": "960",

                        "Index": "0",

                        "Level": "1.000",

                        "NumFrames": "324",

                        "PixFormat": "yuv420p",

                        "Profile": "High",

                        "Rotation": "0",

                        "StartTime": "0.000",

                        "Timebase": "1/12800",

                        "Width": "544"

                    }

                }

            },

            "MediaResult": {

            },

            "QualityEstimate": {

                "Score": "6.460358"

            },



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1481
of 2300

            "UserData": "This is my QualityEstimate job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T19:06:28+0800",

        "State": "Success",

        "Tag": "QualityEstimate"

    }

}
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SDRtoHDR
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:20:45+0800</CreationTime>

        <EndTime>2022-06-30T19:21:06+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>jafa709a2f86611ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>9514.268000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>16238478</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>9878.900000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt2020</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte2084</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>
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                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>ed8b5615687d789d6293bd58fa1ea1c0</Md5>

                        <ObjectName>output/sdr2hdr.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/sdr2hdr.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/sdr2hdr.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <UserData>This is my SDRtoHDR job.</UserData>

            <WatermarkTemplateId>t143ae6e040af6431aa772c9ec3f0a3f36</WatermarkTempl

            <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTempl

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:20:46+0800</StartTime>

        <State>Success</State>

        <Tag>SDRtoHDR</Tag>

    </JobsDetail>

</Response>
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The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details container array

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the SDR-to-HDR job submitting API.﻿
If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.

 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

https://intl.cloud.tencent.com/document/product/1045/48935
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Sample 1: Job callback triggered by a job API

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:20:45+0800</CreationTime>

        <EndTime>2022-06-30T19:21:06+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>
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            <Region>ap-chongqing</Region>

        </Input>

        <JobId>jafa709a2f86611ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>9514.268000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>16238478</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>9878.900000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt2020</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte2084</ColorTransfer>

                        <Duration>12.960000</Duration>
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                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>ed8b5615687d789d6293bd58fa1ea1c0</Md5>

                        <ObjectName>output/sdr2hdr.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/sdr2hdr.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/sdr2hdr.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <UserData>This is my SDRtoHDR job.</UserData>

            <WatermarkTemplateId>t143ae6e040af6431aa772c9ec3f0a3f36</WatermarkTempl

            <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTempl

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:20:46+0800</StartTime>

        <State>Success</State>

        <Tag>SDRtoHDR</Tag>
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    </JobsDetail>

</Response>

Sample 2: Job callback triggered by a workflow

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:20:45+0800</CreationTime>
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        <EndTime>2022-06-30T19:21:06+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>jafa709a2f86611ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>9514.268000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>16238478</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>
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                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>9878.900000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt2020</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte2084</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>ed8b5615687d789d6293bd58fa1ea1c0</Md5>

                        <ObjectName>output/sdr2hdr.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/sdr2hdr.mp4</ObjectName>

                    <ObjectPrefix/>
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                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/sdr2hdr.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <UserData>This is my SDRtoHDR job.</UserData>

            <WatermarkTemplateId>t143ae6e040af6431aa772c9ec3f0a3f36</WatermarkTempl

            <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTempl

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:20:46+0800</StartTime>

        <State>Success</State>

        <Tag>SDRtoHDR</Tag>

        <Workflow>

            <Name>SDRtoHDR_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

Sample 3: Job callback in JSON format triggered by a workflow



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1494
of 2300

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T19:20:45+0800",

        "EndTime": "2022-06-30T19:21:06+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{
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                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "jafa709a2f86611ec9452c1c27f56a659",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "9514.268000",

                    "Duration": "13.654000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "16238478",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "128.726000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",

                        "Duration": "13.652993",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"
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                    },

                    "Video": {

                        "AvgFps": "24.922840",

                        "Bitrate": "9878.900000",

                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Codin

                        "CodecName": "hevc",

                        "CodecTag": "0x31637668",

                        "CodecTagString": "hvc1",

                        "CodecTimeBase": "1/12800",

                        "ColorPrimaries": "bt2020",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte2084",

                        "Duration": "12.960000",

                        "FieldOrder": "progressive",

                        "Fps": "25.000000",

                        "HasBFrame": "2",

                        "Height": "960",

                        "Index": "0",

                        "Language": "und",

                        "Level": "93",

                        "NumFrames": "323",

                        "PixFormat": "yuv420p",

                        "Profile": "Main",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.000000",

                        "Timebase": "1/12800",

                        "Width": "544"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "ed8b5615687d789d6293bd58fa1ea1c0",

                        "ObjectName": "output/sdr2hdr.mp4"

                    },

                    "ObjectName": "output/sdr2hdr.mp4",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/sdr2hdr.mp4",

                "Region": "ap-chongqing"

            },
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            "SDRtoHDR": {

                "HdrMode": "HDR10"

            },

            "TranscodeTemplateId": "t156c107210e7243c5817354565d81b578",

            "UserData": "This is my SDRtoHDR job.",

            "WatermarkTemplateId": [

                "t143ae6e040af6431aa772c9ec3f0a3f36",

                "t12a74d11687d444deba8a6cc52051ac27"

            ]

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T19:20:46+0800",

        "State": "Success",

        "Tag": "SDRtoHDR",

        "Workflow": {

            "Name": "SDRtoHDR_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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Remuxing (Audio/Video Segmentation)
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:14:31+0800</CreationTime>

        <EndTime>2022-06-30T19:14:36+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>jd0c0da74f86511ec8a5a87e016101404</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>2629.749000</Bitrate>

                    <Duration>215.680000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>70898041</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>256.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/48000</CodecTimeBase>

                        <Duration>215.637000</Duration>

                        <Index>1</Index>

                        <Language>eng</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>48000</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/48000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.000000</AvgFps>

                        <Bitrate>2369.296000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12288</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>215.583333</Duration>

                        <Fps>24.000000</Fps>

                        <HasBFrame>2</HasBFrame>
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                        <Height>1080</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>40</Level>

                        <NumFrames>5174</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12288</Timebase>

                        <Width>1920</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>59a4edd95c6ddca43277d82cf33edc0d</Md5>

                        <ObjectName>output/segment-0</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7fdacd7f2e2dbdc1dc3ccc00f96893b5</Md5>

                        <ObjectName>output/segment-1</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>4c377ddb6f65021f6741dbd45bbff654</Md5>

                        <ObjectName>output/segment-2</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>59317dbc9db6d4d6fb723e3005809c01</Md5>

                        <ObjectName>output/segment-3</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a81091e57005eece211b5f60bfbddea1</Md5>

                        <ObjectName>output/segment-4</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7b87e88264a983a06b17558c8a3a2bd8</Md5>

                        <ObjectName>output/segment-5</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>607b2abc29ed11ad1d2f678b594c6ffa</Md5>

                        <ObjectName>output/segment-6</ObjectName>

                    </Md5Info>

                    <Md5Info>
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                        <Md5>4fe2d33dc9d08a5ea9d5d6db0f724008</Md5>

                        <ObjectName>output/segment-7</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a84dd4f738ce81f4e3da55b393b2fae4</Md5>

                        <ObjectName>output/segment-8</ObjectName>

                    </Md5Info>

                    <ObjectName>0</ObjectName>

                    <ObjectName>1</ObjectName>

                    <ObjectName>2</ObjectName>

                    <ObjectName>3</ObjectName>

                    <ObjectName>4</ObjectName>

                    <ObjectName>5</ObjectName>

                    <ObjectName>6</ObjectName>

                    <ObjectName>7</ObjectName>

                    <ObjectName>8</ObjectName>

                    <ObjectPrefix>output/segment-</ObjectPrefix>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/segment-${number}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <Segment>

                <Duration>25</Duration>

                <Format>mp4</Format>

                <HlsEncrypt>

                    <IsHlsEncrypt>false</IsHlsEncrypt>

                    <UriKey/>

                </HlsEncrypt>

            </Segment>

            <UserData>This is my Segment job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:14:32+0800</StartTime>

        <State>Success</State>

        <Tag>Segment</Tag>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container
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 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container array

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the remuxing job submitting API.﻿

If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.

 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API

https://intl.cloud.tencent.com/document/product/1045/48936
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:14:31+0800</CreationTime>

        <EndTime>2022-06-30T19:14:36+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>jd0c0da74f86511ec8a5a87e016101404</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>2629.749000</Bitrate>

                    <Duration>215.680000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>70898041</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>256.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/48000</CodecTimeBase>

                        <Duration>215.637000</Duration>

                        <Index>1</Index>

                        <Language>eng</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>48000</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/48000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.000000</AvgFps>

                        <Bitrate>2369.296000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12288</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>215.583333</Duration>

                        <Fps>24.000000</Fps>

                        <HasBFrame>2</HasBFrame>
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                        <Height>1080</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>40</Level>

                        <NumFrames>5174</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12288</Timebase>

                        <Width>1920</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>59a4edd95c6ddca43277d82cf33edc0d</Md5>

                        <ObjectName>output/segment-0</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7fdacd7f2e2dbdc1dc3ccc00f96893b5</Md5>

                        <ObjectName>output/segment-1</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>4c377ddb6f65021f6741dbd45bbff654</Md5>

                        <ObjectName>output/segment-2</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>59317dbc9db6d4d6fb723e3005809c01</Md5>

                        <ObjectName>output/segment-3</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a81091e57005eece211b5f60bfbddea1</Md5>

                        <ObjectName>output/segment-4</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7b87e88264a983a06b17558c8a3a2bd8</Md5>

                        <ObjectName>output/segment-5</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>607b2abc29ed11ad1d2f678b594c6ffa</Md5>

                        <ObjectName>output/segment-6</ObjectName>

                    </Md5Info>

                    <Md5Info>
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                        <Md5>4fe2d33dc9d08a5ea9d5d6db0f724008</Md5>

                        <ObjectName>output/segment-7</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a84dd4f738ce81f4e3da55b393b2fae4</Md5>

                        <ObjectName>output/segment-8</ObjectName>

                    </Md5Info>

                    <ObjectName>0</ObjectName>

                    <ObjectName>1</ObjectName>

                    <ObjectName>2</ObjectName>

                    <ObjectName>3</ObjectName>

                    <ObjectName>4</ObjectName>

                    <ObjectName>5</ObjectName>

                    <ObjectName>6</ObjectName>

                    <ObjectName>7</ObjectName>

                    <ObjectName>8</ObjectName>

                    <ObjectPrefix>output/segment-</ObjectPrefix>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/segment-${number}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <Segment>

                <Duration>25</Duration>

                <Format>mp4</Format>

                <HlsEncrypt>

                    <IsHlsEncrypt>false</IsHlsEncrypt>

                    <UriKey/>

                </HlsEncrypt>

            </Segment>

            <UserData>This is my Segment job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:14:32+0800</StartTime>

        <State>Success</State>

        <Tag>Segment</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback triggered by a workflow
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:14:31+0800</CreationTime>

        <EndTime>2022-06-30T19:14:36+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>
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                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>jd0c0da74f86511ec8a5a87e016101404</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>2629.749000</Bitrate>

                    <Duration>215.680000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>70898041</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>256.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/48000</CodecTimeBase>

                        <Duration>215.637000</Duration>

                        <Index>1</Index>

                        <Language>eng</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>48000</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/48000</Timebase>
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                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.000000</AvgFps>

                        <Bitrate>2369.296000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12288</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>215.583333</Duration>

                        <Fps>24.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>1080</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>40</Level>

                        <NumFrames>5174</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12288</Timebase>

                        <Width>1920</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>59a4edd95c6ddca43277d82cf33edc0d</Md5>

                        <ObjectName>output/segment-0</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7fdacd7f2e2dbdc1dc3ccc00f96893b5</Md5>

                        <ObjectName>output/segment-1</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>4c377ddb6f65021f6741dbd45bbff654</Md5>

                        <ObjectName>output/segment-2</ObjectName>

                    </Md5Info>

                    <Md5Info>
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                        <Md5>59317dbc9db6d4d6fb723e3005809c01</Md5>

                        <ObjectName>output/segment-3</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a81091e57005eece211b5f60bfbddea1</Md5>

                        <ObjectName>output/segment-4</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7b87e88264a983a06b17558c8a3a2bd8</Md5>

                        <ObjectName>output/segment-5</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>607b2abc29ed11ad1d2f678b594c6ffa</Md5>

                        <ObjectName>output/segment-6</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>4fe2d33dc9d08a5ea9d5d6db0f724008</Md5>

                        <ObjectName>output/segment-7</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a84dd4f738ce81f4e3da55b393b2fae4</Md5>

                        <ObjectName>output/segment-8</ObjectName>

                    </Md5Info>

                    <ObjectName>0</ObjectName>

                    <ObjectName>1</ObjectName>

                    <ObjectName>2</ObjectName>

                    <ObjectName>3</ObjectName>

                    <ObjectName>4</ObjectName>

                    <ObjectName>5</ObjectName>

                    <ObjectName>6</ObjectName>

                    <ObjectName>7</ObjectName>

                    <ObjectName>8</ObjectName>

                    <ObjectPrefix>output/segment-</ObjectPrefix>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/segment-${number}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <Segment>

                <Duration>25</Duration>

                <Format>mp4</Format>

                <HlsEncrypt>

                    <IsHlsEncrypt>false</IsHlsEncrypt>

                    <UriKey/>
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                </HlsEncrypt>

            </Segment>

            <UserData>This is my Segment job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:14:32+0800</StartTime>

        <State>Success</State>

        <Tag>Segment</Tag>

        <Workflow>

            <Name>Segment_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

Sample 3: Job callback in JSON format triggered by a workflow
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{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T19:14:31+0800",

        "EndTime": "2022-06-30T19:14:36+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{
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                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "jd0c0da74f86511ec8a5a87e016101404",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "2629.749000",

                    "Duration": "215.680000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "70898041",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "256.000000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/48000",

                        "Duration": "215.637000",

                        "Index": "1",

                        "Language": "eng",

                        "SampleFmt": "fltp",

                        "SampleRate": "48000",

                        "StartTime": "0.000000",

                        "Timebase": "1/48000"
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                    },

                    "Video": {

                        "AvgFps": "24.000000",

                        "Bitrate": "2369.296000",

                        "CodecLongName": "H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10

                        "CodecName": "h264",

                        "CodecTag": "0x31637661",

                        "CodecTagString": "avc1",

                        "CodecTimeBase": "1/12288",

                        "ColorPrimaries": "unknown",

                        "ColorRange": "unknown",

                        "ColorTransfer": "unknown",

                        "Duration": "215.583333",

                        "Fps": "24.000000",

                        "HasBFrame": "2",

                        "Height": "1080",

                        "Index": "0",

                        "Language": "und",

                        "Level": "40",

                        "NumFrames": "5174",

                        "PixFormat": "yuv420p",

                        "Profile": "High",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.000000",

                        "Timebase": "1/12288",

                        "Width": "1920"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": [{

                            "Md5": "59a4edd95c6ddca43277d82cf33edc0d",

                            "ObjectName": "output/segment-0"

                        },

                        {

                            "Md5": "7fdacd7f2e2dbdc1dc3ccc00f96893b5",

                            "ObjectName": "output/segment-1"

                        },

                        {

                            "Md5": "4c377ddb6f65021f6741dbd45bbff654",

                            "ObjectName": "output/segment-2"

                        },

                        {

                            "Md5": "59317dbc9db6d4d6fb723e3005809c01",
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                            "ObjectName": "output/segment-3"

                        },

                        {

                            "Md5": "a81091e57005eece211b5f60bfbddea1",

                            "ObjectName": "output/segment-4"

                        },

                        {

                            "Md5": "7b87e88264a983a06b17558c8a3a2bd8",

                            "ObjectName": "output/segment-5"

                        },

                        {

                            "Md5": "607b2abc29ed11ad1d2f678b594c6ffa",

                            "ObjectName": "output/segment-6"

                        },

                        {

                            "Md5": "4fe2d33dc9d08a5ea9d5d6db0f724008",

                            "ObjectName": "output/segment-7"

                        },

                        {

                            "Md5": "a84dd4f738ce81f4e3da55b393b2fae4",

                            "ObjectName": "output/segment-8"

                        }

                    ],

                    "ObjectName": [

                        "0",

                        "1",

                        "2",

                        "3",

                        "4",

                        "5",

                        "6",

                        "7",

                        "8"

                    ],

                    "ObjectPrefix": "output/segment-",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/segment-${number}",

                "Region": "ap-chongqing"

            },

            "Segment": {

                "Duration": "25",

                "Format": "mp4",

                "HlsEncrypt": {
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                    "IsHlsEncrypt": "false"

                }

            },

            "UserData": "This is my Segment job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T19:14:32+0800",

        "State": "Success",

        "Tag": "Segment",

        "Workflow": {

            "Name": "Segment_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>output/smartcover-0.jpg</ObjectName>

                    <ObjectName>output/smartcover-1.jpg</ObjectName>

                    <ObjectName>output/smartcover-2.jpg</ObjectName>

                    <ObjectName>output/smartcover-3.jpg</ObjectName>

                    <ObjectName>output/smartcover-4.jpg</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SmartCover>

                <Count>5</Count>

                <DeleteDuplicates>false</DeleteDuplicates>

                <Format>jpg</Format>

                <Height>960</Height>

                <Width>1280</Width>

            </SmartCover>

            <UserData>This is my SmartCover job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>SmartCover</Tag>

    </JobsDetail>

</Response>

The nodes are as described below:
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Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container array

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the intelligent thumbnail job submitting API.
If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.
 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API

https://intl.cloud.tencent.com/document/product/1045/48937
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>output/smartcover-0.jpg</ObjectName>

                    <ObjectName>output/smartcover-1.jpg</ObjectName>

                    <ObjectName>output/smartcover-2.jpg</ObjectName>

                    <ObjectName>output/smartcover-3.jpg</ObjectName>

                    <ObjectName>output/smartcover-4.jpg</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SmartCover>

                <Count>5</Count>

                <DeleteDuplicates>false</DeleteDuplicates>

                <Format>jpg</Format>

                <Height>960</Height>

                <Width>1280</Width>

            </SmartCover>

            <UserData>This is my SmartCover job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>SmartCover</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback triggered by a workflow
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>
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                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>output/smartcover-0.jpg</ObjectName>

                    <ObjectName>output/smartcover-1.jpg</ObjectName>

                    <ObjectName>output/smartcover-2.jpg</ObjectName>

                    <ObjectName>output/smartcover-3.jpg</ObjectName>

                    <ObjectName>output/smartcover-4.jpg</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SmartCover>

                <Count>5</Count>
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                <DeleteDuplicates>false</DeleteDuplicates>

                <Format>jpg</Format>

                <Height>960</Height>

                <Width>1280</Width>

            </SmartCover>

            <UserData>This is my SmartCover job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>SmartCover</Tag>

        <Workflow>

            <Name>SmartCover_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

Sample 3: Job callback in JSON format triggered by a workflow
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{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T15:29:42+0800",

        "EndTime": "2022-06-30T15:29:48+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1528
of 2300

                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j6842765cf84611ecb8546d80f2baf56f",

        "Operation": {

            "MediaInfo": {

                "Stream": {

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "ObjectName": [

                        "output/smartcover-0.jpg",

                        "output/smartcover-1.jpg",

                        "output/smartcover-2.jpg",

                        "output/smartcover-3.jpg",

                        "output/smartcover-4.jpg"

                    ],

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/smartcover-${Number}.jpg",

                "Region": "ap-chongqing"

            },

            "SmartCover": {

                "Count": "5",

                "DeleteDuplicates": "false",

                "Format": "jpg",

                "Height": "960",
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                "Width": "1280"

            },

            "UserData": "This is my SmartCover job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T15:29:43+0800",

        "State": "Success",

        "Tag": "SmartCover",

        "Workflow": {

            "Name": "SmartCover_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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Frame Capturing
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:25:11+0800</CreationTime>

        <EndTime>2022-06-30T19:25:14+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j4e431ba0f86711ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>0.jpg</ObjectName>

                    <ObjectName>1.jpg</ObjectName>

                    <ObjectName>2.jpg</ObjectName>

                    <ObjectName>3.jpg</ObjectName>

                    <ObjectName>4.jpg</ObjectName>

                    <ObjectName>5.jpg</ObjectName>

                    <ObjectPrefix>output/snapshot-</ObjectPrefix>

                    <Region>ap-chongqing</Region>

                    <SpriteOutputFile>

                        <Bucket>test-123456789</Bucket>

                        <Md5Info/>

                        <ObjectName>0.jpg</ObjectName>

                        <ObjectPrefix>output/sprite-</ObjectPrefix>

                        <Region>ap-chongqing</Region>

                    </SpriteOutputFile>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${Number}.jpg</Object>

                <Region>ap-chongqing</Region>

                <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

            </Output>

            <TemplateId>t1f16e1dfbdc9ds4105b31632d45710642a</TemplateId>

            <TemplateName>template_snapshot</TemplateName>

            <UserData>This is my Snapshot job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:25:12+0800</StartTime>

        <State>Success</State>

        <Tag>Snapshot</Tag>

    </JobsDetail>
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</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container array

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the screenshot job submitting API.﻿
If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.
 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

https://intl.cloud.tencent.com/document/product/1045/48938#jobsDetail
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Samples

Sample 1: Job callback triggered by a job API

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:25:11+0800</CreationTime>

        <EndTime>2022-06-30T19:25:14+0800</EndTime>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j4e431ba0f86711ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>0.jpg</ObjectName>

                    <ObjectName>1.jpg</ObjectName>

                    <ObjectName>2.jpg</ObjectName>

                    <ObjectName>3.jpg</ObjectName>

                    <ObjectName>4.jpg</ObjectName>

                    <ObjectName>5.jpg</ObjectName>

                    <ObjectPrefix>output/snapshot-</ObjectPrefix>

                    <Region>ap-chongqing</Region>

                    <SpriteOutputFile>

                        <Bucket>test-123456789</Bucket>

                        <Md5Info/>

                        <ObjectName>0.jpg</ObjectName>

                        <ObjectPrefix>output/sprite-</ObjectPrefix>

                        <Region>ap-chongqing</Region>

                    </SpriteOutputFile>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${Number}.jpg</Object>

                <Region>ap-chongqing</Region>

                <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

            </Output>

            <TemplateId>t1f16e1dfbdc9ds4105b31632d45710642a</TemplateId>

            <TemplateName>template_snapshot</TemplateName>

            <UserData>This is my Snapshot job.</UserData>

        </Operation>
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        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:25:12+0800</StartTime>

        <State>Success</State>

        <Tag>Snapshot</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback triggered by a workflow

<Response>
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    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:25:11+0800</CreationTime>

        <EndTime>2022-06-30T19:25:14+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j4e431ba0f86711ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>0.jpg</ObjectName>

                    <ObjectName>1.jpg</ObjectName>

                    <ObjectName>2.jpg</ObjectName>

                    <ObjectName>3.jpg</ObjectName>

                    <ObjectName>4.jpg</ObjectName>

                    <ObjectName>5.jpg</ObjectName>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1538
of 2300

                    <ObjectPrefix>output/snapshot-</ObjectPrefix>

                    <Region>ap-chongqing</Region>

                    <SpriteOutputFile>

                        <Bucket>test-123456789</Bucket>

                        <Md5Info/>

                        <ObjectName>0.jpg</ObjectName>

                        <ObjectPrefix>output/sprite-</ObjectPrefix>

                        <Region>ap-chongqing</Region>

                    </SpriteOutputFile>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${Number}.jpg</Object>

                <Region>ap-chongqing</Region>

                <SpriteObject>output/sprite-${Number}.jpg</SpriteObject>

            </Output>

            <TemplateId>t1f16e1dfbdc9ds4105b31632d45710642a</TemplateId>

            <TemplateName>template_snapshot</TemplateName>

            <UserData>This is my Snapshot job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:25:12+0800</StartTime>

        <State>Success</State>

        <Tag>Snapshot</Tag>

        <Workflow>

            <Name>Snapshot_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

Sample 3: Job callback in JSON format triggered by a workflow
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{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T19:25:11+0800",

        "EndTime": "2022-06-30T19:25:14+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{
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                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j4e431ba0f86711ecb8546d80f2baf56f",

        "Operation": {

            "MediaInfo": {

                "Stream": {

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "ObjectName": [

                        "0.jpg",

                        "1.jpg",

                        "2.jpg",

                        "3.jpg",

                        "4.jpg",

                        "5.jpg"

                    ],

                    "ObjectPrefix": "output/snapshot-",

                    "Region": "ap-chongqing",

                    "SpriteOutputFile": {

                        "Bucket": "test-123456789",

                        "ObjectName": "0.jpg",

                        "ObjectPrefix": "output/sprite-",

                        "Region": "ap-chongqing"

                    }

                }

            },

            "Output": {

                "Bucket": "test-123456789",
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                "Object": "output/snapshot-${Number}.jpg",

                "Region": "ap-chongqing",

                "SpriteObject": "output/sprite-${Number}.jpg"

            },

            "TemplateId": "t1f16e1dfbdc9ds4105b31632d45710642a",

            "TemplateName": "template_snapshot",

            "UserData": "This is my Snapshot job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T19:25:12+0800",

        "State": "Success",

        "Tag": "Snapshot",

        "Workflow": {

            "Name": "Snapshot_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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Stream Separation
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:27:39+0800</CreationTime>

        <EndTime>2022-06-30T19:27:42+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>ja66d6204f86711ec9ca1073b78d316d3</JobId>

        <Message/>

        <Operation>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>e8c802ed78ba7f4c6a2fb5144cba7cbc</Md5>

                        <ObjectName>output/out0.mp4</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>f5883c1380524eecd1a925657ab17b4c</Md5>

                        <ObjectName>output/out1.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/out0.mp4</ObjectName>

                    <ObjectName>output/out1.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Region>ap-chongqing</Region>

                <StreamExtract>

                    <Index>0</Index>

                    <Output>output/out0.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>1</Index>

                    <Output>output/out1.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>2</Index>

                    <Output>output/out2.mp4</Output>

                </StreamExtract>

            </Output>

            <UserData>This is my StreamExtract job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:27:40+0800</StartTime>

        <State>Success</State>

        <Tag>StreamExtract</Tag>

    </JobsDetail>

</Response>

The nodes are as described below:
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Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container array

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the stream separation job submitting API.
If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.
 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API

https://intl.cloud.tencent.com/document/product/1045/48939#jobsDetail
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:27:39+0800</CreationTime>

        <EndTime>2022-06-30T19:27:42+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>ja66d6204f86711ec9ca1073b78d316d3</JobId>

        <Message/>

        <Operation>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>e8c802ed78ba7f4c6a2fb5144cba7cbc</Md5>

                        <ObjectName>output/out0.mp4</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>f5883c1380524eecd1a925657ab17b4c</Md5>

                        <ObjectName>output/out1.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/out0.mp4</ObjectName>

                    <ObjectName>output/out1.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Region>ap-chongqing</Region>

                <StreamExtract>

                    <Index>0</Index>

                    <Output>output/out0.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>1</Index>

                    <Output>output/out1.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>2</Index>

                    <Output>output/out2.mp4</Output>

                </StreamExtract>

            </Output>

            <UserData>This is my StreamExtract job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:27:40+0800</StartTime>

        <State>Success</State>

        <Tag>StreamExtract</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback in JSON format triggered by a job API
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{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T19:27:39+0800",

        "EndTime": "2022-06-30T19:27:42+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing"

        },
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        "JobId": "ja66d6204f86711ec9ca1073b78d316d3",

        "Operation": {

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": [{

                            "Md5": "e8c802ed78ba7f4c6a2fb5144cba7cbc",

                            "ObjectName": "output/out0.mp4"

                        },

                        {

                            "Md5": "f5883c1380524eecd1a925657ab17b4c",

                            "ObjectName": "output/out1.mp4"

                        }

                    ],

                    "ObjectName": [

                        "output/out0.mp4",

                        "output/out1.mp4"

                    ],

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Region": "ap-chongqing",

                "StreamExtract": [{

                        "Index": "0",

                        "Output": "output/out0.mp4"

                    },

                    {

                        "Index": "1",

                        "Output": "output/out1.mp4"

                    },

                    {

                        "Index": "2",

                        "Output": "output/out2.mp4"

                    }

                ]

            },

            "UserData": "This is my StreamExtract job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T19:27:40+0800",

        "State": "Success",

        "Tag": "StreamExtract"

    }]

}
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Super Resolution
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:30:20+0800</CreationTime>

        <EndTime>2022-06-30T19:31:56+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j06668dc0f86811ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <DigitalWatermark>

                <IgnoreError>false</IgnoreError>

                <Message>123456789ab</Message>

                <State>Failed</State>

                <Type>Text</Type>

                <Version>V1</Version>

            </DigitalWatermark>

            <MediaInfo>

                <Format>

                    <Bitrate>8867.172000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>15134046</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>9197.180000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>
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                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>1920</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>120</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>1088</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>852883012a6ba726e6ed8d9b984edfdf</Md5>

                        <ObjectName>output/super_resolution.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/super_resolution.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/super_resolution.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f1ae1dfsdc9ds41dsb31632d45710642a</TemplateId>

            <TemplateName>template_superresolution</TemplateName>

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <UserData>This is my SuperResolution job.</UserData>

            <WatermarkTemplateId>t143ae6e040af6431aa772c9ec3f0a3f36</WatermarkTempl

            <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTempl

        </Operation>
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        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:30:21+0800</StartTime>

        <State>Success</State>

        <SubTag>DigitalWatermark</SubTag>

        <Tag>SuperResolution</Tag>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container array

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the super resolution job submitting API.﻿
If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.
 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

https://intl.cloud.tencent.com/document/product/1045/48940
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WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API

<Response>
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    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:30:20+0800</CreationTime>

        <EndTime>2022-06-30T19:31:56+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j06668dc0f86811ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <DigitalWatermark>

                <IgnoreError>false</IgnoreError>

                <Message>123456789ab</Message>

                <State>Failed</State>

                <Type>Text</Type>

                <Version>V1</Version>

            </DigitalWatermark>

            <MediaInfo>

                <Format>

                    <Bitrate>8867.172000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>15134046</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>
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                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>9197.180000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>1920</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>120</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>1088</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>852883012a6ba726e6ed8d9b984edfdf</Md5>

                        <ObjectName>output/super_resolution.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/super_resolution.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>
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                <Object>output/super_resolution.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f1ae1dfsdc9ds41dsb31632d45710642a</TemplateId>

            <TemplateName>template_superresolution</TemplateName>

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <UserData>This is my SuperResolution job.</UserData>

            <WatermarkTemplateId>t143ae6e040af6431aa772c9ec3f0a3f36</WatermarkTempl

            <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTempl

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:30:21+0800</StartTime>

        <State>Success</State>

        <SubTag>DigitalWatermark</SubTag>

        <Tag>SuperResolution</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback triggered by a workflow
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:30:20+0800</CreationTime>

        <EndTime>2022-06-30T19:31:56+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>
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                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j06668dc0f86811ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <DigitalWatermark>

                <IgnoreError>false</IgnoreError>

                <Message>123456789ab</Message>

                <State>Failed</State>

                <Type>Text</Type>

                <Version>V1</Version>

            </DigitalWatermark>

            <MediaInfo>

                <Format>

                    <Bitrate>8867.172000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>15134046</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>
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                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>9197.180000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>1920</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>120</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>1088</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>852883012a6ba726e6ed8d9b984edfdf</Md5>

                        <ObjectName>output/super_resolution.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/super_resolution.mp4</ObjectName>
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                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/super_resolution.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f1ae1dfsdc9ds41dsb31632d45710642a</TemplateId>

            <TemplateName>template_superresolution</TemplateName>

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <UserData>This is my SuperResolution job.</UserData>

            <WatermarkTemplateId>t143ae6e040af6431aa772c9ec3f0a3f36</WatermarkTempl

            <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTempl

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:30:21+0800</StartTime>

        <State>Success</State>

        <SubTag>DigitalWatermark</SubTag>

        <Tag>SuperResolution</Tag>

        <Workflow>

            <Name>SuperResolution_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

Sample 3: Job callback in JSON format triggered by a workflow
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{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T19:30:20+0800",

        "EndTime": "2022-06-30T19:31:56+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{
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                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j06668dc0f86811ecb90d0b03267ce0e5",

        "Operation": {

            "DigitalWatermark": {

                "IgnoreError": "false",

                "Message": "123456789ab",

                "State": "Failed",

                "Type": "Text",

                "Version": "V1"

            },

            "MediaInfo": {

                "Format": {

                    "Bitrate": "8867.172000",

                    "Duration": "13.654000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "15134046",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "128.726000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",
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                        "Duration": "13.652993",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"

                    },

                    "Video": {

                        "AvgFps": "25.000000",

                        "Bitrate": "9197.180000",

                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Codin

                        "CodecName": "hevc",

                        "CodecTag": "0x31766568",

                        "CodecTagString": "hev1",

                        "CodecTimeBase": "1/12800",

                        "ColorPrimaries": "bt470bg",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte170m",

                        "Duration": "12.960000",

                        "FieldOrder": "progressive",

                        "Fps": "25.000000",

                        "HasBFrame": "2",

                        "Height": "1920",

                        "Index": "0",

                        "Language": "und",

                        "Level": "120",

                        "NumFrames": "324",

                        "PixFormat": "yuv420p",

                        "Profile": "Main",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.000000",

                        "Timebase": "1/12800",

                        "Width": "1088"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "852883012a6ba726e6ed8d9b984edfdf",

                        "ObjectName": "output/super_resolution.mp4"

                    },

                    "ObjectName": "output/super_resolution.mp4",

                    "Region": "ap-chongqing"
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                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/super_resolution.mp4",

                "Region": "ap-chongqing"

            },

            "TemplateId": "t1f1ae1dfsdc9ds41dsb31632d45710642a",

            "TemplateName": "template_superresolution",

            "TranscodeTemplateId": "t156c107210e7243c5817354565d81b578",

            "UserData": "This is my SuperResolution job.",

            "WatermarkTemplateId": [

                "t143ae6e040af6431aa772c9ec3f0a3f36",

                "t12a74d11687d444deba8a6cc52051ac27"

            ]

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T19:30:21+0800",

        "State": "Success",

        "SubTag": "DigitalWatermark",

        "Tag": "SuperResolution",

        "Workflow": {

            "Name": "SuperResolution_1581665960537_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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Audio/Video Transcoding
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>
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                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/transcode.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/transcode.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <UserData>This is my Transcode job.</UserData>

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:
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Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container array

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the transcoding job submitting API.
If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.
 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API

https://intl.cloud.tencent.com/document/product/1045/48941
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>97624.424000</Bitrate>

                    <Duration>0.870000</Duration>

                    <FormatLongName>CompuServe Graphics Interchange Format (GIF)</F

                    <FormatName>gif</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>10616656</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.666667</AvgFps>

                        <CodecLongName>CompuServe GIF (Graphics Interchange Format)

                        <CodecName>gif</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/100</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>0.870000</Duration>

                        <Fps>15.083333</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>2258</Height>

                        <Index>0</Index>

                        <Level>-99</Level>

                        <NumFrames>7</NumFrames>

                        <PixFormat>bgra</PixFormat>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/100</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>
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                        <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                        <ObjectName>output/animation.gif</ObjectName>

                    </Md5Info>

                    <ObjectName>output/animation.gif</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.gif</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>template_name1512456</TemplateName>

            <UserData>This is my Animation job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>Animation</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback triggered by a workflow



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1576
of 2300

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>
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                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>
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                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/transcode.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/transcode.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <UserData>This is my Transcode job.</UserData>
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        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

        <Workflow>

            <Name>Transcode_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

Sample 3: Job callback in JSON format triggered by a workflow
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{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T15:29:42+0800",

        "EndTime": "2022-06-30T15:30:08+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{
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                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j68427030f84611ecb8546d80f2baf56f",

        "Message": "success",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Duration": "13",

                    "NumStream": "1",

                    "Size": "1909389"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "128000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",

                        "Duration": "13.653",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"

                    },

                    "Video": {

                        "AvgFps": "50.000",

                        "Bitrate": "1031968",
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                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Codin

                        "CodecName": "hevc",

                        "CodecTag": "0x31637668",

                        "CodecTagString": "hvc1",

                        "CodecTimeBase": "1/50",

                        "ColorPrimaries": "bt470bg",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte170m",

                        "Duration": "12.960",

                        "FieldOrder": "Unknown",

                        "Fps": "50/1",

                        "HasBFrame": "4",

                        "Height": "960",

                        "Index": "0",

                        "Language": "und",

                        "Level": "4",

                        "NumFrames": "648",

                        "PixFormat": "hvc1",

                        "Profile": "Main",

                        "RefFrames": "1",

                        "Rotation": "0",

                        "StartTime": "0.000000",

                        "Timebase": "1/12800",

                        "Width": "540"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "2db78d168edf2f883adce89a1b4ca033",

                        "ObjectName": "output/transcode.mp4"

                    },

                    "ObjectName": "output/transcode.mp4",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/transcode.mp4",

                "Region": "ap-chongqing"

            },

            "TemplateId": "t1995d523e42df4c5e858f244b4174360c",

            "TemplateName": "trans_993874",

            "UserData": "This is my Transcode job."

        },
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        "Progress": "100",

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T15:29:42+0800",

        "State": "Success",

        "Tag": "Transcode",

        "Workflow": {

            "Name": "Transcode_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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Text to Speech
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:33:18+0800</CreationTime>

        <EndTime>2022-06-30T19:33:24+0800</EndTime>

        <JobId>j707f4864f86811ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>
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                <Stream>

                    <Audio>

                        <CodecName>mp3</CodecName>

                        <SampleRate>16000</SampleRate>

                    </Audio>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>5b2ca33cd7357abb1e0ea29f57544df9</Md5>

                        <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/aixiaonan.mp3</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TtsConfig>

                <Input>Hi, I'm Aixiaonan. Nice to meet you.</Input>

                <InputType>Text</InputType>

            </TtsConfig>

            <TemplateId>t1f1ae1dfsdc9ds41dsb31632d457ds6s2a</TemplateId>

            <TemplateName>template_tts</TemplateName>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:33:19+0800</StartTime>

        <State>Success</State>

        <Tag>Tts</Tag>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:
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Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container array

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the text-to-speech job submitting API.﻿
If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.
 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API

https://intl.cloud.tencent.com/document/product/1045/48942
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:33:18+0800</CreationTime>

        <EndTime>2022-06-30T19:33:24+0800</EndTime>

        <JobId>j707f4864f86811ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>
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                <Stream>

                    <Audio>

                        <CodecName>mp3</CodecName>

                        <SampleRate>16000</SampleRate>

                    </Audio>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>5b2ca33cd7357abb1e0ea29f57544df9</Md5>

                        <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/aixiaonan.mp3</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TtsConfig>

                <Input>Hi, I'm Aixiaonan. Nice to meet you.</Input>

                <InputType>Text</InputType>

            </TtsConfig>

            <TemplateId>t1f1ae1dfsdc9ds41dsb31632d457ds6s2a</TemplateId>

            <TemplateName>template_tts</TemplateName>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:33:19+0800</StartTime>

        <State>Success</State>

        <Tag>Tts</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback triggered by a workflow
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:33:18+0800</CreationTime>

        <EndTime>2022-06-30T19:33:24+0800</EndTime>

        <JobId>j707f4864f86811ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <Input>

                <CosHeaders>
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                    <Key>Content-Type</Key>

                    <Value>application/octet-stream</Value>

                </CosHeaders>

                <CosHeaders>

                    <Key>x-cos-request-id</Key>

                    <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

                </CosHeaders>

                <CosHeaders>

                    <Key>EventName</Key>

                    <Value>cos:ObjectCreated:Put</Value>

                </CosHeaders>

                <CosHeaders>

                    <Key>Size</Key>

                    <Value>265</Value>

                </CosHeaders>

            </Input>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio>

                        <CodecName>mp3</CodecName>

                        <SampleRate>16000</SampleRate>

                    </Audio>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>5b2ca33cd7357abb1e0ea29f57544df9</Md5>

                        <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/aixiaonan.mp3</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TtsConfig>

                <Input>https://test-123456789.cos.ap-chongqing.myqcloud.com/input/t

                <InputType>Url</InputType>
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            </TtsConfig>

            <TemplateId>t1f1ae1dfsdc9ds41dsb31632d457ds6s2a</TemplateId>

            <TemplateName>template_tts</TemplateName>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:33:19+0800</StartTime>

        <State>Success</State>

        <Tag>Tts</Tag>

        <Workflow>

            <Name>Tts_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

Sample 3: Job callback in JSON format triggered by a workflow
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{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T19:33:18+0800",

        "EndTime": "2022-06-30T19:33:24+0800",

        "JobId": "j707f4864f86811ecb90d0b03267ce0e5",

        "Operation": {

            "Input": {

                "CosHeaders": [{

                        "Key": "Content-Type",
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                        "Value": "application/octet-stream"

                    },

                    {

                        "Key": "x-cos-request-id",

                        "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                    },

                    {

                        "Key": "EventName",

                        "Value": "cos:ObjectCreated:Put"

                    },

                    {

                        "Key": "Size",

                        "Value": "265"

                    }

                ]

            },

            "MediaInfo": {

                "Stream": {

                    "Audio": {

                        "CodecName": "mp3",

                        "SampleRate": "16000"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "5b2ca33cd7357abb1e0ea29f57544df9",

                        "ObjectName": "/output/aixiaonan.mp3"

                    },

                    "ObjectName": "/output/aixiaonan.mp3",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/aixiaonan.mp3",

                "Region": "ap-chongqing"

            },

            "TtsConfig": {

                "Input": "https://test-123456789.cos.ap-chongqing.myqcloud.com/inpu

                "InputType": "Url"

            },

            "TemplateId": "t1f1ae1dfsdc9ds41dsb31632d457ds6s2a",

            "TemplateName": "template_tts"

        },
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        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T19:33:19+0800",

        "State": "Success",

        "Tag": "Tts",

        "Workflow": {

            "Name": "Tts_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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Video Montage
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1597
of 2300

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:55:05+0800</CreationTime>

        <EndTime>2022-06-30T19:55:19+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j7b0dfbe2f86b11ec995acf5cffaf6664</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>14044.868000</Bitrate>

                    <Duration>2.067000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>3628843</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>126.400000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>2.066576</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>14664.836000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>1.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>
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                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>41</Level>

                        <NumFrames>49</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.086000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>6080b31ea94defa6c19cc4def539a291</Md5>

                        <ObjectName>output/videoMontage.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/videoMontage.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/videoMontage.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t164ac18da8bdc403fa27ac4b077a962a1</TemplateId>

            <TemplateName>videoMontage</TemplateName>

            <UserData>This is my VideoMontage job.</UserData>

        </Operation>

        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

        <StartTime>2022-06-30T19:55:05+0800</StartTime>

        <State>Success</State>

        <Tag>VideoMontage</Tag>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container
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 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container array

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the video montage job submitting API.﻿
If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.

 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.
 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API

https://intl.cloud.tencent.com/document/product/1045/48943
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:55:05+0800</CreationTime>

        <EndTime>2022-06-30T19:55:19+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j7b0dfbe2f86b11ec995acf5cffaf6664</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>14044.868000</Bitrate>

                    <Duration>2.067000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>3628843</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>126.400000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>2.066576</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>14664.836000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>1.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>
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                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>41</Level>

                        <NumFrames>49</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.086000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>6080b31ea94defa6c19cc4def539a291</Md5>

                        <ObjectName>output/videoMontage.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/videoMontage.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/videoMontage.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t164ac18da8bdc403fa27ac4b077a962a1</TemplateId>

            <TemplateName>videoMontage</TemplateName>

            <UserData>This is my VideoMontage job.</UserData>

        </Operation>

        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

        <StartTime>2022-06-30T19:55:05+0800</StartTime>

        <State>Success</State>

        <Tag>VideoMontage</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback triggered by a workflow
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:55:05+0800</CreationTime>

        <EndTime>2022-06-30T19:55:19+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>
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                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j7b0dfbe2f86b11ec995acf5cffaf6664</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>14044.868000</Bitrate>

                    <Duration>2.067000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>3628843</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>126.400000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>2.066576</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>
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                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>14664.836000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</C

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>1.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>41</Level>

                        <NumFrames>49</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.086000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>6080b31ea94defa6c19cc4def539a291</Md5>

                        <ObjectName>output/videoMontage.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/videoMontage.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/videoMontage.mp4</Object>

                <Region>ap-chongqing</Region>
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            </Output>

            <TemplateId>t164ac18da8bdc403fa27ac4b077a962a1</TemplateId>

            <TemplateName>videoMontage</TemplateName>

            <UserData>This is my VideoMontage job.</UserData>

        </Operation>

        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

        <StartTime>2022-06-30T19:55:05+0800</StartTime>

        <State>Success</State>

        <Tag>VideoMontage</Tag>

        <Workflow>

            <Name>VideoMontage_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

Sample 3: Job callback in JSON format triggered by a workflow
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{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T19:55:05+0800",

        "EndTime": "2022-06-30T19:55:19+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{
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                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j7b0dfbe2f86b11ec995acf5cffaf6664",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "14044.868000",

                    "Duration": "2.067000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "3628843",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "126.400000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",

                        "Duration": "2.066576",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"
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                    },

                    "Video": {

                        "AvgFps": "25.000000",

                        "Bitrate": "14664.836000",

                        "CodecLongName": "H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10

                        "CodecName": "h264",

                        "CodecTag": "0x31637661",

                        "CodecTagString": "avc1",

                        "CodecTimeBase": "1/90000",

                        "ColorPrimaries": "bt470bg",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte170m",

                        "Duration": "1.960000",

                        "Fps": "25.000000",

                        "HasBFrame": "2",

                        "Height": "960",

                        "Index": "0",

                        "Language": "und",

                        "Level": "41",

                        "NumFrames": "49",

                        "PixFormat": "yuv420p",

                        "Profile": "High",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.086000",

                        "Timebase": "1/90000",

                        "Width": "544"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "6080b31ea94defa6c19cc4def539a291",

                        "ObjectName": "output/videoMontage.mp4"

                    },

                    "ObjectName": "output/videoMontage.mp4",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/videoMontage.mp4",

                "Region": "ap-chongqing"

            },

            "TemplateId": "t164ac18da8bdc403fa27ac4b077a962a1",
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            "TemplateName": "videoMontage",

            "UserData": "This is my VideoMontage job."

        },

        "QueueId": "p09d709939fef48a0a5c247ef39d90cec",

        "StartTime": "2022-06-30T19:55:05+0800",

        "State": "Success",

        "Tag": "VideoMontage",

        "Workflow": {

            "Name": "VideoMontage_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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Video Enhancement
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T20:02:17+0800</CreationTime>

        <EndTime>2022-06-30T20:02:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j7d0eafdaf86c11ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>10269.090000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>17526771</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>10674.365000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>
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                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>a825aa6c59371509995a47b570c29297</Md5>

                        <ObjectName>output/video-process.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/video-process.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/video-process.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <TemplateId>t1f4ac18da8bdc403fa27ac4bfn77a62a1</TemplateId>

            <TemplateName>videoProcess_12654</TemplateName>

            <UserData>This is my VideoProcess job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T20:02:18+0800</StartTime>

        <State>Success</State>

        <Tag>VideoProcess</Tag>

    </JobsDetail>

</Response>

The nodes are as described below:
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Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container array

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the video enhancement job submitting API.﻿
If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.
 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API

https://intl.cloud.tencent.com/document/product/1045/48944
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T20:02:17+0800</CreationTime>

        <EndTime>2022-06-30T20:02:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j7d0eafdaf86c11ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>10269.090000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>17526771</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>10674.365000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>
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                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>a825aa6c59371509995a47b570c29297</Md5>

                        <ObjectName>output/video-process.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/video-process.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/video-process.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <TemplateId>t1f4ac18da8bdc403fa27ac4bfn77a62a1</TemplateId>

            <TemplateName>videoProcess_12654</TemplateName>

            <UserData>This is my VideoProcess job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T20:02:18+0800</StartTime>

        <State>Success</State>

        <Tag>VideoProcess</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback triggered by a workflow
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T20:02:17+0800</CreationTime>

        <EndTime>2022-06-30T20:02:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>
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                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j7d0eafdaf86c11ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>10269.090000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>17526771</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>
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                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>10674.365000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>a825aa6c59371509995a47b570c29297</Md5>

                        <ObjectName>output/video-process.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/video-process.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/video-process.mp4</Object>
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                <Region>ap-chongqing</Region>

            </Output>

            <TranscodeTemplateId>t156c107210e7243c5817354565d81b578</TranscodeTempl

            <TemplateId>t1f4ac18da8bdc403fa27ac4bfn77a62a1</TemplateId>

            <TemplateName>videoProcess_12654</TemplateName>

            <UserData>This is my VideoProcess job.</UserData>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T20:02:18+0800</StartTime>

        <State>Success</State>

        <Tag>VideoProcess</Tag>

        <Workflow>

            <Name>VideoProcess_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

Sample 3: Job callback in JSON format triggered by a workflow
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{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T20:02:17+0800",

        "EndTime": "2022-06-30T20:02:34+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{
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                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j7d0eafdaf86c11ecbdf419856486c0ab",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "10269.090000",

                    "Duration": "13.654000",

                    "FormatLongName": "QuickTime / MOV",

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2",

                    "NumProgram": "0",

                    "NumStream": "2",

                    "Size": "17526771",

                    "StartTime": "0.000000"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "128.726000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",

                        "Duration": "13.652993",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"
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                    },

                    "Video": {

                        "AvgFps": "24.922840",

                        "Bitrate": "10674.365000",

                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Codin

                        "CodecName": "hevc",

                        "CodecTag": "0x31766568",

                        "CodecTagString": "hev1",

                        "CodecTimeBase": "1/12800",

                        "ColorPrimaries": "bt470bg",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte170m",

                        "Duration": "12.960000",

                        "FieldOrder": "progressive",

                        "Fps": "25.000000",

                        "HasBFrame": "2",

                        "Height": "960",

                        "Index": "0",

                        "Language": "und",

                        "Level": "93",

                        "NumFrames": "323",

                        "PixFormat": "yuv420p",

                        "Profile": "Main",

                        "RefFrames": "1",

                        "Rotation": "0.000000",

                        "StartTime": "0.000000",

                        "Timebase": "1/12800",

                        "Width": "544"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "a825aa6c59371509995a47b570c29297",

                        "ObjectName": "output/video-process.mp4"

                    },

                    "ObjectName": "output/video-process.mp4",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/video-process.mp4",

                "Region": "ap-chongqing"

            },
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            "TranscodeTemplateId": "t156c107210e7243c5817354565d81b578",

            "TemplateId": "t1f4ac18da8bdc403fa27ac4bfn77a62a1",

            "TemplateName": "videoProcess_12654",

            "UserData": "This is my VideoProcess job."

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T20:02:18+0800",

        "State": "Success",

        "Tag": "VideoProcess",

        "Workflow": {

            "Name": "VideoProcess_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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Video Tagging
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-01T10:05:48+0800</CreationTime>

        <EndTime>2022-07-01T10:06:02+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j535b10a4f8e211ec9452c1c27f56a659</JobId>

        <Message>Success</Message>

        <Operation>

            <UserData>This is my VideoTag job.</UserData>

            <VideoTag>

                <Scenario>Stream</Scenario>

            </VideoTag>

            <VideoTagResult>

                <StreamData>

                    <Data>

                        <ActionTags>

                            <EndTime>11</EndTime>

                            <StartTime>0</StartTime>

                            <Tags>

                                <Confidence>0.421531</Confidence>

                                <Tag>Speak</Tag>

                                <TagCls>Speak</TagCls>

                            </Tags>

                        </ActionTags>

                        <ActionTags>

                            <EndTime>12.88</EndTime>

                            <StartTime>11.04</StartTime>

                            <Tags/>

                        </ActionTags>

                        <ObjectTags>

                            <Objects>

                                <BBox>

                                    <X1>0.10181817412376404</X1>

                                    <X2>0.8069194555282593</X2>

                                    <Y1>0.6880248785018921</Y1>

                                    <Y2>0.8779844045639038</Y2>

                                </BBox>

                                <Confidence>0.808393</Confidence>

                                <Name>Keyboard</Name>

                            </Objects>

                            <TimeStamp>11</TimeStamp>

                        </ObjectTags>

                        <PersonTags/>

                        <PlaceTags>

                            <ClipFrameResult>Office: 0.55</ClipFrameResult>

                            <ClipFrameResult>Office: 0.55</ClipFrameResult>

                            <ClipFrameResult>Office: 0.59</ClipFrameResult>

                            <ClipFrameResult>Office: 0.54</ClipFrameResult>

                            <ClipFrameResult>Office: 0.42</ClipFrameResult>

                            <ClipFrameResult>Office: 0.43</ClipFrameResult>

                            <ClipFrameResult>Office: 0.33</ClipFrameResult>

                            <ClipFrameResult>Office: 0.29</ClipFrameResult>
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                            <ClipFrameResult>Office: 0.15</ClipFrameResult>

                            <ClipFrameResult>Entertainment venue: 0.42</ClipFrameRe

                            <ClipFrameResult>Office: 0.33</ClipFrameResult>

                            <EndIndex>275</EndIndex>

                            <EndTime>11</EndTime>

                            <StartIndex>0</StartIndex>

                            <StartTime>0</StartTime>

                            <Tags>

                                <Confidence>0.591724</Confidence>

                                <Tag>Office</Tag>

                                <TagCls>Work</TagCls>

                            </Tags>

                            <Tags>

                                <Confidence>0.175342</Confidence>

                                <Tag>Supermarket/Convenience store/Store</Tag>

                                <TagCls>Business</TagCls>

                            </Tags>

                        </PlaceTags>

                        <PlaceTags>

                            <ClipFrameResult>Other: 0.09</ClipFrameResult>

                            <ClipFrameResult>Other: 0.21</ClipFrameResult>

                            <ClipFrameResult>Other: 0.19</ClipFrameResult>

                            <ClipFrameResult>Sky: 0.28</ClipFrameResult>

                            <ClipFrameResult>Sky: 0.25</ClipFrameResult>

                            <ClipFrameResult>Other: 0.30</ClipFrameResult>

                            <ClipFrameResult>Other: 0.28</ClipFrameResult>

                            <ClipFrameResult>Other: 0.49</ClipFrameResult>

                            <ClipFrameResult>Other: 0.56</ClipFrameResult>

                            <ClipFrameResult>Other: 0.58</ClipFrameResult>

                            <EndIndex>322</EndIndex>

                            <EndTime>12.88</EndTime>

                            <StartIndex>276</StartIndex>

                            <StartTime>11.04</StartTime>

                            <Tags>

                                <Confidence>0.581444</Confidence>

                                <Tag>Other</Tag>

                                <TagCls>Other</TagCls>

                            </Tags>

                            <Tags>

                                <Confidence>0.283301</Confidence>

                                <Tag>Sky</Tag>

                                <TagCls>Nature/Outdoor</TagCls>

                            </Tags>

                        </PlaceTags>

                        <Tags>

                            <Confidence>0.355083</Confidence>

                            <Tag>MOBA - Arena of Valor</Tag>
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                        </Tags>

                        <Tags>

                            <Confidence>0.587103</Confidence>

                            <Tag>Game</Tag>

                        </Tags>

                        <Tags>

                            <Confidence>0.544651</Confidence>

                            <Tag>Office</Tag>

                        </Tags>

                        <Tags>

                            <Confidence>0.182886</Confidence>

                            <Tag>Supermarket/Convenience store/Store</Tag>

                        </Tags>

                    </Data>

                    <SubErrCode>0</SubErrCode>

                    <SubErrMsg>ok</SubErrMsg>

                </StreamData>

            </VideoTagResult>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-07-01T10:05:50+0800</StartTime>

        <State>Success</State>

        <Tag>VideoTag</Tag>

        <VideoTag/>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container array

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the video tagging job submitting API.﻿
If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.

https://intl.cloud.tencent.com/document/product/1045/48945
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 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.

 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-01T10:05:48+0800</CreationTime>

        <EndTime>2022-07-01T10:06:02+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j535b10a4f8e211ec9452c1c27f56a659</JobId>

        <Message>Success</Message>

        <Operation>

            <UserData>This is my VideoTag job.</UserData>

            <VideoTag>

                <Scenario>Stream</Scenario>

            </VideoTag>

            <VideoTagResult>

                <StreamData>

                    <Data>

                        <ActionTags>

                            <EndTime>11</EndTime>

                            <StartTime>0</StartTime>

                            <Tags>

                                <Confidence>0.421531</Confidence>

                                <Tag>Speak</Tag>

                                <TagCls>Speak</TagCls>

                            </Tags>

                        </ActionTags>

                        <ActionTags>

                            <EndTime>12.88</EndTime>

                            <StartTime>11.04</StartTime>

                            <Tags/>

                        </ActionTags>

                        <ObjectTags>

                            <Objects>

                                <BBox>

                                    <X1>0.10181817412376404</X1>

                                    <X2>0.8069194555282593</X2>

                                    <Y1>0.6880248785018921</Y1>

                                    <Y2>0.8779844045639038</Y2>

                                </BBox>

                                <Confidence>0.808393</Confidence>

                                <Name>Keyboard</Name>

                            </Objects>

                            <TimeStamp>11</TimeStamp>

                        </ObjectTags>

                        <PersonTags/>

                        <PlaceTags>

                            <ClipFrameResult>Office: 0.55</ClipFrameResult>

                            <ClipFrameResult>Office: 0.55</ClipFrameResult>

                            <ClipFrameResult>Office: 0.59</ClipFrameResult>

                            <ClipFrameResult>Office: 0.54</ClipFrameResult>

                            <ClipFrameResult>Office: 0.42</ClipFrameResult>

                            <ClipFrameResult>Office: 0.43</ClipFrameResult>

                            <ClipFrameResult>Office: 0.33</ClipFrameResult>

                            <ClipFrameResult>Office: 0.29</ClipFrameResult>
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                            <ClipFrameResult>Office: 0.15</ClipFrameResult>

                            <ClipFrameResult>Entertainment venue: 0.42</ClipFrameRe

                            <ClipFrameResult>Office: 0.33</ClipFrameResult>

                            <EndIndex>275</EndIndex>

                            <EndTime>11</EndTime>

                            <StartIndex>0</StartIndex>

                            <StartTime>0</StartTime>

                            <Tags>

                                <Confidence>0.591724</Confidence>

                                <Tag>Office</Tag>

                                <TagCls>Work</TagCls>

                            </Tags>

                            <Tags>

                                <Confidence>0.175342</Confidence>

                                <Tag>Supermarket/Convenience store/Store</Tag>

                                <TagCls>Business</TagCls>

                            </Tags>

                        </PlaceTags>

                        <PlaceTags>

                            <ClipFrameResult>Other: 0.09</ClipFrameResult>

                            <ClipFrameResult>Other: 0.21</ClipFrameResult>

                            <ClipFrameResult>Other: 0.19</ClipFrameResult>

                            <ClipFrameResult>Sky: 0.28</ClipFrameResult>

                            <ClipFrameResult>Sky: 0.25</ClipFrameResult>

                            <ClipFrameResult>Other: 0.30</ClipFrameResult>

                            <ClipFrameResult>Other: 0.28</ClipFrameResult>

                            <ClipFrameResult>Other: 0.49</ClipFrameResult>

                            <ClipFrameResult>Other: 0.56</ClipFrameResult>

                            <ClipFrameResult>Other: 0.58</ClipFrameResult>

                            <EndIndex>322</EndIndex>

                            <EndTime>12.88</EndTime>

                            <StartIndex>276</StartIndex>

                            <StartTime>11.04</StartTime>

                            <Tags>

                                <Confidence>0.581444</Confidence>

                                <Tag>Other</Tag>

                                <TagCls>Other</TagCls>

                            </Tags>

                            <Tags>

                                <Confidence>0.283301</Confidence>

                                <Tag>Sky</Tag>

                                <TagCls>Nature/Outdoor</TagCls>

                            </Tags>

                        </PlaceTags>

                        <Tags>

                            <Confidence>0.355083</Confidence>

                            <Tag>MOBA - Arena of Valor</Tag>
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                        </Tags>

                        <Tags>

                            <Confidence>0.587103</Confidence>

                            <Tag>Game</Tag>

                        </Tags>

                        <Tags>

                            <Confidence>0.544651</Confidence>

                            <Tag>Office</Tag>

                        </Tags>

                        <Tags>

                            <Confidence>0.182886</Confidence>

                            <Tag>Supermarket/Convenience store/Store</Tag>

                        </Tags>

                    </Data>

                    <SubErrCode>0</SubErrCode>

                    <SubErrMsg>ok</SubErrMsg>

                </StreamData>

            </VideoTagResult>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-07-01T10:05:50+0800</StartTime>

        <State>Success</State>

        <Tag>VideoTag</Tag>

        <VideoTag/>

    </JobsDetail>

</Response>

Sample 2: Job callback in JSON format triggered by a job API
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{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-07-01T10:05:48+0800",

        "EndTime": "2022-07-01T10:06:02+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing"

        },
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        "JobId": "j535b10a4f8e211ec9452c1c27f56a659",

        "Message": "Success",

        "Operation": {

            "UserData": "This is my VideoTag job.",

            "VideoTag": {

                "Scenario": "Stream"

            },

            "VideoTagResult": {

                "StreamData": {

                    "Data": {

                        "ActionTags": [{

                                "EndTime": "11",

                                "StartTime": "0",

                                "Tags": {

                                    "Confidence": "0.421531",

                                    "Tag": "Speak",

                                    "TagCls": "Speak"

                                }

                            },

                            {

                                "EndTime": "12.88",

                                "StartTime": "11.04"

                            }

                        ],

                        "ObjectTags": {

                            "Objects": {

                                "BBox": {

                                    "X1": "0.10181817412376404",

                                    "X2": "0.8069194555282593",

                                    "Y1": "0.6880248785018921",

                                    "Y2": "0.8779844045639038"

                                },

                                "Confidence": "0.808393",

                                "Name": "Keyboard"

                            },

                            "TimeStamp": "11"

                        },

                        "PlaceTags": [{

                                "ClipFrameResult": [

                                    "Office: 0.55",

                                    "Office: 0.55",

                                    "Office: 0.59",

                                    "Office: 0.54",

                                    "Office: 0.42",

                                    "Office: 0.43",

                                    "Office: 0.33",

                                    "Office: 0.29",
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                                    "Office: 0.15",

                                    "Entertainment venue: 0.42",

                                    "Office: 0.33"

                                ],

                                "EndIndex": "275",

                                "EndTime": "11",

                                "StartIndex": "0",

                                "StartTime": "0",

                                "Tags": [{

                                        "Confidence": "0.591724",

                                        "Tag": "Office",

                                        "TagCls": "Work"

                                    },

                                    {

                                        "Confidence": "0.175342",

                                        "Tag": "Supermarket/Convenience store/Store

                                        "TagCls": "Business"

                                    }

                                ]

                            },

                            {

                                "ClipFrameResult": [

                                    "Other: 0.09",

                                    "Other: 0.21",

                                    "Other: 0.19",

                                    "Sky: 0.28",

                                    "Sky: 0.25",

                                    "Other: 0.30",

                                    "Other: 0.28",

                                    "Other: 0.49",

                                    "Other: 0.56",

                                    "Other: 0.58"

                                ],

                                "EndIndex": "322",

                                "EndTime": "12.88",

                                "StartIndex": "276",

                                "StartTime": "11.04",

                                "Tags": [{

                                        "Confidence": "0.581444",

                                        "Tag": "Other",

                                        "TagCls": "Other"

                                    },

                                    {

                                        "Confidence": "0.283301",

                                        "Tag": "Sky",

                                        "TagCls": "Nature/Outdoor"

                                    }
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                                ]

                            }

                        ],

                        "Tags": [{

                                "Confidence": "0.355083",

                                "Tag": "MOBA - Arena of Valor"

                            },

                            {

                                "Confidence": "0.587103",

                                "Tag": "Game"

                            },

                            {

                                "Confidence": "0.544651",

                                "Tag": "Office"

                            },

                            {

                                "Confidence": "0.182886",

                                "Tag": "Supermarket/Convenience store/Store"

                            }

                        ]

                    },

                    "SubErrCode": "0",

                    "SubErrMsg": "ok"

                }

            }

        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-07-01T10:05:50+0800",

        "State": "Success",

        "Tag": "VideoTag"

    }]

}
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Voice/Sound Separation
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-01T10:12:26+0800</CreationTime>

        <EndTime>2022-07-01T10:12:32+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j40644e92f8e311ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>128.147000</Bitrate>

                    <Duration>13.688163</Duration>

                    <FormatLongName>MP2/3 (MPEG audio layer 2/3)</FormatLongName>

                    <FormatName>mp3</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>219263</Size>

                    <StartTime>0.025057</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>

                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>
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                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>3b883c0462ba845acdf3eb7e30db1a1c</Md5>

                        <ObjectName>output/audio.mp3</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>62de6bb513d6105eeeb1a6ab0077cb5a</Md5>

                        <ObjectName>output/backgroud.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>output/audio.mp3</ObjectName>

                    <ObjectName>output/backgroud.mp3</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <AuObject>output/audio.mp3</AuObject>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.mp3</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my VoiceSeparate job.</UserData>

            <TemplateId>t1f6ac18da8bdc403fa27ac4ffnd7a6sa1</TemplateId>

            <TemplateName>videoseparate_12654</TemplateName>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-07-01T10:12:27+0800</StartTime>

        <State>Success</State>

        <Tag>VoiceSeparate</Tag>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type
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EventName Response Fixed value: 
 TaskFinish .

String

JobsDetail Response Job details Container array

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the voice/sound separation job submitting API.﻿
If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.

 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API

https://intl.cloud.tencent.com/document/product/1045/48946
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-01T10:12:26+0800</CreationTime>

        <EndTime>2022-07-01T10:12:32+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j40644e92f8e311ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>128.147000</Bitrate>

                    <Duration>13.688163</Duration>

                    <FormatLongName>MP2/3 (MPEG audio layer 2/3)</FormatLongName>

                    <FormatName>mp3</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>219263</Size>

                    <StartTime>0.025057</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>

                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>
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                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>3b883c0462ba845acdf3eb7e30db1a1c</Md5>

                        <ObjectName>output/audio.mp3</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>62de6bb513d6105eeeb1a6ab0077cb5a</Md5>

                        <ObjectName>output/backgroud.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>output/audio.mp3</ObjectName>

                    <ObjectName>output/backgroud.mp3</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <AuObject>output/audio.mp3</AuObject>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.mp3</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my VoiceSeparate job.</UserData>

            <TemplateId>t1f6ac18da8bdc403fa27ac4ffnd7a6sa1</TemplateId>

            <TemplateName>videoseparate_12654</TemplateName>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-07-01T10:12:27+0800</StartTime>

        <State>Success</State>

        <Tag>VoiceSeparate</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback triggered by a workflow
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-01T10:12:26+0800</CreationTime>

        <EndTime>2022-07-01T10:12:32+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp3</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>
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                <Key>Content-Type</Key>

                <Value>video/mp3</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1326515</Value>

            </CosHeaders>

        </Input>

        <JobId>j40644e92f8e311ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>128.147000</Bitrate>

                    <Duration>13.688163</Duration>

                    <FormatLongName>MP2/3 (MPEG audio layer 2/3)</FormatLongName>

                    <FormatName>mp3</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>219263</Size>

                    <StartTime>0.025057</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>
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                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>3b883c0462ba845acdf3eb7e30db1a1c</Md5>

                        <ObjectName>output/audio.mp3</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>62de6bb513d6105eeeb1a6ab0077cb5a</Md5>

                        <ObjectName>output/backgroud.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>output/audio.mp3</ObjectName>

                    <ObjectName>output/backgroud.mp3</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <AuObject>output/audio.mp3</AuObject>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.mp3</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my VoiceSeparate job.</UserData>

            <TemplateId>t1f6ac18da8bdc403fa27ac4ffnd7a6sa1</TemplateId>

            <TemplateName>videoseparate_12654</TemplateName>

        </Operation>
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        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-07-01T10:12:27+0800</StartTime>

        <State>Success</State>

        <Tag>VoiceSeparate</Tag>

        <Workflow>

            <Name>VoiceSeparate_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

Sample 3: Job callback in JSON format triggered by a workflow
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{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-07-01T10:12:26+0800",

        "EndTime": "2022-07-01T10:12:32+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp3",

            "Region": "ap-chongqing",

            "CosHeaders": [{
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                    "Key": "Content-Type",

                    "Value": "video/mp3"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1326515"

                }

            ]

        },

        "JobId": "j40644e92f8e311ecb90d0b03267ce0e5",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Bitrate": "128.147000",

                    "Duration": "13.688163",

                    "FormatLongName": "MP2/3 (MPEG audio layer 2/3)",

                    "FormatName": "mp3",

                    "NumProgram": "0",

                    "NumStream": "1",

                    "Size": "219263",

                    "StartTime": "0.025057"

                },

                "Stream": {

                    "Audio": [{

                            "Bitrate": "128.000000",

                            "Channel": "2",

                            "ChannelLayout": "stereo",

                            "CodecLongName": "MP3 (MPEG audio layer 3)",

                            "CodecName": "mp3",

                            "CodecTag": "0x0000",

                            "CodecTagString": "[0][0][0][0]",

                            "CodecTimeBase": "1/14112000",

                            "Duration": "13.688163",

                            "Index": "0",

                            "SampleFmt": "fltp",

                            "SampleRate": "44100",

                            "StartTime": "0.025057",

                            "Timebase": "1/14112000"

                        },
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                        {

                            "Bitrate": "128.000000",

                            "Channel": "2",

                            "ChannelLayout": "stereo",

                            "CodecLongName": "MP3 (MPEG audio layer 3)",

                            "CodecName": "mp3",

                            "CodecTag": "0x0000",

                            "CodecTagString": "[0][0][0][0]",

                            "CodecTimeBase": "1/14112000",

                            "Duration": "13.688163",

                            "Index": "0",

                            "SampleFmt": "fltp",

                            "SampleRate": "44100",

                            "StartTime": "0.025057",

                            "Timebase": "1/14112000"

                        }

                    ]

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": [{

                            "Md5": "3b883c0462ba845acdf3eb7e30db1a1c",

                            "ObjectName": "output/audio.mp3"

                        },

                        {

                            "Md5": "62de6bb513d6105eeeb1a6ab0077cb5a",

                            "ObjectName": "output/backgroud.mp3"

                        }

                    ],

                    "ObjectName": [

                        "output/audio.mp3",

                        "output/backgroud.mp3"

                    ],

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "AuObject": "output/audio.mp3",

                "Bucket": "test-123456789",

                "Object": "output/backgroud.mp3",

                "Region": "ap-chongqing"

            },

            "UserData": "This is my VoiceSeparate job.",

            "TemplateId": "t1f6ac18da8bdc403fa27ac4ffnd7a6sa1",

            "TemplateName": "videoseparate_12654"
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        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-07-01T10:12:27+0800",

        "State": "Success",

        "Tag": "VoiceSeparate",

        "Workflow": {

            "Name": "VoiceSeparate_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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Top Speed Codec Transcoding
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>
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                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/high_speed.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/high_speed.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/high_speed.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>high_993874</TemplateName>

            <UserData>This is my HighSpeedHd job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container
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 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container array

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the top speed codec transcoding job submitting API.﻿

If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.

 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API

https://intl.cloud.tencent.com/document/product/1045/49782
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>
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                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/high_speed.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/high_speed.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/high_speed.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>high_993874</TemplateName>

            <UserData>This is my HighSpeedHd job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback triggered by a workflow
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>
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                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>
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                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)<

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/high_speed.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/high_speed.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/high_speed.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>high_993874</TemplateName>

            <UserData>This is my HighSpeedHd job.</UserData>
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            <JobLevel>0</JobLevel>

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

        <Workflow>

            <Name>Transcode_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

Sample 3: Job callback in JSON format triggered by a workflow
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{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-06-30T15:29:42+0800",

        "EndTime": "2022-06-30T15:30:08+0800",

        "Input": {

            "BucketId": "test-123456789",

            "Object": "input/demo.mp4",

            "Region": "ap-chongqing",

            "CosHeaders": [{
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                    "Key": "Content-Type",

                    "Value": "video/mp4"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "j68427030f84611ecb8546d80f2baf56f",

        "Message": "success",

        "Operation": {

            "MediaInfo": {

                "Format": {

                    "Duration": "13",

                    "NumStream": "1",

                    "Size": "1909389"

                },

                "Stream": {

                    "Audio": {

                        "Bitrate": "128000",

                        "Channel": "2",

                        "ChannelLayout": "stereo",

                        "CodecLongName": "AAC (Advanced Audio Coding)",

                        "CodecName": "aac",

                        "CodecTag": "0x6134706d",

                        "CodecTagString": "mp4a",

                        "CodecTimeBase": "1/44100",

                        "Duration": "13.653",

                        "Index": "1",

                        "Language": "und",

                        "SampleFmt": "fltp",

                        "SampleRate": "44100",

                        "StartTime": "0.000000",

                        "Timebase": "1/44100"

                    },

                    "Video": {

                        "AvgFps": "50.000",

                        "Bitrate": "1031968",
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                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Codin

                        "CodecName": "hevc",

                        "CodecTag": "0x31637668",

                        "CodecTagString": "hvc1",

                        "CodecTimeBase": "1/50",

                        "ColorPrimaries": "bt470bg",

                        "ColorRange": "tv",

                        "ColorTransfer": "smpte170m",

                        "Duration": "12.960",

                        "FieldOrder": "Unknown",

                        "Fps": "50/1",

                        "HasBFrame": "4",

                        "Height": "960",

                        "Index": "0",

                        "Language": "und",

                        "Level": "4",

                        "NumFrames": "648",

                        "PixFormat": "hvc1",

                        "Profile": "Main",

                        "RefFrames": "1",

                        "Rotation": "0",

                        "StartTime": "0.000000",

                        "Timebase": "1/12800",

                        "Width": "540"

                    }

                }

            },

            "MediaResult": {

                "OutputFile": {

                    "Bucket": "test-123456789",

                    "Md5Info": {

                        "Md5": "2db78d168edf2f883adce89a1b4ca033",

                        "ObjectName": "output/high_speed.mp4"

                    },

                    "ObjectName": "output/high_speed.mp4",

                    "Region": "ap-chongqing"

                }

            },

            "Output": {

                "Bucket": "test-123456789",

                "Object": "output/high_speed.mp4",

                "Region": "ap-chongqing"

            },

            "TemplateId": "t1995d523e42df4c5e858f244b4174360c",

            "TemplateName": "high_993874",

            "UserData": "This is my HighSpeedHd job.",

            "JobLevel": 0
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        },

        "Progress": "100",

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-06-30T15:29:42+0800",

        "State": "Success",

        "Tag": "Transcode",

        "Workflow": {

            "Name": "HighSpeedHd_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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Image Processing
Submit Image Processing Job
CreatePicJobs
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to submit an image processing job.

Request

Sample request
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POST /pic_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>PicProcess</Tag>

    <Input>

        <Object>input/deer.jpg</Object>

    <Operation>

        <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.jpg</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job tag: PicProcess String Yes

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

QueueId Request Queue ID of the job String Yes

CallBackFormat Request
Job callback format, which can be  JSON  or 
 XML  (default). It has a higher priority than that 
of the queue.

String No

CallBackType Request
Job callback type, which can be  Url  (default 
value) or  TDMQ . It has a higher priority than 
that of the queue.

String No
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CallBack Request Job callback address, which has a higher priority 
than that of the queue. If it is set to  no , no 
callbacks will be generated at the callback 
address of the queue.

String No

CallBackMqConfig Request

TDMQ configuration for job callback as 
described in Structure > CallBackMqConfig, 
which is required if  CallBackType  is 
 TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Media filename String Yes

 Operation  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required

PicProcess Request.Operation

Job type parameter. Same as 
 Request.PicProcess  in the image 
processing template creation API 
 CreateMediaTemplate .

Container No

TemplateId Request.Operation Template ID String No

Output Request.Operation Result output address Container Yes

UserData Request.Operation
The user information passed through, which 
is printable ASCII codes of up to 1,024 in 
length.

String No

JobLevel Request.Operation
Job priority. The greater the value, the higher 
the priority. Valid values:  0  (default),  1 , 
 2 .

String No

Note: 
 TemplateId  is used first. If  TemplateId  is unavailable, the corresponding job type parameter is used.

 Output  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

https://intl.cloud.tencent.com/document/product/1045/49945
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Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output Result filename. String Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>
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        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job tag: PicProcess String

State Response.JobsDetail Job status. Valid values:  Submitted , String
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 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue which the job is in String

Input Response.JobsDetail Input resource address of the job Container

Operation Response.JobsDetail Operation rule Container

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

Region Response.JobsDetail.Input Bucket region String

Bucket Response.JobsDetail.Input Result storage bucket String

Object Response.JobsDetail.Input Output result filename String

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

TemplateId Response.JobsDetail.Operation Job template ID String

TemplateName Response.JobsDetail.Operation
Job template name, which will be 
returned if  TemplateId  exists. String

PicProcess Response.JobsDetail.Operation
Same as 
 Request.Operation.PicProcess  
in the request.

Container

Output Response.JobsDetail.Operation
Same as 
 Request.Operation.Output  in 
the request.

Container

PicProcessResult Response.JobsDetail.Operation Output image information. This node will 
not be returned when there is no output.

Container

UserData Response.JobsDetail.Operation The user information passed through. String
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 PicProcessResult  has the following sub-nodes:


Same as the  UploadResult  node in the persistent image processing API.

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request 1: Using the image processing template ID

https://intl.cloud.tencent.com/document/product/1045/33695
https://intl.cloud.tencent.com/document/product/1045/33700
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POST /pic_jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>PicProcess</Tag>

    <Input>

        <Object>input/deer.jpg</Object>

    <Operation>
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        <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.jpg</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

Request 2: Using the image processing parameter
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POST /pic_jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>PicProcess</Tag>

    <Input>

        <Object>input/deer.jpg</Object>

    <Operation>
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         <PicProcess>

            <IsPicInfo>true</IsPicInfo>

            <ProcessRule>imageMogr2/rotate/90</ProcessRule>

        </PicProcess>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.jpg</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2911917386e148639319e13c285cc774</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcess>

                <IsPicInfo>true</IsPicInfo>

                <ProcessRule>imageMogr2/rotate/90</ProcessRule>

            </PicProcess>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Canceling Image Processing Job
CancelPicJob
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to cancel a job. Only pending jobs can be canceled.

Request

Sample request
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PUT /jobs/<jobId>?cancel HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request does not have a request body.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

This request has no response body.

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
https://intl.cloud.tencent.com/document/product/1045/33700
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PUT /jobs/c93984788066911ed89ed352d4d9d2084?cancel HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=
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Querying Image Processing Job
DescribePicJob
Last updated：2024-02-27 15:42:23

Feature Description

This API is used to query a specified job.

Request

Sample request
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GET /pic_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request does not have a request body.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

  <JobsDetail>

  </JobsDetail>

  <NonExistJobIds></NonExistJobIds>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container
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 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

JobsDetail Response Job details Container 
array

NonExistJobIds Response List of non-existing job IDs queried. If all jobs exist, 
this node will not be returned.

String

The content of  JobsDetail  varies by job type. For more information, see the following documents:

CreatePicJobs﻿

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49947
https://intl.cloud.tencent.com/document/product/1045/33700
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GET /pic_jobs/c93984788066911ed89ed352d4d9d2084 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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DescribePicJobs
Last updated：2024-02-27 15:42:23

Feature Description

The API is used to pull jobs that meet specified conditions.

Request

Sample request
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GET /pic_jobs?size=&states=&queueId=&startCreationTime=&endCreationTime= HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request does not have a request body.

Request parameters

The nodes are as described below:

Node Name 
(Keyword)

Parent Node Description Type Required

queueId None ID of the queue from which jobs are pulled. String Yes

tag None Job tag String Yes

workflowId None ID of the workflow triggering this job String No

inventoryTriggerJobId None ID of the batch data processing job 
triggering this job

String No

inputObject None Name of the input file for this job, which 
currently supports only exact match.

String No

orderByTime None  Desc  (default) or  Asc  String No

nextToken None Context token for pagination String No

size None
Maximum number of jobs that can be 
pulled. The default value is  10 . The 
maximum value is  100 .

Integer No

states None

Status of the jobs to pull. If you enter 
multiple job statuses, separate them by 
comma. Valid values:  All  (default), 
 Submitted ,  Running ,  Success , 
 Failed ,  Pause ,  Cancel .

String No

startCreationTime None

Start time of the time range for job pulling in 
the format of  %Y-%m-%dT%H:%m:%S%z , 
such as  2001-01-
01T00:00:00+0800 

String No

endCreationTime None End time of the time range for job pulling in 
the format of  %Y-%m-%dT%H:%m:%S%z , 

String No

https://intl.cloud.tencent.com/document/product/1045/43609
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such as  2001-01-
01T23:59:59+0800 

Supported  tag  types are as follows:

Job type  tag 

Image processing PicProcess

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <JobsDetail>

        ...

    </JobsDetail>

    <NextToken></NextToken>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type
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Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container array

NextToken Response Context token for 
pagination

String

The content of  JobsDetail  varies by job type. For more information, see the following documents:

CreatePicJobs﻿

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49947
https://intl.cloud.tencent.com/document/product/1045/33700
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GET /pic_jobs?queueId=p2911917386e148639319e13c285cc774&tag=PicProcess HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>c93984788066911e689ed352d4d9d2ghd4</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcess>
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                <IsPicInfo>true</IsPicInfo>

                <ProcessRule>imageMogr2/rotate/90</ProcessRule>

            </PicProcess>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Image Processing Callback
Last updated：2024-02-27 15:42:23

Feature Description

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request with the 
body containing notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the configured callback URL. The response body 
is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>2022-07-18T15:16:44+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <Message/>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcessResult>

                <ObjectName>output/out.jpg</ObjectName>

                <OriginalInfo>

                    <Etag>"d5a491cd3d8d071e3212c3478e8e35a1"</Etag>

                    <ImageInfo>

                        <Ave>0xc64847</Ave>

                        <Format>JPEG</Format>

                        <Height>417</Height>

                        <Orientation>0</Orientation>

                        <Quality>68</Quality>

                        <Width>500</Width>

                    </ImageInfo>

                </OriginalInfo>

                <ProcessResult>

                    <Etag/>

                    <Format>JPEG</Format>

                    <Height>500</Height>

                    <Quality>68</Quality>

                    <Size>24911</Size>

                    <Width>417</Width>

                </ProcessResult>

            </PicProcessResult>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my PicProcess job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <StartTime>2022-07-18T15:16:44+0800</StartTime>

        <State>Success</State>

        <Tag>PicProcess</Tag>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container
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 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container array

 JobsDetail  has the following sub-nodes:


Same as Response.JobsDetail in the image processing job submitting API﻿

If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.

 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Samples

Sample 1: Job callback triggered by a job API

https://intl.cloud.tencent.com/document/product/1045/49947
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>2022-07-18T15:16:44+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>
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        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <Message/>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcessResult>

                <ObjectName>output/out.jpg</ObjectName>

                <OriginalInfo>

                    <Etag>"d5a491cd3d8d071e3212c3478e8e35a1"</Etag>

                    <ImageInfo>

                        <Ave>0xc64847</Ave>

                        <Format>JPEG</Format>

                        <Height>417</Height>

                        <Orientation>0</Orientation>

                        <Quality>68</Quality>

                        <Width>500</Width>

                    </ImageInfo>

                </OriginalInfo>

                <ProcessResult>

                    <Etag/>

                    <Format>JPEG</Format>

                    <Height>500</Height>

                    <Quality>68</Quality>

                    <Size>24911</Size>

                    <Width>417</Width>

                </ProcessResult>

            </PicProcessResult>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my PicProcess job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <StartTime>2022-07-18T15:16:44+0800</StartTime>

        <State>Success</State>

        <Tag>PicProcess</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback triggered by a workflow
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>2022-07-18T15:16:44+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>
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                <Key>Content-Type</Key>

                <Value>image/jpeg</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1024</Value>

            </CosHeaders>

        </Input>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <Message/>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcessResult>

                <ObjectName>output/out.jpg</ObjectName>

                <OriginalInfo>

                    <Etag>"d5a491cd3d8d071e3212c3478e8e35a1"</Etag>

                    <ImageInfo>

                        <Ave>0xc64847</Ave>

                        <Format>JPEG</Format>

                        <Height>417</Height>

                        <Orientation>0</Orientation>

                        <Quality>68</Quality>

                        <Width>500</Width>

                    </ImageInfo>

                </OriginalInfo>

                <ProcessResult>

                    <Etag/>

                    <Format>JPEG</Format>

                    <Height>500</Height>

                    <Quality>68</Quality>

                    <Size>24911</Size>

                    <Width>417</Width>

                </ProcessResult>

            </PicProcessResult>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1723
of 2300

            <TemplateName>test</TemplateName>

            <UserData>This is my PicProcess job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <StartTime>2022-07-18T15:16:44+0800</StartTime>

        <State>Success</State>

        <Tag>PicProcess</Tag>

        <Workflow>

            <Name>PicProcess_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

Sample 3: Job callback in JSON format triggered by a workflow
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{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-07-18T15:16:43+0800",

        "EndTime": "2022-07-18T15:16:44+0800",

        "Input": {

            "BucketId": "test-1234567890",

            "Object": "input/deer.jpg",

            "Region": "ap-chongqing",

            "CosHeaders": [{
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                    "Key": "Content-Type",

                    "Value": "image/jpeg"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1024"

                }

            ]

        },

        "JobId": "c93984788066911ed89ed352d4d9d2084",

        "Operation": {

            "Output": {

                "Bucket": "test-1234567890",

                "Object": "output/out.jpg",

                "Region": "ap-chongqing"

            },

            "PicProcessResult": {

                "ObjectName": "output/out.jpg",

                "OriginalInfo": {

                    "Etag": "\\"d5a491cd3d8d071e3212c3478e8e35a1\\"",

                    "ImageInfo": {

                        "Ave": "0xc64847",

                        "Format": "JPEG",

                        "Height": "417",

                        "Orientation": "0",

                        "Quality": "68",

                        "Width": "500"

                    }

                },

                "ProcessResult": {

                    "Format": "JPEG",

                    "Height": "500",

                    "Quality": "68",

                    "Size": "24911",

                    "Width": "417"

                }

            },

            "TemplateId": "t10461fe2bd5a649db9022452ec71e0381",

            "TemplateName": "test",
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            "UserData": "This is my PicProcess job.",

            "JobLevel": 0,

        },

        "QueueId": "p2911917386e148639319e13c285cc774",

        "StartTime": "2022-07-18T15:16:44+0800",

        "State": "Success",

        "Tag": "PicProcess",

        "Workflow": {

            "Name": "PicProcess_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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Multi-Job Processing
Submitting Multiple Jobs
MultiJobs
Last updated：2024-02-27 15:52:05

Feature Description

This API is used to submit multiple jobs.

Request

Sample request
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POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Tag>Animation</Tag>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/animation.gif</Object>

        </Output>

        <UserData>This is my Animation job.</UserData>

    </Operation>

    <Operation>

        <Tag>Transcode</Tag>

        <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/transcode.mp4</Object>

        </Output>

        <UserData>This is my Trancode job.</UserData>

    </Operation>

    <Operation>

        <Tag>SmartCover</Tag>

        <SmartCover>

            <Format>jpg</Format>

            <Width>1280</Width>

            <Height>960</Height>

            <Count>5</Count>

            <DeleteDuplicates>true</DeleteDuplicates>

        </SmartCover>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${Number}.jpg</Object>

        </Output>   

        <UserData>This is my SmartCover job.</UserData>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:
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Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule. Up to six operation rules are 
supported.

Container Yes

QueueId Request Queue ID of the job String Yes

 Input  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

Object Request.Input Media filename String Yes

The content of  Operation  varies by job type. For more information, see the following documents:

Submitting Video Transcoding Job﻿
Submitting Video-to-Animated Image Conversion Job﻿
Submitting Screenshot Job﻿
Submitting Intelligent Thumbnail Job﻿

Submitting Video Splicing Job﻿
Submitting Voice/Sound Separation Job﻿
Submitting Video Montage Job﻿
Submitting SDR-to-HDR Job﻿
Submitting Video Enhancement Job﻿

Submitting Super Resolution Job﻿
Submitting Remuxing Job﻿
Submitting Digital Watermark Adding Job﻿
Submitting Digital Watermark Extracting Job﻿
Submitting Video Tagging Job﻿
Submitting Media Information Query Job﻿

Submitting Stream Separation Job﻿
Submitting Video Quality Scoring Job﻿

https://intl.cloud.tencent.com/document/product/1045/48941
https://intl.cloud.tencent.com/document/product/1045/49569
https://intl.cloud.tencent.com/document/product/1045/48938#operation
https://intl.cloud.tencent.com/document/product/1045/48937
https://intl.cloud.tencent.com/document/product/1045/48929
https://intl.cloud.tencent.com/document/product/1045/48946
https://intl.cloud.tencent.com/document/product/1045/48943
https://intl.cloud.tencent.com/document/product/1045/48935
https://intl.cloud.tencent.com/document/product/1045/48944
https://intl.cloud.tencent.com/document/product/1045/48940
https://intl.cloud.tencent.com/document/product/1045/48936
https://intl.cloud.tencent.com/document/product/1045/48930
https://intl.cloud.tencent.com/document/product/1045/48931
https://intl.cloud.tencent.com/document/product/1045/48945
https://intl.cloud.tencent.com/document/product/1045/48932
https://intl.cloud.tencent.com/document/product/1045/48939
https://intl.cloud.tencent.com/document/product/1045/48934
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Submitting Text-to-Speech Job﻿
Submitting Audio Noise Cancellation Job﻿

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/48942
https://intl.cloud.tencent.com/document/product/1045/48933
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>
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            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Animation</Tag>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>animation_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.gif</Object>

            </Output>

            <UserData>This is my Animation job.</UserData>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Transcode</Tag>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>transcode_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.mp4</Object>

            </Output>

            <UserData>This is my Trancode job.</UserData>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>
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        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>SmartCover</Tag>

            <SmartCover>

                <Format>jpg</Format>

                <Width>1280</Width>

                <Height>960</Height>

                <Count>5</Count>

                <DeleteDuplicates>true</DeleteDuplicates>

            </SmartCover>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

            </Output>   

            <UserData>This is my SmartCover job.</UserData>

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container array

The content of  JobsDetail  varies by job type. For more information, see the following documents:

Submitting Video Transcoding Job﻿
Submitting Video-to-Animated Image Conversion Job﻿
Submitting Video Frame Capturing Job﻿
Submitting Intelligent Thumbnail Job﻿

https://intl.cloud.tencent.com/document/product/1045/48941
https://intl.cloud.tencent.com/document/product/1045/49569
https://intl.cloud.tencent.com/document/product/1045/48938
https://intl.cloud.tencent.com/document/product/1045/48937
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Submitting Video Splicing Job﻿
Submitting Voice/Sound Separation Job﻿
Submitting Video Montage Job﻿

Submitting SDR-to-HDR Job﻿
Submitting Video Enhancement Job﻿
Submitting Super Resolution Job﻿
Submitting Remuxing Job﻿
Submitting Digital Watermark Adding Job﻿

Submitting Digital Watermark Extracting Job﻿
Submitting Video Tagging Job﻿
Submitting Media Information Query Job﻿
Submitting Stream Separation Job﻿
Submitting Video Quality Scoring Job﻿
Submitting Text-to-Speech Job﻿

Submitting Audio Noise Cancellation Job﻿

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Using multiple template IDs

Request

https://intl.cloud.tencent.com/document/product/1045/48929
https://intl.cloud.tencent.com/document/product/1045/48946
https://intl.cloud.tencent.com/document/product/1045/48943
https://intl.cloud.tencent.com/document/product/1045/48935
https://intl.cloud.tencent.com/document/product/1045/48944
https://intl.cloud.tencent.com/document/product/1045/48940
https://intl.cloud.tencent.com/document/product/1045/48936
https://intl.cloud.tencent.com/document/product/1045/48930
https://intl.cloud.tencent.com/document/product/1045/48931
https://intl.cloud.tencent.com/document/product/1045/48945
https://intl.cloud.tencent.com/document/product/1045/48932
https://intl.cloud.tencent.com/document/product/1045/48939
https://intl.cloud.tencent.com/document/product/1045/48934
https://intl.cloud.tencent.com/document/product/1045/48942
https://intl.cloud.tencent.com/document/product/1045/48933
https://intl.cloud.tencent.com/document/product/1045/49353
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POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>
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        <Tag>Animation</Tag>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/animation.gif</Object>

        </Output>

        <UserData>This is my Animation job.</UserData>

    </Operation>

    <Operation>

        <Tag>Transcode</Tag>

        <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/transcode.mp4</Object>

        </Output>

        <UserData>This is my Trancode job.</UserData>

    </Operation>

    <Operation>

        <Tag>SmartCover</Tag>

        <SmartCover>

            <Format>jpg</Format>

            <Width>1280</Width>

            <Height>960</Height>

            <Count>5</Count>

            <DeleteDuplicates>true</DeleteDuplicates>

        </SmartCover>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${Number}.jpg</Object>

        </Output>   

        <UserData>This is my SmartCover job.</UserData>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Animation</Tag>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>animation_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.gif</Object>

            </Output>

            <UserData>This is my Animation job.</UserData>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Transcode</Tag>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>trancode_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.mp4</Object>

            </Output>
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            <UserData>This is my Trancode job.</UserData>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>SmartCover</Tag>

            <SmartCover>

                <Format>jpg</Format>

                <Width>1280</Width>

                <Height>960</Height>

                <Count>5</Count>

                <DeleteDuplicates>true</DeleteDuplicates>

            </SmartCover>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

            </Output>   

            <UserData>This is my SmartCover job.</UserData>

        </Operation>

    </JobsDetail>

</Response>
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AI-Based Content Recognition
Submitting Content Recognition Job
Submitting Translation Job
Last updated：2024-02-27 15:52:06

Overview

This API is used to submit a translation job.

Request

Sample request
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POST /ai_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>Translation</Tag>

    <Input>

        <Object>input/en.pdf</Object>

        <Lang>en</Lang>

        <Type>pdf</Type>

        <BasicType>pptx</BasicType>

    </Input>

    <Operation>

        <Translation>

            <Lang>zh</Lang>

            <Type>pdf</Type>

        </Translation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/zh.pdf</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job type: Translation String Yes

Input Request Information about the object to be operated Container Yes

Operation Request Operation rule Container Yes

QueueId Request ID of the queue where the job is in String Yes

CallBackFormat Request Job callback format, which can be  JSON  or String No
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 XML  (default). It has a higher priority than 
that of the queue.

CallBackType Request
Job callback type, which can be  Url  
(default) or  TDMQ . It has a higher priority than 
that of the queue.

String No

CallBack Request

Job callback address, which has a higher 
priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

String No

CallBackMqConfig Request

TDMQ configuration for job callback as 
described in Structure > CallBackMqConfig, 
which is required if  CallBackType  is 
 TDMQ .

Container No

 Input  has the following sub-nodes:

Input has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required Constraints

Object Request.Input
Source 
filename String Yes

Single file 
(docx/xlsx/html/markdown/txt): 8 
million characters

Number of pages (pdf/pptx): 300 
pages

Text file (txt): 10 MB

Binary file (pdf/docx/pptx/xlsx): 60 
MB

Image file (jpg/jpeg/png): 10 MB

Lang Request.Input File 
language

String Yes zh: Simplified Chinese

zh-hk: Traditional Chinese

zh-tw: Traditional Chinese

zh-tr: Traditional Chinese

en: English

ar: Arabic

de: German

es: Spanish

fr: French

id: Indonesian


https://intl.cloud.tencent.com/document/product/1045/49945
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it: Italian

ja: Japanese

pt: Portuguese

ru: Russian

ko: Korean

km: Khmer

lo: Lao

Type Request.Input File type String Yes

pdf

docx

pptx

xlsx

txt

xml

html: Only text nodes in HTML files 
can be translated, while nodes that 
need to be dynamically loaded 
through JS cannot.

markdown

jpg

jpeg

png

BasicType Request.Input Original file 
type

String No

This parameter can be used only if 
Type is pdf, jpg, jpeg, or png.

If Type is pdf, only values docx and 
pptx are supported.

If Type is jpg, jpeg, png, or webp, 
only value txt is supported. If this 
parameter is left empty, the 
translation result is returned.

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Translation Request.Operation Translation parameter Container Yes

Output Request.Operation Result output address Container
Yes (no if 
 NoNeedOutput  
is  true )

UserData Request.Operation The user information 
passed through, which is 

String No
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printable ASCII codes of up 
to 1,024 in length.

JobLevel Request.Operation

Job priority. The greater the 
value, the higher the 
priority. Valid values:  0  
(default),  1 ,  2 .

String No

NoNeedOutput Request.Operation

Whether to only output the 
result without generating the 
result file. Valid values: 
 true ,  false . This 
parameter takes effect only 
if the input file is an image.

String No

 Translation  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required Constraints

Lang Request.Operation.Translation
Target 
language String Yes

If the source language 
is zh, zh-hk, zh-tw, or 
zh-tr, this parameter 
can be en, ar, de, es, 
fr, id, it, ja, ru, ko, km, 
lo, or pt.

If the source language 
is en, this parameter 
can be zh, zh-hk, zh-
tw, zh-tr, ar, de, es, fr, 
id, it, ja, ru, ko, km, lo, 
or pt.

If the source language 
is other types, this 
parameter can be zh, 
zh-hk, zh-tw, zh-tr, or 
en.

Type Request.Operation.Translation File type String Yes The mappings 
between source file 
types and target file 
types are as follows:

docx: docx

pptx: pptx

xlsx: xlsx
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txt: txt
xml: xml

html: html

markdown: markdown

pdf: pdf, docx

png: txt

jpg: txt

jpeg: txt

 Output  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output Result file name String Yes

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>Translation</Tag>
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        <Input>

            <Object>input/en.pdf</Object>

            <Lang>en</Lang>

            <Type>pdf</Type>

            <BasicType>pptx</BasicType>

        </Input>

        <Operation>

            <Translation>

                <Lang>zh</Lang>

                <Type>pdf</Type>

            </Translation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/zh.pdf</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String
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Tag Response.JobsDetail Job type:  Translation  String

State Response.JobsDetail
Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue where the job is in String

Input Response.JobsDetail
Same as the  Request.Input  node in the 
request

Container

Operation Response.JobsDetail Operation rule. Up to 6 operation rules are 
supported.

Container

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Translation Response.JobsDetail.Operation
Same as 
 Request.Operation.Translation  
in the request.

Containe

Output Response.JobsDetail.Operation
Same as 
 Request.Operation.Output  in the 
request.

Containe

UserData Response.JobsDetail.Operation The user information passed through. String

JobLevel Response.JobsDetail.Operation Job priority String

AITranslateResult Response.JobsDetail.Operation Translation result details Containe

 AITranslateResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Result Response.JobsDetail.Operation Translation result 
content

String
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Error codes

No special error message will be returned for this request. For the common error messages, please see Error Codes.

Examples

Request

POST /ai_jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

https://intl.cloud.tencent.com/document/product/1045/33700
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Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Translation</Tag>

    <Input>

        <Object>input/en.pdf</Object>

        <Lang>en</Lang>

        <Type>pdf</Type>

        <BasicType>pptx</BasicType>

    </Input>

    <Operation>

        <Translation>

            <Lang>zh</Lang>

            <Type>pdf</Type>

        </Translation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/zh.pdf</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>Translation</Tag>

        <Input>

            <Object>input/en.pdf</Object>

            <Lang>en</Lang>

            <Type>pdf</Type>

            <BasicType>pptx</BasicType>

        </Input>

        <Operation>

            <Translation>

                <Lang>zh</Lang>

                <Type>pdf</Type>

            </Translation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/zh.pdf</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Submitting Speech Recognition Job
Last updated：2024-03-04 10:11:42

Overview

This API is used to submit a speech recognition job.
Note: 
For constraints on speech recognition, see Specifications and Limits.

Request

Sample request

https://intl.cloud.tencent.com/document/product/1045/33425
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POST /asr_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>SpeechRecognition</Tag>

    <Input>

        <Object>input/test.mp3</Object>

        <Url></Url>

    </Input>

    <Operation>

        <SpeechRecognition>

            <EngineModelType>16k_zh_video</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <FilterDirty>1</ChannelNum>

            <FilterModal>1</ChannelNum>

        </SpeechRecognition>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/asr.txt</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Job type: SpeechRecognition. String Yes

Input Request Information about the object to be operated Container Yes

Operation Request Operation rule Container Yes

QueueId Request ID of the queue where the job is in String Yes

CallBackFormat Request Job callback format, which can be  JSON  or String No
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 XML  (default). It has a higher priority than that 
of the queue.

CallBackType Request
Job callback type, which can be  Url  
(default) or  TDMQ . It has a higher priority than 
that of the queue.

String No

CallBack Request

Job callback address, which has a higher 
priority than that of the queue. If it is set to 
 no , no callbacks will be generated at the 
callback address of the queue.

String No

CallBackMqConfig Request

TDMQ configuration for job callback as 
described in Structure > CallBackMqConfig, 
which is required if  CallBackType  is 
 TDMQ .

Container No

 Input  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Media filename String No

Url Request.Input

URL that supports downloading over the public 
network. At least one of  Url  and  Object  must 
be passed in. If both parameters are passed in, 
 Object  is preferred.

String No

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

SpeechRecognition Request.Operation Speech recognition parameter Container Yes

Output Request.Operation Result output address Container Yes

UserData Request.Operation
The user information passed 
through, which is printable ASCII 
codes of up to 1,024 in length.

String No

JobLevel Request.Operation
Job priority. The greater the value, 
the higher the priority. Valid values: 
 0 ,  1 ,  2 . Default value:  0 .

String No

https://intl.cloud.tencent.com/document/product/1045/49945
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 SpeechRecognition  has the following sub-nodes:

SpeechRecognition has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

EngineModelType
Request.Operation.Speech 
Recognition

Engine model type. 
Phone call scenario:
8k_zh: 8 kHz Mandarin for 
general fields (applied to dual-
channel audios)
8k_zh_s: 8 kHz Mandarin for 
speaker diarization (applied only 
to mono-channel audios)
Non-phone call scenario:
16k_zh: 16 kHz Mandarin for 
general fields
16k_zh_video: 16 kHz Mandarin 
for audiovisual fields
16k_en: 16 kHz English
16k_ca: 16 kHz Cantonese

String Yes

ChannelNum Request.Operation.Speech 
Recognition

Number of sound channels:
1: Mono
2: Dual (for the 8k_zh engine 
only)

Integer Yes

ResTextFormat Request.Operation.Speech 
Recognition

Format of the returned 
recognition result.
0: recognition result text, 
including the list of segment 
timestamps
1: recognition result details, 
including the list of word 
timestamps (generally used to 
generate subtitles and for the 16 
kHz Mandarin engine only).

Integer Yes

FilterDirty Request.Operation.Speech 
Recognition

Whether to filter restricted words 
(for the Mandarin engine only).
0: Does not filter.
1: Filters.
2: Replaces restricted words 
with *. Default value: 0.

Integer No
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FilterModal Request.Operation.Speech 
Recognition

Whether to filter modal particles 
(for the Mandarin engine only).
0: Does not filter.
1: Filters partially.
2: Filters strictly. Default value: 0.

Integer No

ConvertNumMode Request.Operation.Speech 
Recognition

Whether to intelligently convert 
Chinese numbers to Arabic 
numerals (for the Mandarin 
engine only):
0: Directly outputs Chinese 
numbers.
1: Intelligently converts based on 
the scenario. Default value: 1.

Integer No

 Output  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

Region Request.Operation.Output Bucket region String Yes

Bucket Request.Operation.Output Result storage bucket String Yes

Object Request.Operation.Output Result file name String Yes

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2021-08-05T15:43:50+0800</CreationTime>

        <EndTime>-</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s58ccb634149211ed84ce2b1cd7fbb14a</JobId>
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        <Message/>

        <Operation>

            <JobLevel>0</JobLevel>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/asr.txt</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SpeechRecognition>

                <ChannelNum>1</ChannelNum>

                <ConvertNumMode>0</ConvertNumMode>

                <EngineModelType>16k_zh_video</EngineModelType>

                <FilterDirty>0</FilterDirty>

                <FilterModal>0</FilterModal>

                <FilterPunc>0</FilterPunc>

                <OutputFileType>txt</OutputFileType>

                <ResTextFormat>0</ResTextFormat>

                <SpeakerDiarization>0</SpeakerDiarization>

                <SpeakerNumber>0</SpeakerNumber>

            </SpeechRecognition>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <StartTime>-</StartTime>

        <State>Submitted</State>

        <Tag>SpeechRecognition</Tag>

    </JobsDetail>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type
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Code Response.JobsDetail Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job type: SpeechRecognition String

State Response.JobsDetail
Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue where the job is in String

Input Response.JobsDetail
Same as the  Request.Input  node in the 
request

Container

Operation Response.JobsDetail Operation rule. Up to 6 operation rules are 
supported.

Container

 Operation  has the following sub-nodes:

Node Name (Keyword) Parent Node Description

SpeechRecognition Response.JobsDetail.Operation
Same as 
 Request.Operation.SpeechRecognitio

in the request.

Output Response.JobsDetail.Operation
Same as  Request.Operation.Output  in 
the request.

UserData Response.JobsDetail.Operation The user information passed through.

JobLevel Response.JobsDetail.Operation Job priority

SpeechRecognitionResult Response.JobsDetail.Operation Speech recognition job result. It is not returned 
when there is no result.

 SpeechRecognitionResult  has the following sub-nodes:
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Node Name 
(Keyword)

Parent Node Description Type

AudioTime Response.JobsDetail.Operation.SpeechRecognitionResult Audio duration 
(seconds)

String

Result Response.JobsDetail.Operation.SpeechRecognitionResult Speech recognition 
result

String

FlashResult Response.JobsDetail.Operation.SpeechRecognitionResult Result of fast 
speech recognition

Container 
array

ResultDetail Response.JobsDetail.Operation.SpeechRecognitionResult

Recognition result 
details, including the 
time offsets of words 
in each sentence 
(generally used to 
generate subtitles). 
This field will not be 
empty if 
 ResTextFormat  
in the speech 
recognition request 
is  1 .
Note: This field may 
be empty, indicating 
that no valid values 
can be obtained.

Container 
array

 FlashResult  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description

channel_id Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult

Sound channel ID, 
which starts from 0 
and is 
corresponding to 
the number of audio 
channels

text Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult

Complete audio 
recognition results 
of the sound 
channel
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sentence_list Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult List of recognition 
results at 
sentence/paragraph 
level

 sentence_list  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description

text Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult.sentence_list Sentence/p
level text

start_time Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult.sentence_list Start time

end_time Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult.sentence_list End time

speaker_id Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult.sentence_list

Speaker ID
speaker_d
is set in the
speakers c
distinguish
 speaker

word_list Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult.sentence_list List of reco
results at w

 word_list  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node D

word Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult.sentence_list.word_list W
te

start_time Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult.sentence_list.word_list S

end_time Response.JobsDetail.Operation.SpeechRecognitionResult.FlashResult.sentence_list.word_list E

 ResultDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description
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FinalSentence Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail Final recognition 
result of a single 
sentence

SliceSentence Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail

Middle recognition 
result of a single 
sentence, which is 
split into multiple 
words using 
spaces

StartMs Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail
Start time of a 
single sentence 
(millisecond)

EndMs Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail
End time of a single 
sentence 
(millisecond)

WordsNum Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail Number of words in 
a single sentence

SpeechSpeed Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail
Speed of a single 
sentence. Unit: 
words/second

SpeakerId Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail

Sound channel or 
speaker ID (If 
speaker_diarization 
is set or 
 ChannelNum  is 
set to  Dual  in 
the request, the 
speakers or 
channels can be 
distinguished.)

Words Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail Word details in a 
single sentence

 Words  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description

Word Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail.Words Word text
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OffsetStartMs Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail.Words Start time 
offset in a 
sentence

OffsetEndMs Response.JobsDetail.Operation.SpeechRecognitionResult.ResultDetail.Words
End time 
offset in a 
sentence

Error codes

No special error message will be returned for this request. For the common error messages, please see Error Codes.

Examples

Request

https://intl.cloud.tencent.com/document/product/1045/33700
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POST /asr_jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SpeechRecognition</Tag>

    <Input>

        <Object>input/test.mp3</Object>

    </Input>
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    <Operation>

        <SpeechRecognition>

            <EngineModelType>16k_zh_video</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <FilterDirty>1</ChannelNum>

            <FilterModal>1</ChannelNum>

        </SpeechRecognition>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/asr.txt</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <CreationTime>2021-08-05T15:43:50+0800</CreationTime>

        <EndTime>-</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s58ccb634149211ed84ce2b1cd7fbb14a</JobId>

        <Message/>

        <Operation>

            <JobLevel>0</JobLevel>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/asr.txt</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SpeechRecognition>

                <ChannelNum>1</ChannelNum>

                <ConvertNumMode>0</ConvertNumMode>

                <EngineModelType>16k_zh_video</EngineModelType>

                <FilterDirty>0</FilterDirty>

                <FilterModal>0</FilterModal>

                <FilterPunc>0</FilterPunc>

                <OutputFileType>txt</OutputFileType>

                <ResTextFormat>0</ResTextFormat>

                <SpeakerDiarization>0</SpeakerDiarization>

                <SpeakerNumber>0</SpeakerNumber>

            </SpeechRecognition>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <StartTime>-</StartTime>

        <State>Submitted</State>

        <Tag>SpeechRecognition</Tag>

    </JobsDetail>

</Response>
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Submitting Word Segmentation Job
Last updated：2024-02-27 15:52:05

Feature Description

This API is used to submit a word segmentation job.

Request

Sample request
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POST /ai_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>WordsGeneralize</Tag>

    <Input>

        <Object>text.txt</Object>

    </Input>

    <Operation>

        <WordsGeneralize>

            <NerMethod>DL</NerMethod>

            <SegMethod>MIX</SegMethod>

        </WordsGeneralize>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Tag Request Job tag: WordsGeneralize String Yes

Input Request Information about the object to be 
operated

Container Yes

Operation Request Operation rule Container Yes

QueueId Request ID of the queue where the job is in String Yes

CallBackFormat Request
Job callback format, which can be 
 JSON  or  XML  (default value). It has 
a higher priority than that of the queue.

String No

CallBackType Request
Job callback type, which can be  Url  
(default value) or  TDMQ . It has a 
higher priority than that of the queue.

String No
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CallBack Request Job callback address, which has a 
higher priority than that of the queue. If it 
is set to  no , no callbacks will be 
generated at the callback address of the 
queue.

String No

CallBackMqConfig Request
TDMQ configuration for job callback as 
described in Structure, which is required 
if  CallBackType  is  TDMQ .

Container No

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Object Request.Input Media filename String Yes

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

WordsGeneralize Request.Operation Word segmentation parameter Container Yes

UserData Request.Operation
The user information passed 
through, which is printable ASCII 
codes of up to 1,024 in length.

String No

JobLevel Request.Operation
Job priority. The greater the value, 
the higher the priority. Valid values: 
 0 ,  1 ,  2 . Default value:  0 .

String No

 WordsGeneralize  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required Constraints

NerMethod Request.Operation.WordsGeneralize
NER method. 
Default 
value:  DL .

String No
 NerBasic  
or  DL 

SegMethod Request.Operation.WordsGeneralize Word 
segmentation 
granularity. 
Default 

String No  SegBasic  
or  MIX 

https://intl.cloud.tencent.com/document/product/1045/49945
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value: 
 MIX .

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>WordsGeneralize</Tag>
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        <Input>

            <Object>text.txt</Object>

        </Input>

        <Operation>

            <WordsGeneralize>

                <NerMethod>DL</NerMethod>

                <SegMethod>MIX</SegMethod>

            </WordsGeneralize>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

JobId Response.JobsDetail Job ID String

Tag Response.JobsDetail Job type:  WordsGeneralize  String

State Response.JobsDetail
Job status. Valid values:  Submitted ,  Running , 
 Success ,  Failed ,  Pause ,  Cancel .

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String
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EndTime Response.JobsDetail Job end time String

QueueId Response.JobsDetail ID of the queue where the job is in String

Input Response.JobsDetail Same as the  Request.Input  node in the request Container

Operation Response.JobsDetail Operation rule. Up to 6 operation rules are supported. Container

 Operation  has the following sub-nodes:

Node Name (Keyword) Parent Node Description

WordsGeneralize Response.JobsDetail.Operation
Same as 
 Request.Operation.WordsGeneralize  
in the request.

UserData Response.JobsDetail.Operation The user information passed through.

JobLevel Response.JobsDetail.Operation Job priority

WordsGeneralizeResult Response.JobsDetail.Operation Word segmentation result, which will be returned 
if the job is executed successfully.

 WordsGeneralizeResult  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

WordsGeneralizeLable Response.JobsDetail.Operation.WordsGeneralizeResult
Smart 
categorization 
result

Contain
array

WordsGeneralizeToken Response.JobsDetail.Operation.WordsGeneralizeResult
Detailed word 
segmentation 
result

Contain
array

 WordsGeneralizeLable  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description T

Category Response.JobsDetail.Operation.WordsGeneralizeResult.WordsGeneralizeLable Category s

Word Response.JobsDetail.Operation.WordsGeneralizeResult.WordsGeneralizeLable Word s

 WordsGeneralizeToken  has the following sub-nodes:
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Node 
Name 
(Keyword)

Parent Node Description

Word Response.JobsDetail.Operation.WordsGeneralizeResult.WordsGeneralizeToken Word

Offset Response.JobsDetail.Operation.WordsGeneralizeResult.WordsGeneralizeToken Offset

Length Response.JobsDetail.Operation.WordsGeneralizeResult.WordsGeneralizeToken Word 
length

Pos Response.JobsDetail.Operation.WordsGeneralizeResult.WordsGeneralizeToken Part of 
speech

See the subscript for the part of speech:

Value Description

A Adjective

AD Adverbial adjective

AN Nominal adjective

B Distinguishing word

C Conjunction

D Adverb

E Interjection

F Locality word

G Morpheme

H Preceding component

I Idiom

J Abbreviation

K Trailing component

L Idiom

M Numeral

N Noun
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NR Person name

NRF Surname

NRG First name

NS Place name

NT Organization

NZ Other proper names

NX Non-Chinese string

O Onomatopoeia

P Preposition

Q Quantifier

R Pronoun

S Location word

T Time word

U Particle

V Verb

VD Adverbial verb

VN Nominal verb

W Punctuation

X Non-morpheme word

Y Modal particle

Z State word

AG Adjective morpheme

BG Distinguishing morpheme

DG Adverbial morpheme

MG Numeral morpheme
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NG Nominal morpheme

QG Quantifying morpheme

RG Pronominal morpheme

TG Verbal morpheme

VG Quantifying morpheme

YG Modal morpheme

ZG State morpheme

UNK Unknown

Error codes

No special error message will be returned for this request. For the common error messages, please see Error Codes.

Examples

Request

https://intl.cloud.tencent.com/document/product/1045/33700
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POST /ai_jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>WordsGeneralize</Tag>

    <Input>

        <Object>text.txt</Object>

    </Input>
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    <Operation>

        <WordsGeneralize>

            <NerMethod>DL</NerMethod>

            <SegMethod>MIX</SegMethod>

        </WordsGeneralize>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>WordsGeneralize</Tag>

        <Input>

            <Object>text.txt</Object>

        </Input>

        <Operation>

            <WordsGeneralize>

                <NerMethod>DL</NerMethod>

                <SegMethod>MIX</SegMethod>

            </WordsGeneralize>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Canceling Content Recognition Job
Last updated：2024-02-27 15:52:05

Feature Description

This API (  CancelAIJob ) is used to cancel a job. Only pending jobs can be canceled.

Request

Sample request
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PUT /ai_jobs/<jobId>?cancel HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request does not have a request body.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

This request has no response body.

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49351
https://intl.cloud.tencent.com/document/product/1045/49352
https://intl.cloud.tencent.com/document/product/1045/49353
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PUT /ai_jobs/a-xxx-xxx-xxx-xxxx?cancel HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=
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Querying Content Recognition Job
Querying Content Recognition Job
Last updated：2024-02-27 15:52:06

Feature Description

This API is used to query a specified job.

Request

Sample request
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GET /ai_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1798
of 2300

Request headers

This API only uses Common Request Headers.

Request body

This request does not have a request body.

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <JobsDetail>

    </JobsDetail>

    <NonExistJobIds></NonExistJobIds>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container
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 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

JobsDetail Response Job details Container

NonExistJobIds Response List of non-existing job IDs queried. If all jobs exist, this node 
is not returned.

String

The content of  JobsDetail  varies by job type. For more information, see the following documents:

Translation﻿

Word Segmentation﻿

Error codes

No special error message will be returned for this request. For the common error messages, please see Error Codes.

Examples

Request

https://intl.cloud.tencent.com/document/product/1045/49788
https://intl.cloud.tencent.com/document/product/1045/49790
https://intl.cloud.tencent.com/document/product/1045/33700
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GET /ai_jobs/a8d121820f5e411ec926ef19d53ba9c6f HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Response



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1802
of 2300

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTRfMThhYTk0MGFfYmU1Nl8xNTk=

<Response>

    <JobsDetail>

        <Code>Success</Code>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1803
of 2300

        <Message></Message>

        <JobId>a8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Running</State>

        <CreationTime>2022-07-07T12:12:12+0800</CreationTime>

        <StartTime>2022-07-07T12:12:13+0800</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

        <Tag>Translation<Tag>

        <Input>

            <Object>test.txt</Object>

            <Lang>zh</Lang>

            <Type>txt</Type>

        </Input>

        <Operation>

            <Translation>

                <Lang>en</Lang>

                <Type>txt</Type>

            </Translation>

            <Output>

                <Region>ap-beijing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>test-result.txt</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Pulling Content Recognition Jobs in Batches
Last updated：2024-02-27 15:52:05

Feature Description

The API is used to pull jobs that meet specified conditions.

Request

Sample request
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GET /jobs?size=&states=&queueId=&startCreationTime=&endCreationTime= HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request parameters

The nodes are described as follows:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

queueId None ID of the queue from which jobs are pulled String Yes

tag None Job type String Yes

workflowId None ID of the workflow triggering this job String No

inventoryTriggerJobId None ID of the batch data processing job triggering 
this job

String No

inputObject None Name of the input file for this job, which currently 
supports only exact match

String No

orderByTime None Desc (default) or Asc string No

nextToken None Context token for pagination, which is returned 
for the previous request

String No

size None
Maximum number of jobs that can be pulled. 
The default value is 10. The maximum value is 
100.

Integer No

states None

Status of the jobs to pull. If you enter multiple job 
statuses, separate them by comma. Valid 
values:  All  (default),  Submitted , 
 Running ,  Success ,  Failed , 
 Pause ,  Cancel .

String No

startCreationTime None
Start time of the time range for job pulling. 
Format:  %Y-%m-%dT%H:%m:%S%z . Example: 
2001-01-01T00:00:00+0800

String No

endCreationTime None
End time of the time range for job pulling. 
Format:  %Y-%m-%dT%H:%m:%S%z . Example: 
2001-01-01T23:59:59+0800

String No

Supported  tag  types are as follows:

Job type  tag 

Translation Translation
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Speech recognition SpeechRecognition

Word segmentation WordsGeneralize

Request headers

This API only uses Common Request Headers.

Request body

This request does not have a request body.

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <JobsDetail>

        ...

    </JobsDetail>

    <NextToken></NextToken>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type
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Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

JobsDetail Response Job details Container array

NextToken Response Context token for 
pagination

String

The content of  JobsDetail  varies by job type. For more information, see the following documents:

Translation﻿
Word Segmentation﻿

Error codes

No special error message will be returned for this request. For the common error messages, please see Error Codes.

Examples

Request

https://intl.cloud.tencent.com/document/product/1045/49788
https://intl.cloud.tencent.com/document/product/1045/49790
https://intl.cloud.tencent.com/document/product/1045/33700
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GET /jobs?queueId=p893bcda225bf4945a378da6662e81a89&tag=Translation HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Message></Message>

        <JobId>a8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Running</State>

        <CreationTime>2022-07-07T12:12:12+0800</CreationTime>

        <StartTime>2022-07-07T12:12:13+0800</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

        <Tag>Translation<Tag>

        <Input>

            <Object>test.txt</Object>

            <Lang>zh</Lang>

            <Type>txt</Type>

        </Input>

        <Operation>

            <Translation>

                <Lang>en</Lang>

                <Type>txt</Type>

            </Translation>

            <Output>

                <Region>ap-beijing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>test-result.txt</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message></Message>

        <JobId>a8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Running</State>

        <CreationTime>2022-07-07T12:12:12+0800</CreationTime>

        <StartTime>2022-07-07T12:12:13+0800</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

        <Tag>Translation<Tag>

        <Input>

            <Object>test.txt</Object>

            <Lang>zh</Lang>

            <Type>txt</Type>

        </Input>

        <Operation>

            <Translation>

                <Lang>en</Lang>

                <Type>txt</Type>

            </Translation>
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            <Output>

                <Region>ap-beijing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>test-result.txt</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <NextToken>225508</NextToken>

</Response>
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Content Recognition Job Callback
Translation Job Callback
Last updated：2024-02-27 15:52:05

Feature Overview

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request whose 
body contains notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the callback URL that you configure. The 
response body is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-25T16:35:39+0800</CreationTime>

        <EndTime>2022-07-25T16:35:43+0800</EndTime>

        <Input>

            <Object>input/en.pdf</Object>

            <Lang>en</Lang>

            <Type>pdf</Type>

            <BasicType>pptx</BasicType>
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        </Input>

        <JobId>ac34be3aa0bf411ed9ce39d7cc972e427</JobId>

        <Message>Success</Message>

        <Operation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/zh.pdf</Object>

            </Output>

            <Translation>

                <Lang>en</Lang>

                <Type>txt</Type>

            </Translation>

            <UserData>This is my Translation job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pbde29b842b1b4e2ea4f0b20d264fcec2</QueueId>

        <StartTime>2022-07-25T16:35:39+0800</StartTime>

        <State>Success</State>

        <Tag>Translation</Tag>

    </JobsDetail>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:


Same as the  Response.JobsDetail  in the translation job submitting API.

If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.

 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

https://intl.cloud.tencent.com/document/product/1045/49788


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1817
of 2300

Key Response.JobsDetail.Input.CosHeaders Name of the custom header String

Value Response.JobsDetail.Input.CosHeaders Value of the custom header String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.
 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

Examples

Sample 1: Job callback triggered by a job API
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-25T16:35:39+0800</CreationTime>

        <EndTime>2022-07-25T16:35:43+0800</EndTime>

        <Input>

            <Object>input/en.pdf</Object>

            <Lang>en</Lang>

            <Type>pdf</Type>

            <BasicType>pptx</BasicType>
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        </Input>

        <JobId>ac34be3aa0bf411ed9ce39d7cc972e427</JobId>

        <Message>Success</Message>

        <Operation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/zh.pdf</Object>

            </Output>

            <Translation>

                <Lang>en</Lang>

                <Type>txt</Type>

            </Translation>

            <UserData>This is my Translation job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pbde29b842b1b4e2ea4f0b20d264fcec2</QueueId>

        <StartTime>2022-07-25T16:35:39+0800</StartTime>

        <State>Success</State>

        <Tag>Translation</Tag>

    </JobsDetail>

</Response>

Sample 2: Job callback in JSON format triggered by a job
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{

    "EventName": "TaskFinish",

    "JobsDetail": {

        "Code": "Success",

        "CreationTime": "2022-07-25T16:35:39+0800",

        "EndTime": "2022-07-25T16:35:43+0800",

        "Input":{

            "Object": "input/en.pdf",

            "Lang": "en",

            "Type": "pdf",

            "BasicType": "pptx"
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        },

        "JobId": "ac34be3aa0bf411ed9ce39d7cc972e427",

        "Message": "Success",

        "Operation": {

            "Output": {

                "Region": "ap-chongqing",

                "Bucket": "test-123456789",

                "Object": "output/zh.pdf"

            },

            "Translation": {

                "Lang": "en",

                "Type": "txt"

            },

            "UserData": "This is my Translation job.",

            "JobLevel": 0,

        },

        "QueueId": "pbde29b842b1b4e2ea4f0b20d264fcec2",

        "StartTime": "2022-07-25T16:35:39+0800",

        "State": "Success",

        "Tag": "Translation"

    }

}
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Word Segmentation Job Callback
Last updated：2024-02-27 15:52:06

Feature Overview

CI supports user-defined callback URLs. After a job is completed, the system sends an HTTP POST request whose 
body contains notification content to a user-defined callback URL. You can use the configured callback URL to learn 
about the processing progress and status of the job so that you can perform other operations as needed.

Callback Content

After the job is completed, the system sends the callback content to the callback URL that you configure. The 
response body is returned as application/xml data. The following contains all the nodes:
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Tag>WordsGeneralize</Tag>

        <Code>Success</Code>

        <CreationTime>2022-07-25T16:35:39+0800</CreationTime>

        <EndTime>2022-07-25T16:35:43+0800</EndTime>

        <Input>

            <Object>text.txt</Object>

            <BucketId>test-123456789</BucketId>

            <Region>ap-chongqing</Region>
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        </Input>

        <JobId>ac34be3aa0bf411ed9ce39d7cc972e427</JobId>

        <Message>Success</Message>

        <Operation>

            <UserData>This is my WordsGeneralize job.</UserData>

            <JobLevel>0</JobLevel>

            <WordsGeneralize>

                <NerMethod>DL</NerMethod>

                <SegMethod>MIX</SegMethod>

            </WordsGeneralize>

            <WordsGeneralizeResult>

                <WordsGeneralizeLable>

                    <Category>Transportation</Category>

                    <Word>Taxi</Word>

                </WordsGeneralizeLable>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>0</Offset>

                    <Pos>t</Pos>

                    <Word>Today</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>2</Offset>

                    <Pos>v</Pos>

                    <Word>Taxi</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>1</Length>

                    <Offset>4</Offset>

                    <Pos>v</Pos>

                    <Word>Cost</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>5</Offset>

                    <Pos>nx</Pos>

                    <Word>60</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>1</Length>

                    <Offset>7</Offset>

                    <Pos>q</Pos>

                    <Word>CNY</Word>

                </WordsGeneralizeToken>

            </WordsGeneralizeResult>

        </Operation>
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    </JobsDetail>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

EventName Response
Fixed value: 
 TaskFinish . String

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:


Same as the  Response.JobsDetail  in the word segmentation job submitting API.

If the job is triggered by a workflow,  Response.JobsDetail.Input  will also contain a  CosHeaders  

node of the container array type.
 CosHeaders  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Key Response.JobsDetail.Input.CosHeaders Name of the custom 
header

String

Value Response.JobsDetail.Input.CosHeaders Value of the custom 
header

String

If the job is triggered by a workflow,  Response.JobsDetail  will also contain a  Workflow  node of 

the container type.
 Workflow  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RunId Response.Workflow Workflow instance ID String

WorkflowId Response.Workflow Workflow ID String

WorkflowName Response.Workflow Workflow name String

Name Response.Workflow Workflow node name String

https://intl.cloud.tencent.com/document/product/1045/49790
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Examples

Sample 1: Job callback triggered by a job API

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Tag>WordsGeneralize</Tag>
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        <Code>Success</Code>

        <CreationTime>2022-07-25T16:35:39+0800</CreationTime>

        <EndTime>2022-07-25T16:35:43+0800</EndTime>

        <Input>

            <Object>text.txt</Object>

            <BucketId>test-123456789</BucketId>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>ac34be3aa0bf411ed9ce39d7cc972e427</JobId>

        <Message>Success</Message>

        <Operation>

            <UserData>This is my WordsGeneralize job.</UserData>

            <JobLevel>0</JobLevel>

            <WordsGeneralize>

                <NerMethod>DL</NerMethod>

                <SegMethod>MIX</SegMethod>

            </WordsGeneralize>

            <WordsGeneralizeResult>

                <WordsGeneralizeLable>

                    <Category>Transportation</Category>

                    <Word>Taxi</Word>

                </WordsGeneralizeLable>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>0</Offset>

                    <Pos>t</Pos>

                    <Word>Today</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>2</Offset>

                    <Pos>v</Pos>

                    <Word>Taxi</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>1</Length>

                    <Offset>4</Offset>

                    <Pos>v</Pos>

                    <Word>Cost</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>5</Offset>

                    <Pos>nx</Pos>

                    <Word>60</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1828
of 2300

                    <Length>1</Length>

                    <Offset>7</Offset>

                    <Pos>q</Pos>

                    <Word>CNY</Word>

                </WordsGeneralizeToken>

            </WordsGeneralizeResult>

        </Operation>

    </JobsDetail>

</Response>

Sample 2: Job callback in JSON format triggered by a job
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{

    "Response": {

        "EventName": "TaskFinish",

        "JobsDetail": {

            "Code": "Success",

            "CreationTime": "2022-07-25T16:35:39+0800",

            "EndTime": "2022-07-25T16:35:43+0800",

            "Input":{

                "Object": "text.txt",

                "BucketId": "test-123456789",

                "Region": "ap-chongqing"
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            },

            "JobId": "ac34be3aa0bf411ed9ce39d7cc972e427",

            "Message": "Success",

            "Operation": {

                "JobLevel": "0",

                "WordsGeneralize": {

                    "NerMethod": "DL",

                    "SegMethod": "MIX"

                },

                "WordsGeneralizeResult": {

                    "WordsGeneralizeLable": {

                        "Category": "Mobility",

                        "Word": "Taxi"

                    },

                    "WordsGeneralizeToken": [{

                            "Length": "2",

                            "Offset": "0",

                            "Pos": "t",

                            "Word": "Today"

                        },

                        {

                            "Length": "2",

                            "Offset": "2",

                            "Pos": "v",

                            "Word": "Taxi"

                        },

                        {

                            "Length": "1",

                            "Offset": "4",

                            "Pos": "v",

                            "Word": "Cost"

                        },

                        {

                            "Length": "2",

                            "Offset": "5",

                            "Pos": "nx",

                            "Word": "60"

                        },

                        {

                            "Length": "1",

                            "Offset": "7",

                            "Pos": "q",

                            "Word": "CNY"

                        }

                    ]

                }

            }
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        }

    }

}
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Template APIs
Media Processing
Creating Media Processing Template
Creating Animated Image Template
Last updated：2024-02-27 15:52:06

Feature Description

This API is used to create a video-to-animated image conversion template.

Request

Sample request
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POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>Animation</Tag>

    <Name>TemplateName</Name>

    <Container>

       <Format>gif</Format>

    </Container>

    <Video>

       <Codec>gif</Codec>

       <Width>1280</Width>

       <Height></Height>

       <Fps>15</Fps>

       <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

    </Video>

    <TimeInterval>

       <Start>0</Start>

       <Duration>60</Duration>

    </TimeInterval>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Template tag: Animation String Yes

Name Request Template name, which can contain letters, digits, 
underscores (_), hyphens (-), and asterisks (*).

String Yes

Container Request Container format Container Yes

Video Request Video information Container No

TimeInterval Request Time interval Container No

 Container  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required
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Format Request.Container Container format. Valid values:  gif ,  hgif  
(higher-definition GIF),  webp 

String Yes

 Video  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Default 
Value

Con

Codec Request.Video Codec format String Yes None gif, w

Width Request.Video Width String No
Original 
video 
width

Valu
Unit
If on
calc
origi

Height Request.Video Height String No
Original 
video 
height

Valu
Unit
If on
calc
origi

Fps Request.Video Frame rate String No

Original 
video 
frame 
rate

Valu
Unit
This
it is n
play
the o
para
rate 
play

AnimateOnly

KeepKeyFrame Request.Video

Keeps only key frames for 
animated images. If 
AnimateOnlyKeepKeyFrame 
is set to true, 
AnimateTimeIntervalOfFrame 
and 
AnimateFramesPerSecond 
don't need to be set. If 
AnimateOnlyKeepKeyFrame 
is set to false, either 
AnimateTimeIntervalOfFrame 
or AnimateFramesPerSecond 
must be set.

String No false

Valid
This
whe
fram
Prio
Anim
Anim
> 
Anim
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AnimateTime

IntervalOfFrame

Request.Video Frame sampling interval for 
animated images

String No None Valu
dura
Fram
anim
The 
mus
Time
Time

AnimateFrames

PerSecond Request.Video

Number of frames sampled 
per second for animated 
images

String No None

Valu
rate)
Fram
for a
Prio
Anim
Anim
> 
Anim

Quality Request.Video Relative quality String No None

Valu
This
effec
is no
imag

 TimeInterval  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value Constraints

Start Request.TimeInterval Start time String No 0

Value range: [0, 
video duration]
Unit: Second
The float format 
is supported, 
accurate to the 
millisecond.

Duration Request.TimeInterval Duration String No Video 
duration

Value range: [0, 
video duration]
Unit: Second
The float format 
is supported, 
accurate to the 
millisecond.



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1838
of 2300

Response

Response headers

This response contains common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1839
of 2300

<Response>

    <Template>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Tag>Animation</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransTpl>

            <Container>

                <Format>gif</Format>

            </Container>

            <Video>

                <Codec>gif</Codec>

                <Width>1280</Width>

                <Height></Height>

                <Fps>15</Fps>

                <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

            </Video>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

TemplateId Response Template ID String

Name Response Template name String

BucketId Response Template bucket String

Category Response
Template category:  Custom  or 
 Official .

String
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Tag Response Template tag String

UpdateTime Response Update time String

CreateTime Response Creation time String

TransTpl Response Template parameters Container

 Container  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Format Response.TransTpl.Container
Container format:  gif ,  hgif  (higher-
definition GIF),  webp .

String

 Video  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Codec Response.TransTpl.Video Codec String

Width Response.TransTpl.Video Width String

Height Response.TransTpl.Video Height String

Fps Response.TransTpl.Video Frame rate String

AnimateOnly

KeepKeyFrame

Response.TransTpl.Video Keeps only keyframes for animated images String

AnimateTime

IntervalOfFrame

Response.TransTpl.Video Frame sampling interval for animated images String

AnimateFrames

PerSecond

Response.TransTpl.Video Number of frames sampled per second for 
animated images

String

Quality Response.TransTpl.Video Relative quality String

 TimeInterval  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Start Response.TransTpl.TimeInterval Start time String
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Duration Response.TransTpl.TimeInterval Duration String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1842
of 2300

POST /template HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Animation</Tag>

    <Name>TemplateName</Name>

    <Container>

       <Format>gif</Format>

    </Container>

    <Video>

       <Codec>gif</Codec>

       <Width>1280</Width>

       <Height></Height>

       <Fps>15</Fps>

       <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

    </Video>

    <TimeInterval>

       <Start>0</Start>

       <Duration>60</Duration>

    </TimeInterval>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYz****=

<Response>

    <Template>

        <Name>TemplateName</Name>
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        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Tag>Animation</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransTpl>

            <Container>

                <Format>gif</Format>

            </Container>

            <Video>

                <Codec>gif</Codec>

                <Width>1280</Width>

                <Height></Height>

                <Fps>15</Fps>

                <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

            </Video>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Creating Splicing Template
Last updated：2024-02-27 15:52:06

Feature Description

This API is used to create a splicing template.

Request

Sample request
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POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

Common request headers

This API uses common request headers. For more information, see Common Request Headers.

Non-common request headers

This request operation does not use any non-common request headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>Concat</Tag>

    <Name>TemplateName</Name>

    <ConcatTemplate>

        <ConcatFragment>

            <Mode>Start</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4</Ur

        </ConcatFragment>

        <ConcatFragment>

            <Mode>End</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</Url>
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        </ConcatFragment>

        <Audio>

            <Codec>mp3</Codec>

            <Samplerate></Samplerate>

            <Bitrate></Bitrate>

            <Channels></Channels>

        </Audio>

        <Video>

            <Codec>H.264</Codec>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Height></Height>

            <Fps>30</Fps>

        </Video>

        <Container>

            <Format>mp4</Format>

        </Container>

        <AudioMix>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3</Au

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMix>

    </ConcatTemplate>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Template tag: Concat String Yes
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Name Request Template name, which can contain letters, digits, 
underscores (_), hyphens (-), and asterisks (*).

String Yes

ConcatTemplate Request Splicing template Container Yes

 ConcatTemplate  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Default 
Value

Constra

ConcatFragment Request.ConcatTemplate Splicing 
node

Container 
array

Yes None None

Audio Request.ConcatTemplate Audio 
parameter

Container No
Original 
media 
value

If the ta
does no
audio in
set 
 Audi

to  tru

Video Request.ConcatTemplate Video 
parameter

Container No
Original 
media 
value

If the ta
does no
video in
set 
 Vide

to  tru

Container Request.ConcatTemplate Container 
format

Container Yes None None

AudioMix Request.ConcatTemplate

Audio mix 
parameter 
as 
described 
in 
Structure.

Container 
array

No None
Valid o
 Audi

is  fal

DirectConcat Request.ConcatTemplate

Whether to 
splice 
without 
transcoding

String No false true/ fa

 ConcatFragment  has the following sub-nodes:

Node 
Name 

Parent Node Description Type Required Default 
Value

C

https://intl.cloud.tencent.com/document/product/1045/49945
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(Keyword)

Url Request.ConcatTemplate.ConcatFragment
Splicing 
object 
address

String Yes None

S
th
a
th
o

Mode Request.ConcatTemplate.ConcatFragment Node type String Yes None S
E

 Audio  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value Constrain

Codec Request.ConcatTemplate.Audio
Codec 
format String Yes

Original 
codec of 
the file

Valid 
values: 
aac, mp3

Samplerate Request.ConcatTemplate.Audio Sample 
rate

String No

Original 
sample 
rate of 
the file

Unit: Hz
Valid 
values: 
11025, 
22050, 
32000, 
44100, 
48000, 
96000.
Different 
container
formats 
support 
different 
MP3 
sample 
rates, as 
shown in 
the table 
below.

Bitrate Request.ConcatTemplate.Audio Audio 
bitrate

String No

Original 
audio 
bitrate of 
the file

Unit: Kbp
Value 
range: [8
1000]
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Channels Request.ConcatTemplate.Audio Number of 
sound 
channels

String No Original 
number 
of sound 
channels 
of the file

If Codec 
aac, the 
value can
be 1, 2, 4
5, 6, or 8
If Codec 
mp3, the 
value can
be 1 or 2

Y indicates supported, and N indicates unsupported.

Container Format/Audio Sample Rate 11025 22050 32000 44100 48000 96000

mp3 Y Y Y Y Y N

 Container  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Format Request.ConcatTemplate.Container Container format: mp4, flv, 
hls, ts, mp3, aac

String Yes

 Video  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value Constraints

Codec Request.ConcatTemplate.Video Codec 
format

String Yes H.264 H.264

Width Request.ConcatTemplate.Video Width String No Original 
video 
width

Value 
range: 
[128, 4096]
Unit: px
If only 
Width is 
set, Height 
is 
calculated 
based on 
the original 
video 
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aspect 
ratio.

Height Request.ConcatTemplate.Video Height String No
Original 
video 
height

Value 
range: 
[128, 4096]
Unit: px
If only 
Height is 
set, Width 
is 
calculated 
based on 
the original 
video 
aspect 
ratio.

Fps Request.ConcatTemplate.Video Frame rate String No

Original 
video 
frame 
rate

Value 
range: (0, 
60]
Unit: fps

Bitrate Request.ConcatTemplate.Video
Bitrate of 
the video 
output file

String No
Original 
video 
bitrate

Value 
range: [10, 
50000]
Unit: Kbps

Crf Request.ConcatTemplate.Video

Bitrate, 
which is a 
quality 
control 
factor

String No
Original 
video 
bitrate

Value 
range: (0, 
51]
If Crf is set, 
the setting 
of Bitrate 
becomes 
invalid.
If Bitrate is 
empty, 25 
is used for 
this 
parameter 
by default.

Remove Request.ConcatTemplate.Video Whether to 
delete the 

String No false Valid 
values: 
true, false.
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video 
stream

Rotate Request.Video
Rotation 
angle String No None

Value 
range: [0, 
360)
Unit: 
Degree

Response

Response headers

Common response headers

This response contains common response headers. For more information, see Common Response Headers.

Non-common response headers

This response does not use any non-common response header.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Tag>Concat</Tag>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4
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            </ConcatFragment>

            <ConcatFragment>

                <Mode>End</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</

            </ConcatFragment>

            <Audio>

                <Codec>mp3</Codec>

                <Samplerate></Samplerate>

                <Bitrate></Bitrate>

                <Channels></Channels>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height></Height>

                <Fps>30</Fps>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMix>

        </ConcatTemplate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:
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Node Name 
(Keyword)

Parent Node Description Type

TemplateId Response.Template Template ID String

Name Response.Template Template name String

BucketId Response.Template Template bucket String

Category Response.Template Template category: Custom or Official String

Tag Response.Template Template tag: Concat String

UpdateTime Response.Template Update time String

CreateTime Response.Template Creation time String

ConcatTemplate Response.Template
Same as the  Request.ConcatTemplate  in 
the request body.

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353
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POST /template HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

   <Tag>Concat</Tag>

   <Name>TemplateName</Name>

   <ConcatTemplate>

        <ConcatFragment>
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            <Mode>Start</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4</Ur

        </ConcatFragment>

        <ConcatFragment>

            <Mode>End</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</Url>

        </ConcatFragment>

        <Audio>

            <Codec>mp3</Codec>

            <Samplerate></Samplerate>

            <Bitrate></Bitrate>

            <Channels></Channels>

        </Audio>

        <Video>

            <Codec>H.264</Codec>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Height></Height>

            <Fps>30</Fps>

        </Video>

        <Container>

            <Format>mp4</Format>

        </Container>

        <AudioMix>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3</Au

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMix>

   </ConcatTemplate>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>
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        <Tag>Concat</Tag>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4

            </ConcatFragment>

            <ConcatFragment>

                <Mode>End</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</

            </ConcatFragment>

            <Audio>

                <Codec>mp3</Codec>

                <Samplerate></Samplerate>

                <Bitrate></Bitrate>

                <Channels></Channels>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height></Height>

                <Fps>30</Fps>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMix>

        </ConcatTemplate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1862
of 2300



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1863
of 2300

Creating Top Speed Codec Transcoding
Template
Last updated：2024-02-27 15:52:06

Feature Description

This API is used to create a top speed codec transcoding template.

Request

Sample request
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POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>HighSpeedHd</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Bufsize>0</Bufsize>

        <Maxrate>0</Maxrate>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required Constraints

Tag Request Template tag: HighSpeedHd String Yes None

Name Request Template name, which can contain String Yes None



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1867
of 2300

letters, digits, underscores (_), 
hyphens (-), and asterisks (*).

Container Request Container format Container Yes None

Video Request Video information Container Yes None

TimeInterval Request Time interval Container No None

Audio Request Audio information Container No None

TransConfig Request Transcoding configuration Container No None

 Container  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Format Request.Container
Container format. Valid values:  mp4 , 
 flv ,  hls .

String Yes

ClipConfig Request.Container
Segment configuration. This node will take 
effect only when  Format  is  hls . Container No

 ClipConfig  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Duration Request.Container.ClipConfig Segment duration. Default 
value: 5s

String No

Audio/Video formats supported by different container formats are as follows:

Container Audio Codecs Video Codecs

mp4/hls/mkv AAC, MP3 H.264, H.265

flv AAC, MP3 H.264

 Video  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value Constraints
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Codec Request.Video Codec 
format

String No H.264 H.264, H.265

Width Request.Video Width String No
Original 
video 
width

Value range: [128, 
4096]
Unit: px
If only Width is set, 
Height is calculated 
according to the 
original video aspect 
ratio.
This parameter must 
be an even number.

Height Request.Video Height String No
Original 
video 
height

Value range: [128, 
4096]
Unit: px
If only Height is set, 
Width is calculated 
according to the 
original video aspect 
ratio.
This parameter must 
be an even number.

Fps Request.Video Frame rate String No None Value range: (0, 60]
Unit: fps

Profile Request.Video
Encoding 
level String No high

Valid values: baseline, 
main, high.
 baseline: Suitable for 
mobile devices
main: Suitable for 
standard resolution 
devices
high: Suitable for high 
resolution devices
Only H.264 supports 
this parameter.

Bitrate Request.Video
Bitrate of 
the video 
output file

String No None
Value range: [10, 
50000]
Unit: Kbps

Crf Request.Video Bitrate, 
which is a 

String No None Value range: (0, 51]
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quality 
control 
factor

If Crf is set, the setting 
of Bitrate will become 
invalid.
If Bitrate is empty, 25 is 
used for this parameter 
by default.

Gop Request.Video

Maximum 
number of 
frames 
between two 
keyframes

String No None
Value range: [0, 
100000]

Preset Request.Video
Video 
algorithm 
preset

String No medium

Only H.264 supports 
this parameter.
Valid values: veryfast, 
fast, medium, slow, 
slower.

Bufsize Request.Video Buffer size String No None
Value range: [1000, 
128000]
Unit: Kb

Maxrate Request.Video
Peak video 
bitrate String No None

Value range: [10, 
50000]
Unit: Kbps

Pixfmt Request.Video
Video color 
format String No None

Valid values for H.264: 
yuv420p, auto.
Valid values for H.265: 
yuv420p, yuv420p10le, 
auto.

Rotate Request.Video Rotation 
angle

String No None Value range: [0, 360)
Unit: Degree

 TimeInterval  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value Constraints

Start Request.TimeInterval Start time String No None Value range: [0, 
video duration]
Unit: Second
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The float format is 
supported, 
accurate to the 
millisecond.

Duration Request.TimeInterval Duration String No None

Value range: [0, 
video duration]
Unit: Second
The float format is 
supported, 
accurate to the 
millisecond.

 Audio  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value Constraints

Codec Request.Audio
Codec 
format String No aac

Valid values: 
 aac ,  mp3 .

Samplerate Request.Audio
Sample 
rate String No 44100

1. Unit: Hz
2. Valid values: 
11025, 22050, 
32000, 44100, 
48000, 96000.
3. Different 
container formats 
support different 
MP3 sample rates, 
as shown in the 
table below.

Bitrate Request.Audio
Original 
audio 
bitrate

String No None
1. Unit: Kbps
2. Value range: [8, 
1000]

Channels Request.Audio
Number of 
sound 
channels

String No None

1. If Codec is aac, 
the value can be 1, 
2, 4, 5, 6, or 8.
2. If Codec is mp3, 
the value can be 1 
or 2.

Remove Request.Audio Whether to String No false Valid values: 
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delete the 
source 
audio 
stream

 true , 
 false .

Note: 

 Y indicates supported, and N indicates unsupported.

Container Format/Audio Sample Rate 11025 22050 32000 44100 48000 96000

flv N Y N Y N N

mp4 N Y Y Y Y N

hls/mkv Y Y Y Y Y N

 TransConfig  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required Default 
Value

Cons

AdjDarMethod Request.TransConfig
Resolution 
adjustment 
method

String No none

Valid
crop

If the
the o
diffe
the o
the r
adju
to th

IsCheckReso Request.TransConfig
Whether to 
check the 
resolution

String No false

Valid
false
If the
trans
perfo
setti

ResoAdjMethod Request.TransConfig Resolution 
adjustment 
method

String No 0 Valid
indic
origi
reso
indic
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the t
failur
This
take
when
is tru

IsCheckVideoBitrate Request.TransConfig
Whether to 
check the 
video bitrate

String No false

Valid
false
If the
trans
perfo
setti

VideoBitrateAdjMethod Request.TransConfig
Video bitrate 
adjustment 
method

String No 0

Valid
Whe
video
bitra
video
use t
video
indic
the t
failur
This
take
when
IsCh
is tru

IsCheckAudioBitrate Request.TransConfig
Whether to 
check the 
audio bitrate

String No false

Valid
false
If the
trans
perfo
setti

AudioBitrateAdjMethod Request.TransConfig Audio bitrate 
adjustment 
method

String No 0 Valid
Whe
audi
bitra
audi
use t
audi
indic
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the t
failur
This
take
when
IsCh
is tru

IsCheckVideoFps Request.TransConfig

Whether to 
check the 
video frame 
rate

String No false

Valid
false
If the
trans
perfo
setti

VideoFpsAdjMethod Request.TransConfig

Video frame 
rate 
adjustment 
method

String No 0

Valid
Whe
video
fram
inpu
indic
origi
rate,
to re
trans
mes
This
take
when
IsCh
true.

DeleteMetadata Request.TransConfig

Whether to 
delete 
metadata 
from the file

String No false

Valid
false
If the
the s
infor
retai

IsHdr2Sdr Request.TransConfig

Whether to 
enable HDR-
to-SDR 
conversion

String No false true/

HlsEncrypt Request.TransConfig HLS 
encryption 

Container No None None
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configuration

The  AdjDarMethod  parameter is illustrated as follows:

 HlsEncrypt  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Default 
Value

Constrain

IsHlsEncrypt Request.TransConfig.HlsEncrypt

Whether to 
enable 
HLS 
encryption

String No false

1. Valid v
true, false
2. Encryp
supporte
when 
Containe
is hls.
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UriKey Request.TransConfig.HlsEncrypt HLS 
encryption 
key

String No None This para
take effec
when 
 IsHlsE

is  true

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <Template>

        <Tag>HighSpeedHd</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <HighSpeedHd>

            <Container>

                <Format>mp4</Format>

            </Container>
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            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Bufsize>0</Bufsize>

                <Maxrate>0</Maxrate>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </HighSpeedHd>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

TemplateId Response.Template Template ID String

Name Response.Template Template name String

BucketId Response.Template Template bucket String

Category Response.Template Template category: Custom or Official String

Tag Response.Template Template tag: HighSpeedHd String
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UpdateTime Response.Template Update time String

CreateTime Response.Template Creation time String

HighSpeedHd Response.Template Template parameters Container

 HighSpeedHd  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

TimeInterval Response.Template.HighSpeedHd
Same as 
 Request.TimeInterval  in the 
request body.

Container

Container Response.Template.HighSpeedHd
Same as  Request.Container  in 
the request body.

Container

Video Response.Template.HighSpeedHd
Same as  Request.Video  in the 
request body.

Container

Audio Response.Template.HighSpeedHd
Same as  Request.Audio  in the 
request body.

Container

TransConfig Response.Template.HighSpeedHd
Same as  Request.TransConfig  
in the request body.

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353
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POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>HighSpeedHd</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>
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    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Bufsize>0</Bufsize>

        <Maxrate>0</Maxrate>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>HighSpeedHd</Tag>
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        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <HighSpeedHd>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Bufsize>0</Bufsize>

                <Maxrate>0</Maxrate>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </HighSpeedHd>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Creating Screenshot Template
Last updated：2024-02-27 15:52:06

Feature Description

This API is used to create a screenshot template.

Request

Sample request
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POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers. 

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>Snapshot</Tag>

    <Name>TemplateName</Name>

    <Snapshot>

        <Mode>Interval</Mode>

        <Width>1280</Width>

        <Height>960</Height>

        <Start>0</Start>

        <TimeInterval>0.5</TimeInterval>

        <Count>10</Count>

        <SnapshotOutMode>OnlySprite</SnapshotOutMode>

        <SpriteSnapshotConfig>

            <Color>Aquamarine</Color>

            <Columns>3</Columns>

            <Lines>3</Lines>

        </SpriteSnapshotConfig>

    </Snapshot>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Template tag: Snapshot String Yes

Name Request
Template name, which can contain letters, 
digits, underscores (_), hyphens (-), and 
asterisks (*).

String Yes

Snapshot Request Screenshot Container Yes

 Snapshot  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Default Value C

Mode Request.Snapshot Screenshot 
mode

String No Interval V
A
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In
A
m
K
m
In
S
C
va
T
a
ca
n
ca
C
A
S
p
in
to
a
S
vi

Start Request.Snapshot Start time String No 0

[0
U
S
fo
m

TimeInterval Request.Snapshot
Screenshot 
time interval String No None

(0
U
S
fo
m

Count Request.Snapshot Number of 
screenshots

String Yes None (0

Width Request.Snapshot Width String No
Original video 
width

V
4
U
If 
H
b
vi
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Height Request.Snapshot Height String No Original video 
height

V
4
U
If 
W
b
vi

CIParam Request.Snapshot
Screenshot 
processing 
parameter

String No None
S
E
im

IsCheckCount Request.Snapshot

Whether to 
force check 
the number 
of 
screenshots

String No false

W
in
ta
vi
to
sc
av
sw
C

IsCheckBlack Request.Snapshot

Whether to 
enable black 
screen 
check

String No false tr

BlackLevel Request.Snapshot

Screenshot 
black screen 
check 
parameter

String No None

V
Is
V
in
of
sm
sm
b
If 
p
a
no
If 
p
fr
st
b

PixelBlackThreshold Request.Snapshot Screenshot String No None V
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black screen 
check 
parameter

Is
T
d
p
ra

SnapshotOutMode Request.Snapshot
Screenshot 
output mode 
parameter

String No OnlySnapshot

V
O
O
S
O
sc
O
im
S
O
a

SpriteSnapshotConfig Request.Snapshot
Image sprite 
output 
configuration

Container No None N

 Snapshot.SpriteSnapshotConfig  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value

CellWidth Request.Snapshot.SpriteSnapshotConfig Subimage 
width

String No Screenshot 
width

CellHeight Request.Snapshot.SpriteSnapshotConfig Subimage 
height

String No Screenshot 
height

Padding Request.Snapshot.SpriteSnapshotConfig

Image 
sprite 
padding 
size

String No 0

Margin Request.Snapshot.SpriteSnapshotConfig Image 
sprite 
margin size

String No 0
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Color Request.Snapshot.SpriteSnapshotConfig Background 
color

String Yes None

Columns Request.Snapshot.SpriteSnapshotConfig

Number of 
columns in 
the image 
sprite

String Yes 0

Lines Request.Snapshot.SpriteSnapshotConfig

Number of 
rows in the 
image 
sprite

String Yes 0

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <Template>

        <Tag>Snapshot</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Snapshot>

            <Mode>Interval</Mode>

            <Width>1280</Width>

            <Height>960</Height>
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            <Start>0</Start>

            <TimeInterval>0.5</TimeInterval>

            <Count>10</Count>

            <SnapshotOutMode>OnlySprite</SnapshotOutMode>

            <SpriteSnapshotConfig>

                <Color>Aquamarine</Color>

                <Columns>3</Columns>

                <Lines>3</Lines>

            </SpriteSnapshotConfig>

        </Snapshot>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

Tag Response Template tag: Snapshot String

Name Response Template name String

TemplateId Response Template ID String

UpdateTime Response Update time String

CreateTime Response Creation time String

Snapshot Response
Template parameter, which is the same as the  Snapshot  
in the request body.

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353
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POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Snapshot</Tag>

    <Name>TemplateName</Name>

    <Snapshot>

        <Mode>Interval</Mode>
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        <Width>1280</Width>

        <Height>960</Height>

        <Start>0</Start>

        <TimeInterval>0.5</TimeInterval>

        <Count>10</Count>

        <SnapshotOutMode>OnlySprite</SnapshotOutMode>

        <SpriteSnapshotConfig>

            <Color>Aquamarine</Color>

            <Columns>3</Columns>

            <Lines>3</Lines>

        </SpriteSnapshotConfig>

    </Snapshot>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <Template>

        <Tag>Snapshot</Tag>
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        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Snapshot>

            <Mode>Interval</Mode>

            <Width>1280</Width>

            <Height>960</Height>

            <Start>0</Start>

            <TimeInterval>0.5</TimeInterval>

            <Count>10</Count>

            <SnapshotOutMode>OnlySprite</SnapshotOutMode>

            <SpriteSnapshotConfig>

                <Color>Aquamarine</Color>

                <Columns>3</Columns>

                <Lines>3</Lines>

            </SpriteSnapshotConfig>

        </Snapshot>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Creating Super Resolution Template
Last updated：2024-02-27 15:52:06

Feature Description

This API is used to create a super resolution template.

Request

Sample request
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POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>SuperResolution</Tag>

    <Name>TemplateName</Name>

    <Resolution>sdtohd</Resolution>

    <EnableScaleUp>true</EnableScaleUp>

    <Version>Enhance</Version>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required Constraints

Tag Request Template tag: 
SuperResolution

String Yes None

Name Request

Template name, 
which can contain 
letters, digits, 
underscores (_), 
hyphens (-), and 
asterisks (*).

String Yes None

Resolution Request Resolution option String Yes 1. sdtohd: SD to HD
2. hdto4k: HD to 4K

EnableScaleUp Request

Whether to enable 
automatic scaling, 
which is disabled by 
default.

String No true/false

Version Request
Version. Default value: 
Base. String No

1. Base: Basic version
2. Enhance: Enhanced 
version

Response
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Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

<Response>

    <Template>

        <Tag>SuperResolution</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

https://intl.cloud.tencent.com/document/product/1045/43610
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        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SuperResolution>

            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>

        </SuperResolution>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

TemplateId Response.Template Template ID String

Name Response.Template Template name String

BucketId Response.Template Template bucket String

Category Response.Template Template category: Custom or Official String

Tag Response.Template Template tag: SuperResolution String

UpdateTime Response.Template Update time String

CreateTime Response.Template Creation time String

SuperResolution Response.Template Template parameters Container

 SuperResolution  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Resolution Response.Template.SuperResolution
Same as  Request.Resolution  
in the request body.

String

EnableScaleUp Response.Template.SuperResolution Same as String
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 Request.EnableScaleUp  in the 
request body.

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353
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POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SuperResolution</Tag>

    <Name>TemplateName</Name>

    <Resolution>sdtohd</Resolution>

    <EnableScaleUp>true</EnableScaleUp>
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    <Version>Enhance</Version>

</Request>

Response

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci
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x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>SuperResolution</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SuperResolution>

            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>

        </SuperResolution>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Creating Audio/Video Transcoding Template
Last updated：2024-02-27 15:52:05

Overview

This API is used to create an audio/Video transcoding template.

Request

Sample request
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POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (See Request Signature for details.)
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>Transcode</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Preset>medium</Preset>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</Audio

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</Audio

        <MixMode>Once</MixMode>

        <Replace>true</Replace>
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        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required Constraints

Tag Request Task type: 
Transcode

String Yes None

Name Request

Template name, 
which can contain 
letters, digits, 
underscores (_), 
hyphens (-), and 
asterisks (*).

String Yes None

Container Request Container format Container Yes None

Video Request Video information Container No
If  Video  is not passed 
in, the video information 
will be deleted.

TimeInterval Request Time interval Container No None

Audio Request Audio information Container No
If  Audio  is not passed 
in, the audio information 
will be deleted.

TransConfig Request Transcoding Container No None
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configuration

AudioMix Request
Audio mix parameter 
as described in 
Structure.

Container No
Valid if 
 Audio.Remove  is 
 false 

AudioMixArray Request

Up to two audio mix 
parameters as 
described in 
Structure.

Container 
array

No
Valid if 
 Audio.Remove  is 
 false 

 Container  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Format Request.Container Container format. See the following table 
for valid values.

String Yes

ClipConfig Request.Container
Segment configuration. This node will take 
effect only when  format  is  hls  or 
 dash .

Container No

 ClipConfig  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Duration Request.Container.ClipConfig
Segment duration. Default 
value:  5s . String No

Audio/Video formats supported by different container formats are as follows:

Container Audio Codecs Video Codecs

mp4/hls/mkv aac, mp3 H.264, H.265, AV1

hls/mkv aac, mp3 H.264, H.265

ts/flv/avi/mov aac, mp3 H.264

dash aac H.264

WebM Vorbis, Opus VP8, VP9, AV1

AAC AAC Not supported

https://intl.cloud.tencent.com/document/product/1045/49945
https://intl.cloud.tencent.com/document/product/1045/49945Array
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MP3 MP3 Not supported

FLAC FLAC Not supported

AMR AMR Not supported

adts aac Not supported

m4a aac Not supported

wav pcm_s16le Not supported

 Video  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Default 
Value

Constraints

Codec Request.Video
Codec 
format String No

H.264
If format 
is WebM, 
the 
default 
value is 
VP8.

H.264
H.265
VP8
VP9
AV1

Width Request.Video Width String No
Original 
video 
width

Value range: 
[128, 4096]
Unit: px
If only Width is 
set, Height is 
calculated 
according to the 
original video 
aspect ratio.
This parameter 
must be an even 
number.

Height Request.Video Height String No Original 
video 
height

Value range: 
[128, 4096]
Unit: px
If only Height is 
set, Width is 
calculated 
according to the 
original video 
aspect ratio.
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This parameter 
must be an even 
number.

Fps Request.Video Frame rate String No None
Value range: (0, 
60]
Unit: fps

Remove Request.Video

Whether to 
delete the 
video 
stream

String No false Valid values: 
true, false.

Profile Request.Video
Encoding 
level String No high

Valid values: 
baseline, main, 
high, auto.
If Pixfmt is auto, 
this parameter 
can only be auto 
and will be 
changed to auto 
if set to other 
values.
baseline: 
Suitable for 
mobile devices.
main: Suitable 
for standard 
resolution 
devices.
high: Suitable for 
high resolution 
devices.
Only H.264 
supports this 
parameter.

Bitrate Request.Video
Bitrate of 
the video 
output file

String No None

Value range: [10, 
50000] kbps
auto indicates 
adaptive bitrate.

Crf Request.Video Bitrate, 
which is a 
quality 

String No None Value range: (0, 
51]
If Crf is set, the 
setting of Bitrate 
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control 
factor

will become 
invalid.
If Bitrate is 
empty, 25 is 
used for this 
parameter by 
default.

Gop Request.Video

Maximum 
number of 
frames 
between 
two 
keyframes

String No None Value range: [1, 
100000]

Preset Request.Video
Video 
algorithm 
preset

String No

If Codec 
is H.264, 
the 
default 
value is 
medium.
If Codec 
is VP8, 
the 
default 
value is 
good.
If Codec 
is AV1, 
the 
default 
value is 
5.

Valid values for 
H.264: veryfast, 
fast, medium, 
slow, slower.
Valid values for 
VP8: good, 
realtime.
Valid values for 
AV1: 5 
(recommend), 4.
H.265 and VP9 
don't support this 
parameter.

Bufsize Request.Video Buffer size String No None

Value range: 
[1000, 128000]
Unit: KB
If Codec is VP8 
or VP9, this 
parameter is not 
supported.

Maxrate Request.Video Peak video 
bitrate

String No None Value range: [10, 
50000]
Unit: Kbps



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1916
of 2300

If Codec is VP8 
or VP9, this 
parameter is not 
supported.

Pixfmt Request.Video
Video color 
format String No None

Valid values for 
H.264: yuv420p, 
yuv422p, 
yuv444p, 
yuvj420p, 
yuvj422p, 
yuvj444p, auto
Valid values for 
H.265: yuv420p, 
yuv420p10le, 
auto
If Codec is VP8, 
VP9, or AV1, this 
parameter is not 
supported.

LongShortMode Request.Video
Whether to 
use long 
short mode

String No false

Valid values: 
true, false.
If Codec is VP8, 
VP9, or AV1, this 
parameter is not 
supported.

Rotate Request.Video
Rotation 
angle String No None

Value range: [0, 
360)
Unit: Degree

 TimeInterval  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value Constraints

Start Request.TimeInterval Start time String No 0 Value range: 
[0, video 
duration]
Unit: Second
The float 
format is 
supported, 
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accurate to the 
millisecond.

Duration Request.TimeInterval Duration String No
Original 
video 
duration

Value range: 
[0, video 
duration]
Unit: Second
The float 
format is 
supported, 
accurate to the 
millisecond.

 Audio  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Default 
Value

Constraints

Codec Request.Audio
Codec 
format String No

aac
If format is 
WebM, the 
default 
value is 
Vorbis.
If format is 
wav, the 
default 
value is 
pcm_s16le.

Valid values: 
aac, mp3, flac, 
amr, Vorbis, 
opus, 
pcm_s16le.

Samplerate Request.Audio Sample 
rate

String No If Codec is 
opus, the 
default 
value is 
48000.

Unit: Hz
Valid values: 
8000, 11025, 
12000, 16000, 
22050, 24000, 
32000, 44100, 
48000, 88200, 
96000.
Different 
container 
formats 
support 
different MP3 
sample rates, 
as shown in 
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the table 
below.
If Codec is 
amr, the value 
can only be 
8000.
If Codec is 
opus, the value 
can be 8000, 
16000, 24000, 
or 48000.

Bitrate Request.Audio
Original 
audio 
bitrate

String No None
Unit: Kbps
Value range: 
[8, 1000]

Channels Request.Audio
Number of 
sound 
channels

String No None

If Codec is aac 
or flac, the 
value can be 1, 
2, 4, 5, 6, or 8.
If Codec is 
mp3 or opus, 
the value can 
only be 1 or 2.
If Codec is 
Vorbis, the 
value can only 
be 2.
If Codec is 
amr, the value 
can only be 1.
If Codec is 
pcm_s16le, 
the value can 
only be 1 or 2.
If Codec is 
dash, the value 
cannot be 8.

Remove Request.Audio

Whether to 
delete the 
source 
audio 
stream

String No false
Valid values: 
true, false.

KeepTwoTracks Request.Audio Keep String No false Valid values: 



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1919
of 2300

double 
audio track

true, false. If 
Video.Codec is 
H.265, this 
parameter will 
not take effect.

SwitchTrack Request.Audio Switch the 
track

String No false

Valid values: 
true, false. If 
Video.Codec is 
H.265, this 
parameter will 
not take effect.

SampleFormat Request.Audio
Sampling 
bit width String No None

If Codec is 
aac, the value 
can be fltp.
If Codec is 
mp3, the value 
can be fltp, 
s16p, or s32p.
If Codec is 
flac, the value 
can be s16, 
s32, s16p, or 
s32p.
If Codec is 
amr, the value 
can be s16 or 
s16p.
If Codec is 
opus, the value 
can be s16.
If Codec is 
pcm_s16le, 
the value can 
be s16.
If Codec is 
Vorbis, the 
value can be 
fltp.
If Video.Codec 
is H.265, this 
parameter will 
not take effect.



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1920
of 2300

Note: 
 Y indicates supported, and N indicates unsupported.
 Audio.Codec  supports sample rates as follows:

Audio.Codec      aac      amr      flac      opus      Vorbis      pcm_s16le      mp3   

8000 Y Y Y Y Y Y

Different sample rates are 
supported for different container 
formats.

11025 Y N Y N Y Y

12000 Y N Y N Y Y

16000 Y N Y Y Y Y

22050 Y N Y N Y Y

24000 Y N Y Y Y Y

32,000 Y N Y N Y Y

44100 Y N Y N Y Y

48000 Y N Y Y Y Y

88200 Y N Y N Y Y

96000 Y N Y N Y Y

If  Audio.Codec  is  mp3 ,  Container.Format  supports sample rates as follows:

Container 
Format/Audio Sample 
Rate

8000 11025 12000 16000 22050 24000 32000 44100 4

flv N N N N Y N N Y N

mp4 N N N Y Y Y Y Y Y

hls/ts/mp3/mkv/avi/mov Y Y Y Y Y Y Y Y Y

 TransConfig  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type R

AdjDarMethod Request.TransConfig Resolution adjustment method String N
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IsCheckReso Request.TransConfig Whether to check the resolution String N

ResoAdjMethod Request.TransConfig Resolution adjustment method String N

IsCheckVideoBitrate Request.TransConfig Whether to check the video bitrate String N

VideoBitrateAdjMethod Request.TransConfig Video bitrate adjustment method String N
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IsCheckAudioBitrate Request.TransConfig Whether to check the audio bitrate String N

AudioBitrateAdjMethod Request.TransConfig Audio bitrate adjustment method String N

IsCheckVideoFps Request.TransConfig Whether to check the video frame rate String N

VideoFpsAdjMethod Request.TransConfig Video frame rate adjustment method String N
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DeleteMetadata Request.TransConfig Whether to delete metadata from the file String N

IsHdr2Sdr Request.TransConfig Whether to enable HDR-to-SDR 
conversion

String N

TranscodeIndex Request.TransConfig

The stream number to be processed, 
which corresponds to 
Response.MediaInfo.Stream.Video.Index 
and 
Response.MediaInfo.Stream.Audio.Index 
in the media information. For more 
information, see Getting Media File 
Information.

String N

HlsEncrypt Request.TransConfig HLS encryption configuration Container N

DashEncrypt Request.TransConfig DASH encryption configuration Container N

The  AdjDarMethod  parameter is illustrated as follows:

https://intl.cloud.tencent.com/document/product/1045/49541
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 HlsEncrypt  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Default 
Value

Constrain

IsHlsEncrypt Request.TransConfig.HlsEncrypt

Whether to 
enable 
HLS 
encryption

String No false

Valid valu
 false 

Encryptio
only whe
 Contai

is  hls 

UriKey Request.TransConfig.HlsEncrypt
HLS 
encryption 
key

String No None

This para
effect onl
 IsHlsE

true.

 DashEncrypt  has the following sub-nodes:
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Node 
Name 
(Keyword)

Parent Node Description Type Required Default 
Value

Constrain

IsEncrypt Request.TransConfig.DashEncrypt

Whether to 
enable 
DASH 
encryption

String No false

Valid valu
 false 

Encryptio
only when
 Contai

is  dash 

UriKey Request.TransConfig.DashEncrypt
DASH 
encryption 
key

String No None

This para
effect only
 IsEncr

 true .

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <Template>

        <Tag>Transcode</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Container>

            <Format>mp4</Format>

        </Container>

        <Video>
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            <Codec>H.264</Codec>

            <Profile>high</Profile>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Fps>30</Fps>

            <Preset>medium</Preset>

        </Video>

        <Audio>

            <Codec>aac</Codec>

            <Samplerate>44100</Samplerate>

            <Bitrate>128</Bitrate>

            <Channels>4</Channels>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>
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        </AudioMixArray>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

TemplateId Response.Template Template ID String

Name Response.Template Template name String

BucketId Response.Template Template bucket String

Category Response.Template
Template category:  Custom  or 
 Official 

String

Tag Response.Template Task type: Transcode String

UpdateTime Response.Template Update time String

CreateTime Response.Template Creation time String

TransTpl Response.Template Template parameters Container

 TransTpl  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

TimeInterval Response.Template.TransTpl
Same as  Request.TimeInterval  in 
the request body.

Container

Container Response.Template.TransTpl
Same as  Request.Container  in the 
request body.

Container

Video Response.Template.TransTpl
Same as  Request.Video  in the 
request body.

Container



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1929
of 2300

Audio Response.Template.TransTpl Same as  Request.Audio  in the 
request body.

Container

TransConfig Response.Template.TransTpl
Same as  Request.TransConfig  in 
the request body.

Container

AudioMix Response.Template.TransTpl
Same as  Request.AudioMix  in the 
request body.

Container

AudioMixArray Response.Template.TransTpl
Same as  Request.AudioMixArray  
in the request body.

Container 
array

Error codes

No special error message will be returned for this request. For the common error messages, please see Error Codes.

Examples

Request

https://intl.cloud.tencent.com/document/product/1045/33700
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POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>
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    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Preset>medium</Preset>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</Audio

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</Audio

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>
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            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

</Request>

Response

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive
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Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>Transcode</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Container>

            <Format>mp4</Format>

        </Container>

        <Video>

            <Codec>H.264</Codec>

            <Profile>high</Profile>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Fps>30</Fps>

            <Preset>medium</Preset>

        </Video>

        <Audio>

            <Codec>aac</Codec>

            <Samplerate>44100</Samplerate>

            <Bitrate>128</Bitrate>

            <Channels>4</Channels>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>
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                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Creating Professional Transcoding Template
Last updated：2024-02-27 15:52:06

Feature Description

This API is used to create a professional transcoding template.

Request

Sample request
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POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>TranscodePro</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mxf</Format>

    </Container>

    <Video>

        <Codec>xavc</Codec>

        <Profile>XAVC-HD_422_10bit</Profile>

        <Width>1920</Width>

        <Height>1080</Height>

        <Interlaced>true</Interlaced>

        <Fps>30000/1001</Fps>

        <Bitrate>50000</Bitrate>

    </Video>

    <Audio>

        <Codec>pcm_s24le</Codec>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required Constraints

Tag Request Template tag: TranscodePro String Yes None

Name Request Template name, which can 
contain letters, digits, 

String Yes None
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underscores (_), hyphens (-), 
and asterisks (*).

Container Request Container format Container Yes None

Video Request Video information Container Yes None

TimeInterval Request Time interval Container No None

Audio Request Audio information Container No

If  Audio  is not 
passed in, the 
audio information 
will be deleted.

TransConfig Request Transcoding configuration Container No None

 Container  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Format Request.Container
Container format. Valid values:  mxf , 
 mov ,  mkv .

String Yes

Audio/Video formats supported by different container formats are as follows:

Container Audio Codecs Video Codecs

mxf pcm_s24le xavc

mov, mkv aac, mp3 apple_prores

 Video  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value Constraints

Codec Request.Video Codec 
format

String Yes None xavc, apple_prores

Profile Request.Video
Video 
algorithm 
profile

String Yes None
See the following table for 
valid values.

Width Request.Video Width String Yes None See the following table for 
valid values.



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1940
of 2300

Height Request.Video Height String Yes None See the following table for 
valid values.

Interlaced Request.Video Field mode String Yes None See the following table for 
valid values.

Fps Request.Video Frame rate String Yes None See the following table for 
valid values.

Bitrate Request.Video
Bitrate of 
the video 
output file

String No None
See the following table for 
valid values.

Rotate Request.Video Rotation 
angle

String No None 1. Value range: [0, 360)
2. Unit: Degree

Video Parameter Constraint Table:
Note: '-' indicates empty. The valid values of bitrate correspond to the valid values of frame rate numerically.
If  Video.Codec  is  xavc :

Profile Width Height Interlaced Fps Bitrate (Kbps)

XAVC-
HD_intra_420_10bit_class50

1440 1080 true 1. 25
2. 30000/1001

-

XAVC-
HD_intra_420_10bit_class50 1440 1080 false

1. 25
2. 24000/1001
3. 30000/1001

-

XAVC-
HD_intra_422_10bit_class100

1280 720 false 1. 50
2. 60000/1001

-

XAVC-
HD_intra_422_10bit_class100

1920 1080 true 1. 25
2. 30000/1001

-

XAVC-
HD_intra_422_10bit_class100

1920 1080 false

1. 1.25
2. 2. 50
3. 3. 
24000/1001
4. 4. 
30000/1001
5. 5. 
60000/1001

-

XAVC-
HD_intra_422_10bit_class200

1920 1080 true 1. 25
2. 30000/1001

-
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XAVC-
HD_intra_422_10bit_class200 1920 1080 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

-

XAVC-
4K_intra_422_10bit_class100 2048 1080 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

-

XAVC-
4K_intra_422_10bit_class300 3840 2160 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

-

XAVC-
4K_intra_422_10bit_class300 4096 2160 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

-

XAVC-
4K_intra_422_10bit_class480 3840 2160 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

-

XAVC-
4K_intra_422_10bit_class480 4096 2160 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

-

XAVC-4K_intra_422_10bit 2048 1080 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

1. 93000

2. 185000

3. 89000

4. 111000

5. 222000

XAVC-4K_intra_422_10bit 3840 2160 false 1. 25

2. 50

3. 24000/1001


1. 250000 or 
400000

2. 500000 or 
800000
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4. 30000/1001

5. 60000/1001

3. 240000 or 
384000

4. 300000 or 
480000

5. 600000 or 
960000

XAVC-4K_intra_422_10bit 4096 2160 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

1. 250000 or 
400000

2. 500000 or 
800000

3. 240000 or 
384000

4. 300000 or 
480000

5. 600000 or 
960000

XAVC-HD_422_10bit 1280 720 false 1. 50

2. 60000/1001

1. 50000

2. 50000

XAVC-HD_422_10bit 1920 1080 true 1. 25

2. 30000/1001

1. 25000, 35000, or 
50000

2. 25000, 35000, or 
50000

XAVC-HD_422_10bit 1920 1080 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

1. 25000, 35000, or 
50000

2. 35000 or 50000

3. 25000, 35000, or 
50000

4. 25000, 35000, or 
50000

5. 35000 or 50000

XAVC-4K_422_10bit 3840 2160 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

1. 100000, 140000, 
or 200000

2. 140000 or 
200000

3. 100000, 140000, 
or 200000

4. 100000, 140000, 
or 200000

5. 140000 or 
200000
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XAVC-4K_420_8bit 3840 2160 false 1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

1. 188000

2. 300000

3. 188000

4. 188000

5. 300000

If  Video.Codec  is  apple_prores :

Profile

1.ProRes_422_Proxy

2.ProRes_422_LT

3.ProRes_422

4.ProRes_422_HQ

5.ProRes_4444

6.ProRes_4444_XQ

7.ProRes_4444_alpha

8.ProRes_4444_XQ_alpha

Width Height Interlaced Fps Bitrate (Kbps)

720 486 false 1. 24000/1001

2. 30000/1001

Value range: [2000,3000000]

720 486 true 1. 60000/1001 Value range: [2000,3000000]

720 576 false 1. 25 Value range: [2000,3000000]

720 576 true 1. 50 Value range: [2000,3000000]

960 720 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

Value range: [2000,3000000]

1280 720 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

Value range: [2000,3000000]

1280 1080 false 1. 24000/1001

2. 30000/1001

Value range: [2000,3000000]
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1280 1080 true 1. 60000/1001 Value range: [2000,3000000]

1440 1080 false
1. 24000/1001

2. 25

3. 30000/1001

Value range: [2000,3000000]

1440 1080 true 1. 50

2. 60000/1001

Value range: [2000,3000000]

1920 1080 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

Value range: [2000,3000000]

1920 1080 true 1. 50

2. 60000/1001

Value range: [2000,3000000]

2048 1080 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

Value range: [2000,3000000]

2048 1556 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

Value range: [2000,3000000]

3840 2160 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

Value range: [2000,3000000]

4096 2160 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

Value range: [2000,3000000]

5120 2700 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

Value range: [2000,3000000]
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6144 3240 false 1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

Value range: [2000,3000000]

8192 4320 false

1. 25

2. 50

3. 24000/1001

4. 30000/1001

5. 60000/1001

Value range: [2000,3000000]

 TimeInterval  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value Constraints

Start Request.TimeInterval Start time String No 0

Value range: [0, 
video duration]
Unit: Second
The float format 
is supported, 
accurate to the 
millisecond.

Duration Request.TimeInterval Duration String No
Original 
video 
duration

Value range: [0, 
video duration]
Unit: Second
The float format 
is supported, 
accurate to the 
millisecond.

 Audio  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value Constraints

Codec Request.Audio Codec 
format

String Yes None pcm_s24le, aac, 
mp3

Remove Request.Audio Whether to 
delete the 

String No false Valid values: 
 true , 
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source 
audio 
stream

 false .

 TransConfig  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required Default 
Value

Constraint

AdjDarMethod Request.TransConfig
Resolution 
adjustment 
method

String No none

Valid valu
crop, pad,
If the aspe
the output
different fr
the origina
the resolu
adjusted a
to this par

IsCheckReso Request.TransConfig
Whether to 
check the 
resolution

String No false

Valid valu
false.
If the valu
transcodin
performed
settings.

ResoAdjMethod Request.TransConfig
Resolution 
adjustment 
method

String No 0

Valid valu
indicates t
original vid
resolution
indicates t
the transc
failure me
This param
take effect
when IsCh
is true.

IsCheckVideoBitrate Request.TransConfig

Whether to 
check the 
video 
bitrate

String No false

Valid valu
false.
If the valu
transcodin
performed
settings.

VideoBitrateAdjMethod Request.TransConfig Video String No 0 Valid valu
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bitrate 
adjustment 
method

When the 
video has 
bitrate tha
video, 0 in
use the or
video bitra
indicates t
the transc
failure me
This param
take effect
when 
IsCheckV
is true.

IsCheckAudioBitrate Request.TransConfig

Whether to 
check the 
audio 
bitrate

String No false

Valid valu
false.
If the valu
transcodin
performed
settings.

AudioBitrateAdjMethod Request.TransConfig

Audio 
bitrate 
adjustment 
method

String No 0

Valid valu
When the 
audio has
bitrate tha
audio, 0 in
use the or
audio bitra
indicates t
the transc
failure me
This param
take effect
when 
IsCheckA
is true.

IsCheckVideoFps Request.TransConfig

Whether to 
check the 
video 
frame rate

String No false

Valid valu
false.
If the valu
transcodin
performed
settings.

VideoFpsAdjMethod Request.TransConfig Video String No 0 Valid valu
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frame rate 
adjustment 
method

When the 
video has 
frame rate
input vide
indicates t
original vid
rate, and 1
to return th
transcodin
message.
This param
take effect
when 
IsCheckV
true.

DeleteMetadata Request.TransConfig

Whether to 
delete 
metadata 
from the 
file

String No false

Valid valu
false.
If the valu
the source
informatio
retained.

IsHdr2Sdr Request.TransConfig

Whether to 
enable 
HDR-to-
SDR 
conversion

String No false true/false

The  AdjDarMethod  parameter is illustrated as follows:
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Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <Template>

        <Tag>TranscodePro</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransProTpl>

            <Container>

                <Format>mxf</Format>

            </Container>
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            <Video>

                <Codec>xavc</Codec>

                <Profile>XAVC-HD_422_10bit</Profile>

                <Width>1920</Width>

                <Height>1080</Height>

                <Interlaced>true</Interlaced>

                <Fps>30000/1001</Fps>

                <Bitrate>50000</Bitrate>

            </Video>

            <Audio>

                <Codec>pcm_s24le</Codec>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransProTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

TemplateId Response.Template Template ID String

Name Response.Template Template name String

BucketId Response.Template Template bucket String

Category Response.Template Template category: Custom or Official String

Tag Response.Template Template tag: TranscodePro String

UpdateTime Response.Template Update time String
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CreateTime Response.Template Creation time String

TransProTpl Response.Template Template parameters Container

 TransProTpl  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

TimeInterval Response.Template.TransProTpl
Same as  Request.TimeInterval  
in the request body.

Container

Container Response.Template.TransProTpl
Same as  Request.Container  in 
the request body.

Container

Video Response.Template.TransProTpl
Same as  Request.Video  in the 
request body.

Container

Audio Response.Template.TransProTpl
Same as  Request.Audio  in the 
request body.

Container

TransConfig Response.Template.TransProTpl
Same as  Request.TransConfig  
in the request body.

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353
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POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>TranscodePro</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mxf</Format>
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    </Container>

    <Video>

        <Codec>xavc</Codec>

        <Profile>XAVC-HD_422_10bit</Profile>

        <Width>1920</Width>

        <Height>1080</Height>

        <Interlaced>true</Interlaced>

        <Fps>30000/1001</Fps>

        <Bitrate>50000</Bitrate>

    </Video>

    <Audio>

        <Codec>pcm_s24le</Codec>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>TranscodePro</Tag>
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        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransProTpl>

            <Container>

                <Format>mxf</Format>

            </Container>

            <Video>

                <Codec>xavc</Codec>

                <Profile>XAVC-HD_422_10bit</Profile>

                <Width>1920</Width>

                <Height>1080</Height>

                <Interlaced>true</Interlaced>

                <Fps>30000/1001</Fps>

                <Bitrate>50000</Bitrate>

            </Video>

            <Audio>

                <Codec>pcm_s24le</Codec>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransProTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Creating Text-to-Speech Template
Last updated：2024-02-27 15:52:06

Feature Description

This API is used to create a text-to-speech template.

Request

Sample request
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POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 1960
of 2300

<Request>

    <Tag>Tts</Tag>

    <Name>TemplateName</Name>

    <Mode>Sync</Mode>

    <Codec>pcm</Codec>

    <VoiceType>ruxue</VoiceType>

    <Volume>2</Volume>

    <Speed>200</Speed>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required Constraints

Tag Request Template tag: Tts String Yes Tts

Name Request

Template name, which 
can contain letters, digits, 
underscores (_), hyphens 
(-), and asterisks (*).

String Yes None

Mode Request
Processing mode, which 
is  Asyc  by default. String No

 Asyc  (async 
synthesis);  Sync  
(sync synthesis).
When  Asyc  is 
selected, the codec can 
only be  pcm .

Codec Request
Audio format, which is 
 wav  (sync) or  pcm  
(async) by default.

String No  wav ,  mp3 ,  pcm 

VoiceType Request
Voice, which is  ruxue  
by default.

String No See the table below

Volume Request
Volume, which is  0  by 
default.

String No [-10,10]
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Speed Request Speech rate, which is 
 100  by default.

String No [50,200]

Supported voices

Name Voice Parameter Value Async Synthesis Sync Synthesis

Ruxue ruxue Supported Supported

Aixiaonan aixiaonan Not supported Supported

Aixiaoxing aixiaoxing Supported Supported

Aixiaocheng aixiaocheng Supported Supported

Aixiaoxue aixiaoxue Supported Supported

Aixiaolu aixiaolu Supported Supported

Aixiaodong aixiaodong Supported Supported

Aixiaoliao aixiaoliao Not supported Supported

Aixiaoqian aixiaoqian Supported Supported

Aixiaoyang aixiaoyang Supported Supported

Alice alice Supported Supported

Voice description

Name
Voice 
Parameter 
Value

Type Use Case
Supported 
Languages

Voice 
Quality

Ruxue ruxue Standard 
female voice

General Chinese, Chinese-
English mix

Standard

Aixiaonan aixiaonan Sweet female 
voice

General, social Chinese, Chinese-
English mix

Premium

Aixiaoxing aixiaoxing Vigorous male 
voice

General, 
commentary

Chinese, Chinese-
English mix

Premium

Aixiaocheng aixiaocheng Standard male 
voice

General Chinese, Chinese-
English mix

Standard

Aixiaoxue aixiaoxue Standard General, customer Chinese, Chinese- Standard
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female voice service English mix

Aixiaolu aixiaolu Reading female 
voice

General, 
audiobook

Chinese, Chinese-
English mix

Standard

Aixiaodong aixiaodong News male 
voice

General, news 
broadcasting

Chinese, Chinese-
English mix

Standard

Aixiaoliao aixiaoliao Sentimental 
female voice

General, social Chinese, Chinese-
English mix

Premium

Aixiaoqian aixiaoqian Vigorous female 
voice

General, social Chinese, Chinese-
English mix

Premium

Aixiaoyang aixiaoyang Broadcasting 
male voice

General, news 
broadcasting

Chinese, Chinese-
English mix

Standard

Alice alice English female 
voice

General English Standard

Multi-sentiment voice description

Name Voice Parameter Value Sentiment Category

Aixiaoxing aixiaoxing Neutral, excited

Aixiaocheng aixiaocheng Neutral, broadcasting

Aixiaoxue aixiaoxue Neutral, broadcasting, customer service

Aixiaolu aixiaolu Neutral, story telling, customer service

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <Template>

        <Tag>Tts</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TtsTpl>

            <Mode>Sync</Mode>

            <Codec>pcm</Codec>

            <VoiceType>ruxue</VoiceType>
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            <Volume>2</Volume>

            <Speed>200</Speed>

        </TtsTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

TemplateId Response.Template Template ID String

Name Response.Template Template name String

BucketId Response.Template Template bucket String

Category Response.Template
Template category:  Custom  or 
 Official 

String

Tag Response.Template Template tag: Tts String

UpdateTime Response.Template Update time String

CreateTime Response.Template Creation time String

TtsTpl Response.Template Template parameters Container

 TtsTpl  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description

Mode Response.Template.TtsTpl Same as  Request.Mode  in the request body.

Codec Response.Template.TtsTpl Same as  Request.Codec  in the request body.

VoiceType Response.Template.TtsTpl
Same as  Request.VoiceType  in the request 
body.
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Volume Response.Template.TtsTpl Same as  Request.Volume  in the request body.

Speed Response.Template.TtsTpl Same as  Request.Speed  in the request body.

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/33700
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POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Tts</Tag>

    <Name>TemplateName</Name>

    <Mode>Sync</Mode>

    <Codec>pcm</Codec>
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    <VoiceType>ruxue</VoiceType>

    <Volume>2</Volume>

    <Speed>200</Speed>

</Request>

Response

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive
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Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>Tts</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TtsTpl>

            <Mode>Sync</Mode>

            <Codec>pcm</Codec>

            <VoiceType>ruxue</VoiceType>

            <Volume>2</Volume>

            <Speed>200</Speed>

        </TtsTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Creating Video Montage Template
Last updated：2024-02-27 15:52:05

Feature Description

This API is used to create a video montage template.

Request

Sample request
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POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>VideoMontage</Tag>

    <Name>TemplateName</Name>

    <Duration>10.5</Duration>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

        <Remove>false</Remove>

    </Audio>

    <AudioMix>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

    </AudioMix>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required Constraints

Tag Request Template tag: 
VideoMontage

String Yes None

Name Request Template name, 
which can contain 
letters, digits, 

String Yes None
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underscores (_), 
hyphens (-), and 
asterisks (*).

Duration Request
Video montage 
duration String No

1. The default value is 
the automatically 
analyzed duration.
2. Unit: Second
3. Supports the float 
format, accurate to the 
millisecond.

Container Request Container format Container Yes None

Video Request Video information Container Yes None

Audio Request Audio information Container No None

AudioMix Request

Audio mix 
parameter as 
described in 
Structure.

Container 
array

No
Valid only if 
 Audio.Remove  is 
 false 

 Container  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Format Request.Container
Container format. Valid values:  mp4 ,  flv , 
 hls ,  ts ,  mkv .

String Yes

Audio/Video formats supported by different container formats are as follows:

Container Audio Codecs Video Codecs

mp4/ts/hls/mkv AAC, MP3 H.264, H.265

flv AAC, MP3 H.264

 Video  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value Constraints

Codec Request.Video Codec String No H.264 1. H.264


https://intl.cloud.tencent.com/document/product/1045/49945
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format 2.H.265

Width Request.Video Width String No
Original 
video 
width

1. Value range: [128, 
4096]
2.Unit: px

3.If only Width is set, 
Height is calculated 
based on the original 
video aspect ratio.

4.This parameter must 
be an even number.

Height Request.Video Height String No
Original 
video 
height

1. Value range: [128, 
4096]
2.Unit: px

3. If only Height is set, 
Width is calculated 
based on the original 
video aspect ratio.

4. This parameter must 
be an even number.

Fps Request.Video Frame rate String No None 1. Value range: (0, 60]

2. Unit: fps

Bitrate Request.Video
Bitrate of the 
video output 
file

String No None
1. Value range: [10, 
50000]

2. Unit: Kbps

Crf Request.Video

Bitrate, 
which is a 
quality 
control 
factor

String No None

1. Value range: (0, 51]

2. If Crf is set, the 
setting of Bitrate 
becomes invalid.

3. If Bitrate is empty, 25 
is used for this 
parameter by default.

Rotate Request.Video Rotation 
angle

String No None 1. Value range: [0, 360)

2. Unit: Degree

 Audio  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value Constraints
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Codec Request.Audio Codec 
format

String No aac Valid values:  aac , 
 mp3 .

Samplerate Request.Audio Sample 
rate

String No 44100

1. Unit: Hz
2. Valid values: 
11025, 22050, 
32000, 44100, 
48000, 96000.
3.  Different container 
formats support 
different MP3 sample 
rates, as shown in the 
table below.

Bitrate Request.Audio
Original 
audio 
bitrate

String No None
1. Unit: Kbps
2. Value range: [8, 
1000]

Channels Request.Audio
Number of 
sound 
channels

String No None

1. If Codec is aac, the 
value can be 1, 2, 4, 
5, 6, or 8.
2. If Codec is mp3, 
the value can be 1 or 
2.

Remove Request.Audio

Whether to 
delete the 
audio 
stream

String No false
Valid values: 
 true ,  false .

Note: 
 Y indicates supported, and N indicates unsupported.

Container Format/Audio Sample Rate 11025 22050 32000 44100 48000 96000

flv N Y N Y N N

mp4 N Y Y Y Y N

hls/ts/mkv Y Y Y Y Y N

Response

Response headers
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This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

<Response>

    <Template>

        <Tag>VideoMontage</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

https://intl.cloud.tencent.com/document/product/1045/43610
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        <Category>Custom</Category>

        <VideoMontage>

            <Duration>10.5</Duration>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

                <Remove>false</Remove>

            </Audio>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

            </AudioMix>

        </VideoMontage>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

TemplateId Response.Template Template ID String

Name Response.Template Template name String

BucketId Response.Template Template bucket String

Category Response.Template Template category: Custom or Official String
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Tag Response.Template Template tag: VideoMontage String

UpdateTime Response.Template Update time String

CreateTime Response.Template Creation time String

VideoMontage Response.Template Template parameters Container

 VideoMontage  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description

Duration Response.TemplateList.VideoMontage
Same as the  Request.Duration  in the 
request body.

TimeInterval Response.TemplateList.VideoMontage
Same as the  Request.TimeInterval  in 
the request body.

Container Response.TemplateList.VideoMontage
Same as the  Request.Container  in the 
request body.

Video Response.TemplateList.VideoMontage
Same as the  Request.Video  in the 
request body.

Audio Response.TemplateList.VideoMontage
Same as the  Request.Audio  in the 
request body.

AudioMix Response.TemplateList.VideoMontage
Same as the  Request.AudioMix  in the 
request body.

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353
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POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoMontage</Tag>

    <Name>TemplateName</Name>

    <Duration>10.5</Duration>

    <Container>
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        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

        <Remove>false</Remove>

    </Audio>

    <AudioMix>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

    </AudioMix>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>VideoMontage</Tag>
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        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoMontage>

            <Duration>10.5</Duration>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

                <Remove>false</Remove>

            </Audio>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

            </AudioMix>

        </VideoMontage>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Creating Video Enhancement Template
Last updated：2024-02-27 15:52:06

Feature Description

This API is used to create a video enhancement template.

Request

Sample request
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POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>VideoProcess</Tag>

    <Name>TemplateName</Name>

    <ColorEnhance>

        <Enable>true</Enable>

        <Contrast></Contrast>

        <Correction></Correction>

        <Saturation></Saturation>

    </ColorEnhance>

    <MsSharpen>

        <Enable>true</Enable>

        <SharpenLevel></SharpenLevel>

    </MsSharpen>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Constraints

Tag Request Template tag: 
VideoProcess

String Yes No

Name Request

Template 
name, which 
can contain 
letters, digits, 
underscores 
(_), hyphens 
(-), and 
asterisks (*).

String Yes None

ColorEnhance Request Color 
enhancement

Container

No. 
 ColorEnhance  
and 
 MsSharpen  
cannot be empty at 
the same time.

None
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MsSharpen Request Detail 
enhancement

Container No. 
 ColorEnhance  
and 
 MsSharpen  
cannot be empty at 
the same time.

None

 ColorEnhance  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value Constraints

Enable Request.ColorEnhance
Whether to 
enable color 
enhancement

String None false true, false

Contrast Request.ColorEnhance Contrast String No None

Value range: [0, 
100] or a null 
string indicating 
automatic 
analysis

Correction Request.ColorEnhance
Color 
correction String No None

Value range: [0, 
1000] or a null 
string indicating 
automatic 
analysis

Saturation Request.ColorEnhance Saturation String No None

Value range: [0, 
300] or a null 
string indicating 
automatic 
analysis

 MsSharpen  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Default 
Value

Constraints

Enable Request.MsSharpen
Whether to 
enable detail 
enhancement

String None false true, false

SharpenLevel Request.MsSharpen Enhancement 
level

String No None Value range: 
[0, 10] or a null 
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string 
indicating 
automatic 
analysis

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <Template>

        <Tag>VideoProcess</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoProcess>

            <ColorEnhance>

                <Enable>true</Enable>

                <Contrast></Contrast>
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                <Correction></Correction>

                <Saturation></Saturation>

            </ColorEnhance>

            <MsSharpen>

                <Enable>true</Enable>

                <SharpenLevel></SharpenLevel>

            </MsSharpen>

        <VideoProcess>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

TemplateId Response.Template Template ID String

Name Response.Template Template name String

BucketId Response.Template Template bucket String

Category Response.Template Template category: Custom or Official String

Tag Response.Template Template tag: VideoProcess String

UpdateTime Response.Template Update time String

CreateTime Response.Template Creation time String

VideoProcess Response.Template Template parameters Container

 VideoProcess  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description

ColorEnhance Response.Template.VideoProcess
Same as the  Request.ColorEnhance  in the 
request body.

MsSharpen Response.Template.VideoProcess Same as the  Request.MsSharpen  in the 
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request body.

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353
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POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoProcess</Tag>

    <Name>TemplateName</Name>

    <ColorEnhance>

        <Enable>true</Enable>

        <Contrast></Contrast>

        <Correction></Correction>

        <Saturation></Saturation>

    </ColorEnhance>

    <MsSharpen>

        <Enable>true</Enable>

        <SharpenLevel></SharpenLevel>

    </MsSharpen>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>VideoProcess</Tag>
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        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <ColorEnhance>

            <Enable>true</Enable>

            <Contrast></Contrast>

            <Correction></Correction>

            <Saturation></Saturation>

        </ColorEnhance>

        <MsSharpen>

            <Enable>true</Enable>

            <SharpenLevel></SharpenLevel>

        </MsSharpen>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Creating Voice/Sound Separation Template
Last updated：2024-02-27 15:52:06

Feature Description

This API is used to create a voice/sound separation template.

Request

Sample request
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POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>VoiceSeparate</Tag>

    <Name>TemplateName</Name>

    <AudioMode>IsAudio</AudioMode>

    <AudioConfig>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </AudioConfig>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Constraints

Tag Request Template tag: 
VoiceSeparate

String Yes None

Name Request

Template name, 
which can contain 
letters, digits, 
underscores (_), 
hyphens (-), and 
asterisks (*).

String Yes None

AudioMode Request Audio output mode String Yes

IsAudio: Outputs voice
IsBackground: 
Outputs background 
sound
AudioAndBackground: 
Outputs voice and 
background sound

AudioConfig Request Audio configuration Container Yes None
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 AudioConfig  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value Constraints

Codec Request.Audio Codec 
format

String No aac Valid values: aac, 
mp3, flac, amr.

Samplerate Request.Audio
Sample 
rate String No 44100

1. Unit: Hz

2. Valid values: 8000, 
11025, 22050, 32000, 
44100, 48000, 96000.

3. If Codec is aac or 
flac, the value cannot 
be 8000.

4. If Codec is mp3, the 
value cannot be 8000 
or 96000.

5. If Codec is amr, the 
value can only be 
8000.

Bitrate Request.Audio
Original 
audio 
bitrate

String No None
1. Unit: Kbps

2. Value range: [8, 
1000]

Channels Request.Audio
Number of 
sound 
channels

String No None

1. If Codec is aac or 
flac, the value can be 
1, 2, 4, 5, 6, or 8.

2. If Codec is mp3, the 
value can only be 1 or 
2.

3. If Codec is amr, the 
value can only be 1.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <Template>

        <Tag>VoiceSeparate</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VoiceSeparate>

            <AudioMode>IsAudio</AudioMode>

            <AudioConfig>

                <Codec>mp3</Codec>
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                <Samplerate>44100</Samplerate>

                <Bitrate>12</Bitrate>

                <Channels>2</Channels>

            </AudioConfig>

        </VoiceSeparate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

TemplateId Response.Template Template ID String

Name Response.Template Template name String

BucketId Response.Template Template bucket String

Category Response.Template Template category: Custom or Official String

Tag Response.Template Template tag: VoiceSeparate String

UpdateTime Response.Template Update time String

CreateTime Response.Template Creation time String

VoiceSeparate Response.Template Template parameters Container

 VoiceSeparate  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

AudioMode Response.Template.VoiceSeparate
Same as  Request.AudioMode  in 
the request body.

String

AudioConfig Response.Template.VoiceSeparate
Same as 
 Request.AudioConfig  in the 
request body.

Container
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Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

https://intl.cloud.tencent.com/document/product/1045/49353
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Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VoiceSeparate</Tag>

    <Name>TemplateName</Name>

    <AudioMode>IsAudio</AudioMode>

    <AudioConfig>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </AudioConfig>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>VoiceSeparate</Tag>
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        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VoiceSeparate>

            <AudioMode>IsAudio</AudioMode>

            <AudioConfig>

                <Codec>mp3</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>12</Bitrate>

                <Channels>2</Channels>

            </AudioConfig>

        </VoiceSeparate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Creating Watermark Template
Last updated：2024-02-27 15:52:05

Feature Description

This API is used to create a watermark template.

Request

Sample request
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POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers. 

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>Watermark</Tag>

    <Name>TemplateName</Name>

    <Watermark>

        <Type>Text</Type>

        <LocMode>Absolute</LocMode>

        <Dx>128</Dx>

        <Dy>128</Dy>

        <Pos>TopRight</Pos>

        <StartTime>0</StartTime>

        <EndTime>100.5</EndTime>

        <Text>

            <Text>Watermark content</Text>

            <FontSize>30</FontSize>

            <FontType></FontType>

            <FontColor>0xRRGGBB</FontColor>

            <Transparency>30</Transparency>

        </Text>

    </Watermark>

</Request>

<Request>

    <Tag>Watermark</Tag>

    <Name>TemplateName</Name>

    <Watermark>

        <Type>Image</Type>

        <LocMode>Absolute</LocMode>

        <Dx>128</Dx>

        <Dy>128</Dy>

        <Pos>TopRight</Pos>

        <StartTime>0</StartTime>

        <EndTime>100.5</EndTime>

        <Image>

            <Url>http://test-1234567890.ci.ap-beijing.myqcloud.com/shuiyin_2.png</U

            <Mode>Proportion</Mode>

            <Width>10</Width>

            <Height></Height>

            <Transparency>100</Transparency>

        </Image>

    </Watermark>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type
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Request None Request container Container

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Template type: Watermark String Yes

Name Request Template name, which can contain letters, digits, 
underscores (_), hyphens (-), and asterisks (*).

String Yes

Watermark Request Watermark information Container Yes

 Watermark  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value Constraints

Type Request.Watermark Watermark 
type

String Yes None

Text: Text 
watermark. 
Image: Image 
watermark.

Pos Request.Watermark
Reference 
position String Yes None

TopRight, 
TopLeft, 
BottomRight, 
BottomLeft, 
Left, Right, 
Top, Bottom, 
Center

LocMode Request.Watermark Offset mode String Yes None

Relativity: 
Proportionally. 
Absolute: 
Fixed position.

Dx Request.Watermark Horizontal 
offset

String Yes None 1. Image 
watermark 
with 
Background 
being true: If 
locMode is 
Relativity, the 
unit is %, and 
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the value 
range is [-300, 
0]. If locMode 
is Absolute, 
the unit is px, 
and the value 
range is 
[-4096, 0].

2. Image 
watermark 
with 
Background 
being false: If 
locMode is 
Relativity, the 
unit is %, and 
the value 
range is [0, 
100]. If 
locMode is 
Absolute, the 
unit is px, and 
the value 
range is [0, 
4096].

3. Text 
watermark: If 
locMode is 
Relativity, the 
unit is %, and 
the value 
range is [0, 
100]. If 
locMode is 
Absolute, the 
unit is px, and 
the value 
range is [0, 
4096].

4. If Pos is 
Top, Bottom, 
or Center, this 
parameter will 
not take 
effect.
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Dy Request.Watermark Vertical 
offset

String Yes None 1. Image 
watermark 
with 
Background 
being true: If 
locMode is 
Relativity, the 
unit is %, and 
the value 
range is [-300, 
0]. If locMode 
is Absolute, 
the unit is px, 
and the value 
range is 
[-4096, 0].

2. Image 
watermark 
with 
Background 
being false: If 
locMode is 
Relativity, the 
unit is %, and 
the value 
range is [0, 
100]. If 
locMode is 
Absolute, the 
unit is px, and 
the value 
range is [0, 
4096].

3. Text 
watermark: If 
locMode is 
Relativity, the 
unit is %, and 
the value 
range is [0, 
100]. If 
locMode is 
Absolute, the 
unit is px, and 
the value 
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range is [0, 
4096].

4. If Pos is 
Left, Right, or 
Center, this 
parameter will 
not take 
effect.

StartTime Request.Watermark Watermark 
start time

String No 0

1. Value 
range: [0, 
video 
duration]

2. Unit: 
Second

3. The float 
format is 
supported, 
accurate to 
the 
millisecond.

EndTime Request.Watermark Watermark 
end time

String No
Video 
end 
time

1. Value 
range: [0, 
video 
duration]

2. Unit: 
Second

3. The float 
format is 
supported, 
accurate to 
the 
millisecond.

SlideConfig Request.Watermark Watermark 
sliding 
configuration. 
If this 
parameter is 
configured, 
the 
watermark 
offset setting 
will not take 
effect. This 

Container No None None
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parameter is 
not 
supported for 
top speed 
codec/H.265 
transcoding.

Image Request.Watermark
Image 
watermark 
node

Container No None None

Text Request.Watermark
Text 
watermark 
node

Container No None None

 SlideConfig  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Default 
Value

Constrain

SlideMode Request.Watermark.SlideConfig Sliding 
mode

String Yes None

Default: N
 Scroll

Slides fro
right. If 
 Scroll

is set, the
 Waterm

paramete
effect.

XSlideSpeed Request.Watermark.SlideConfig
Horizontal 
sliding 
speed

String Yes None
Valid valu
integer be
10. Defau

YSlideSpeed Request.Watermark.SlideConfig
Vertical 
sliding 
speed

String Yes None
Valid valu
integer be
10. Defau

 Image  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Default 
Value

Constraints

Url Request.Watermark.Image Watermark 
image 
address 

String Yes None Same as th
watermark 
image 
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(which must 
be URL-
encoded 
before being 
passed in).

address of 
the bucket.

Mode Request.Watermark.Image
Dimension 
mode String Yes None

1. Original: 
Original siz
2. Proportio
Scaled 
proportiona
3. Fixed: 
Fixed size

Width Request.Watermark.Image Width String No None 1. If Mode i
Original, th
watermark 
image widt
cannot be 
set.

2. If Mode i
Proportion,
the unit is %
and the val
range is 
[100, 300] f
the 
background
image and 
100] for the
foreground
image. 
Compared 
with the 
video width
the 
watermark 
image widt
cannot be 
greater tha
4096 px.

3. If Mode i
Fixed, the 
unit is px, 
and the val
range is [8,
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4096].

4. If only 
Width is se
Height is 
calculated 
according t
the original
watermark 
image aspe
ratio.


Height Request.Watermark.Image Height String No None 1. If Mode i
Original, th
watermark 
image heig
cannot be 
set.

2. If Mode i
Proportion,
the unit is %
and the val
range is 
[100, 300] f
the 
background
image and 
100] for the
foreground
image. 
Compared 
with the 
video heigh
the 
watermark 
image heig
cannot be 
greater tha
4096 px.

3. If Mode i
Fixed, the 
unit is px, 
and the val
range is [8,
4096].
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4. If only 
Height is se
Width is 
calculated 
according t
the original
watermark 
image aspe
ratio.


Transparency Request.Watermark.Image Transparency String Yes None
Value range
[1, 100]. Un
%

Background Request.Watermark.Image
Whether it is 
a background 
image

String No false
Valid value
true, false.

Watermark position description:
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 Text  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Default 
Value

Constraints

FontSize Request.Watermark.Text Font size String Yes None

Value 
range: [5, 
100]. Unit: 
px

FontType Request.Watermark.Text Font type String Yes None See the 
table below.

FontColor Request.Watermark.Text Font color String Yes None Format: 
0xRRGGBB

Transparency Request.Watermark.Text Transparency String Yes None Value 
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range: [1, 
100]. Unit: 
%

Text Request.Watermark.Text Watermark 
content

String Yes None

The value 
can contain 
up to 64 
letters, 
digits, 
underscores 
(_), hyphens 
(-), and 
asterisks 
(*).

 FontType  has the following sub-nodes:

Font Name Supported Language Description

simfang.ttf Chinese/English FangSong

simhei.ttf Chinese/English SimHei

simkai.ttf Chinese/English KaiTi

simsun.ttc Chinese/English SimSun

STHeiti-Light.ttc Chinese/English STHeiti-Light

STHeiti-Medium.ttc Chinese/English STHeiti-Medium

youyuan.TTF Chinese/English YouYuan

ariblk.ttf English None

arial.ttf English None

ahronbd.ttf English None

Helvetica.dfont English None

HelveticaNeue.dfont English None

Response

Response headers
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This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Tag>Watermark</Tag>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

https://intl.cloud.tencent.com/document/product/1045/43610
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        <Category>Custom</Category>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>Watermark content</Text>

                <FontSize>30</FontSize>

                <FontType></FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

TemplateId Response.Template Template ID String

Name Response.Template Template name String

BucketId Response.Template Template bucket String

Category Response.Template Template category: Custom or Official String

Tag Response.Template Template type: VideoProcess String

UpdateTime Response.Template Update time String

CreateTime Response.Template Creation time String

Watermark Response.Template Same as  Request.Watermark  in the Container
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request body.

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request 1: Text watermark

https://intl.cloud.tencent.com/document/product/1045/49353
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POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0****&q-sign-tim

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

   <Tag>Watermark</Tag>

   <Name>TemplateName</Name>

   <Watermark>

      <Type>Text</Type>

      <LocMode>Absolute</LocMode>

      <Dx>128</Dx>

      <Dy>128</Dy>

      <Pos>TopRight</Pos>

      <StartTime>0</StartTime>

      <EndTime>100.5</EndTime>

      <Text>

        <Text>Watermark content</Text>

        <FontSize>30</FontSize>

        <FontType></FontType>

        <FontColor>0xRRGGBB</FontColor>

        <Transparency>30</Transparency>

      </Text>

   </Watermark>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>
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        <Tag>Watermark</Tag>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>Watermark content</Text>

                <FontSize>30</FontSize>

                <FontType></FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

   </Template>

</Response>

Request 2: Image watermark
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POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0****&q-sign-tim

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

   <Tag>Watermark</Tag>

   <Name>TemplateName</Name>

   <Watermark>

      <Type>Image</Type>
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      <LocMode>Absolute</LocMode>

      <Dx>128</Dx>

      <Dy>128</Dy>

      <Pos>TopRight</Pos>

      <StartTime>0</StartTime>

      <EndTime>100.5</EndTime>

      <Image>

        <Url>http://test-1234567890.ci.ap-beijing.myqcloud.com/shuiyin_2.png</Url>

        <Mode>Proportion</Mode>

        <Width>10</Width>

        <Height>10</Height>

        <Transparency>30</Transparency>

      </Image>

   </Watermark>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>
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        <Tag>Watermark</Tag>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Watermark>

            <Type>Image</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Image>

                <Url>http://test-1234567890.ci.ap-beijing.myqcloud.com/shuiyin_2.pn

                <Mode>Proportion</Mode>

                <Width>10</Width>

                <Height>10</Height>

                <Transparency>30</Transparency>

            </Image>

        </Watermark>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Creating Intelligent Thumbnail Template
Last updated：2024-02-27 15:52:05

Feature Description

This API is used to create an intelligent thumbnail template.

Request

Sample request
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POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers. 

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>SmartCover</Tag>

    <Name>TemplateName</Name>

    <SmartCover>

        <Format>jpg</Format>

        <Width>1280</Width>

        <Height>960</Height>

        <Count>10</Count>

        <DeleteDuplicates>true</DeleteDuplicates>

    </SmartCover>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Tag Request Template tag: SmartCover String Yes

Name Request Template name, which can contain letters, digits, 
underscores (_), hyphens (-), and asterisks (*).

String Yes

SmartCover Request Intelligent thumbnail parameter Container Yes

 SmartCover  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Default 
Value

Constraints

Format Request.SmartCover Image 
format

String No jpg jpg, png, 
webp

Width Request.SmartCover Width String No Original 
video 
width

Value 
range: [128, 
4096]
Unit: px
If only Width 
is set, 
Height is 
calculated 
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based on 
the original 
video 
aspect ratio.

Height Request.SmartCover Height String No
Original 
video 
height

Value 
range: [128, 
4096]
Unit: px
If only 
Height is 
set, Width is 
calculated 
based on 
the original 
video 
aspect ratio.

Count Request.SmartCover Number of 
screenshots

String No 3 [1,10]

DeleteDuplicates Request.SmartCover
Whether to 
deduplicate 
thumbnails.

String No false true/false

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <Template>

        <Tag>SmartCover</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f43110a08702470b8fa75894629501fa</TemplateId>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SmartCover>

            <Width>1280</Width>

            <Height>960</Height>

            <Format>jpg</Format>
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            <Count>5</Count>

            <DeleteDuplicates>false</DeleteDuplicates>

        </SmartCover>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Tag Response.Template Template tag: SmartCover String

Name Response.Template Template name String

BucketId Response.Template Template bucket String

Category Response.Template Template category: Custom or Official String

TemplateId Response.Template Template ID String

UpdateTime Response.Template Update time String

CreateTime Response.Template Creation time String

SmartCover Response.Template
Template parameter, which is the same as 
 SmartCover  in the request body. Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/33700
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POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SmartCover</Tag>

    <Name>TemplateName</Name>

    <SmartCover>

        <Format>jpg</Format>
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        <Width>1280</Width>

        <Height>960</Height>

        <Count>10</Count>

        <DeleteDuplicates>true</DeleteDuplicates>

    </SmartCover>

</Request>

Response

HTTP/1.1 200 OK

Content-Type: application/xml
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Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <Template>

        <Tag>SmartCover</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SmartCover>

            <Format>jpg</Format>

            <Width>1280</Width>

            <Height>960</Height>

            <Count>10</Count>

            <DeleteDuplicates>true</DeleteDuplicates>

        </SmartCover>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Deleting Media Processing Template
DeleteMediaTemplate
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to delete a template.

Request

Sample request
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DELETE /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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Request headers

Common request headers

This API uses common request headers. For more information, see Common Request Headers.

Non-common request headers

This request operation does not use any non-common request headers.

Request body

The request body of this request is empty.

Response

Response headers

Common response headers

This response contains common response headers. For more information, see Common Response Headers.

Non-common response headers

This response does not use any non-common response header.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TemplateId>A</TemplateId>

<Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container
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 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RequestId Response Unique ID of the request String

TemplateId Response ID of the deleted 
template

String

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353
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DELETE /template/t143ae6e040af6431aa772c9ec3f0a3f36 HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJjYmU0YmRfOTBmYTUwNjRfODhjXzE=

<Response>

    <RequestId>NjJjYmU0YmRfOTBmYTUwNjRfODhjXzE=</RequestId>

    <TemplateId>t143ae6e040af6431aa772c9ec3f0a3f36</TemplateId>
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<Response>
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Querying Media Processing Template
DescribeMediaTemplates
Last updated：2024-03-04 10:16:48

Feature Description

This API is used to query a template.

Request

Sample request
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GET /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (for more information, see Request Signature).

https://intl.cloud.tencent.com/document/product/436/7778
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Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Request parameters

The parameters are as described below:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

tag None Template tag. Default value:  All . String No

category None
Valid values:  Official  (system preset template); 
 Custom  (custom template). Default value:  Custom .

String No

ids None Template ID. If you enter multiple IDs, separate them by 
comma.

String No

name None Template name prefix String No

pageNumber None Page number. Default value:  1 . Integer No

pageSize None Number of entries per page. Default value:  10 . Integer No

Supported  tag  types are as follows:

Template type tag

Audio/Video transcoding Transcode

Video-to-animated image conversion Animation

Screenshot Snapshot

Audio/Video splicing Concat

Voice/Sound separation VoiceSeparate

Video montage VideoMontage

Video enhancement VideoProcess

Super resolution SuperResolution

Image/Text watermark Watermark

https://intl.cloud.tencent.com/document/product/1045/43609
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Text to speech Tts

Professional audio/video transcoding TranscodePro

Top speed codec transcoding HighSpeedHd

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <TemplateList>

        <TemplateId>A</TemplateId>

        <Name>TemplateName</Name>

        <Tag>Transcode</Tag>

        <TransTpl>

            <Container>
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                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

RequestId Response Unique ID of the request. String

TotalCount Response Total number of templates Int

PageNumber Response Current page number, which is the same as Int
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 pageNumber  in the request.

PageSize Response
Number of entries per page, which is the same as 
 pageSize  in the request. Int

TemplateList Response Template array Container 
array

For different types of templates, the  TemplateList  content is the same as the  Response  of the corresponding 

template creation API. For more information, see:

Creating Audio/Video Transcoding Template﻿
Creating Animated Image Template﻿
Creating Screenshot Template﻿
Creating Splicing Template﻿
Creating Voice/Sound Separation Template﻿

Creating Video Montage Template﻿
Creating Video Enhancement Template﻿
Creating Super Resolution Template﻿
Creating Watermark Template﻿
Creating Text-to-Speech Template﻿

Creating Professional Transcoding Template﻿
Creating Top Speed Codec Transcoding Template﻿

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Sample 1. Querying by template ID

Request

https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49906
https://intl.cloud.tencent.com/document/product/1045/49909
https://intl.cloud.tencent.com/document/product/1045/49907
https://intl.cloud.tencent.com/document/product/1045/49916
https://intl.cloud.tencent.com/document/product/1045/49914
https://intl.cloud.tencent.com/document/product/1045/49915
https://intl.cloud.tencent.com/document/product/1045/49910
https://intl.cloud.tencent.com/document/product/1045/49917
https://intl.cloud.tencent.com/document/product/1045/49913
https://intl.cloud.tencent.com/document/product/1045/49912
https://intl.cloud.tencent.com/document/product/1045/49908
https://intl.cloud.tencent.com/document/product/1045/49353
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GET /template?ids=t1847cd4ca57f543e89f551dbe68169eb9,t1a30a323f55434a29b25bf2a16bdf

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TemplateList>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 2057
of 2300

        <TemplateId>t1847cd4ca57f543e89f551dbe68169eb9</TemplateId>

        <Name>TemplateName</Name>

        <Tag>Transcode</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransTpl>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

    <TemplateList>

        <TemplateId>t140325e8918ac423da53b7d78dbbab564</TemplateId>

        <Name>template_name3544697</Name>

        <Tag>Concat</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/input/ad

            </ConcatFragment>
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            <Audio>

                <Codec>aac</Codec>

                <Samplerate/>

                <Bitrate/>

                <Channels/>

                <Remove>false</Remove>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Width>1280</Width>

                <Height>960</Height>

                <Fps>15</Fps>

                <Remove>false</Remove>

                <Crf>25</Crf>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <DirectConcat>false</DirectConcat>

        </ConcatTemplate>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

    </TemplateList>

    <NonExistTIDs>

        <TemplateId>C</TemplateId>

    </NonExistTIDs>

</Response>

Sample 2. Querying by paginated list

Request
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GET /template?pageSize=10&pageNumber=1 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>2</TotalCount>
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    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <TemplateList>

        <TemplateId>t1847cd4ca57f543e89f551dbe68169eb9</TemplateId>

        <Name>TemplateName</Name>

        <Tag>Transcode</Tag>

        <TransTpl>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

    <TemplateList>

        <TemplateId>t140325e8918ac423da53b7d78dbbab564</TemplateId>

        <Name>template_name3544697</Name>

        <Tag>Concat</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/input/ad
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            </ConcatFragment>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate/>

                <Bitrate/>

                <Channels/>

                <Remove>false</Remove>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Width>1280</Width>

                <Height>960</Height>

                <Fps>15</Fps>

                <Remove>false</Remove>

                <Crf>25</Crf>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <DirectConcat>false</DirectConcat>

        </ConcatTemplate>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

    </TemplateList>

</Response>
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Updating Template
Updating Animated Image Template
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to update an animated image template.

Request

Sample request
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PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>Animation</Tag>

    <Name>TemplateName</Name>

    <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

    <Container>

        <Format>gif</Format>

    </Container>

    <Video>

        <Codec>gif</Codec>

        <Width>1280</Width>

        <Height></Height>

        <Fps>15</Fps>

        <AnimateOnlyKeepKeyFrame>false</AnimateOnlyKeepKeyFrame>

    </Video>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

The nodes are described as follows:

Node 
Name 
(Keyword)

Parent 
Node Description Type Required

Request None Same as Request in the animated image template 
creation API.﻿

Container Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49906
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <Template>

        <Tag>Animation</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <TransTpl>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>gif</Codec>
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                <Width>1280</Width>

                <Height></Height>

                <Fps>15</Fps>

                <AnimateOnlyKeepKeyFrame>false</AnimateOnlyKeepKeyFrame>

            </Video>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node 
Name 
(Keyword)

Parent 
Node Description Type

Response None Same as Response in the animated image template creation API.﻿ Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49906
https://intl.cloud.tencent.com/document/product/1045/49353
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PUT /template/t1f16e1dfbdc994105b31292d45710642a HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Animation</Tag>

    <Name>TemplateName</Name>

    <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

    <Container>
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        <Format>gif</Format>

    </Container>

    <Video>

        <Codec>gif</Codec>

        <Width>1280</Width>

        <Height></Height>

        <Fps>15</Fps>

        <AnimateOnlyKeepKeyFrame>false</AnimateOnlyKeepKeyFrame>

    </Video>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <Tag>Animation</Tag>

    <Name>TemplateName</Name>
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    <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

    <TransTpl>

      <Container>

         <Format>mp4</Format>

      </Container>

      <Video>

        <Codec>gif</Codec>

        <Width>1280</Width>

        <Height></Height>

        <Fps>15</Fps>

        <AnimateOnlyKeepKeyFrame>false</AnimateOnlyKeepKeyFrame>

      </Video>

      <TimeInterval>

         <Start>0</Start>

         <Duration>60</Duration>

      </TimeInterval>

   </TransTpl>

   <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

   <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

</Response>
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Updating Splicing Template
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to update a splicing template.

Request

Sample request
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PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

Common request headers

This API uses common request headers. For more information, see Common Request Headers.

Non-common request headers

This request operation does not use any non-common request headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>Concat</Tag>

    <Name>TemplateName</Name>

    <ConcatTemplate>

        <ConcatFragment>

            <Mode>Start</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4</Ur

        </ConcatFragment>

        <ConcatFragment>

            <Mode>End</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</Url>
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        </ConcatFragment>

        <Audio>

            <Codec>mp3</Codec>

            <Samplerate></Samplerate>

            <Bitrate></Bitrate>

            <Channels></Channels>

        </Audio>

        <Video>

            <Codec>H.264</Codec>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Height></Height>

            <Fps>30</Fps>

        </Video>

        <Container>

            <Format>mp4</Format>

        </Container>

        <AudioMix>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3</Au

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMix>

    </ConcatTemplate>

</Request>

The nodes are described as follows:

Node 
Name 
(Keyword)

Parent 
Node Description Type

Request None Same as Request in the splicing template creation API.﻿ Container

Response

Response headers

https://intl.cloud.tencent.com/document/product/1045/49907
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Common response headers

This response contains common response headers. For more information, see Common Response Headers.

Non-common response headers

This response does not use any non-common response header.

Response body

The response body returns application/xml data. The following contains all the nodes:

<Response>

https://intl.cloud.tencent.com/document/product/1045/43610
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    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Tag>Concat</Tag>

        <Name>TemplateName</Name>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4

            </ConcatFragment>

            <ConcatFragment>

                <Mode>End</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</

            </ConcatFragment>

            <Audio>

                <Codec>mp3</Codec>

                <Samplerate></Samplerate>

                <Bitrate></Bitrate>

                <Channels></Channels>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height></Height>

                <Fps>30</Fps>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMix>

        </ConcatTemplate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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The nodes are as described below:

Node 
Name 
(Keyword)

Parent Node Description Type

Response None Same as Response in the splicing template creation 
API.﻿

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49907
https://intl.cloud.tencent.com/document/product/1045/49353
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PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Concat</Tag>

    <Name>TemplateName</Name>

    <ConcatTemplate>

        <ConcatFragment>
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            <Mode>Start</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4</Ur

        </ConcatFragment>

        <ConcatFragment>

            <Mode>End</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</Url>

        </ConcatFragment>

        <Audio>

            <Codec>mp3</Codec>

            <Samplerate></Samplerate>

            <Bitrate></Bitrate>

            <Channels></Channels>

        </Audio>

        <Video>

            <Codec>H.264</Codec>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Height></Height>

            <Fps>30</Fps>

        </Video>

        <Container>

            <Format>mp4</Format>

        </Container>

        <AudioMix>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3</Au

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMix>

    </ConcatTemplate>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>
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        <Tag>Concat</Tag>

        <Name>TemplateName</Name>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4

            </ConcatFragment>

            <ConcatFragment>

                <Mode>End</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</

            </ConcatFragment>

            <Audio>

                <Codec>mp3</Codec>

                <Samplerate></Samplerate>

                <Bitrate></Bitrate>

                <Channels></Channels>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height></Height>

                <Fps>30</Fps>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMix>

        </ConcatTemplate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 2085
of 2300

Updating Top Speed Codec Transcoding
Template
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to update a top speed codec transcoding template.

Request

Sample request
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PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>HighSpeedHd</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Bufsize>0</Bufsize>

        <Maxrate>0</Maxrate>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Request None Same as Request in the top speed codec 
transcoding template creation API.﻿

Container Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

https://intl.cloud.tencent.com/document/product/1045/49908
https://intl.cloud.tencent.com/document/product/1045/43610
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Response body

The response body returns application/xml data. The following contains all the nodes:

<Response>

    <Template>

        <Tag>HighSpeedHd</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <HighSpeedHd>

            <Container>

                <Format>mp4</Format>
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            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Bufsize>0</Bufsize>

                <Maxrate>0</Maxrate>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </HighSpeedHd>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node 
Name 
(Keyword)

Parent 
Node Description Type

Response None Same as Response in the top speed codec transcoding template 
creation API.﻿

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

https://intl.cloud.tencent.com/document/product/1045/49908
https://intl.cloud.tencent.com/document/product/1045/49353
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Request

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>HighSpeedHd</Tag>

    <Name>TemplateName</Name>
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    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Bufsize>0</Bufsize>

        <Maxrate>0</Maxrate>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>HighSpeedHd</Tag>
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        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <HighSpeedHd>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Bufsize>0</Bufsize>

                <Maxrate>0</Maxrate>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </HighSpeedHd>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Updating Screenshot Template
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to update a screenshot template.

Request

Sample request
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PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>Snapshot</Tag>

    <Name>TemplateName</Name>

    <Snapshot>

        <Mode>Interval</Mode>

        <Width>1280</Width>

        <Height>960</Height>

        <Start>0</Start>

        <TimeInterval>0.5</TimeInterval>

        <Count>10</Count>

        <SnapshotOutMode>OnlySprite</SnapshotOutMode>

        <SpriteSnapshotConfig>

            <Color>Aquamarine</Color>

            <Columns>3</Columns>

            <Lines>3</Lines>

        </SpriteSnapshotConfig>

    </Snapshot>

</Request>

The nodes are described as follows:

Node 
Name 
(Keyword)

Parent Node Description Type Required

Request None Same as Request in the screenshot template 
creation API.﻿

Container Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49909
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <Template>

        <Tag>Snapshot</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Snapshot>

            <Mode>Interval</Mode>

            <Width>1280</Width>

            <Height>960</Height>

            <Start>0</Start>

            <TimeInterval>0.5</TimeInterval>
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            <Count>10</Count>

            <SnapshotOutMode>OnlySprite</SnapshotOutMode>

            <SpriteSnapshotConfig>

                <Color>Aquamarine</Color>

                <Columns>3</Columns>

                <Lines>3</Lines>

            </SpriteSnapshotConfig>

        </Snapshot>>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node 
Name 
(Keyword)

Parent Node Description Type

Response None Same as Response in the screenshot template creation 
API.﻿

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49909
https://intl.cloud.tencent.com/document/product/1045/49353
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PUT /template/t1f16e1dfbdc994105b31292d45710642a HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Snapshot</Tag>

    <Name>TemplateName</Name>

    <Snapshot>

        <Mode>Interval</Mode>
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        <Width>1280</Width>

        <Height>960</Height>

        <Start>0</Start>

        <TimeInterval>0.5</TimeInterval>

        <Count>10</Count>

        <SnapshotOutMode>OnlySprite</SnapshotOutMode>

        <SpriteSnapshotConfig>

            <Color>Aquamarine</Color>

            <Columns>3</Columns>

            <Lines>3</Lines>

        </SpriteSnapshotConfig>

    </Snapshot>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <Template>

        <Tag>Snapshot</Tag>
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        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Snapshot>

            <Mode>Interval</Mode>

            <Width>1280</Width>

            <Height>960</Height>

            <Start>0</Start>

            <TimeInterval>0.5</TimeInterval>

            <Count>10</Count>

            <SnapshotOutMode>OnlySprite</SnapshotOutMode>

            <SpriteSnapshotConfig>

                <Color>Aquamarine</Color>

                <Columns>3</Columns>

                <Lines>3</Lines>

            </SpriteSnapshotConfig>

        </Snapshot>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Updating Super Resolution Template
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to update a super resolution template.

Request

Sample request
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PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>SuperResolution</Tag>

    <Name>TemplateName</Name>

    <Resolution>sdtohd</Resolution>

    <EnableScaleUp>true</EnableScaleUp>

    <Version>Enhance</Version>

</Request>

The nodes are described as follows:

Node 
Name 
(Keyword)

Parent Node Description Type Required

Request None Same as Request in the super resolution template 
creation API.﻿

Container Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49910
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <Template>

        <Tag>SuperResolution</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <SuperResolution>

            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>

        </SuperResolution>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>
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        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node 
Name 
(Keyword)

Parent Node Description Type

Response None Same as Response in the super resolution template creation 
API.﻿

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49910
https://intl.cloud.tencent.com/document/product/1045/49353
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PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SuperResolution</Tag>

    <Name>TemplateName</Name>

    <Resolution>sdtohd</Resolution>

    <EnableScaleUp>true</EnableScaleUp>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 2112
of 2300

    <Version>Enhance</Version>

</Request>

Response

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci
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x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>SuperResolution</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <SuperResolution>

            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>

        </SuperResolution>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Updating Audio/Video Transcoding Template
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to update a transcoding template.

Request

Sample request
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PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>Transcode</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Preset>medium</Preset>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

The nodes are described as follows:

Node 
Name 
(Keyword)

Parent Node Description Type Required

Request None Same as Request in the transcoding template 
creation API.﻿

Container Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/43610
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Response body

The response body returns application/xml data. The following contains all the nodes:

<Response>

    <Template>

        <Tag>Transcode</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Container>

            <Format>mp4</Format>

        </Container>
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        <Video>

            <Codec>H.264</Codec>

            <Profile>high</Profile>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Fps>30</Fps>

            <Preset>medium</Preset>

        </Video>

        <Audio>

            <Codec>aac</Codec>

            <Samplerate>44100</Samplerate>

            <Bitrate>128</Bitrate>

            <Channels>4</Channels>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node 
Name 
(Keyword)

Parent Node Description Type

Response None Same as Response in the transcoding template 
creation API.﻿

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49911
https://intl.cloud.tencent.com/document/product/1045/49353
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PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>
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    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Preset>medium</Preset>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>
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    <Template>

        <Tag>Transcode</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Container>

            <Format>mp4</Format>

        </Container>

        <Video>

            <Codec>H.264</Codec>

            <Profile>high</Profile>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Fps>30</Fps>

            <Preset>medium</Preset>

        </Video>

        <Audio>

            <Codec>aac</Codec>

            <Samplerate>44100</Samplerate>

            <Bitrate>128</Bitrate>

            <Channels>4</Channels>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Updating Professional Transcoding Template
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to update a professional transcoding template.

Request

Sample request
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PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 2126
of 2300

Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>TranscodePro</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mxf</Format>

    </Container>

    <Video>

        <Codec>xavc</Codec>

        <Profile>XAVC-HD_422_10bit</Profile>

        <Width>1920</Width>

        <Height>1080</Height>

        <Interlaced>true</Interlaced>

        <Fps>30000/1001</Fps>

        <Bitrate>50000</Bitrate>

    </Video>

    <Audio>

        <Codec>pcm_s24le</Codec>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

The nodes are described as follows:

Node 
Name 
(Keyword)

Parent 
Node Description Type Required

Request None Same as Request in the professional transcoding 
template creation API.﻿

Container Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

https://intl.cloud.tencent.com/document/product/1045/49912
https://intl.cloud.tencent.com/document/product/1045/43610
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The response body returns application/xml data. The following contains all the nodes:

<Response>

    <Template>

        <Tag>TranscodePro</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Container>

            <Format>mxf</Format>

        </Container>

        <Video>
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            <Codec>xavc</Codec>

            <Profile>XAVC-HD_422_10bit</Profile>

            <Width>1920</Width>

            <Height>1080</Height>

            <Interlaced>true</Interlaced>

            <Fps>30000/1001</Fps>

            <Bitrate>50000</Bitrate>

        </Video>

        <Audio>

            <Codec>pcm_s24le</Codec>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node 
Name 
(Keyword)

Parent Node Description Type

Response None Same as Response in the professional transcoding template 
creation API.﻿

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49912
https://intl.cloud.tencent.com/document/product/1045/49353
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PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>TranscodePro</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mxf</Format>
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    </Container>

    <Video>

        <Codec>xavc</Codec>

        <Profile>XAVC-HD_422_10bit</Profile>

        <Width>1920</Width>

        <Height>1080</Height>

        <Interlaced>true</Interlaced>

        <Fps>30000/1001</Fps>

        <Bitrate>50000</Bitrate>

    </Video>

    <Audio>

        <Codec>pcm_s24le</Codec>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>TranscodePro</Tag>
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        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Container>

            <Format>mxf</Format>

        </Container>

        <Video>

            <Codec>xavc</Codec>

            <Profile>XAVC-HD_422_10bit</Profile>

            <Width>1920</Width>

            <Height>1080</Height>

            <Interlaced>true</Interlaced>

            <Fps>30000/1001</Fps>

            <Bitrate>50000</Bitrate>

        </Video>

        <Audio>

            <Codec>pcm_s24le</Codec>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Updating Text-to-Speech Template
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to update a text-to-speech template.

Request

Sample request
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PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>Tts</Tag>

    <Name>TemplateName</Name>

    <Mode>Sync</Mode>

    <Codec>pcm</Codec>

    <VoiceType>ruxue</VoiceType>

    <Volume>2</Volume>

    <Speed>200</Speed>

</Request>

The nodes are described as follows:

Node 
Name 
(Keyword)

Parent Node Description Type Required

Request None Same as Request in the text-to-speech template 
creation API.﻿

Container Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49913
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <Template>

        <Tag>Tts</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <TtsTpl>

            <Mode>Sync</Mode>

            <Codec>pcm</Codec>

            <VoiceType>ruxue</VoiceType>

            <Volume>2</Volume>

            <Speed>200</Speed>
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        </TtsTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node 
Name 
(Keyword)

Parent Node Description Type

Response None Same as Response in the text-to-speech template creation API.﻿ Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49913
https://intl.cloud.tencent.com/document/product/1045/49353
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PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Tts</Tag>

    <Name>TemplateName</Name>

    <Mode>Sync</Mode>

    <Codec>pcm</Codec>
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    <VoiceType>ruxue</VoiceType>

    <Volume>2</Volume>

    <Speed>200</Speed>

</Request>

Response

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive
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Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>Tts</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <TtsTpl>

            <Mode>Sync</Mode>

            <Codec>pcm</Codec>

            <VoiceType>ruxue</VoiceType>

            <Volume>2</Volume>

            <Speed>200</Speed>

        </TtsTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Updating Video Montage Template
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to update a video montage template.

Request

Sample request
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PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>VideoMontage</Tag>

    <Name>TemplateName</Name>

    <Duration>10.5</Duration>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

        <Remove>false</Remove>

    </Audio>

    <AudioMix>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

    </AudioMix>

</Request>

The nodes are described as follows:

Node 
Name 
(Keyword)

Parent 
Node Description Type Required

Request None Same as Request in the video montage template 
creation API.﻿

Container Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49914
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <Template>

        <Tag>VideoMontage</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <VideoMontage>

            <Duration>10.5</Duration>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>
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                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

                <Remove>false</Remove>

            </Audio>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

            </AudioMix>

        </VideoMontage>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node 
Name 
(Keyword)

Parent Node Description Type

Response None Same as Response in the video montage template creation API.﻿ Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49914
https://intl.cloud.tencent.com/document/product/1045/49353
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PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoMontage</Tag>

    <Name>TemplateName</Name>

    <Duration>10.5</Duration>

    <Container>
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        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

        <Remove>false</Remove>

    </Audio>

    <AudioMix>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

    </AudioMix>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>VideoMontage</Tag>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 2152
of 2300

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <VideoMontage>

            <Duration>10.5</Duration>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

                <Remove>false</Remove>

            </Audio>

            <AudioMix>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix.mp3

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

            </AudioMix>

        </VideoMontage>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Updating Video Enhancement Template
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to update a video enhancement template.

Request

Sample request
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PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>VideoProcess</Tag>

    <Name>TemplateName</Name>

    <ColorEnhance>

        <Enable>true</Enable>

        <Contrast></Contrast>

        <Correction></Correction>

        <Saturation></Saturation>

    </ColorEnhance>

    <MsSharpen>

        <Enable>true</Enable>

        <SharpenLevel></SharpenLevel>

    </MsSharpen>

</Request>

The nodes are described as follows:

Node 
Name 
(Keyword)

Parent 
Node Description Type Required

Request None Same as Request in the video enhancement template 
creation API.﻿

Container Yes

Response

Response headers

Note: 

Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49915
https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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<Response>

    <Template>

        <Tag>VideoProcess</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <VideoProcess>

            <ColorEnhance>

                <Enable>true</Enable>

                <Contrast></Contrast>

                <Correction></Correction>

                <Saturation></Saturation>
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            </ColorEnhance>

            <MsSharpen>

                <Enable>true</Enable>

                <SharpenLevel></SharpenLevel>

            </MsSharpen>

        </VideoProcess>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node 
Name 
(Keyword)

Parent 
Node Description Type

Response None Same as Response in the video enhancement template creation 
API.﻿

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49915
https://intl.cloud.tencent.com/document/product/1045/49353
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PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoProcess</Tag>

    <Name>TemplateName</Name>

    <ColorEnhance>

        <Enable>true</Enable>
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        <Contrast></Contrast>

        <Correction></Correction>

        <Saturation></Saturation>

    </ColorEnhance>

    <MsSharpen>

        <Enable>true</Enable>

        <SharpenLevel></SharpenLevel>

    </MsSharpen>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>VideoProcess</Tag>
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        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <VideoProcess>

            <ColorEnhance>

                <Enable>true</Enable>

                <Contrast></Contrast>

                <Correction></Correction>

                <Saturation></Saturation>

            </ColorEnhance>

            <MsSharpen>

                <Enable>true</Enable>

                <SharpenLevel></SharpenLevel>

            </MsSharpen>

        </VideoProcess>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Updating Voice/Sound Separation Template
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to update a voice/sound separation template.

Request

Sample request
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PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>VoiceSeparate</Tag>

    <Name>TemplateName</Name>

    <AudioMode>IsAudio</AudioMode>

    <AudioConfig>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>2</Channels>

    </AudioConfig>

</Request>

The nodes are described as follows:

Node 
Name 
(Keyword)

Parent 
Node Description Type Required

Request None Same as Request in the voice/sound separation 
template creation API.﻿

Container Yes

Response

Response headers

Note: 

Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49916#Request
https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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<Response>

    <Template>

        <Tag>VoiceSeparate</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <VoiceSeparate>

            <AudioMode>IsAudio</AudioMode>

            <AudioConfig>

                <Codec>mp3</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>12</Bitrate>
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                <Channels>2</Channels>

            </AudioConfig>

        </VoiceSeparate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node 
Name 
(Keyword)

Parent 
Node Description Type

Response None Same as Response in the voice/sound separation template creation 
API.﻿

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49916#Response
https://intl.cloud.tencent.com/document/product/1045/49353
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PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VoiceSeparate</Tag>

    <Name>TemplateName</Name>

    <AudioMode>IsAudio</AudioMode>

    <AudioConfig>
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        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </AudioConfig>

</Request>

Response

HTTP/1.1 200 OK

Content-Type: application/xml
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Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>VoiceSeparate</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <VoiceSeparate>

            <AudioMode>IsAudio</AudioMode>

            <AudioConfig>

                <Codec>mp3</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>12</Bitrate>

                <Channels>2</Channels>

            </AudioConfig>

        </VoiceSeparate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Updating Watermark Template
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to update a watermark template.

Request

Sample request
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PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>Watermark</Tag>

    <Name>TemplateName</Name>

    <Watermark>

        <Type>Text</Type>

        <LocMode>Absolute</LocMode>

        <Dx>128</Dx>

        <Dy>128</Dy>

        <Pos>TopRight</Pos>

        <StartTime>0</StartTime>

        <EndTime>100.5</EndTime>

        <Text>

            <Text>Watermark content</Text>

            <FontSize>30</FontSize>

            <FontType></FontType>

            <FontColor>0xRRGGBB</FontColor>

            <Transparency>30</Transparency>

        </Text>

    </Watermark>

</Request>

The nodes are described as follows:

Node 
Name 
(Keyword)

Parent Node Description Type Required

Request None Same as Request in the watermark template 
creation API.﻿

Container Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49917#Request
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Tag>Watermark</Tag>

        <Name>TemplateName</Name>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>
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            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>Watermark content</Text>

                <FontSize>30</FontSize>

                <FontType></FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node 
Name 
(Keyword)

Parent 
Node Description Type

Response None Same as Response in the watermark template creation API.﻿ Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49917#Response
https://intl.cloud.tencent.com/document/product/1045/49353
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PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Watermark</Tag>

    <Name>TemplateName</Name>

    <Watermark>

        <Type>Text</Type>
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        <LocMode>Absolute</LocMode>

        <Dx>128</Dx>

        <Dy>128</Dy>

        <Pos>TopRight</Pos>

        <StartTime>0</StartTime>

        <EndTime>100.5</EndTime>

        <Text>

            <Text>Watermark content</Text>

            <FontSize>30</FontSize>

            <FontType></FontType>

            <FontColor>0xRRGGBB</FontColor>

            <Transparency>30</Transparency>

        </Text>

    </Watermark>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>
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        <Tag>Watermark</Tag>

        <Name>TemplateName</Name>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>Watermark content</Text>

                <FontSize>30</FontSize>

                <FontType></FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Updating Intelligent Thumbnail Template
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to update an intelligent thumbnail template.

Request

Sample request
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PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>SmartCover</Tag>

    <Name>TemplateName</Name>

    <SmartCover>

        <Format>jpg</Format>

        <Width>1280</Width>

        <Height>960</Height>

        <Count>10</Count>

        <DeleteDuplicates>true</DeleteDuplicates>

    </SmartCover>

</Request>

The nodes are described as follows:

Node 
Name 
(Keyword)

Parent 
Node Description Type Required

Request None Same as Request in the intelligent thumbnail template 
creation API.﻿

Container Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/50614
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <Template>

        <Tag>SmartCover</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f43110a08702470b8fa75894629501fa</TemplateId>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SmartCover>

            <Width>1280</Width>

            <Height>960</Height>

            <Format>jpg</Format>
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            <Count>5</Count>

            <DeleteDuplicates>false</DeleteDuplicates>

        </SmartCover>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

The nodes are as described below:

Node 
Name 
(Keyword)

Parent Node Description Type

Response None Same as Response in the intelligent thumbnail template 
creation API.﻿

Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/50614
https://intl.cloud.tencent.com/document/product/1045/33700
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PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SmartCover</Tag>

    <Name>TemplateName</Name>

    <SmartCover>

        <Format>jpg</Format>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 2189
of 2300

        <Width>1280</Width>

        <Height>960</Height>

        <Count>10</Count>

        <DeleteDuplicates>true</DeleteDuplicates>

    </SmartCover>

</Request>

Response

HTTP/1.1 200 OK

Content-Type: application/xml
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Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>SmartCover</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f43110a08702470b8fa75894629501fa</TemplateId>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SmartCover>

            <Width>1280</Width>

            <Height>960</Height>

            <Format>jpg</Format>

            <Count>5</Count>

            <DeleteDuplicates>false</DeleteDuplicates>

        </SmartCover>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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AI-Based Content Recognition
Creating AI-Based Content Recognition
Template
Creating Speech Recognition Template
Last updated：2024-03-01 17:29:56

Feature Description

This API is used to create a speech recognition template.

Request

Sample request
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POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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<Request>

    <Tag>SpeechRecognition</Tag>

    <Name>TemplateName</Name>

    <SpeechRecognition>

        <EngineModelType>16k_zh</EngineModelType>

        <ResTextFormat>1</ResTextFormat>

        <FilterDirty>0</FilterDirty>

        <FilterModal>1</FilterModal>

        <ConvertNumMode>0</ConvertNumMode>

        <SpeakerDiarization>1</SpeakerDiarization>

        <SpeakerNumber>0</SpeakerNumber>

        <FilterPunc>0</FilterPunc>

        <OutputFileType>txt</OutputFileType>

    </SpeechRecognition>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required Constraints

Tag Request Template tag: 
SpeechRecognition.

String Yes No

Name Request

Template name, which can 
contain letters, digits, 
underscores (_), hyphens (-), 
and asterisks (*).

String Yes None

SpeechRecognition Request Speech recognition parameter. Container Yes None

 SpeechRecognition  has the following sub-nodes:

SpeechRecognition has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

EngineModelType Request.Speech
 Engine model type, divided into phone call String Yes
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Recognition and non-phone call scenarios.
Phone call scenarios:
8k_zh: 8 kHz, for Mandarin in general 
scenarios (available for dual-channel 
audio).
8k_zh_s: 8 kHz, for Mandarin with 
speaker separation (available for mono-
channel audio only).
8k_en: 8 kHz, for English.
Non-phone call scenarios:
16k_zh: 16 kHz, for Mandarin in general 
scenarios.
16k_zh_video: 16 kHz, for audio/video 
scenarios.
16k_en: 16 kHz, for English.
16k_ca: 16 kHz, for Cantonese.
16k_ja: 16 kHz, for Japanese.
16k_zh_edu: For Mandarin in education 
scenarios.
16k_en_edu: For English in education 
scenarios.
16k_zh_medical: For healthcare 
scenarios.
16k_th: For Thai.
16k_zh_dialect: Multi-dialect, for up to 23 
dialects.
Fast ASR is only supported for 8k_zh, 
16k_zh, 16k_en, and 16k_zh_video.

ChannelNum
Request.Speech

Recognition

This parameter is supported only for 
general ASR.
Number of sound channels:
1: Mono. If EngineModelType is not the 
phone call scenario, only mono channel is 
supported.
2: Dual (for the 8k_zh engine only, where 
the two channels correspond to the caller 
and callee respectively).

Integer Yes

ResTextFormat Request.Speech

Recognition

This parameter is supported only for 
general ASR.
Format of the returned recognition result.
0: Recognition result text, including the list 
of segment timestamps.
1: Detailed word-level recognition result, 
excluding punctuation marks but including 

Integer Yes
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the speech speed value (the list of word 
timestamps, generally used to generate 
subtitles).
2: Detailed word-level recognition result, 
including punctuation marks and the 
speech speed value.

FilterDirty Request.Speech

Recognition

Whether to filter restricted words (for the 
Mandarin engine only).
0: Does not filter.
1: Filters.
2: Replaces restricted words with *.
Default value: 0.

Integer No

FilterModal Request.Speech

Recognition

Whether to filter modal particles (for the 
Mandarin engine only).
0: Does not filter.
1: Filters partially.
2: Filters strictly.
Default value: 0.

Integer No

ConvertNumMode Request.Speech

Recognition

Whether to intelligently convert Chinese 
numbers to Arabic numerals (for the 
Mandarin engine only):
0: Directly outputs Chinese numbers.
1: Intelligently converts based on the 
scenario.
3: Enables mathematic number 
conversion. This parameter is supported 
only for general ASR.
Default value: 0.

Integer No

SpeakerDiarization
Request.Speech

Recognition

Whether to enable speaker separation:
0: No.
1: Yes (for mono-channel audios with the 
8k_zh, 16k_zh, or 16k_zh_video engine 
only).
Default value: 0.

Note: In the 8 kHz phone call scenario, we 
recommend you use dual channels to 
distinguish between the caller and callee 
by setting ChannelNum=2, so you don't 
need to enable speaker separation.

Integer No

SpeakerNumber Request.Speech

Recognition

This parameter is supported only for 
general ASR.

Integer No
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Number of speakers to be separated (with 
speaker separation enabled). Value 
range: 0–10.
0: Automatic separation (currently only for 
six or fewer people only). 1–10: Specified 
number of speakers to be separated. 
Default value: 0.

FilterPunc
Request.Speech

Recognition

Whether to filter punctuation marks 
(currently for the Mandarin engine only):
0: Does not filter.
1: Filters the punctuation mark at the end 
of the sentence.
2: Filters all punctuation marks.
Default value: 0.

Integer No

OutputFileType
Request.Speech

Recognition

Output file type. Valid values: txt (default), 
srt 
txt is supported only for fast ASR.

String No

FlashAsr Request.Speech

Recognition

Whether to enable fast ASR. Valid values: 
true, false (default).

String No

Format
Request.Speech

Recognition

Audio format for fast ASR. Supported 
formats include WAV, PCM, OGG-OPUS, 
SPEEX, SILK, MP3, M4A, and AAC.

String
Yes if 
FlashAsr 
is true

FirstChannelOnly
Request.Speech

Recognition

Whether to recognize only the first sound 
channel (in fast ASR mode). Valid values: 
0 (recognizes all sound channels); 1 
(recognizes the first sound channel). 
Default value: 1.

Integer No

WordInfo
Request.Speech

Recognition

Whether to display word-level timestamps 
(in fast ASR mode). Valid values: 0 (no); 1 
(yes, excluding punctuation timestamps), 
2 (yes, including punctuation timestamps). 
Default value: 0.

Integer No

Response

Response headers
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This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

<Response>

    <Template>

        <Tag>SpeechRecognition</Tag>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>SpeechRecognition</Tag>

https://intl.cloud.tencent.com/document/product/1045/43610
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        <CreateTime></CreateTime>

        <UpdateTime></UpdateTime>

        <BucketId></BucketId>

        <Category>Custom</Category>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ResTextFormat>1</ResTextFormat>

            <FilterDirty>0</FilterDirty>

            <FilterModal>1</FilterModal>

            <ConvertNumMode>0</ConvertNumMode>

            <SpeakerDiarization>1</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

            <OutputFileType>txt</OutputFileType>

        </SpeechRecognition>

    </Template>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

TemplateId Response.Template Template ID String

Name Response.Template Template name String

BucketId Response.Template Template bucket String

Category Response.Template Template category: Custom or Official String

Tag Response.Template Template tag: SpeechRecognition. String

UpdateTime Response.Template Update time String

CreateTime Response.Template Creation time String

SpeechRecognition Response.Template
Same as  Request.SpeechRecognition  
in the request body.

Container

Error codes
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There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

https://intl.cloud.tencent.com/document/product/1045/33700
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Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SpeechRecognition</Tag>

    <Name>TemplateName</Name>

    <SpeechRecognition>

        <EngineModelType>16k_zh</EngineModelType>

        <ResTextFormat>1</ResTextFormat>

        <FilterDirty>0</FilterDirty>

        <FilterModal>1</FilterModal>

        <ConvertNumMode>0</ConvertNumMode>

        <SpeakerDiarization>1</SpeakerDiarization>

        <SpeakerNumber>0</SpeakerNumber>

        <FilterPunc>0</FilterPunc>

        <OutputFileType>txt</OutputFileType>

    </SpeechRecognition>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>
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        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>SpeechRecognition</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <ResTextFormat>0</ResTextFormat>

            <FilterDirty>1</FilterDirty>

            <FilterModal>0</FilterModal>

            <ConvertNumMode>1</ConvertNumMode>

            <SpeakerDiarization>0</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

        </SpeechRecognition>

    </Template>

</Response>
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Querying AI-Based Content Recognition
Template
DescribeTemplates
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to query a template.

Request

Sample request
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GET /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (See Request Signature for details.)

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses Common Request Headers.

Request body

The request body of this request is empty.

Request parameters

The nodes are described as follows:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

tag None Template tag. Default value:  All . String No

category None
Valid values:  Official  (system preset template); 
 Custom  (custom template). Default value: 
 Custom .

String No

ids None Template ID. If you enter multiple IDs, separate them 
with commas (,).

String No

name None Template name prefix String No

pageNumber None Page number. Default value:  1 . Integer No

pageSize None Number of records per page. Default value:  10 . Integer No

Supported  tag  types are as follows:

Template type tag

Speech recognition SpeechRecognition

Response

Response headers

This API only returns Common Response Headers.

Response body

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
https://intl.cloud.tencent.com/document/product/1045/43610
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The response body returns application/xml data. The following contains all the nodes:

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <TemplateList>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Tag>SpeechRecognition</Tag>
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        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ResTextFormat>1</ResTextFormat>

            <FilterDirty>0</FilterDirty>

            <FilterModal>1</FilterModal>

            <ConvertNumMode>0</ConvertNumMode>

            <SpeakerDiarization>1</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

            <OutputFileType>txt</OutputFileType>

        </SpeechRecognition>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

RequestId Response Unique ID of the request String

TotalCount Response Total number of templates Int

PageNumber Response
Current page number. Same as  pageNumber  in 
the request.

Int

PageSize Response
Number of records per page. Same as  pageSize  
in the request.

Int

TemplateList Response Template array Container array

For different types of templates, the  TemplateList  content is the same as the  Response  of the corresponding 

template creation API. For more information, see:Speech Recognition﻿

Error codes

No special error message will be returned for this request. For the common error messages, please see Error Codes.

https://intl.cloud.tencent.com/document/product/1045/50303
https://intl.cloud.tencent.com/document/product/1045/33700
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Examples

Example 1: query by template ID

Request

GET /template?ids=t1847cd4ca57f543e89f551dbe68169eb9,t1a30a323f55434a29b25bf2a16bdf

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 0
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Content-Type: application/xml

Response

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****
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<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TemplateList>

        <TemplateId>t1847cd4ca57f543e89f551dbe68169eb9</TemplateId>

        <Name>TemplateName</Name>

        <Tag>SpeechRecognition</Tag>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ResTextFormat>1</ResTextFormat>

            <FilterDirty>0</FilterDirty>

            <FilterModal>1</FilterModal>

            <ConvertNumMode>0</ConvertNumMode>

            <SpeakerDiarization>1</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

            <OutputFileType>txt</OutputFileType>

        </SpeechRecognition>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

    <TemplateList>

        <TemplateId>t1a30a323f55434a29b25bf2a16bdf5f59</TemplateId>

        <Name>TemplateName</Name>

        <Tag>SpeechRecognition</Tag>

        <SpeechRecognition>

            <EngineModelType>8k_zh_s</EngineModelType>

            <ResTextFormat>1</ResTextFormat>

            <FilterDirty>0</FilterDirty>

            <FilterModal>1</FilterModal>

            <ConvertNumMode>0</ConvertNumMode>

            <SpeakerDiarization>1</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

            <OutputFileType>txt</OutputFileType>

        </SpeechRecognition>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

    <NonExistTIDs>

        <TemplateId>C</TemplateId>

    </NonExistTIDs>

</Response>

Example 2: query by paginated list

Request
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GET /template?pageSize=10&pageNumber=1 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>2</TotalCount>
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    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <TemplateList>

        <TemplateId>t1847cd4ca57f543e89f551dbe68169eb9</TemplateId>

        <Name>TemplateName</Name>

        <Tag>SpeechRecognition</Tag>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ResTextFormat>1</ResTextFormat>

            <FilterDirty>0</FilterDirty>

            <FilterModal>1</FilterModal>

            <ConvertNumMode>0</ConvertNumMode>

            <SpeakerDiarization>1</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

            <OutputFileType>txt</OutputFileType>

        </SpeechRecognition>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

    <TemplateList>

        <TemplateId>t1a30a323f55434a29b25bf2a16bdf5f59</TemplateId>

        <Name>TemplateName</Name>

        <Tag>SpeechRecognition</Tag>

        <SpeechRecognition>

            <EngineModelType>8k_zh_s</EngineModelType>

            <ResTextFormat>1</ResTextFormat>

            <FilterDirty>0</FilterDirty>

            <FilterModal>1</FilterModal>

            <ConvertNumMode>0</ConvertNumMode>

            <SpeakerDiarization>1</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

            <OutputFileType>txt</OutputFileType>

        </SpeechRecognition>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

</Response>
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Updating AI-Based Content Recognition
Template
Updating Speech Recognition Template
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to update a speech recognition template.

Request

Sample request
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PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Tag>SpeechRecognition</Tag>

    <Name>TemplateName</Name>

    <SpeechRecognition>

        <EngineModelType>16k_zh</EngineModelType>

        <ResTextFormat>1</ResTextFormat>

        <FilterDirty>0</FilterDirty>

        <FilterModal>1</FilterModal>

        <ConvertNumMode>0</ConvertNumMode>

        <SpeakerDiarization>1</SpeakerDiarization>

        <SpeakerNumber>0</SpeakerNumber>

        <FilterPunc>0</FilterPunc>

        <OutputFileType>txt</OutputFileType>

    </SpeechRecognition>

</Request>

The nodes are described as follows:

Node 
Name 
(Keyword)

Parent 
Node Description Type Required

Request None Same as Request in the speech recognition template 
creation API.﻿

Container Yes

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/50303#Request
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>SpeechRecognition</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SpeechRecognition>
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            <EngineModelType>16k_zh</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <ResTextFormat>0</ResTextFormat>

            <FilterDirty>1</FilterDirty>

            <FilterModal>0</FilterModal>

            <ConvertNumMode>1</ConvertNumMode>

            <SpeakerDiarization>0</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

        </SpeechRecognition>

    </Template>

</Response>

The nodes are as described below:

Node 
Name 
(Keyword)

Parent 
Node Description Type

Response None Same as Response in the text-to-speech template creation API.﻿ Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/50303
https://intl.cloud.tencent.com/document/product/1045/49353
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PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-si

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SpeechRecognition</Tag>

    <Name>TemplateName</Name>

    <SpeechRecognition>

        <EngineModelType>16k_zh</EngineModelType>
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        <ResTextFormat>1</ResTextFormat>

        <FilterDirty>0</FilterDirty>

        <FilterModal>1</FilterModal>

        <ConvertNumMode>0</ConvertNumMode>

        <SpeakerDiarization>1</SpeakerDiarization>

        <SpeakerNumber>0</SpeakerNumber>

        <FilterPunc>0</FilterPunc>

        <OutputFileType>txt</OutputFileType>

    </SpeechRecognition>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>
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        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>SpeechRecognition</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <ResTextFormat>0</ResTextFormat>

            <FilterDirty>1</FilterDirty>

            <FilterModal>0</FilterModal>

            <ConvertNumMode>1</ConvertNumMode>

            <SpeakerDiarization>0</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

        </SpeechRecognition>

    </Template>

</Response>
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Batch Job APIs
Triggering Job (Independent Node)
Last updated：2024-02-27 15:58:00

Overview

This API is used to trigger a batch data processing job through independent job parameters.

Request

Sample request
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POST /inventorytriggerjob HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

Note: 
Authorization: Auth String (See Request Signature for details.)

https://intl.cloud.tencent.com/document/product/436/7778
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When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses Common Request Headers.

Request body

This request requires the following request body:

<Request>

https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/43609
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    <Name>demo</Name>

    <Type>Job</Type>

    <Input>

        <Prefix>input</Prefix>

    </Input>

    <Operation>

        <TimeInterval>

            <Start>2022-02-01T12:00:00+0800</Start>

            <End>2022-05-01T12:00:00+0800</End>

        </TimeInterval>

        <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

        <UserData>this is my inventorytriggerjob</UserData>

        <CallBack>https://www.callback.com</CallBack>

        <Tag>Transcode</Tag>

        <JobParam>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        </JobParam>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

        </Output>

        <JobLevel>0</JobLevel>

    </Operation>

</Request>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Name Request Batch data processing job name, which can contain up 
to 128 letters, digits, hyphens, and underscores.

String Yes

Type Request Batch operation job type: Job String Yes

Input Request Information about the media to be operated Container Yes

Operation Request Operation rule Container Yes

 Input  has the following sub-nodes:
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Node Name 
(Keyword)

Parent Node Description Type Required

Manifest Request.Input
Name of the COS inventory file, i.e., the 
 manifest.json  file generated by the COS 
inventory feature.

String No

UrlFile Request.Input Name of the URL file, where each URL is a COS 
object access address.

String No

Prefix Request.Input Object prefix String No

Object Request.Input Media filename String No

 Operation  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

TimeInterval Request.Operation Trigger range filtered by time Container No

Tag Request.Operation Tag of the created media job String Yes

Output Request.Operation

Output address 
If the media job type is not 
 VideoTag , 
 ExtractDigitalWatermark , 
 MediaInfo , or 
 QualityEstimate , this 
parameter will be required.

Container No

JobParam Request.Operation Job parameter Container Yes

QueueId Request.Operation Queue ID String Yes

UserData Request.Operation User information String No

JobLevel Request.Operation
Job priority. The greater the value, the 
higher the priority. Valid values:  0 , 
 1 ,  2 . Default value:  0 .

String No

CallBackFormat Request.Operation
Job callback format, which can be 
 JSON  or  XML  (default). It has a 
higher priority than that of the queue.

String No

CallBackType Request.Operation Job callback type, which can be 
 Url  (default) or  TDMQ . It has a 

String No
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higher priority than that of the queue.

CallBack Request.Operation

Job callback address, which has a 
higher priority than that of the queue. 
If it is set to  no , no callbacks will be 
generated at the callback address of 
the queue.

String No

CallBackMqConfig Request.Operation
TDMQ configuration for job callback, 
which will be required if 
 CallBackType  is  TDMQ .

Container No

 CallBackMqConfig  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required

MqRegion Request.Operation.CallBackMqConfig

Message queue region. Valid 
values:  sh  (Shanghai), 
 bj  (Beijing),  gz  
(Guangzhou),  cd  
(Chengdu),  hk  (Hong Kong, 
China).

String Yes

MqMode Request.Operation.CallBackMqConfig

Message queue mode. Default 
value:  Queue . 
Topic: Topic subscription 
Queue: Queue service 

String Yes

MqName Request.Operation.CallBackMqConfig TDMQ topic name String Yes

 Operation.Tag  supports the following types:

Job Type Tag

Video-to-animated image conversion Animatin

Intelligent thumbnail SmartCover

Audio/Video transcoding Transcode

Screenshot Snapshot

Speech recognition SpeechRecognition

Audio/Video splicing Concat
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Voice/Sound separation VoiceSpearte

Video montage VideoMontage

SDR to HDR SDRtoHDR

Voice/Sound separation VoiceSeparate

Video enhancement VideoProcess

Super resolution SuperResolution

Audio/Video remuxing Segment

Video tagging VideoTag

Image processing PicProcess

Digital watermark DigitalWatermark

Digital watermark extraction ExtractDigitalWatermark

Async media information query MediaInfo

Audio/Video stream separation StreamExtract

Text to speech Tts

Audio noise cancellation NoiseReduction

Video quality analysis QualityEstimate

 TimeInterval  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value Constraints

Start Request.Operation.TimeInterval Start time String No 0

Upload time
scanned obj
%Y-%m-
%dT%H:%m

End Request.Operation.TimeInterval End time String No Current 
time

Upload time
scanned obj
%Y-%m-
%dT%H:%m
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 Output  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required Constraints

Region Request.Operation.Output Bucket region String Yes None

Bucket Request.Operation.Output Bucket name String Yes None

Object Request.Operation.Output Result filename String No

If the medi
 VoiceSep

parameter
If the medi
 Request

is greater t
included.
If the medi
 Snapshot

parameter

AuObject Request.Operation.Output
Voice/Sound result 
filename String No

If the medi
parameter
 Object  

SpriteObject Request.Operation.Output Image sprite name String No

If the medi
take effect
empty at th
If  Snapsh
 ${Number

Only the  j

StreamExtract Request.Operation.Output

Configuration 
information of the 
stream separation 
result file. If the 
media job type is 
 StreamExtract , 
this parameter will 
take effect and be 
required.

Container Yes None

 StreamExtract  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description
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Index Request.Operation.Output.StreamExtract

Stream number, which corresponds to 
 Response.MediaInfo.Stream.Video.Index  
and 
 Response.MediaInfo.Stream.Audio.Index  
in the media information. For more information, see 
Getting Media File Information. If the input media 
format is  mxf , only video streams can be extracted.

Object Request.Operation.Output.StreamExtract Result output filename

 JobParam  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

TemplateId Request.Operation.JobParam Template ID String

TranscodeTemplateId Request.Operation.JobParam

Transcoding template ID, which 
will take effect if the media job type 
is  VideoProcess , 
 SuperResolution , or 
 SDR2HDR .

Container

Animation Request.Operation.JobParam
Animated image job parameter, 
which will take effect if the media 
job type is  Animation .

Container

Transcode Request.Operation.JobParam

Transcoding job parameter, which 
will take effect if the media job type 
is  Transcode , 
 VideoProcess , 
 SuperResolution , or 
 SDR2HDR .

String

SmartCover Request.Operation.JobParam
Intelligent thumbnail job parameter, 
which will take effect if the media 
job type is  SmartCover .

Container

DigitalWatermark Request.Operation.JobParam

Digital watermark parameter, 
which will take effect if the media 
job type is  Transcode , 
 VideoProcess , 
 SuperResolution , or 
 DigitalWatermark .

Container

Watermark Request.Operation.JobParam Watermark template parameter, Container

https://intl.cloud.tencent.com/document/product/1045/43732
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which is the same as 
 Request.Watermark  in the 
watermark template creation API 
 CreateMediaTemplate  and 
will take effect if the media job type 
is  Transcode ,  SDR2HDR , 
 VideoProcess , or 
 SuperResolution .

RemoveWatermark Request.Operation.JobParam

Digital watermark removal 
parameter, which will take effect if 
the media job type is 
 Transcode .

Container

WatermarkTemplateId Request.Operation.JobParam

Watermark template parameter, 
which is the same as 
 Request.Watermark  in the 
watermark template creation API 
 CreateMediaTemplate  and 
will take effect if the media job type 
is  Transcode ,  SDR2HDR , 
 VideoProcess , or 
 SuperResolution .

Container

RemoveWatermark Request.Operation.JobParam

Digital watermark removal 
parameter, which will take effect if 
the media job type is 
 Transcode .

Container

Snapshot Request.Operation.JobParam
Screenshot job parameter, which 
will take effect if the media job type 
is  Snapshot .

Container

SpeechRecognition Request.Operation.JobParam

Speech recognition job parameter, 
which will take effect if the media 
job type is 
 SpeechRecognition .

Container

ConcatTemplate Request.Operation.JobParam
Splicing job parameter, which will 
take effect if the media job type is 
 Concat .

Container

VoiceSeparate Request.Operation.JobParam

Voice/Sound separation job 
parameter, which will take effect if 
the media job type is 
 VoiceSeparate .

Container
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VideoMontage Request.Operation.JobParam Video montage job parameter, 
which will take effect if the media 
job type is  VideoMontage .

Container

SDRtoHDR Request.Operation.JobParam
SDR-to-HDR job parameter, which 
will take effect if the media job type 
is  SDRtoHDR .

Container

VideoProcess Request.Operation.JobParam
Video enhancement job parameter, 
which will take effect if the media 
job type is  VideoProcess .

Container

SuperResolution Request.Operation.JobParam
Super resolution job parameter, 
which will take effect if the media 
job type is  SuperResolution .

Container

Segment Request.Operation.JobParam
Remuxing job parameter, which 
will take effect if the media job type 
is  Segment .

Container

ExtractDigitalWatermark Request.Operation.JobParam

Digital watermark extraction job 
parameter, which will take effect if 
the media job type is 
 ExtractDigitalWatermark .

Container

VideoTag Request.Operation.JobParam
Video tagging job parameter, 
which will take effect if the media 
job type is  VideoTag .

Container

TtsTpl Request.Operation.JobParam
Text-to-speech template 
parameter, which will take effect if 
the media job type is  Tts .

Container

Note: 
 TemplateId  is used first. If  TemplateId  is unavailable, the corresponding job type parameter is used.

 DigitalWatermark  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type

Message Request.Operation.JobParam.DigitalWatermark The string embedded by the 
digital watermark, which can 
contain up to 64 letters, digits, 

String
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underscores (_), hyphens (-), 
and asterisks (*).

Type Request.Operation.JobParam.DigitalWatermark
Watermark type, which 
currently can be set to  Text  
only.

String

Version Request.Operation.JobParam.DigitalWatermark
Watermark version, which 
currently can be set to  V1  
only.

String

IgnoreError Request.Operation.JobParam.DigitalWatermark

Whether to ignore the 
watermarking failure and 
continue the job. Valid values: 
 true ,  false  (default). 
If 
 Request.Operation.Tag  
is  DigitalWatermark , this 
parameter will not take effect, 
and the job will fail if watermark 
adding fails. 

String

 Animation  has the following sub-nodes:


Same as  Request.Operation.Animation  as described in Submitting Video-to-Animated Image Conversion 

Job.
 Transcode  has the following sub-nodes:


Same as  Request.Operation.Transcode  as described in Submitting Audio/Video Transcoding Job.

 Watermark  has the following sub-nodes:


Same as  Request.Operation.Watermark  as described in Submitting Audio/Video Transcoding Job.

 RemoveWatermark  has the following sub-nodes:


Same as  Request.Operation.RemoveWatermark  as described in Submitting Audio/Video Transcoding Job.

 SmartCover  has the following sub-nodes:


Same as  Request.Operation.SmartCover  as described in Submitting Intelligent Thumbnail Job.

 Snapshot  has the following sub-nodes:


Same as  Request.Operation.Snapshot  as described in Submitting Video Frame Capturing Job.

 SpeechRecognition  has the following sub-nodes:


Same as  Request.Operation.SpeechRecognition  as described in Submitting Speech Recognition Job.

 ConcatTemplate  has the following sub-nodes:


Same as  Request.Operation.ConcatTemplate  as described in Submitting Video Splicing Job.

https://intl.cloud.tencent.com/document/product/1045/49569
https://intl.cloud.tencent.com/document/product/1045/48941
https://intl.cloud.tencent.com/document/product/1045/48941
https://intl.cloud.tencent.com/document/product/1045/48941
https://intl.cloud.tencent.com/document/product/1045/48937
https://intl.cloud.tencent.com/document/product/1045/48938
https://intl.cloud.tencent.com/document/product/1045/48929
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 VoiceSeparate  has the following sub-nodes:


Same as  Request.Operation.VoiceSeparate  as described in Submitting Voice/Sound Separation Job.

 VideoMontage  has the following sub-nodes:


Same as  Request.Operation.VideoMontage  as described in Submitting Video Montage Job.

 SDRtoHDR  has the following sub-nodes:


Same as  Request.Operation.SDRtoHDR  as described in Submitting SDR-to-HDR Job.

 VideoProcess  has the following sub-nodes:


Same as  Request.Operation.VideoProcess  as described in Submitting Video Enhancement Job.

 SuperResolution  has the following sub-nodes:


Same as  Request.Operation.SuperResolution  as described in Submitting Super Resolution Job.

 Segment  has the following sub-nodes:


Same as  Request.Operation.Segment  as described in Submitting Remuxing Job.

 ExtractDigitalWatermark  has the following sub-nodes:


Same as  Request.Operation.ExtractDigitalWatermark  as described in Submitting Digital Watermark 

Extracting Job.
 VideoTag  has the following sub-nodes:


Same as  Request.Operation.VideoTag  as described in Submitting Video Tagging Job.

 TtsTpl  has the following sub-nodes:


Same as  Request.Operation.TtsTpl  as described in Submitting Text-to-Speech Job.

Response

Response headers

This API only returns Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/48946
https://intl.cloud.tencent.com/document/product/1045/48943
https://intl.cloud.tencent.com/document/product/1045/48935
https://intl.cloud.tencent.com/document/product/1045/48944
https://intl.cloud.tencent.com/document/product/1045/48940
https://intl.cloud.tencent.com/document/product/1045/48936
https://intl.cloud.tencent.com/document/product/1045/48931
https://intl.cloud.tencent.com/document/product/1045/48945
https://intl.cloud.tencent.com/document/product/1045/48942
https://intl.cloud.tencent.com/document/product/1045/43610
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<Response>

    <RequestId>NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==<RequestId>

    <JobsDetail>

        <Code>Success</Code>

        <Type>Job</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>be8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>2022-06-27T15:23:11+0800</StartTime>    
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        <EndTime>2022-06-27T15:25:10+0800</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

            <UserData>this is my inventorytriggerjob</UserData>

            <CallBack>https://www.callback.com</CallBack>

            <Tag>Transcode</Tag>

            <JobParam>

                <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            </JobParam>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

            </Output>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

The nodes are described as follows:

Node Name (Keyword) Parent Node Description Type

Response None Result storage container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RequestId Response Unique ID of the request String

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String
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Message Response.JobsDetail Error message, which will be returned only if 
 State  is  Failed 

String

Type Response.JobsDetail Batch operation job type: Job String

Name Response.JobsDetail Job name String

JobId Response.JobsDetail Job ID String

State Response.JobsDetail
Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String

CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

Input Response.JobsDetail
Input resource address of the job, which is the same 
as the  Request.Input  node in the request. Container

Operation Response.JobsDetail
Operation rule, which is the same as the 
 Request.Input Operation  node in the 
request.

Container

Error codes

No special error message will be returned for this request. For the common error messages, please see Error Codes.

Examples

Request

https://intl.cloud.tencent.com/document/product/1045/33700


Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 2241
of 2300

POST /inventorytriggerjob HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Name>demo</Name>

    <Type>Job</Type>

    <Input>

        <Prefix>input</Prefix>
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    </Input>

    <Operation>

        <TimeInterval>

            <Start>2022-02-01T12:00:00+0800</Start>

            <End>2022-05-01T12:00:00+0800</End>

        </TimeInterval>

        <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

        <UserData>this is my inventorytriggerjob</UserData>

        <CallBack>https://www.callback.com</CallBack>

        <Tag>Transcode</Tag>

        <JobParam>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        </JobParam>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

        </Output>

        <JobLevel>0</JobLevel>

    </Operation>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==

<Response>

    <RequestId>NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==<RequestId>

    <JobsDetail>
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        <Code>Success</Code>

        <Type>Job</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>be8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>2022-06-27T15:23:11+0800</StartTime>    

        <EndTime>2022-06-27T15:25:10+0800</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

            <UserData>this is my inventorytriggerjob</UserData>

            <CallBack>https://www.callback.com</CallBack>

            <Tag>Transcode</Tag>

            <JobParam>

                <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            </JobParam>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

            </Output>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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Triggering Job
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to trigger a batch data processing job through workflow.

Request

Sample request
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POST /inventorytriggerjob HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

Note: 
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Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request requires the following request body:

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
https://intl.cloud.tencent.com/document/product/1045/49351
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<Request>

    <Name>demo</Name>

    <Type>Workflow</Type>

    <Input>

        <Prefix>input</Prefix>

    </Input>

    <Operation>

        <TimeInterval>

            <Start>2022-02-01T12:00:00+0800</Start>

            <End>2022-05-01T12:00:00+0800</End>

        </TimeInterval>

        <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

    </Operation>

</Request>

The nodes are described as follows:

Node Name 
(Keyword)

Parent Node Description Type Required

Request None Request container Container Yes

 Request  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

Name Request Batch data processing job name, which can contain 
up to 128 letters, digits, hyphens, and underscores.

String Yes

Type Request Batch operation job type:  Workflow . String No

Input Request Information of the media file to be processed Container Yes

Operation Request Operation rule Container Yes

 Input  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type Required

Manifest Request.Input
Name of the COS inventory file, i.e., the 
 manifest.json  file generated by the COS 
inventory feature.

String No

UrlFile Request.Input Name of the URL file, where each URL is a COS String No
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object access address.

Prefix Request.Input Object prefix String No

Object Request.Input Media filename String No

 Operation  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type Required

WorkflowIds Request.Operation ID of the triggered workflow String Yes

TimeInterval Request.Operation Trigger range filtered by time Container No

 TimeInterval  has the following sub-nodes:

Node 
Name 
(Keyword)

Parent Node Description Type Required
Default 
Value Constraints

Start Request.TimeInterval Start time String No 0

Upload time of the 
scanned object 
%Y-%m-
%dT%H:%m:%S%z 

End Request.TimeInterval End time String No Current 
time

Upload time of the 
scanned object 
%Y-%m-
%dT%H:%m:%S%z

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <Type>Workflow</Type>

        <Name>demo</Name>

        <JobId>b3deffea2f84911ec9cb15254008618d9</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>
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        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

        </Operation>

    </JobsDetail>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RequestId Response Unique ID of the request String

JobsDetail Response Job details Container

 JobsDetail  has the following sub-nodes:

Node Name 
(Keyword)

Parent Node Description Type

Code Response.JobsDetail
Error code, which is returned only if  State  is 
 Failed 

String

Message Response.JobsDetail
Error message, which is returned only if  State  is 
 Failed 

String

Type Response.JobsDetail Batch operation job type String

Name Response.JobsDetail Job name String

JobId Response.JobsDetail Job ID String

State Response.JobsDetail
Job status. Valid values:  Submitted , 
 Running ,  Success ,  Failed ,  Pause , 
 Cancel .

String
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CreationTime Response.JobsDetail Job creation time String

StartTime Response.JobsDetail Job start time String

EndTime Response.JobsDetail Job end time String

Input Response.JobsDetail Same as  Request.Input  in the request Container

Operation Response.JobsDetail Same as  Request.Operation  in the request Container

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49353
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POST /inventorytriggerjob HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Name>demo</Name>

    <Type>Workflow</Name>

    <Input>

        <Prefix>input</Prefix>
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    </Input>

    <Operation>

        <TimeInterval>

            <Start>2022-02-01T12:00:00+0800</Start>

            <End>2022-05-01T12:00:00+0800</End>

        </TimeInterval>

        <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

    </Operation>

</Request>

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>
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        <Type>Workflow</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>b3deffea2f84911ec9cb15254008618d9</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

        </Operation>

    </JobsDetail>

</Response>
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Canceling Job
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to cancel a batch data processing job.

Request

Sample request
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PUT /inventorytriggerjob/<jobId>?cancel HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request does not have a request body.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

This request has no response body.

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/49351
https://intl.cloud.tencent.com/document/product/1045/49352
https://intl.cloud.tencent.com/document/product/1045/49353
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PUT /inventorytriggerjob/b-xxx-xxx-xxx-xxxx?cancel HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=
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Querying Job
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to query a batch data processing job.

Request

Sample request
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GET /inventorytriggerjob/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted as instructed in Authorization 
Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

The request body of this request is empty.

Response

Response headers

This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

https://intl.cloud.tencent.com/document/product/1045/49351
https://intl.cloud.tencent.com/document/product/1045/49352
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<Response>

    <RequestId><RequestId>

    <JobsDetail>

    ...

    </JobsDetail>

    <NonExistJobIds></NonExistJobIds>

</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type
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Response None Response container Container

 Response  has the following sub-nodes:

Node Name 
(Keyword)

Parent 
Node

Description Type

RequestId Response Unique ID of the request String

JobsDetail Response Job details Container

NonExistJobIds Response List of non-existing job IDs queried. If all jobs exist, this node 
will not be returned.

String

The content of  JobsDetail  varies by triggering method. For more information, see the following documents:

Triggering Job (Workflow)﻿
Triggering Job (Independent Node)

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/47029
https://intl.cloud.tencent.com/document/product/1045/49353
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GET /inventorytriggerjob/b3deffea2f84911ec9cb15254008618d9 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==

<Response>

    <RequestId>NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==</RequestId>

    <JobsDetail>
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        <Code>Success</Code>

        <Type>Workflow</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>b3deffea2f84911ec9cb15254008618d9</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

        </Operation>

    </JobsDetail>

</Response>
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Pulling Jobs in Batches
Last updated：2024-02-27 15:58:00

Feature Description

This API is used to get the list of batch data processing jobs.

Request

Sample request
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GET /inventorytriggerjob?size=&states=&startCreationTime=&endCreationTime= HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Note: 
Authorization: Auth String (for more information, see Request Signature).
When this feature is used by a sub-account, relevant permissions must be granted. For more information, see 
Authorization Granularity Details.

https://intl.cloud.tencent.com/document/product/436/7778
https://intl.cloud.tencent.com/document/product/1045/49896
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Request headers

This API only uses common request headers. For more information, see Common Request Headers.

Request body

This request does not have a request body.

Request parameters

The nodes are as described below:

Node Name 
(Keyword)

Parent 
Node

Description Type Required

nextToken None Context token for pagination. String No

size None
Maximum number of jobs that can be pulled. 
The default value is  10 . The maximum value 
is  100 .

Integer No

type None
Type of the batch jobs to be obtained. Valid 
values:  Workflow ,  Job . String No

orderByTime None  Desc  (default) or  Asc  String No

States None

Status of the jobs to pull. If you enter multiple 
job statuses, separate them by comma. 
Valid values:  All  (default),  Submitted , 
 Running ,  Success ,  Failed , 
 Pause ,  Cancel .

String No

startCreationTime None
Start time of the time range for job pulling in the 
format of  %Y-%m-%dT%H:%m:%S%z . String No

endCreationTime None
End time of the time range for job pulling in the 
format of  %Y-%m-%dT%H:%m:%S%z . String No

workflowId None Workflow ID String No

jobId None Batch data processing job ID String No

name None Batch data processing job name String No

Response

Response headers

https://intl.cloud.tencent.com/document/product/1045/43609
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This API only returns common response headers. For more information, see Common Response Headers.

Response body

The response body returns application/xml data. The following contains all the nodes:

<Response>

    <RequestId></RequestId>

    <JobsDetail>

    ...

    </JobsDetail>

    <NextToken></NextToken>

https://intl.cloud.tencent.com/document/product/1045/43610
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</Response>

The nodes are as described below:

Node Name (Keyword) Parent Node Description Type

Response None Response container Container

 Response  has the following sub-nodes:

Node Name (Keyword) Parent Node Description Type

RequestId Response Unique ID of the request String

JobsDetail Response Job details Container array

NextToken Response Context token for 
pagination

String

The content of  JobsDetail  varies by triggering method. For more information, see the following documents:

Triggering Job﻿
Triggering Job (Independent Node)

Error codes

There are no special error messages for this request. For common error messages, see Error Codes.

Samples

Request

https://intl.cloud.tencent.com/document/product/1045/47029
https://intl.cloud.tencent.com/document/product/1045/33700
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GET /inventorytriggerjob HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Response
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <RequestId>NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==</RequestId>

    <JobsDetail>



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 2277
of 2300

        <Code>Success</Code>

        <Type>Workflow</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>b3deffea2f84911ec9cb15254008618d9</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Type>Job</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>be8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>2022-06-27T15:23:11+0800</StartTime>    

        <EndTime>2022-06-27T15:25:10+0800</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

            <UserData>this is my inventorytriggerjob</UserData>

            <CallBack>https://www.callback.com</CallBack>

            <JobParam>

                <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            </JobParam>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>
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                <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

            </Output>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <NextToken>25</NextToken>

</Response>
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Error Codes
Last updated：2024-02-27 15:58:00

Feature Overview

When an image fails to be downloaded, X-ErrNo contained in the header of the response packet refers to the error 
code field. In this case, you can handle the error according to the following list.
Note: 

 For other download error codes that are passed through from COS, see COS Error Codes.

Error Codes

Download errors

Error Code Description Action

-103 Invalid request. The request packet cannot be 
recognized.

Check the content of the request.

-104
Invalid APPID. The APPID contained in the URL is 
invalid, or the domain name is not bound to the 
APPID.

Check whether the APPID is correct.

-105 Invalid style name. The style name or alias specified in 
the URL is not set.

Check the style configuration or style 
name.

-106 Invalid URL. The URL format is invalid. Check the URL format.

-107 Invalid Host header field Check whether Host is correct.

-108 Invalid Referer Check the Referer configuration.

-109

Invalid style name ID. The image corresponding to the 
style name is not found. This style name may have 
been added after the image was uploaded, and 
therefore data corresponding to this style name could 
not be generated when the image was uploaded.

-

-110 The image is blocked. -

-113 The file type is not supported. For the input file types supported by 
file preview, see Rules and 

https://intl.cloud.tencent.com/document/product/436/7730
https://intl.cloud.tencent.com/document/product/1045/33425
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Restrictions.

-120
Data returned by the origin is abnormal during origin-
pull, and consequently image data cannot be properly 
retrieved.

Check the data on the origin.

-124
A download offset error has occurred. The setting of 
Range (checkpoint restart offset) for the HTTP 
request may be incorrect.

Check the checkpoint restart offset 
setting.

-154 Download is prohibited for this URL by the original 
image protection mechanism.

Use the style to access the image.

-156 Forcible execution of the 302 process -

-162 Image downloading is not allowed due to overdue 
payment.

Top up your account promptly.

-163 The business configuration does not exist. Check relevant configuration items.

-164 The request frequency is too high. Reduce the request frequency, or 
submit a ticket to contact us.

-165 Attack download requests are restricted. -

-166 Invalid message format -

-167 The image file is too large and cannot be downloaded. Reduce the size of the file.

-441
Unsupported image format. The image cannot be 
compressed.

Use a CI supported image format for 
image processing. Valid formats: 
JPG, BMP, GIF, PNG, WEBP

-442 The image size exceeds the limit. Ensure that image dimensions are 
equal to or less than 9,999 pixels.

-443 Unsupported image format Use a supported image format. For 
details, see Specifications and Limits.

-447
Image resolution exceeds the limit or the GIF file 
contains too many frames.

Limit image dimensions to 9,999 
pixels (limit the frame number of GIF 
files).

-901 Compression times out. -

-902
Origin-pull times out. Specifically, when the image 
storage feature forwards a request to the developer's 
origin, the timer expires before a response is received.

Check the origin data or origin-pull 
configuration.

https://intl.cloud.tencent.com/document/product/1045/33425
https://console.intl.cloud.tencent.com/workorder/category
https://intl.cloud.tencent.com/document/product/1045/33425
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-3006 The file is encrypted and cannot be parsed. -

-3008 The file is empty and cannot be parsed. -

-3011 The file type is not supported.
For the input file types supported by 
file preview, see Specifications and 
Limits.

-3015 The requested page number does not exist. -

-3075 This file exceeds 100 MB and cannot be parsed. Ensure that the file size is equal to or 
less than 100 MB.

-5062 The image may be illegal. Check whether the content of the 
image is illegal.

-6101 The image does not exist, is not uploaded, or has 
been deleted.

Check the raw data of the request.

-29033 The download request does not contain a valid range. -

-29034 The download offset is greater than the file size. -

-29214 Frequency control is triggered. Reduce the request frequency, or 
submit a ticket to contact us.

-40168 The original image is null. Check the raw data of the request.

-46152 Invalid bucket name Check whether the bucket name is 
valid.

-46154 Invalid APPID Check whether the APPID is valid.

-46614 Downloading is not allowed for a file that is being 
uploaded.

Send the download request after the 
file upload is completed.

-46617 A blocked entry is hit. Check whether the content of the 
image is illegal.

-46618 Signature authentication fails. Check whether the signature is 
correct.

-46619 The signature is expired. Update the signature.

-46620 The bucket is blocked. Your bucket is blocked. Submit a 
ticket for further assistance.

-46621 The file is blocked. Your resource is blocked. Submit a 
ticket for further assistance.

https://intl.cloud.tencent.com/document/product/1045/33425
https://console.intl.cloud.tencent.com/workorder/category
https://console.intl.cloud.tencent.com/workorder/category
https://console.intl.cloud.tencent.com/workorder/category
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-46627 The user is currently on the blocklist. Your account is blocked. Submit a 
ticket for further assistance.

-46628 The file does not exist. Check whether the file to be 
downloaded exists.

-46642 The APPID does not exist. Check whether the APPID is correct.

-46646 The file is blocked. The file is blocked. Check whether 
the content of the file is illegal.

-46661 No access permission Contact the resource owner for 
permission.

Persistence processing errors

Error Code Description Action

-60998 An image processing parameter is 
invalid.

Check whether image processing rules are correct.

-60997
The number of image processing 
rules exceeds the limit.

Persistence processing currently supports a maximum of 
five rules. Therefore, ensure that at most five rules are 
configured.

-60996 The file is too large to process. Ensure that the file size is less than or equal to 32 MB.

-60987 Failed to retrieve the image Check the URL of the image.

-60983 Invalid host Check the host.

-60972 Invalid region
Check if the region in the request supports CI. For more 
information on regions that support CI, see Regions and 
Domain Names.

-60967 The image style does not exist. Check the image style.

-60957 The number of used styles 
exceeds the limit.

Currently, a maximum of 100 styles are supported. If you 
need more styles, submit a ticket to contact us.

-60955 Invalid URL Check whether the URL is correct.

-60950 No file is specified. Specify the file to be processed in the request.

-60949 The request frequency is too high. Reduce the request frequency. To increase the frequency 
limit, submit a ticket.

https://console.intl.cloud.tencent.com/workorder/category
https://intl.cloud.tencent.com/document/product/1045/33423
https://console.intl.cloud.tencent.com/workorder/category
https://console.intl.cloud.tencent.com/workorder/category
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-60948 The account is suspected of 
violation.

Your APPID is blocked. Submit a ticket for further 
assistance.

-60938 Incomplete signing information Check the required items in the signing information.

-60936 The request is rejected. Access denied

-60932 Signature error The signature is invalid. Check whether the signing 
information matches.

-62999 Invalid image format Check whether the image format is valid.

File preview errors

Error 
Code

Description Action

-3006 The file is encrypted. Use a decrypted file.

-3008 The file length is 0. Check whether the file is normal.

-3011 The file type is not supported. Check whether the file type is supported. For the supported 
file types, see Specifications and Limits.

-3015
The number of requested page is 
greater than the total number of 
document pages.

Check whether the number of the requested page is 
correct.

Content moderation errors

Error Code Description Action

-61011 The file does not exist. Check whether the file exists.

-65007 File content error. Decoding 
failed.

Check whether the file format is correct.

-65010 Failed to download the file Check whether the file link is correct. For a file with private 
read permission, the file link must be signed.

-65011 The file is too large to process. Currently, an excessively large file cannot be moderated.

-65012 The image resolution is too low 
to process.

Currently, images with excessively low resolution are not 
supported.

-65013 The file is not processed 
because it does not meet 

Check whether the file meets requirements.

https://console.intl.cloud.tencent.com/workorder/category
https://intl.cloud.tencent.com/document/product/1045/33425
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requirements (e.g., unsupported 
file suffix or excessively large 
size).

-65014 No CI role (CI_QCSRole) Bind a CI role.

-65015 No moderation scenario is used. Use at least one moderation scenario for moderation.

-65016 BizType used does not exist. Enter a correct BizType.

Other Internal error -

Media processing errors

Error Code Error Message Description

1007 InternalError Internal error

1010 InvalidUrl Invalid URL

1011 InvalidContent Invalid request body

1012 MissingAuthorization Missing signature

1013 InvalidAuthorization Invalid signature

1014 SignatureExpired Signature expired

1015 InvalidArgument Invalid argument

1016 MissingContent Missing request body

1017 InvalidHost Invalid host

1018 AccessDenied Access denied

1019 SecretidNotExist The key does not exist

1020 SlowDown Frequency control

1021 InvalidContentType Invalid request body type

1100 BucketAlreadyBinded The bucket is already bound

1103 ResourceNotFound Resource not found

1106 QueueNotFound Queue not found

1107 TemplateNotFound Template not found
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1109 BindedBucketNumLimit The number of bound buckets 
exceeds the upper limit

1110 CreatedTemplateNumLimit The number of created templates 
exceeds the upper limit

1111 MediaBucketUnBinded The bucket is not bound

1112 TemplateNameDuplicate Duplicate template name

1114 ActiveWorkflowForbiddenUpdate The workflow that has been 
enabled cannot be updated

1120 WorkFlowNumLimit The number of created workflows 
exceeds the upper limit

1124 WriteTargetBucketDenied Writing to the bucket is forbidden

1145 QueueNumLimit The number of created queues 
exceeds the upper limit
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Appendix
Structure
Last updated：2024-02-27 15:58:00

MediaWorkflow_Topology_Nodes_Start_Input

Node Name (Keyword) Description Type Required Constraints

ObjectPrefix Object prefix String Yes None

QueueId Queue ID String Yes None

PicProcessQueueId
Image 
processing 
queue ID

String
Yes if there is an 
image 
processing node

None

SpeechRecognitionQueueId
Speech 
recognition 
queue ID

String
Yes if there is a 
speech 
recognition node

None

AIProcessQueueId
AI processing 
queue ID String

Yes if there is an 
AI-based 
recognition node

None

NotifyConfig

Callback 
information. If 
none is 
specified, the 
queue callback 
information is 
used.

Container No None

ExtFilter Filename 
extension filter.

Container No None

 NotifyConfig  has the following sub-nodes:

Node Name 
(Keyword)

Description Type Required Default 
Value

Constraints

Url Callback 
address

String Yes None The callback address cannot 
be a private network 
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address.

Type Callback type String Yes None
Url: URL callback
TDMQ: TDMQ message 
callback

Event
Callback 
information String Yes None

TaskFinish: Job completed
WorkflowFinish: Workflow 
completed
You can configure multiple 
events separated by comma.

ResultFormat Callback 
format

String No XML XML
JSON

MqRegion TDMQ region String No None

Yes if the callback type is 
TDMQ. For supported 
regions, see Request Domain 
Description.

MqMode TDMQ mode String No None

Yes if the callback type is 
TDMQ.
Topic: Topic subscription
Queue: Queue service

MqName TDMQ topic 
name

String No None Yes if the callback type is 
TDMQ.

 ExtFilter  has the following sub-nodes:

Node Name 
(Keyword)

Description Type Required Default 
Value

Constraints

State Switch. String No Off On/Off

Video
Require a 
video 
extension.

String No false false/true

Audio
Require an 
audio 
extension.

String No false false/true

Image
Require an 
image 
extension.

String No false false/true

https://intl.cloud.tencent.com/document/product/406/12667
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ContentType Require a 
content type.

String No false false/true

Custom
Require a 
custom 
extension.

String No false false/true

CustomExts
Custom 
extension. String No None

Separate filename 
extensions by slash (/). Up to 
ten extensions are 
supported.
If  Custom  is  true , this 
parameter is required. 

AllFile All files String No false false/true

MediaWorkflow_Topology_Nodes_***_Operation_Output

Node Name 
(Keyword)

Description Type Required Constraints

Region Bucket region String Yes None

Bucket Bucket name String Yes None

Object Result filename String Yes

If the workflow node type is 
 Snapshot  or  SmartCover , and 
there are more than one result file, 
 ${Number} $  must be included. 
If the workflow node type is 
 Segment ,  Duration  is 
specified, and  Format  is not  HLS  
or  m3u8 ,  ${Number}  must be 
included. 

SpriteObject Image sprite name String No
If the workflow node type is 
 Snapshot  and the image sprite 
feature is enabled, this field is required.

AuObject Voice result 
filename

String No
If the workflow node type is 
 VoiceSeparate  and there is a 
voice output, this field is required.
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MediaWorkflow_Topology_Nodes_Snapshot_***_Operation

Node Name 
(Keyword)

Description Type Required Constraints

TemplateId Screenshot 
template ID

String Yes None

Output Output address Container. For more information, see 
Output.

Yes None

MediaWorkflow_Topology_Nodes_Animation_***_Operation

Node Name 
(Keyword)

Description Type Required Constraints

TemplateId Video-to-animated image 
conversion template ID

String Yes None

Output Output address Container. For more 
information, see Output.

Yes None

MediaWorkflow_Topology_Nodes_SmartCover_***_Operation

Node Name 
(Keyword)

Description Type Required Constraints

TemplateId Intelligent thumbnail 
template ID

String No None

SmartCover Intelligent thumbnail 
parameter

Container. For more 
information, see SmartCover.

No None

Output Output address Container. For more 
information, see Output.

Yes None

Note: 
 Both  TemplateId  and  SmartCover  can be left empty, in which case three thumbnails will be generated 

according to the original video size by default. If both of them are specified,  TemplateId  will take effect.
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MediaWorkflow_Topology_Nodes_Transcode_***_Operation

Node Name 
(Keyword)

Description Type Required Constraints

TemplateId
Audio/Video 
transcoding 
template ID

String No None

WatermarkTemplateId
Watermark 
template ID String array No

Up to three watermark 
template IDs are 
supported.

RemoveWatermark
Watermark 
removal 
parameter

Container. For more 
information, see 
RemoveWatermark.

No None

DigitalWatermark
Digital watermark 
parameter

Container. For more 
information, see 
DigitalWatermark.

No None

Output Output address
Container. For more 
information, see 
Output.

Yes None

Input Input 
configuration

Container No None

 MediaWorkflow_Topology_Nodes_Transcode_\\*\\*\\*_Operation.Input  has the following sub-

nodes:

Node Name (Keyword) Description Type Required Constraints

SpeedTranscodingQueueId Accelerated transcoding queue String No None

MediaWorkflow_Topology_Nodes_Concat_***_Operation

Node Name 
(Keyword)

Description Type Required Constraints

TemplateId Splicing 
template ID

String Yes None
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Output Output address Container. For more information, see 
Output.

Yes None

MediaWorkflow_Topology_Nodes_VoiceSeparate_***_Operation

Node Name 
(Keyword)

Description Type Required Constraints

TemplateId
Voice/Sound 
separation 
template ID

String Yes None

Output Output address
Container. For 
more information, 
see Output.

Yes None

MediaWorkflow_Topology_Nodes_VideoMontage_***_Operation

Node Name 
(Keyword)

Description Type Required Constraints

TemplateId Video montage 
template ID

String Yes None

Output Output address Container. For more information, 
see Output.

Yes None

MediaWorkflow_Topology_Nodes_SDRtoHDR_***_Operation

Node Name 
(Keyword)

Description Type Required Constraints

SDRtoHDR SDR-to-HDR 
configuration

Container Yes None

TranscodeTemplateId
Audio/Video 
transcoding 
template ID

String Yes None

WatermarkTemplateId Watermark String array No Up to three watermark 
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template ID template IDs are 
supported.

Output Output address
Container. For more 
information, see 
Output.

Yes None

 SDRtoHDR  has the following sub-nodes:

Node Name 
(Keyword)

Description Type Required Constraints

HdrMode HDR mode String Yes HLG
HDR10

MediaWorkflow_Topology_Nodes_VideoProcess_***_Operation

Node Name 
(Keyword)

Description Type Required Constraints

TemplateId
Video 
enhancement 
template ID

String Yes None

TranscodeTemplateId
Audio/Video 
transcoding 
template ID

String Yes None

WatermarkTemplateId Watermark 
template ID

String array No

Up to three 
watermark 
template IDs are 
supported.

DigitalWatermark
Digital watermark 
parameter

Container. For more 
information, see 
DigitalWatermark.

No None

Output Output address Container. For more 
information, see Output.

Yes None

MediaWorkflow_Topology_Nodes_SCF_***_Operation
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Node Name 
(Keyword)

Description Type Required Constraints

SCF SCF function 
information

Container Yes None

 SCF  has the following sub-nodes:

Node Name 
(Keyword)

Description Type Required Constraints

Region Function region String Yes None

FunctionName Function name String Yes None

Namespace Namespace String No None

Alias Function alias String No None

MediaWorkflow_Topology_Nodes_SuperResolution_***_Operation

Node Name 
(Keyword)

Description Type Required Constraints

TemplateId Super resolution 
template ID

String Yes None

TranscodeTemplateId
Audio/Video 
transcoding 
template ID

String Yes None

WatermarkTemplateId
Watermark 
template ID String array No

Up to three 
watermark template 
IDs are supported.

DigitalWatermark
Digital 
watermark 
parameter

Container. For more 
information, see 
DigitalWatermark.

No None

Output Output address Container. For more 
information, see Output.

Yes None

MediaWorkflow_Topology_Nodes_Segment_***_Operation
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Node Name 
(Keyword)

Description Type Required Constraints

Segment
Audio/Video 
remuxing 
parameter

Container Yes None

Output Output address Container. For more 
information, see Output.

Yes None

 Segment  has the following sub-nodes:

Node Name 
(Keyword)

Description Type Required Constraints

Format Container format String Yes aac, mp3, flac, mp4, ts, mkv, avi, hls, 
m3u8

Duration
Remuxing 
duration in 
seconds

String No
The value must be an integer equal to 
or greater than 5.

HlsEncrypt HLS encryption 
configuration

Container No
This parameter takes effect only when 
the container format is  hls . For 
more information, see HlsEncrypt.

MediaWorkflow_Topology_Nodes_PicProcess_***_Operation

Node Name 
(Keyword)

Description Type Required Constraints

TemplateId Image processing 
template ID

String Yes None

Output Output address Container. For more information, 
see Output.

Yes None

MediaWorkflow_Topology_Nodes_Tts_***_Operation

Node Name 
(Keyword)

Description Type Required Constraints



Cloud Infinite

©2013-2022 Tencent Cloud. All rights reserved. Page 2295
of 2300

TemplateId Text-to-speech 
template ID

String Yes None

Output Output address Container. For more information, 
see Output.

Yes None

MediaWorkflow_Topology_Nodes_SpeechRecognition_***_Operati
on

Node Name 
(Keyword)

Description Type Required Constraints

Output Output address Container. For more information, 
see Output.

Yes None

StreamPackConfig Packaging 
configuration

Container Yes None

MediaWorkflow_Topology_Nodes_StreamPackConfig_***_Operatio
n

Node Name (Keyword) Description Type Required Constraints

StreamPackConfig Packaging configuration Container No None

 StreamPackConfig  has the following sub-nodes:

Node Name 
(Keyword)

Description Type Required Constraints

PackType
Packaging type. Default 
value:  HLS . String No HLS/DASH

IgnoreFailedStream

Whether to ignore the 
substream failed to be 
transcoded and continue 
packaging. Default value: 
 true .

String No true/false
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MediaWorkflow_Topology_Nodes_VideoStream_***_Operation

Node Name 
(Keyword)

Description Type Required Constraints

TemplateId
Audio/Video 
transcoding 
template ID

String No None

WatermarkTemplateId Watermark 
template ID

String array No

Up to three 
watermark 
template IDs are 
supported.

RemoveWatermark
Watermark 
removal 
parameter

Container. For more 
information, see 
RemoveWatermark.

No None

Output Output address Container. For more 
information, see Output.

Yes None

MediaWorkflow_Topology_Nodes_StreamPack_***_Operation

Node Name (Keyword) Description Type Required Constraints

StreamPackInfo Packaging rule Container No None

 StreamPackInfo  has the following sub-nodes:

Node Name 
(Keyword)

Description Type Required Constraints

VideoStreamConfig Video substream 
configuration

Container No None

 VideoStreamConfig  has the following sub-nodes:

Node Name 
(Keyword)

Description Type Required Constraints

VideoStreamName Video substream name String Yes It must be consistent with the 
existing video node.
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BandWidth Video substream 
bandwidth limit. Unit: b/s. 
Value range: [0, 
2000000000], where 0 
indicates no limit.

String No The value must be equal to 
or greater than 0. The default 
value is  0 .

AudioMix

Node Name 
(Keyword)

Description Type Required Default 
Value

Constraints

AudioSource
Address of the audio 
track file to be mixed String Yes None

It must be stored in the 
same bucket as the input 
media file.

MixMode Audio mix mode String No Repeat

Repeat: Repeats the 
background sound 
Once: Plays back the 
background sound once

Replace

Whether to replace 
the original audio of 
the input media file 
with the mixed audio 
track

String No false true/false

EffectConfig Audio mix transition 
configuration

Container No false None

 EffectConfig   has the following sub-nodes:

Node Name 
(Keyword)

Description Type Required Default 
Value

Constraints

EnableStartFadein Enables fade-
in

String No false true/false

StartFadeinTime Fade-in 
duration

String No None A floating point number 
above 0

EnableEndFadeout Enables fade-
out

String No false true/false

EndFadeoutTime Fade-out String No None A floating point number 
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duration above 0

EnableBgmFade

Enables fade-
in for 
background 
music 
transition

String No false true/false

BgmFadeTime

Fade-in 
duration for 
background 
music 
transition

String No None
A floating point number 
above 0

CallBackMqConfig

Node Name 
(Keyword)

Description Type Required

MqRegion
Message queue region. Valid values:  sh  (Shanghai),  bj  
(Beijing),  gz  (Guangzhou),  cd  (Chengdu),  hk  (Hong 
Kong, China).

String Yes

MqMode
Message queue mode. Default value:  Queue . 
 Topic : Topic subscription 
 Queue : Queue service 

String Yes

MqName TDMQ topic name String Yes

DigitalWatermark

Node 
Name 
(Keyword)

Description Type Required Constraints

Message
The watermark information 
embedded by the digital 
watermark

String Yes
It can contain up to 64 letters, digits, 
underscores (_), hyphens (-), and 
asterisks (*).

Type Digital watermark type String Yes It currently can be set to  Text  only.

Version Digital watermark version String Yes It currently can be set to  V1  only.
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IgnoreError
Whether to ignore the 
watermarking failure and 
continue the job.

String Yes Valid values:  true ,  false .

State

Whether the watermark is 
added successfully. Valid 
values:  Running , 
 Success ,  Failed .

string No
This field cannot be set actively; 
instead, it will be returned after the job 
is submitted successfully.

DashEncrypt

Node Name 
(Keyword)

Description Type Required Default 
Value

Constraints

IsEncrypt Whether to enable 
DASH encryption

String No false true/false

UriKey DASH encryption key String No None

This parameter will take 
effect only when 
 IsEncrypt  is 
 true .

HlsEncrypt

Node Name 
(Keyword)

Description Type Required Default 
Value

Constraints

IsEncrypt Whether to enable 
HLS encryption

String No false true/false

UriKey HLS encryption key String No None
This parameter will take 
effect only when 
 IsEncrypt  is  true .

RemoveWatermark

Node Name 
(Keyword)

Description Type Required Constraints
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Dx X-axis offset of the top-left 
corner origin

String Yes Value range: [0, 
4096]
Unit: px

Dy
Y-axis offset of the top-left 
corner origin String Yes

Value range: [0, 
4096]
Unit: px

Width Watermark width String Yes
Value range: (0, 
4096]
Unit: px

Height Watermark height String Yes
Value range: (0, 
4096]
Unit: px

SmartCover

Node Name 
(Keyword)

Description Type Required Default 
Value

Constraints

Format Image format String No jpg jpg, png, webp

Width Width String No
Original 
video width

Value range: [128, 4096]
Unit: px
If only Width is set, Height is 
calculated based on the 
original video aspect ratio.

Height Height String No
Original 
video 
height

Value range: [128, 4096]
Unit: px
If only Height is set, Width is 
calculated based on the 
original video aspect ratio.

Count Number of 
screenshots

String No 3 [1,10]

DeleteDuplicates
Whether to 
deduplicate 
thumbnails.

String No false true/false


